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Preface

While SAS and SPSS have many things in common, R is very different. My
goal in writing this book is to help you translate what you know about SAS or
SPSS into a working knowledge of R as quickly and easily as possible. I point
out how they differ using terminology with which you are familiar, and show
you which add-on packages will provide results most like those from SAS or
SPSS. I provide many example programs done in SAS, SPSS, and R so that
you can see how they compare topic by topic.
When finished, you should know how to:

e Install R, choose a user interface, and choose and install add-on packages.

e Read data from various sources such as text or Excel files, SAS or SPSS
data sets, or relational databases.

e Manage your data through transformations, recodes, and combining data
sets from both the add-cases and add-variables approaches and restructur-
ing data from wide to long formats and vice versa.

e Create publication-quality graphs including bar, histogram, pie, line, scat-
ter, regression, box, error bar, and interaction plots.

e Perform the basic types of analyses to measure strength of association and
group differences, and be able to know where to turn to learn how to do
more complex methods.

Who This Book Is For

This book teaches R requiring no prior knowledge of statistical software. How-
ever, you know SAS or SPSS this book will make learning R as easy as possible
by using terms and concepts that you already know. If you do not know SAS
or SPSS, then you will learn R along with how it compares to the two most
popular commercial packages for data analysis. Stata users would be better
off reading R for Stata Users [41].
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An audience I did not expect to serve is R users wanting to learn SAS or
SPSS. However, I have heard from quite a few of them who have said that
by explaining the differences, it helped them learn in the reverse order I had
anticipated. Keep in mind that I explain none of the SAS or SPSS programs,
only the R ones and how the packages differ, so it is not ideal for that purpose.

Who This Book Is Not For

I make no effort to teach statistics or graphics. Although I briefly state the goal
and assumptions of each analysis along with how to interpret their output,
I do not cover their formulas or derivations. We have more than enough to
discuss without tackling those topics too.

This is also not a book about writing complex R functions, it is about
using the thousands that already exist. We will write only a few very short
functions. If you want to learn more about writing functions, I recommend
Jones et al.’s Introduction to Scientific Programming and Simulation Using R
[31]. However, reading this book should ease your transition to more complex
books like that one.

Practice Data Sets and Programs

All of the programs, data sets, and files that we use in this book are avail-
able for download at http://rdstats.com. A file containing corrections and
clarifications is also available there.

Regarding the Second Edition

As the first edition went to press, I began planning the second edition with the
main goal of adding more statistical methods. However, my readers quickly
let me know that they needed far more information about the basics. There
are many wonderful books devoted to statistics in R. I recommend some in
Chap. 17. The enhancements to this edition include the following:

1. Programming code has been updated throughout.

2. It is easier to find reference material using the new list of tables and list
of figures.

3. It is easier to find topics using the index, which now has four times as
many entries.

4. The glossary defines more R terms.

5. There is a new Sect. 3.6, “Running R in SAS and WPS,” including A
Bridge to R and IML Studio.

6. There is a new Sect. 3.9, “Running R from within Text Editors.”
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There is a new Sect. 3.8, “Running R in Excel,” complete with R Com-
mander menus.

. There is a new Sect. 3.10 on integrated development environments, in-

cluding RStudio.

. There is a new Sect. 3.11.1 on the Deducer user interface and its Plot

Builder (similar to IBM SPSS Visualization Designer).

New Sect. 3.11.4 on Red-R, a flowchart user interface like SAS Enterprise
Miner or IBM SPSS Modeler (Clementine).

Chapter 5, “Programming Language Basics,” has been significantly en-
hanced, including additional examples and explanations.

There is a new Sect. 5.3.4 on matrix algebra with table of basic matrix
algebra functions.

There is a new Sect. 5.6, “Comments to Document Your Objects.”
Chapter 6, “Data Acquisition,” includes improved examples of reading SAS
and SPSS data files.

There is a new Sect. 6.2.3, “Reading Text from a Web Site.”

There is a new Sect. 6.2.4, “Reading Text from the Clipboard.”

There is a new Sect. 6.2.6, “Trouble with Tabs,” on common problems
when reading tab-delimited files.

Section 6.3, “Reading Text Data Within a Program,” now includes a sim-
pler approach using the stdin function.

There is a new Sect. 6.4 “Reading Multiple Observations per Line.”
There are new sections on reading/writing Excel files.

There is a new Sect. 6.9, “Reading Data from Relational Databases.
There is a new Sect. 7.11.1, “Selecting Numeric or Character Variables,”
(like VAR A-numeric-Z; or A-character-Z).

There is a new Sect. 8.4, “Selecting Observations using Random Sampling.”
Chapter 9, “Selecting Variables and Observations,” has many more exam-
ples, and they are presented in order from most widely used to least.
There is a new Table 10.2, “Basic Statistical Functions.”

There is a new Sect. 10.2.3 “Standardizing and Ranking Variables.”
Section 10.14, “Removing Duplicate Observations,” now includes an exam-
ple for eliminating observations that are duplicates only on key variables
(i.e., PROC SORT NODUPKEY).

There is a new Sect. 10.16, “Transposing or Flipping Data Sets” (tricky
with character variables).

There is a new Sect. 10.20, “Character String Manipulations,” using the
stringr package.

There is a new Sect. 10.21, “Dates and Times,” which covers date/time
manipulations using the lubridate package.

The new Chap. 11, “Enhancing Your Output,” covers how to get publica-
tion quality tables from R into word processors, Web pages or KTEX.
The new Sect. 12.4, “Generating Values for Reading Fixed-Width Files,”
shows how to generate repetitive patterns of variable names and matching
widths for reading complex text files.



viii Preface

33. There is a new Sect. 16.15, which shows how to make geographic maps.

34. There is a new Sect. 17.11 “Sign Test: Paired Groups.”

35. Appendix B, A Comparison of SAS and SPSS Products with R Packages
and Functions,” is now far more comprehensive and changes so frequently
that I have moved it from the appendix to http://r4stats.com.
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Introduction

1.1 Overview

Norman Nie, one of the founders of SPSS, calls R [55] “The most powerful
statistical computing language on the planet.”! Written by Ross Ihaka, Robert
Gentleman, the R Core Development Team, and an army of volunteers, R pro-
vides both a language and a vast array of analytical and graphical procedures.
The fact that this level of power is available free of charge has dramatically
changed the landscape of research software.

R is a variation of the S language, developed by John Chambers with
substantial input from Douglas Bates, Rick Becker, Bill Cleveland, Trevor
Hastie, Daryl Pregibon, and Allan Wilks.? The Association of Computing
Machinery presented John Chambers with a Software System Award and said
that the S language, ... will forever alter the way people analyze, visualize,
and manipulate data...” and went on to say that it is, ... an elegant, widely
accepted, and enduring software system, with conceptual integrity....” The
original S language is still commercially available as Tibco Spotfire S+. Most
programs written in the S language will run in R.

The SAS Institute, IBM’s SPSS Company, and other vendors are helping
their customers extend the power of their software through R. They have
added interfaces that allow you to use R functions from within their programs,
expanding their capabilities. You can now blend SAS or IBM SPSS Statistics
(hereafter referred to as simply SPSS) code with R, easily transferring data
and output back and forth.

SAS and SPSS are so similar to each other that moving from one to the
other is straightforward. R, however, is very different, making the transition
confusing at first. I hope to ease that confusion by focusing on the similarities

! He said this after moving to Revolution Analytics, a company that sells a version
of R.

2 For a fascinating history of S and R, see Appendix A of Software for Data Anal-
ysis: Programming with R [12].

R.A. Muenchen, R for SAS and SPSS Users, Statistics and Computing, 1
DOI 10.1007/978-1-4614-0685-3 1, © Springer Science+Business Media, LLC 2011
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and differences in this book. When we examine a particular analysis by, say,
comparing two groups with a t-test, someone who knows SAS or SPSS will
have very little trouble figuring out what R is doing. However, the basics of
the R language are very different, so that is where we will spend most of our
time.

For each aspect of R we discuss, I will compare and contrast it with SAS
and SPSS. Many of the topics end with example programs that do almost
identical things in all three. The R programs often display more variations
on each theme than do the SAS or SPSS examples, making the R programs
longer.

I introduce topics in a carefully chosen order, so it is best to read from
beginning to end the first time through, even if you think you do not need
to know a particular topic. Later you can skip directly to the section you
need. I include a fair amount of redundancy on key topics to help teach those
topics and to make it easier to read just one section as a future reference. The
glossary in Appendix A defines R concepts in terms that SAS or SPSS users
will understand, and provides parallel definitions using R terminology.

1.2 Why Learn R?

If you already know SAS or SPSS, why should you bother to learn R? Both
SAS and SPSS are excellent packages for analyzing data. I use them both
several times a week. However, R has many benefits:

e R offers a vast array of analytical methods. There are several thousand add-
on packages available for R on the Internet, and you can easily download
and install them within R itself.

e R offers new methods sooner. Since people who develop new analytic meth-
ods often program in R, you often get access to them years before the
methods are added to SAS or SPSS.

e Many analytic packages can run R programs. These include: SAS, SPSS,
Excel, JMP, Oracle Data Mining, Statistica, StatExact, and others. This
provides you the option of using R functions without having to learn its
entire language. You can do all your data management in your preferred
software, and call the R functions you need from within it.

e R is rapidly becoming a universal language for data analysis. Books and
journals frequently use R for their examples because they know everyone
can run them. As a result, understanding R is important for your continu-
ing education. It also allows you to communicate your analytic ideas with
a wide range of colleagues.

e R’s graphics are extremely flexible and are of publication quality. They are
flexible enough to overlay data from different data sets, even at different
levels of aggregation. You are even free to completely replace R’s graphics
subsystem, as people have already done.
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e R is very flexible in the type of data it can analyze. While SAS and SPSS
require you to store your data in rectangular data sets, R offers a rich
variety of data structures that are much more flexible. You can perform
analyses that include variables from different data structures easily without
having to merge them.

e R has object oriented abilities. This provides many advantages including
an ability to “do the right thing.” For example, when using a categorical
variable as a predictor in a linear regression analysis, it will automatically
take the proper statistical approach.

e If you like to develop your own analytic methods, you'll find much to like
in the power of R’s language. The vast array of add-ons for R demonstrates
that people who like to develop new methods like working in R.

e R’s procedures, called functions, are open for you to see and modify. This
makes it easier to understand what it is doing. Copying an existing function
and then modifying it is a common way to begin writing your own function.

e Functions that you write in R are automatically on an equal footing with
those that come with the software. The ability to write your own com-
pletely integrated procedures in SAS or SPSS requires using a different
language such as C or Python and, in the case of SAS, a developer’s kit.

e R has comprehensive matrix algebra capabilities similar to those in MAT-
LAB. It even offers a MATLAB emulation package [48].

e R runs on almost any computer, including Windows, Macintosh, Linux,
and UNIX.

e R is free. This has an obvious appeal to corporate users. Even academics
who purchase software at substantial discounts for teaching and internal
use will appreciate the fact that they can consult with outside organiza-
tions without having to purchase a commercial license.

1.3 Is R Accurate?

When people first learn of R, one of their first questions is, “Can a package
written by volunteers be as accurate as one written by a large corporation?”
Just as with SAS and SPSS, the development of the main R package, referred
to as Base R plus Recommended Packages, is handled with great care. This
includes levels of beta testing and running validation suites to ensure accu-
rate answers. When you install R, you can ask it to install the Test Files,
which includes the tools package and a set of validation programs. See the R
Installation and Administration Manual [56] on the R help menu for details.

The various quality assurance steps used with each version of R are
outlined in [19]. R’s Base and Recommended Packages currently consist of
the following packages: base, boot, class, cluster, codetools, datasets,
foreign, graphics, grDevices, grid, KernSmooth, lattice, MASS, methods,
mgcv, nlme, nnet, rpart, spatial, splines, stats, stats4, survival, tcltk,
tools and utils. Those packages, and the functions they contain, are roughly
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the equivalent to Base SAS, SAS/GRAPH, SAS/STAT and SAS/IML. Com-
pared to SPSS products, they cover similar territory as IBM SPSS Statistics
Base, IBM SPSS Advanced Statistics, and IBM SPSS Regression. The help
files show in which each package each function resides.

Just as with SAS or SPSS programs or macros that you find on the In-
ternet, R’s add-on packages may or may not have been put through rigorous
testing. They are often written by the university professors who invented the
methods the packages implement. In that case, the work has usually passed the
academic journal peer-review process with three experts in the field checking
the work. However, a package could have been written by some poor program-
mer who just learned R.

One way you can estimate the quality of a given package is to see how
people rate it at http://crantastic.org. You can also search the R-help
archives to see what people are saying about a package that interests you. For
details on R-help, see Chap. 4, "Help and Documentation”.

It is to their credit that the SAS Institute and SPSS, Inc. post databases of
known bugs on their Web sites, and they usually fix problems quickly. R also
has open discussions of its known bugs and R’s developers fix them quickly,
too. However, software of this complexity will never be completely free of
errors, regardless of its source.

The most comprehensive study of R’s accuracy to date was done by Keeling
and Pavur [33]. They compared nine statistics packages on the accuracy of
their univariate statistics, analysis of variance, linear regression, and nonlinear
regression. The accuracy of R was comparable to SAS and SPSS and, by the
time the article was published, Bolker [9] found that R’s accuracy had already
improved.

Another study by Almiron et al. [1] replicated the Keeling and Pavur
results, verified that R’s accuracy had improved, and found R to be more
accurate than several other open source packages.

1.4 What About Tech Support?

When you buy software from SAS or SPSS, you can call or e-mail for tech
support that is quick, polite, and accurate. Their knowledgeable consultants
have helped me out of many a jam.

If you use the free version of R, you do not get a number to call, but you
do get direct access to the people who wrote the program and others who
know it well via e-mail. They usually answer your question in less than an
hour. Since they are scattered around the world, that support is around the
clock.

The main difference is that the SAS or SPSS consultants will typically
provide a single solution that they consider best, while the R-help list respon-
ders will often provide several ways to solve your problem. You learn more
that way, but the solutions can vary quite a bit in level of difficulty. However,
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by the time you finish this book, that should not be a problem. For details on
the various R e-mail support lists, see Chap. 4, “Help and Documentation.”

There are companies that provide various types of support for a fee. Ex-
amples of such organizations are Revolution Analytics, Inc., RStudio, Inc.,
and XL-Solutions Corporation.

1.5 Getting Started Quickly

If you wish to start using R quickly, you can do so by reading fewer than fifty
pages of this book. Since you have SAS, the SAS-compatible World Program-
ming System (WPS), or SPSS to do your basic descriptive statistics, you are
likely to need R’s modeling functions. Here are the steps you can follow to use
them.

1. Read the remainder of this chapter and Chap. 2, “Installing and Updating
R.” Download and install R on your computer.

2. Read the part of Chap. 3, “Running R,” that covers your operating system
and running R from within either SAS, WPS or SPSS.

3. In Chap. 5, “Programming Language Basics,” read Sect. 5.3.2 about fac-
tors, and Sect. 5.3.3 about data frames.

4. Also in Chap. 5, read Sect. 5.7.1, “Controlling Functions with Arguments,”
and Sect. 5.7.3, “Controlling Functions with Formulas,” including Ta-
ble 17.1, “Example formulas in SAS, SPSS, and R.”

5. If you do not have SAS/IML Studio, or MineQuest’s A Bridge to R, read
Sect. 6.10, “Reading Data from SAS.”

After reading the pages above, do all your data management in SAS, WPS
or SPSS, stripping out observations containing any missing values. Then save
the data to a new file to pass to SAS or SPSS using their internal links to R.
Assuming your variables are named y, x1, x2, ..., your entire R program will
look something like this:

library("TheLibraryYouNeed") # If you need any.

mymodel <- TheFunctionYouNeed(y ~ x1 + x2, data = mydata)
summary (mymodel)

plot (mymodel) # If your function does plots.

We will discuss what these commands mean shortly. The ones that begin
with “#” are comments.

1.6 The Five Main Parts of SAS and SPSS

While SAS and SPSS offer hundreds of functions and procedures, they fall

into five main categories:
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1. Data input and management statements that help you read, transform,
and organize your data.

2. Statistical and graphical procedures to help you analyze data. You could
certainly consider these two as separate categories, but they share a similar
syntax and you can use them in the same parts of programs;

3. An output management system to help you extract output from statistical
procedures for processing in other procedures or to let you customize
printed output. SAS calls theirs the Output Delivery System (ODS) and
SPSS calls theirs the Output Management System (OMS);

4. A macro language to help you use sets of the above commands repeatedly;

5. A matrix language to add new algorithms (SAS/IML and SPSS Matrix).

SAS and SPSS handle each of these five areas with different systems that
follow different rules. For simplicity’s sake, introductory training in SAS or
SPSS typically focuses on only the first two topics. Perhaps the majority of
users never learn the more advanced topics. However, R performs these five
functions in a way that completely integrates them all. The integration of
these five areas gives R a significant advantage in power and is the reason
that most R developers write procedures using the R language.

While we will focus on topics 1 and 2 when discussing SAS and SPSS, we
will discuss some of all five regarding R. Since SAS and SPSS procedures tend
to print all of their output at once, a relatively small percentage of their users
take advantage of their output management systems. Virtually all R users use
output management. That is partly because R shows you only the pieces of
output you request, and partly because R’s output management is easier to
use. For example, you can create and store a linear regression model using the
1m function.

myModel <- 1lm(y ~ x)

You can then get several diagnostic plots with the plot function.
plot (myModel)

You can compare two models using the anova function.
anova(myModell, myModel2)

That is a very flexible approach! It requires fewer commands than SAS or
SPSS and it requires almost no knowledge of how the model is stored. The
plot and anova functions have a built-in ability to work with models and
other data structures.

The price R pays for this output management advantage is that the output
to most procedures is sparse and does not appear as publication quality within
R itself. It appears in a monospace font without a word-processor-style table
structure or even tabs between columns. Variable labels are not a part of the
core system, so if you want clarifying labels, you add them in other steps.
You can use functions from add-on packages to write out HTML, ODF, or
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ITEX files to use in word processing tools. SPSS and, more recently, SAS
make output that is publication quality by default, but not as easy to use as
input to further analyses.

On the topic of matrix languages, SAS and SPSS offer them in a form
that differs sharply from their main languages. For example, the way you
select variables in the main SAS product bears no relation to how you select
them in SAS/IML. In R, the matrix capabilities are completely integrated and
follow the same rules.

1.7 Our Practice Data Sets

Throughout much of this book we will use a small artificial data set named
mydata. This allows me to show you how to enter and manipulate it in many
ways without much work on your part. The data set is a pretend survey of
students who attended some workshops to learn statistical software. It records
which workshop they took, their gender, and their responses to four questions:

ql — The instructor was well prepared.

q2 — The instructor communicated well.
g3 — The course materials were helpful.

g4 — Overall, I found this workshop useful.

The values for the workshops are 1, 2, 3, and 4 for R, SAS, SPSS, and
Stata respectively. In the smallest form of these data, only the R and SAS
workshops appear. Here is mydata:

workshop gender ql g2 g3 q4

1 1 f 1 1 56 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 NA 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 b

The letters “NA” stand for Not Available, or missing.

In Chap. 5 we will create various small R objects. They are all stored in a
file named myall. RData.

When we study missing data, we will use a version of these data named
mydataNA. That file contains many missing values coded in different ways.

For examples that require more data the data set mydata100 has 100 obser-
vations in the same form, plus two additional variables, pretest and posttest.
A version of this data set that adds variable labels is mydatal00L, with the
“L” standing “labeled.”
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Here are the first few observations from mydatal00:

workshop gender ql g2 g3 g4 pretest posttest

1 R Female 4 3 4 5 72 80
2 SPSS Male 3 4 3 4 70 75
3 <NA> <NA> 3 2 NA 3 74 78
4 SPSS Female 5 4 5 3 80 82
5 Stata Female 4 4 3 4 75 81
6 SPSS Female 5 4 3 b5 72 77

We will occasionally treat the survey questions as interval-level data, which
is a bit of a stretch. In a more realistic setting, we would have several items
for each topic and we would create mean scores containing many more values
than simply 1, 2, 3, 4, and 5.

Finally, when learning to read and manipulate dates and character strings,
we will use a very small data file containing some famous people from the field
of statistics:

born, died
R.A. Fisher, 2/17/1890, 7/29/1962
Carl Pearson, 3/27/1857, 4/27/1936
Gertrude Cox, 1/13/1900, 10/17/1978
John Tukey, 6/16/1915, 7/26/2000
William Gosset, 6/13/1876, 10/16/1937

1.8 Programming Conventions

The example programs are set to look for their matching data files in a folder
named myRfolder, but that is easy to change to whatever location you prefer.
Each program begins by loading the data as if it were a new session. That
is not required if you already have the data loaded, but it makes it easier to
ensure that previous programming does not interfere with the example. It also
allows each program to run on its own.

Each example program in this book begins with a comment stating its
purpose and the name of the file it is stored in. For example, each of the
programs for selecting variables begin with a comment like the following.

# R Program for Selecting Variables.
# Filename: SelectingVars.R

R uses the “#” symbol at the beginning of comments used to document
programs. The filename in the practice files will always match, so the three files
for this topic are SelectingVars.sas, SelectingVars.sps, and SelectingVars.R.
Each R data object in this book is available in a single file. Its name is the
same as is used in the book, with the extension “.RData.” For example, our
most widely used data object, mydata, is stored in mydata. RData. Also, the
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objects we create and use frequently, data and functions, are all stored in
my Workspace. R Data.

1.9 Typographic Conventions

All programming code and the names of all R functions and packages are
written in this Courier font. The names of other documents and menus
is in this italic font. Menus appear in the form File> Save as, which means
“choose Save as from the File menu.”

When learning a new language, it can be hard to tell the commands from
the names you can choose (e.g., variable or data set names). To help differ-
entiate, I CAPITALIZE statements in SAS and SPSS and use lowercase for
names that you can choose. However, R is case-sensitive, so I have to use the
exact case that the program requires. Therefore, to help differentiate, I use
the common prefix “my” in names like mydata or mySubset.

R uses “>” to prompt you to input a new line and “+” to prompt you to
enter a continued line. When there is no output to see, I delete the prompt
characters to reduce clutter. However, when examples include both input and
output, I leave the input prompts in place. That helps you identify which is
which. So the first three lines below are the input I submitted and the last
line is the mean that R wrote out.

> ql <- c(1, 2, 2, 3,

+ 4, 5, 5, 5, 4)
> mean(ql)

[1] 3.4444

R tends to pack its input and different sections of output tightly together.
This makes it harder to read when you are learning it. Therefore, I also add
spacing in some places to improve legibility. In the example above, I added a
blank line on either side of the line containing “> mean(q1)”.
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Installing and Updating R

When you purchase SAS, WPS or SPSS; they sell you a “binary” version. That
is one that the company has compiled for you from the “source code” version
they wrote using languages such as C, FORTRAN, or Java. You usually install
everything you purchased at once and do not give it a second thought. Instead,
R is modular. The main installation provides Base R and a recommended set
of add-on modules called packages. You can install other packages later when
you need them. With thousands to choose from, few people need them all.

To download R itself, go to the Comprehensive R Archive Network
(CRAN) at http://cran.r-project.org/. Choose your operating system
under the web page heading, Download and Install R. The binary versions
install quickly and easily. Binary versions exist for many operating systems
including Windows, Mac OS X, and popular versions of Linux such as Ubuntu,
RedHat, Suse, and others that use either the RPM or APT installers.

Since R is an Open Source project, there are also source code versions of
R for experienced programmers who prefer to compile their own copy. Using
that version, you can modify R in any way you like. Although R’s developers
write many of its analytic procedures (or at least parts of them) using the R
language, they use other languages such as C and FORTRAN to write R’s
most fundamental functions.

Each version of R installs into its own directory (folder), so there is no
problem having multiple versions installed on your computer. You can then
install your favorite add-on packages for the new release.

2.1 Installing Add-on Packages

While the main installation of R contains many useful functions, many addi-
tional packages, written by R users, are available on the Internet. The main
site for additional packages is at the CRAN web site under Packages. The sec-
tion labeled Tusk Views organizes packages by task, such as Bayesian, Cluster
Analysis, Distribution, Econometrics, and so on. While CRAN is a good place

R.A. Muenchen, R for SAS and SPSS Users, Statistics and Computing, 11
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to read about and choose packages to install, you usually do not need to down-
load them from there yourself. As you will see, R automates the download and
installation process. A comparison of SAS and SPSS add-ons to R packages is
presented at this book’s web site, http://www.rdstats.com. Another useful
site helps you to find useful packages and write reviews of packages you like:
Crantastic at http://crantastic.org/

Before installing packages, your computer account should have adminis-
trative privileges and you must start R in a manner that allows administrative
control. If you do not have administrative privileges on your computer, you can
install packages to a directory to which you have write access. For instructions,
see the FAQ (Frequently Asked Questions) at http://www.r-project.org/.

To start R with administrative control on Windows Vista or later, right-
click its menu choice and then choose Run as administrator. Window’s User
Account Control will then ask for your permission to allow R to modify your
computer.

On the R version for Microsoft Windows, you can choose Packages> Install
package(s) from the menus. It will ask you to choose a CRAN site or “mirror”
that is close you:

CRAN mirror
Australia
Austria
Belgium
Brazil (PR)
USA (TX 2)
USA (WA)
Then it will ask which package you wish to install:

Packages
abc
abd
abind
AcceptanceSampling

zipcode
Z00
zyp
Choose one of each and click OK.
If you prefer to use a function instead of the menus, you can use the

install.packages function. For example, to download and install Frank Har-
rell’s Hnisc package [32], start R and enter the command:

install.packages("Hmisc")
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R will then prompt you to choose the closest mirror site and the package
you need. If you are using a graphical user interface (GUT), you click on your
choice, then click OK. If not, R will number them for you and you enter the
number of the mirror.

A common error is to forget the quotes around the package name:

> install.packages(Hmisc) # Quotes are missing!

Error in install.packages(Hmisc) : object 'Hmisc' not found

Older versions of R also required the argument dependencies = TRUE,
which tells R to also install any packages that this package “depends” on and
those that its author “suggests” as useful. That is now the default setting and
so it is usually best to avoid adding that. However, a few packages still require
that setting. The best known of these packages is Fox’s R Commander user
interface. So you would install it using:

install.packages("Rcmdr", dependencies = TRUE)

After a package is installed, you can find out how to cite it using the
citation function. Note that you call this function with the package name in
quotes:

> citation("Rcmdr")
To cite package 'Rcmdr' in publications use:

John Fox <jfox@mcmaster.ca>, with
contributions from ...(2010). Rcmdr: R
Commander. R package version 1.6-2.
http://CRAN.R-project.org/package=Rcmdr

A BibTeX entry for LaTeX users is

@Manuald{,
title = {Rcmdr: R Commander},
author = {John Fox and with contributions from ...

If you use simply citation() it will tell you how to cite R itself.

2.2 Loading an Add-on Package

Once installed, a package is on your computer’s hard drive in an area called
your library. However, it is not quite ready to use. Each time you start R,
you also have to load the package from your library into your computer’s
main memory before you can use it. The reason for this additional step is
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twofold. It makes efficient use of your computer’s memory and it keeps different
packages conflicting with each other, or with base R functions. You can see
what packages are installed and ready to load with the library function:

> library()

R Packages available
Packages in library 'C:/PROGRA~1/R/R-21271.1/library':

anchors  Statistical analysis of surveys with...
arules Mining Association Rules and Frequent Itemsets
base The R Base Package

xtable Export tables to LaTeX or HTML
xts Extensible Time Series
Zelig Everyone's Statistical Software

If you have just installed R, this command will show you the Base and
Recommended Packages. They are the ones that are thoroughly tested by the
R Core Team. The similar installed.packages function lists your installed
packages along with the version and location of each.

You can load a package you need with the menu selection, Packages> Load
packages. It will show you the names of all packages that you have installed
but have not yet loaded. You can then choose one from the list.

Alternatively, you can use the library function. Here I am loading the
Hmisc package. Since the Linux version lacks menus, this function is the only
way to load packages.

library("Hmisc")

With the library function, the quotes around the package name are op-
tional and are not usually used. However, other commands that refer to pack-
age names — such as install.packages — require them.

Many packages load without any messages; you will just see the “>” prompt
again. When trying to load a package, you may see the error message below. It
means you have either mistyped the package name (remember capitalization
is important) or you have not installed the package before trying to load
it. In this case, Lemon and Grosjean’s prettyR [38] package name is typed
accurately, so I have not yet installed it.

> library("prettyR")

Error in library("prettyR")
there is no package called 'prettyR'

To see what packages you have loaded, use the search function.
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> search()

[1] ".GlobalEnv" "package:Hmisc"
[3] "package:stats" "package:graphics"
[5] "package:grDevices" "package:utils"
[7] "package:datasets" '"package:methods"
[9] "Autoloads" "package:base"

We will discuss this function in detail in Chapter 13, “Managing Your Files
and Workspace.”

Since there are so many packages written by users, two packages will occa-
sionally have functions with the same name. That can be very confusing until
you realize what is happening. For example, the Hnisc and prettyR packages
both have a describe function that does similar things. In such a case, the
package you load last will mask the function(s) in the package you loaded ear-
lier. For example, I loaded the Hmisc package first, and now I am loading the
prettyR package (having installed it in the meantime). The following message
results:

> library("prettyR")

Attaching package: 'prettyR'
The following object(s) are masked from package:Hmisc :
describe

Since people usually want to use the functions in the package they loaded
most recently, this is rarely a problem. However, if warnings like these bother
you, you can avoid them by detaching each package as soon as you are done
using it by using the detach function. For details, see Section 13.4, “Loading
Packages.”

If your favorite packages do not conflict with one anther, you can have R
load them each time you start R by putting the commands in a file named
“.Rprofile”. That file can automate your settings just like the autoexec.sas file
for SAS. For details, see Appendix C.

2.3 Updating Your Installation

Keeping your add-on packages current is very easy. You simply use the
update.packages function.

> update.packages()

graph :
Version 1.15.6 installed in C:/PROGRA™1/R/R-2671.1/library
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Version 1.16.1 available at
http://rh-mirror.linux.iastate.edu/CRAN

Update (y/N/c)? y

R will ask you if you want to update each package. That can get tedious if
you have a lot of packages to install. You can avoid that starting the update
process with:

update.packages(ask = FALSE)

W, 9

If you enter “y,” it will do it and show you the following. This message, repeated
for each package, tells you what file it is getting from the mirror you requested
(Towa State) and where it placed the file.

trying URL 'http://rh-mirror.linux.iastate.edu
/CRAN/bin/windows/contrib/2.6/graph_1.16.1.zip'

Content type 'application/zip' length 870777 bytes (850 Kb)

opened URL

downloaded 850 Kb

This next message tells you that the file was checked for errors (its sums
were checked) and it says where it stored the file. As long as you see no error
messages, the update is complete.

package 'graph' successfully unpacked and MD5 sums checked

The downloaded packages are in
C:/Documents and Settings/muenchen/Local Settings/
Temp/Rtmpgf4C4B/downloaded_packages
updating HTML package descriptions

Moving to a whole new version of R is not as easy. First, you download and
install the new version just like you did the first one. Multiple versions can
coexist on the same computer. You can even run them at the same time if you
wanted to compare results across versions. When you install a new version of
R, T recommend also installing your add-on packages again. There are ways
to point your new version to the older set of packages, I find them more
trouble than they are worth. You can reinstall your packages in the step-
by-step fashion discussed previously. An easier way is to define a character
variable like “myPackages” that contains the names of the packages you use.
The following is an example that uses this approach to install most of the
packages we use in this book!.

myPackages <- c("car", "hexbin", "Hmisc", "ggplot2",
"gmodels", "gplots", "reshape2", "prettyR", "xtable")

! R Commander is left out since it requires dependencies = TRUE.
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install.packages (myPackages)

We will discuss the details of the ¢ function used above later. We will also
discuss how to store programs like this so you can open and execute them
again in the future. While this example makes it clear what we are storing
in myPackages, a shortcut to creating it is to use the installed.packages
function:

myPackages <- row.names( installed.packages() )

You can automate the creation of myPackages (or whatever name you
choose to store your package names) by placing either code example that
defines it in your .Rprofile. Putting it there will ensure that myPackages is
defined every time you start R. As you find new packages to install, you
can add to the definition of myPackages. Then installing all of them when a
new version of R comes out is easy. Of course, you do not want to place the
install.packages function into your .Rprofile. There is no point in installing
package every time you start R! For details, see Appendix C.

2.4 Uninstalling R

When you get a new version of any software package, it is good to keep the
old one around for a while in case any bugs show up in the new one. Once
you are confident that you will no longer need an older version of R, you can
remove it.

In Microsoft Window, uninstall it in the usual way using Start> Control
Panel, then Programs and Features. To uninstall R on the Macintosh, simply
drag the application to the trash. Linux users should use their distribution’s
package manager to uninstall R.

2.5 Uninstalling a Package

Since uninstalling R itself also removes any packages in your library, it is
rarely necessary to uninstall packages separately. However, it is occasionally
necessary. You can uninstall a package using the uninstall.packages func-
tion. First, though, you must make sure it is not in use by detaching it. For
example, to remove just the Hmisc package, use the following code:

detach("package:Hmisc") # If it is loaded.

remove.packages ("Hmisc")
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2.6 Choosing Repositories

While most R packages are stored at the CRAN site, there are other repos-
itories. If the Packages window does not list the one you need, you may
need to choose another repository. The Omegahat Project for Statistical
Computing [59] at http://www.omegahat.org/ and R-Forge [61] at http:
//r-forge.r-project.org/ are repositories similar to CRAN that have a
variety of different packages available. There are also several repositories as-
sociated with the BioConductor project. As they say at their main web site,
http://www.bioconductor.org/, “BioConductor is an open source and open
development software project for the analysis and comprehension of genomic
data” [23].

To choose your repositories, choose Packages> Select repositories. .. and
the Repositories window will appear:

Repositories
CRAN
CRAN (extras)
Omegahat
BioC software
BioC annotation
BioC experiment
BioC extra
R-Forge
rforge.net

The two CRAN repositories are already set by default. Your operating
system’s common mouse commands work as usual to make contiguous or
noncontiguous selections. In Microsoft Window, that is Shift-click and Ctrl-
click, respectively.

You can also select repositories using the setRepositories function:

> setRepositories()

If you are using a GUI the result will be the same. If you are instead working
without a graphical user interface, R will number the repositories and prompt
you to enter the number(s) of those you need.

2.7 Accessing Data in Packages

You can get a list of data sets available in each loaded package with the data
function. A window listing the default data sets will appear:

> data()

R data sets
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Data sets in package 'datasets':

AirPassengers Monthly Airline Passenger Numbers 1949-1960

BJsales Sales Data with Leading Indicator

Cc02 Carbon Dioxide Uptake in Grass Plants

volcano Topographic Information on Auckland's...
warpbreaks The Number of Breaks in Yarn during Weaving
women Average Heights and Weights for American Women

You can usually use these practice data sets directly. For example, to look
at the top of the CO2 file (capital letters C and O, not zero!), you can use the
head function:

> head(C02)

Plant Type Treatment conc uptake
Qnl Quebec nonchilled 95 16.
Qnl Quebec nonchilled 175 30.
Qnl1 Quebec nonchilled 250 34.
Qnl Quebec nonchilled 350 37.
Qnl Quebec nonchilled 500 35.
Qnl1 Quebec nonchilled 675 39.

DO WN =
N W N 0O

The similar tail function shows you the bottom few observations.

Not all packages load their example data sets when you load the packages.
If you see that a package includes a data set, but you cannot access it after
loading the package, try loading it specifically using the data function. For
example:

data(C02)

If you only want a list of data sets in a particular package, you can use
the package argument. For example, if you have installed the car package
[21] (from Fox’s C'ompanion to Applied Regression), you can load it from the
library and see the data sets only it has using the following statements:

> library("car")
> data(package = "car")

Data sets in package 'car':
AMSsurvey American Math Society Survey Data
Adler Experimenter Expectations
Angell Moral Integration of American Cities
Anscombe U. S. State Public-School Expenditures
Baumann Methods of Teaching Reading Comprehension
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Bfox Canadian Women's Labour-Force Participation
Blackmoor Exercise Histories of Eating-Disordered...
Burt Fraudulent Data on IQs of Twins Raised Apart

You could then print the top of any data set using the head function:

> head(Adler)

instruction expectation rating

1 GOOD HIGH 25
2 GOOD HIGH 0
3 GOOD HIGH -16
4 GOOD HIGH 5
5 GOOD HIGH 11
6 GOOD HIGH -6

To see all of the data sets available in all the packages you have installed,
even those not loaded from your library, enter the following function call:

data(package = .packages(all.available = TRUE))
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Running R

There are several ways you can run R:

Interactively using its programming language: You can see the result of
each command immediately after you submit it;

Interactively using one of several GUIs that you can add on to R: Some
of these use programming while others help you avoid programming by
using menus and dialog boxes like SPSS, ribbons like Microsoft Office, or
flowcharts like SAS Enterprise Guide or SPSS Modeler (formerly Clemen-
tine);

Noninteractively in batch mode using its programming language: You enter
your program into a file and run it all at once.

From within another package, such as Excel, SAS, or SPSS.

You can ease your way into R by continuing to use SAS, SPSS, or your

favorite spreadsheet program to enter and manage your data and then use
one of the methods below to import and analyze them. As you find errors in
your data (and you know you will), you can go back to your other software,
correct them, and then import them again. It is not an ideal way to work, but
it does get you into R quickly.

3.1 Running R Interactively on Windows

You can run R programs interactively in several steps:

1. Start R by double-clicking on its desktop icon or by choosing Start> All

Programs> R> R z.x.z (where x.x.x is the version of R you are using).
The main R console window will appear looking like the left window in
Fig. 3.1. Then enter your program choosing one of the methods described
in steps 2 and 3 below.

R.A. Muenchen, R for SAS and SPSS Users, Statistics and Computing, 21
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> mydata <- read.ecsv("mydata.csv") - N N
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£ nmydata <- read.csv("mydata.csv")
mydata

£

£
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mydata <- read.csv("mydataID.csv",
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R version 2.12.1 (2010-12-16)

Fig. 3.1. R graphical user interface in Microsoft Windows with the console on the
left and an open script editor window on the right

2. Enter R commands into the R console. You can enter commands into the
console one line at a time at the “>” prompt. R will execute each line
when you press the Enter key. If you enter commands into the console,
you can retrieve them with the up arrow key and edit them to run again.
I find it much easier to use the program editor described in the next step.
If you type the beginning of an R function, such as “me” and press Tab,
R will show you all of the R functions that begin with those letters, such
as mean or median. If you enter the name of a function and an open
parenthesis, such as “mean(,” R will show you the parameters or keywords
(R calls them arguments) that you can use to control that function.

3. Enter R programming commands into the R editor. Open the R editor
by choosing File> New Script. R programs are called scripts. You can see
one on the right side of Fig. 6.1. You can enter programs as you would in
the SAS Program Editor or the SPSS Syntax Editor.

4. Submit your program from the R editor. To submit just the current line,
you can hold the Ctrl key down and press “r,” for run, or right-click on it
and choose Run line or selection, or using the menus choose, Edit> Run
line or selection. To run a block of lines, select them first, and then submit
them the same way. To run the whole program, select all lines by holding
the Ctrl key down and pressing “a” and then submit them the same way.

5. As you submit program statements, they will appear in the R Console
along with results or error messages. Make any changes you need and
submit the program again until finished. You can clear the console results
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by choosing Edit> Clear console or by holding the Ctrl key down and
pressing “1” (i.e., Ctrl-1). See Help> Console for more keyboard shortcuts.

. Save your script (program). Click on the R editor window to make it active

and choose File> Save to file. Unlike most Windows programs, R will not
automatically add the “.R” extension to files saved in the program editor.
You must actually type the extension yourself. If you forget, later when
you go to open the program R will not see the file, making you wonder if
you actually saved it!

Save your output. Click on the console window to make it active and
choose File> Save to file. The console output will contain the commands
and their output blended together like an SPSS output file rather than
the separate log and listing files of SAS. It will simply be text so giving it
a file extension of “.txt” is good. Again, you will have to actually type the
extension if later you want to be able to double-click on the file and open
it with your default text editor.

. Save your data and any functions you may have written. The data or

function(s) you created are stored in an area called your workspace. You
can save them with the command File> Save Workspace. ... In a later R
session you can retrieve it with File> Load Workspace. ... You can also
save your workspace using the save.image function:

save.image(file = "myWorkspace.RData")

Again note that you need to type the extension “.RData” at the end of the
filename. Later, you can read the workspace back in with the command:

load("myWorkspace.RData")

For details, see Chap. 13, “Managing Your Files and Workspace.”

. Optionally save your history. R has a history file that saves all of the

commands you submit in a given session. This is just like the SPSS journal
file. This is similar to the SAS log except that the history contains input
and no output or system messages. If you are working with the R editor,
your program is already saved in a more organized form, so I rarely save
the command history.

You can save the session history to a file using File> Save History. .. and
you can load it in a future session with File> Load History. ... You can
also use R functions to do these tasks.

savehistory(file = "myHistory.Rhistory")
loadhistory(file = "myHistory.Rhistory")

Note that the filename can be anything you like, but the extension should
be “.Rhistory.” In fact the entire filename will be simply “.Rhistory” if you
do not provide one.

To quit R, choose File> FExit or submit the function quit () or just q().
R offers to save your workspace automatically on exit. If you are using
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Fig. 3.2. R graphical user interface on Macintosh with the console on the left, script
editor in the center, and the history window on the right

the save.image and load functions to tell R where to save and retrieve
your workspace in step 4 above, you can answer No. If you answer Yes, it
will save your work in the file “. RData” in your default working directory.
The next time you start R, it will load the contents of the .RData file
automatically. Creating an .RData file in this way is a convenient way to
work. However, I recommend naming each project yourself, as described
in step 4 above.

You can stop R from saving and restoring its own workspace by starting R
with the options ——no-save --no-restore. You can set these options by
right-clicking on the R menu item or icon, choosing Properties and under
Target appending the options to the string that appears there as follows:
"C:\Program Files...\Rgui.exe" --no-save --no-restore

Be careful not to change the Properties string itself. Then simply click
OK. From then on, R will neither save the workspace to .RData nor load
one automatically if it finds it.

3.2 Running R Interactively on Macintosh

You can run R programs interactively on a Macintosh in several steps.

1.

Start R by choosing R in the Applications folder. The R console window
will appear (see left window in Fig. 3.2). Then enter your program choosing
one of the methods described in steps 2 and 3 below.
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2. Enter R functions in the console window. You can enter commands into
the console one line at a time at the “>” prompt. R will execute each line
when you press the Enter key. If you enter commands into the console, you
can retrieve them with the up arrow key and edit them to run again. I find
it much easier to use the program editor described in the next step. If you
type “me” at the command prompt and press Tab or hold the Command
key down and press “.” (i.e., CTRL-period), R will show you all of the R
functions that begin with those letters, such as mean or median. When
you type a whole function name, the arguments (parameters or keywords)
that you can use to control the function will appear below it in the console
window.

3. Enter R programming statements into the R editor. Open the R editor by
choosing File> New Document. Although R programs are called scripts,
here R uses the standard Macintosh term document. The R editor will
start with an empty window. You can see it in the center of Fig. 3.2. You
can enter R programs as you would in the SAS Program Editor or the
SPSS Syntax Editor.

4. Submit your program from the R editor. To submit one or more lines,
highlight them, then hold the Command key, and press Return, or choose
Edit> Ezxecute. To run the whole program, select it by holding down the
Command key and pressing “a,” and then choose Fdit> Ezecute.

5. As you submit program statements, they will appear in the R Console
along with results or error messages. Make any changes you need and
submit the program again until finished.

6. Save your program and output. Click on a window to make it the active
window and choose File> Save as.... The commands and their output are
blended together like an SPSS output file rather than the separate log and
listing files of SAS.

7. Save your data and any functions you may have written. The data or func-
tion(s) you created are stored in an area called your workspace. You can
save your workspace with Workspace> Save Workspace File. ... In a later
R session you can retrieve it with Workspace> Load Workspace File. . ..
You can also perform these functions using the R functions save.image
and load:

save.image(file = "myWorkspace.RData")
load ("myWorkspace.RData")

For details, see Chap. 13, “Managing Your Files and Workspace.”

8. Optionally save your history. R has a history file that saves all of the com-
mands you submit in a given session (and not the output). This is just
like the SPSS journal file. This is similar to the SAS log except that the
history contains input and no output or system messages. If you are work-
ing with the R editor, your program is already saved in a more organized
form, so I rarely save the command history.
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You can view your history by clicking on the Show/Hide R command
history icon in the console window (to the right of the lock icon). You can
see the command history window on the right side of Fig. 3.2. Notice that
it has alternating stripes, matching its icon. Clicking the icon once makes
the history window slide out to the right of the console. Clicking it again
causes it to slide back and disappear. You can see the various buttons at
the bottom of the history, such as Save History or Load History. You can
use them to save your history or load it from a previous session. You can
also use R functions to do these tasks:

savehistory(file = "myHistory.Rhistory")
loadhistory(file = "myHistory.Rhistory")

Note that the filename can be anything you like, but the extension should
be “.Rhistory.” In fact the entire filename will be simply “.Rhistory” if you
do not provide one.

. Exit R by choosing R> Quit R. Users of any operating system can also

quit by submitting the function quit () or just (0. R will offer to save
your workspace automatically on exit. If you are using the save.image
and load functions to tell R where to save/retrieve your workspace as
recommended previously, you can answer No. If you answer Yes, it will
save your work in the file “.RData” in your default working directory. The
next time you start R, it will load the contents of the .RData file auto-
matically. Some people find creating an .RData file this way a convenient
way to work. However, I much prefer giving each project its own name.

You can stop R from ever saving an .RData file by choosing the menu R>
Preferences> Startup and under Save workspace on exit from R click No.

3.3 Running R Interactively on Linux or UNIX

You can run R programs interactively in several steps.

1.

Start R by entering the command “R,” which will bring up the “>”
prompt, where you enter commands. For a wide range of options, re-
fer to Appendix B, “An Introduction to R” [66], available at http:
//www.r-project.org/ under Manuals, or in your R Help menu. You
can enter R functions using either of the methods described in steps 2 and
3 below.

Enter R functions into the console one line at a time at the “>” prompt.
R will execute each line when you press the Enter key. You can retrieve a
function call with the up arrow key and edit it, and then press Enter to
run it again. You can include whole R programs from files with the source
function. For details, see Sect. 3.4, “Running Programs That Include Other
Programs.” If you type the beginning of an R function, such as “me” and
press Tab, R will show you all of the R functions that begin with those



3.3 Running R Interactively on Linux or UNIX 27

letters, such as mean or median. If you enter the name of a function and
an open parenthesis, such as “mean(,” R will show you the arguments
(parameters or keywords) that you can use to control that function.

. Enter your R program in an R-compatible text editor and submit your
functions from there. Although R for Linux or UNIX does not come with
its own GUI or program editor, a popular alternative is to use text editors
that color-code their commands and automatically transfer them to R.
See Sect. 3.9 for details.

. Save your program and output. If you are working in a text editor (highly
recommended), then saving your program is the usual process. You can
save your output from the console window easily as well. However, if you
are entering your program into the console directly, you may wish to route
input and output to a file with the sink function. You must specify it in
advance of any output you wish to save.

sink("myTranscript.txt", split = TRUE)

The argument split = TRUE tells R to display the text on the screen as
well as route it to the file. The file will contain a transcript of your work.
The commands and their output are blended together like an SPSS output
file rather than the separate log and listing files of SAS.

. Save your data and any functions you may have written. The data and and
function(s) you created are stored in an area called your workspace. Users
of any operating system can save it by calling the save.image function:

save.image(file = "myWorkspace.RData")
Later, you can read the workspace back in with the function call:
load("myWorkspace.RData")

For details, see Chap. 13, “Managing Your Files and Workspace.”

. Optionally save your command history. R has a history file that saves all
of the functions you submit in a given session. This is just like the SPSS
journal file. This is similar to the SAS log except that the history contains
input and no output or system messages. If you are using a separate text
editor, this step is usually unnecessary. You can save or load your history
at any time with the savehistory and loadhistory functions:

savehistory(file = "myHistory.Rhistory")
loadhistory(file = "myHistory.Rhistory")

Note that the filename can be anything you like, but the extension should
be “.Rhistory.” In fact the entire filename will be simply “.Rhistory” if you
do not provide one.

. Quit R by submitting the function quit() or just q(). R offers to save
your workspace automatically on exit. If you are using the save.image
and load functions to tell R where to save/retrieve your workspace as
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recommended previously, you can answer No. If you answer Yes, it will
save your work in the file “RData” in your default working directory.
The next time you start R, it will load the contents of the .RData file
automatically. Creating an .RData file in this way is a convenient way to
work. However, I prefer naming each project myself as described in step
4 above.

3.4 Running Programs That Include Other Programs

When you find yourself using the same block of code repeatedly in different
programs, it makes sense to save it to a file and include it into the other
programs where it is needed. SAS does this with the form

%INCLUDE 'myprog.sas';
and SPSS does it with
INSERT FILE='myprog.sps'.

or the similar INCLUDE command.
To include a program in R, use the source function:

source ("myprog.R")

One catch to keep in mind is that by default R will not display any results
that sourced files may have created. Of course, any objects they create — data,
functions, and so forth — will be available to the program code that follows. If
the program you source creates output that you want to see, you can source
the program in the following manner:

source ("myprog.R", echo = TRUE)

This will show you all of the output created by the program. If you prefer
to see only some results, you can wrap the print function around only those
functions whose output you do want displayed. For example, if you sourced
the following R program, it would display the standard deviation, but not the
mean:

x <-c(1, 2, 3, 4, 5)
mean (x) # This result will not display.
print( sd(x) ) # This one will.

An alternative to using the source function is to create your own R pack-
age and load it with the library function. However, that is beyond the scope
of this book.
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3.5 Running R in Batch Mode

You can write a program to a file and run it all at once, routing its results to
another file (or files). This is called batch processing. If you had a program
named myprog.sas, you would run it with the following command:

SAS myprog

SAS would run the program and place the log messages in myprog.log and
the listing of the output in myprog.lis. Similarly, SPSS runs batch programs
with the statisticsb batch command:

statisticsb -f myprog.sps -out myprog.txt

If the SPSS program uses the SPSS-R Integration Package, you must add
the “-i” parameter. See the next section for details. In its GUI versions, SPSS
also offers batch control through its Production Facility.

In R, you can find the details of running batch on your operating system
by starting R and entering the following command. Note that the letters of
BATCH must be all uppercase:

help ("BATCH")

In Microsoft Windows batch processing is simplified with a set of batch
files that are available on CRAN at http://cran.\linebreakr-project.
org/other-software.html. Here is an example of using the Rscript.bat file
to run an R program and display the results on your screen:

Rscript myprog.R
If you prefer to route your results to a file, you can do so using
Rscript myprog.R > myprog.Rout

It will route your results to myprog.Rout.
UNIX users can run a batch program with the following command. It will
write your output to myprog.Rout:

R CMD BATCH myprog.R

There are, of course, many options to give you more control over how your
batch programs run. See the help file for details.
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3.6 Running R in SAS and WPS

Neither SAS nor the similar World Programming System (WPS) keeps its
data in your computer’s main memory as R does. So you can use either of
them to read vast amounts data, manage or transform the data, select the
variables and observations you need, and then pass them on to R for analysis.
This approach also lets you make the most of your SAS/WPS know-how,
calling on R only after the data are cleaned up and ready to analyze.

For example, we can read our practice data set, keep only the variables
named ql through g4, eliminate the missing values using the N function, and
select only the males using

LIBNAME myLib 'C:\myRfolder';
DATA mySubset;
SET myLib.mydata;
* Keep only the variables you need;
KEEP ql-q94;
*Eliminate missing values;
WHERE N(OF ql1-94) = 4 & gender = "m";
RUN;

Now we are ready to send these data on to R. SAS users can run R pro-
grams in four ways:

Through SAS/IML Studio;

Through a program called A Bridge to R;
Through the SAS X command;

Sequentially, simply using SAS followed by R.

We will discuss these variations in the following sections.

3.6.1 SAS/IML Studio

The most comprehensive approach to running R in SAS is SAS/IML Studio.
The aptly named subroutine ExportDatasetToR sends your data set to R,
and the submit/R; statement tells IML Studio that R code follows.

proc iml;
run ExportDatasetToR("mySubset");
submit/R;

Now we are ready to run any R code we like. For example, to print our
data and perform a linear regression analysis we can use:

print (mydata)
myModel <- 1m(q4 ~ ql + g2 + g3, data = mydata)
summary (myModel)
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We will discuss those R statements later. When you are ready to finish your
R program and return to SAS programming statements, enter the statement:

endsubmit;

For details regarding transferring data or results back and forth between SAS
and R, see Wicklin’s article [75].

3.6.2 A Bridge to R

A similar way to run R programs from within SAS is to use a software pack-
age called A Bridge to R, available from MineQuest, LLC (http://www.
minequest.com). That program adds the ability to run R programs from
either Base SAS or WPS. It sends your data from SAS or WPS to R using a
SAS transport format data set, which only allows for eight-character variable
names. To use it, simply place your R programming statements where our
indented example is below and submit your program as usual.

%Rstart(dataformat = XPT, data = mydata,
rGraphicsViewer NOGRAPHWINDOW) ;
datalines4;
print (mydata)
myModel <- 1m(g4 ~ ql + g2 + g3, data = mydata)
summary (myModel)

299

%Rstop (import=) ;

While this approach uses SAS transport format files behind the scenes, you
do not have to create them yourself nor do you need to import them into R.

3.6.3 The SAS X Command

The third way to run R from within SAS is to use SAS’s X command. This is
less expensive than the previous two approaches, which require you to purchase
additional software. However, it also has a big disadvantage: you must pass
your data back and forth between SAS and R by writing data or results to
files, and you must run R in batch mode. Here are the steps to follow:

1. Read your data into SAS as usual and do whatever data preparation work
you need. Then write your data to a permanent SAS data set.

2. Use SAS’s X command to submit a batch program that runs your R
program. For example:

OPTIONS NOXWAIT;
X 'CD C:\myRfolder' ;
X 'Rscript ReadSAS.R > ReadSAS.Rout';
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The NOXWAIT option tells SAS to close the Windows command window
automatically. The CD command should change to the directory in which
you have your R program. The Rscript.bat file must either be in that
directory or must be on your system’s path. For details regarding running
R in batch mode, see Sec. 3.5.

R has now placed its results in a file, in this example, ReadSAS.Rout.
You can use any method you like to see its contents. The Windows type
command is perhaps the easiest:

OPTIONS XWAIT;
X 'type ReadSAS.Rout';

This time T set the XWAIT option so I could read the results before
the command window disappeared. The only things that the ReadSAS.R
program did was read a SAS data set, convert it to R, and print it, as
described in Sec. 6.10, “Reading Data from SAS.” When I was done viewing
the results, I entered the Windows exit command to continue.

If you need to return any results to SAS, you must write them to a file as
described in Sec. 6.16. Then read them back into your SAS program and
continue working.

3.6.4 Running SAS and R Sequentially

The fourth way to use SAS and R together is to use them sequentially. That is,
do your initial work in SAS, write your data to a SAS data set and exit SAS.
Then start R, import the data and continue working. For details on reading
SAS data sets in R, see Sec. 6.10. This approach is easy to implement, does not
require additional software, and allows you to explore your data interactively

n

R.

3.6.5 Example Program Running R from Within SAS

The program below demonstrates the first three approaches discussed above
to read data, pass it on to R, and run analyses there. The last approach is
described in Sec. 6.10.

*

Filename: RunningRinSAS.sas ;

LIBNAME myLib 'C:\myRfolder';
DATA mySubset;

SET myLib.mydata;

* Keep only the variables you need;
KEEP ql-qg4;

*Eliminate missing values;

WHERE N(OF ql-q4)=4 & gender="m";

RUN;
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* Using SAS/IML;

proc iml;

run ExportDatasetToR("mySubset");

submit/R;
print (mydata)
myModel <- 1m(gq4 ~ ql + g2 + g3, data = mydata)
summary (myModel)

endsubmit;

* Using A Bridge to R;
%Rstart (dataformat = XPT, data = mydata,
rGraphicsViewer = NOGRAPHWINDOW) ;
datalines4;
print (mydata)
myModel <- 1m(gq4 ~ ql + g2 + g3, data = mydata)
summary (myModel)

%Rstop (import=) ;

* Running R with X Command;

OPTIONS NOXWAIT;

X 'CD C:\myRfolder' ;

X 'Rscript ReadSAS.R > ReadSAS.Rout';

* Displaying the results;

OPTIONS XWAIT;

X 'type ReadSAS.Rout';

* Enter "exit" in the command window ;
* when you finish reading it ;

3.7 Running R in SPSS

SPSS has a very useful interface to R that allows you to transfer data back
and forth, run R programs, and get R results back into nicely formatted SPSS
pivot tables. You can even add R programs to SPSS menus so that people can
use R without knowing how to program.

Since SPSS does not need to keep its data in the computer’s main memory
as R does, you can read vast amounts of data into SPSS, select the subset of
variables and/or cases you need and then pass them on to R for analysis. This
approach also lets you make the most of your SPSS know-how, calling on R
only after the data are cleaned up and ready to analyze.

This interface is called the SPSS Statistics-R Integration Package and it
is documented fully in a manual of the same name [52]. The package plug-
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in and its manual are available at http://www.ibm.com/developerworks/
spssdevcentral. Full installation instructions are also at that site, but it is
quite easy as long as you follow the steps in order. First install SPSS (version
16 or later), then the latest version of R that it supports, and finally the plug-
in. The version of R that SPSS supports at the time you download it may
be a version or two behind R’s production release. Older versions of R are
available at http://cran.r-project.org/.

Understanding how the SPSS Statistics-R Integration Package works re-
quires discussing topics that we have not yet covered. If this is your first time
reading this book, you might want to skip this section for now and return to
it when you have finished the book.

To see how to run an R program within an SPSS program, let us step
through an example. First, you must do something to get a data set into
SPSS. We will use our practice data set mydata.sav, but any valid SPSS data
set will do. Open the data by choosing File> Open> Data from the menus
or by running the SPSS programming code below. If you use the commands,
adjust your path specification to match your computer.

CD 'C:\myRfolder'.
GET FILE = 'mydata.sav’.

Now that you have data in SPSS, you can do any type of modifications you
like, perhaps creating new variables or selecting subsets of observations before
passing the data to R. For the next step, you must have an SPSS syntax
window open. So if you used menus to open the file, you must now choose
File> New> Syntax to open a program editor window. Enter the program
statement below.

BEGIN PROGRAM R.

From this command on we will enter R programming statements. To get
the whole current data set and name it mydata in R we can use the following:

mydata <- spssdata.GetDataFromSPSS(missingValueToNA = TRUE)

The argument missingValueToNA = TRUE converts SPSS’s missing values to
R’s standard representation for missing, which is “NA”. Without that argu-
ment, SPSS will convert them to them to “NaN”, Not a Number, a different
kind of missing value in R. Many R procedures treat these two in the same
way, but it is best to use NA unless you have a specific reason not to. When
I created the data set in SPSS, I set a blank to represent missing data for
gender so it would transfer to R as a missing value. I also set the scale of the
workshop variable to be nominal, so it would pass to R as R’s equivalent, a
factor. Getting the data from SPSS to R is a snap, but getting an R data set
to SPSS is more complicated. See the manual for details.

The previous example took all of the variables over to R. However, it is
often helpful to select variables by adding two arguments to this R function.
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The variables argument lets you list variables similar to the way SPSS does
except that it encloses the list within the ¢ function. We will discuss that
function more later. You can use the form c("workshop gender ql to g4")
or simply c("workshop to g4"). You can also use syntax that is common
to R, such as c(1:6). This syntax uses the fact that workshop is the first
variable and g4 is sixth variable in the data set.

mydata <- spssdata.GetDataFromSPSS(
variables = c("workshop gender ql to g4"),
missingValueToNA = TRUE,
row.label = "id" )

You can include the optional row.label argument to specify an ID variable
that R will use automatically in procedures that may identify individual cases.
If the data set had SPLIT FILE turned on, this step would have retrieved only
data from the first split group. See the manual for details about the aptly
named function, GetSplitDataFromSPSS.

Now that we have transferred the data to R, we can write any R statements
we like. Below we print all of the data.

> mydata

workshop gender ql g2 g3 g4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <NA> 3 1 NA 3
5 1 m 3 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

Notice that the variable ID is not labeled. Its values are used on the far left
to label the rows. If we had not specified the row.label = "id" argument, we
would see the ID variable listed before workshop and labeled “id.” However,
the row labels would still appear the same because R always labels them. If
you do not provide a variable that contains labels to use, it defaults to simply
sequential numbers, 1, 2, 3, etc.

Now let us calculate some descriptive statistics using variables ql to q4.
There are a number of different ways to select variables in R. One way is to
use mydata[3:6] since ql is the third variable in the data set and g4 is the
sixth. R can select variables by name, but we will save that topic for later.
The summary function in R gets descriptive statistics.
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summary (mydata[3:6])

ql q2 q3 q4
Min. :1.000 Min. :1.00 Min. :2.000 Min. :1.00
1st Qu.:2.000 1st Qu.:1.00 1st Qu.:4.000 1st Qu.:2.50
Median :3.000 Median :2.50 Median :4.000 Median :3.50
Mean :3.125 Mean :2.75 Mean :4.143 Mean :3.25
3rd Qu.:4.250 3rd Qu.:4.25 3rd Qu.:5.000 3rd Qu.:4.25
Max. :5.000 Max. :5.00 Max. :5.000 Max. :5.00
NA's 1.000

Next, we will do a linear regression model using standard R commands
that we will discuss in detail much later. Our goal here is just to see what the
spsspivottable.Display function does.

myModel <- 1m(g4 ~ ql + g2 + g3, data = mydata)
myAnova <- anova(myModel)

spsspivottable.Display(myAnova,
title = "My ANOVA table",
format = formatSpec.GeneralStat)

The function call immediately above created Table 3.1 formatted exactly
as you see it. I routinely tell SPSS to put all my output in CompactAca-
demicTimesRoman style. That style draws only horizontal lines in tables, as
most scientific journals prefer. If you copy this table and paste it into a word
processor, it should maintain its nice formatting and be a fully editable table.

When I ran the program, this table appeared first in the SPSS output
window even though it was the last analysis run. SPSS puts its pivot tables
first.

So far we have submitted commands to R and seen the results returned to
SPSS. You can, however, open an R console window using this command:

browser ()

From there you can interact with R and see the result in R’s console
window.

Finally, I ended the program with the statement below and exited SPSS
in the usual way:

END PROGRAM.

If your program contains some R code, then some SPSS code, then more R
code, any data sets or variables you created in the earlier R session(s) will still
exist. If the program you submit from SPSS to R uses R’s quit function, it
will cause both R and SPSS to terminate. To learn how to add R functions to
the SPSS GUI, see the SPSS help file topic, Custom Dialog Builder in SPSS
Statistics 17 or later.
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Table 3.1. An example pivot table created by R and transferred to SPSS.

My ANOVA table
Df  Sum Sq Mean Sq F value Pr(>F)

ql 1.000 12.659 12.659  34.890 .010
q2 1.000 3.468 3.468 9.557 .054
q3 1.000 .213 213 587 499
Residuals 3.000 1.089 .363

3.7.1 Example Program Running R from Within SPSS

The program below combines all of the steps discussed above to read data,
pass it on to R, and run analyses there.

* Filename: RunningRinSPSS.sps

CD 'C:\myRfolder'.
GET FILE = 'mydata.sav'.

BEGIN PROGRAM R.

mydata <- spssdata.GetDataFromSPSS(
variables = c("workshop gender ql to g4"),
missingValueToNA = TRUE,
row.label = "id" )

mydata

mydatal[3:6]

myModel <- 1m(q4 ~ ql + g2 + g3, data = mydata)
myAnova <- anova(myModel)

spsspivottable.Display(myAnova,
title = "My Anova Table",

format = formatSpec.GeneralStat)

END PROGRAM.

3.8 Running R in Excel

R integrates nicely into Excel, where you can control it using either function
calls or the R Commander menus described in Sect. 3.11.2. As of this writing,
only Excel on Microsoft Windows can control R, and both must be the 32-bit
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versions. However, work is underway to support the 64-bit versions and to
allow similar control from the spreadsheet in the free OpenOffice.org software.

There are several pieces of software — some R packages and some not — that
allow communications to flow between R and Excel. Among these pieces are
Neuwirth’s RExcel [43] and Heiberger and Neuwirth’s R through Excel [27]
and Baier and Neuwirth’s statconnDCOM software [5]. The latter implements
Microsoft’s Distributed Component Object Model (DCOM), which allows R
to communicate with any software that implements that standard.

The easiest way to get R working with Excel is to use the R and Friends
installer available at http://rcom.univie.ac.at/. That installer gives you
R, R Commander, and all the pieces you need to make them work with Excel.

If you already have R installed, you can also install the pieces one at a
time. Start by installing and loading the RExcelInstaller package:

install.packages("RExcelInstaller")
library("RExcelInstaller")

The package will then give you detailed instructions on the steps to follow to
finish the installation.

After installing the software and starting Excel, you will see a new RExcel
menu in the Add-Ins tab (Fig. 3.3, upper left corner). Choosing REzcel> R
Commander> with Excel Menus will activate menus that we will use in a
different way in Sect. 3.11.2. You can see the menus in Fig. 3.3 where I have
selected Statistics> Means from the R Commander menus.

You can use Excel to open any file and then transfer it to R by selecting
its cell range (including a row with variable names) and choosing Add-Ins>
RExcel> Put R Var> Dataframe. With your data frame transferred to R, you
can then analyze it using R commands or R Commander menus. R Comman-
der works on an “active data set”, which you can select by choosing Data>
Active data set> Select active data set. You can save the R data frame by
choosing Data> Active data set> save active data set.

To transfer a data frame from R to Excel, set the one you want to be the
active data set (if you have not already done so) by choosing Data> Active
data set> Select active data set. ... Then position the cursor in a spreadsheet
cell and choose Add-Ins> RExcel> Get R Value> Active dataframe. The data
frame will appear below and to the right of the chosen cell.

After you run an analysis, you can bring its results into an Excel spread-
sheet by selecting a cell and then choosing Rexcel> Get R oulput.

For a much more comprehensive demonstration of the various ways to use
R and Excel together, see Richard M. Heiberger and Erich Neuwirth’s book
R Through FExcel: A Spreadsheet Interface for Statistics, Data Analysis, and
Graphics [27].
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Fig. 3.3. R and R Commander both integrated into Excel

3.9 Running R from Within Text Editors

Although R offers a basic program editor on Windows and Macintosh, people
who program a lot prefer to use a powerful editor. While any text editor will
do, there are significant advantages in choosing one that is optimized for R.
Since the R versions for Linux and UNIX do not include a text editor, this
approach is a popular way to run R on those systems. The advantages of
running R from a text editor include the following:

Such editors are connected to R itself and can submit code directly and
interactively without leaving the editor. This greatly speeds your work.
Such editors understand R syntax and apply color coding to help you
avoid trouble. For example, you have probably been vexed with forgetting
to put a final quotation mark around a character string. Your following
commands become part of that string and you have a mess on your hands!
These editors will keep all following code highlighted as they do character
strings, making problems like that obvious.

Such editors can deactivate a block of R code by adding the R comment
symbol # to the beginning of each line. That is very helpful in debugging.
Such editors can automatically open all the programs you were working
on when you exited the software the last time. If you work on several
programs at once, copying and pasting sections among them (as I often
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do), this is much faster than remembering what you were doing before and
finding each file to open.

The following are some good text editors:

EMACS with ESS — Available on all operating systems, EMACS is the
hands-down favorite among hard-core UNIX fans. The Emacs Speaks Statis-
tics (ESS) option is what links it to R and provides its R-specific capabilities.
This editor can do it all, but it is not the easiest to learn. You can download it
at http://ess.r-project.org/. Emacs with ESS pre-packaged is also avail-
able for Windows at http://vgoulet.act.ulaval.ca/en/emacs/.

Komodo Edit with SciViews-K — Komodo Edit from ActiveState is a
full-featured program editor that is free. It makes heavy use of menus and
dialog boxes, making it particularly easy for Windows and Mac users to
learn. Philippe Grosjean’s SciViews-K extension provides the link to R and
it even includes some rudimentary dialog boxes that generate R code for
you. It runs on Windows, Macintosh, Linux, and UNIX and is available at
http://sciviews.org/SciViews-K/.

Notepad++ with NppToR — Windows users usually know the rudimentary
Notepad editor that comes with the operating system. Notepad++ is a full-
featured editor that is modeled after Notepad itself, making it very easy to
learn. Andrew Redd wrote the NppToR part that hooks Notepad++ into R.
It runs the standard R GUI at the same time, letting you use features of both.
This Windows-specific software is available at http://npptor.sourceforge.
net.

Tinn-R — This is another Windows editor that works similarly to Notepad
[58]. Tinn stands for “Tinn Is Not Notepad.” It has frequently used R com-
mands on its toolbar and also includes R reference material to help you pro-
gram. Tinn-R is available at: http://www.sciviews.org/Tinn-R/

3.10 Integrated Development Environments

An integrated development environment (IDE) is a set of tools that work to-
gether to enhance programmer productivity. Since IDEs include text editors
that are optimized for the language you are using, they have all the advantages
discussed in the previous section. For R, IDEs may also include package man-
agers to help you install, load, and manage add-on packages; object managers
to let you view and manage things like data sets; and help or documentation
viewers and even graphics display windows.

3.10.1 Eclipse

The Eclipse IDE has a full suite of debugging tools and supports most pro-
gramming languages. This power comes at a price, however. Its complexity
means that it is used mainly by full-time programmers. If you have been
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using SAS AppDev Studio with the Eclipse plug-in, this is the R equiva-
lent. Stephan Wahlbrink’s StatET plug-in provides the link from Eclipse to
R. It runs on Windows, Macintosh, Linux, and UNIX and is available at
http://www.walware.de/goto/statet.

3.10.2 JGR

JGR [28] (pronounced “jaguar”) stands for the Java GUI for R. It is very
similar to R’s own simple interface, making it very easy to learn. Written by
Helbig, et al., JGR provides some very helpful additions to R, like syntax
checking in its program editor. It also provides the help R files in a way that
lets you execute any part of an example you select. That is very helpful when
trying to understand a complicated example.

JGR is installed differently than most R packages. In Microsoft Window
or Apple Macintosh, you download two programs: an installer and a launcher.
Running the installer installs JGR, and double-clicking the launcher starts it
up. The JGR Web site that contains both programs is http://www.rforge.
net/JGR/. Linux users follow slightly different steps that are described at the
site.

I started JGR by double-clicking on its launcher and opened an R program
using File> Open Document. You can see the program in Fig. 3.4. Note that
the JGR program editor has automatically color-coded my comments, function
names, and arguments, making it much easier to spot errors. In the printed
version of this book, those colors are displayed as shades of gray. If someone
brings you a messy R program, the program editor can format it nicely by
choosing Edit> Format Selection.

In the next example, I typed “cor (” into the bottom of the console area
shown in Fig. 3.5. JGR then displayed a box showing the various arguments
that control the cor function for doing correlations. That is very helpful when
you are learning!

JGR’s Package Manager makes it easier to control which packages you
are using (Fig. 3.6). Simply checking the boxes under “loaded” will load those
packages from your library. If you also check it under “default,” JGR will load
them every time you start JGR. Without JGR’s help, automatically loading
packages would require editing your .Rprofile as described in Appendix C.

JGR’s Object Browser makes it easy to manage your workspace; see
Fig. 3.7. Selecting different tabs across the top enable you to see the dif-
ferent types of objects in your workspace. Double-clicking on a data frame in
Object Browser starts the Data Table editor, which is much nicer than the one
built into R. It lets you rename variables, search for values, sort by clicking
on variable names, cut and paste values, and add or delete rows or columns.

If you have created models, they will appear under the models tab. There
you can do things like review them or sort them by various measures such as
their R-squared values. There are many more useful features in JGR that are
described on its Web site.
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Fig. 3.4. Color-coded editor in JGR helps prevent typing errors

3.10.3 RStudio

RStudio is a free and open source integrated development environment written
by JJ Allaire, Joe Cheng, Josh Paulson, and Paul DiCristina, at RStudio, Inc.
It is easy to install, learn, and use. It runs on Windows, Macintosh, Linux,
and even runs over the Web in a browser window from Linux servers.

The screenshot in Fig. 3.8 shows the program I was editing in the upper
left, the data set I created in the upper right, the program output in the
lower left, and a plot of a linear regression in the lower right. Each of the four
windows is tabbed, allowing you to do many more things including browsing
your files, editing multiple programs, reading documentation, examining your
command history, and installing or loading packages.

RStudio is a big improvement over the default user interfaces on any of
the operating systems that it supports. You can download it for free at http:
//rstudio.org/.

3.11 Graphical User Interfaces

The main R installation provides an interface to help you enter programs. For
Windows and Macintosh users it includes a very minimal GUI. As we have
discussed, that interface allows you to use menus and dialog boxes for a few
tasks, like opening and saving files. However, it does not include a point-and-
click GUI for running analyses. Fortunately, users have written several GUIs
to address this need. You can learn about several at the main R Web site,
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Fig. 3.5. JGR showing arguments that you might choose for the cor function

http://wuw.r-project.org/, under Related Projects and then R GUIs. We
will discuss the most promising ones in this section.

3.11.1 Deducer

Tan Fellows’ Deducer [18] is a user interface that is similar to SPSS’s point-
and-click menu system (Fig. 3.9). It is also similar to R Commander covered
in Sect. 3.11.2. Having arrived on the scene more recently, Deducer does not
have as many plug-ins as R Commander, nor it does not yet integrate into
Excel.

You can install Deducer using:

install.packages("Deducer")
When you load it from the library with:
library("Deducer")

Your R Console window will gain some menu choices, which you can see
in Figure 3.9. Here are the steps I followed to perform a simple analysis using
Deducer.
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Fig. 3.6. JGR’s Package Manager, which allows you to load packages from the
library on demand or at startup
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Fig. 3.7. JGR’s Object Browser shows information about each object in your
workspace

1. Topened mydata by choosing Deducer> Open data, browsed to myRfolder,
and chose mydata.RData to open.

2. To see the data, I chose Deducer> Data viewer. The data popped up as
shown in Fig. 3.10. Using it, you can see and edit the data. Note that it has
a Data View tab and a Variable View tab, just like the SPSS data editor.
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Fig. 3.8. RStudio lets you edit files (upper left) manage objects (upper right), view
output (lower left) and view plots, files or packages (lower right)
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> |

4

Fig. 3.9. The Deducer graphical user interface integrated into the main R console

These allow you to see both the data (shown) and variable information
such as variable names and types.

3. To obtain some descriptive statistics, I chose Analysis> Descriptives. 1
selected the q variables and clicked the right-facing arrow icon to move
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Fig. 3.10. Deducer’s Data viewer/editor

them to the Descriptives of: box. You can see this step in Fig. 3.11. I then
chose workshop as my Stratify By: variable and chose Continue.

4. T was offered a list of statistics from which to choose (not shown). I ac-
cepted the defaults and chose Run. The results are shown back in Fig. 3.9.

Deducer also has a powerful Plot Builder (Fig. 3.12) that helps you create
graphs using the flexible Grammar of Graphics approach that we will discuss
in Chap. 16. Plot Builder is very similar to IBM’s SPSS Visualization Designer.
This feature alone makes it worth looking into, even if you do most of your
work using programming or other user interfaces.

Deducer also integrates into the JGR user interface, which is covered in
Sect. 3.10.2. The combination of Deducer and JGR provides a very compre-
hensive set of tools for both R beginners and advanced programmers.

3.11.2 R Commander

Fox’s R Commander [20] looks and works similarly to the SPSS GUL. It pro-
vides menus for many analytic and graphical methods and shows you the R
commands that it enters, making it easy to learn the commands as you use
it. Since it does not come with the main R installation, you have to install it
one time with the install.packages function:

install.packages("Rcmdr", dependencies = TRUE)
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Fig. 3.11. Deducer’s descriptive statistics dialog box

R Commander uses many other packages, and R will download and install
them for you if you use the dependencies = TRUE argument. It also has many
plug-ins available that add even more methods to its menus. They are easy to
find because their names all begin with “RemdrPlugin.” You install them just
like any other R package. To use them, you start R Commander and choose
Tools> Load Remdr plug-in(s). ... A menu will then appear from which you
can choose the plug-in you need.

Let us examine a basic R Commander session. Below are the steps 1 fol-
lowed to create the screen image you see in Fig. 3.13.

1. I'started R. For details see the section, “Running R Interactively on Win-
dows,” or similarly named sections for other operating systems previously
covered in this chapter.

2. Then, from within R itself I started R Commander by loading its package
from the library using library("Rcmdr"). That brought up the window
similar to the one shown in Fig. 3.13, but relatively empty.

3. I then chose Data>Load a data set, browsed to C:\myRfolder, and selected
mydata.RData.

4. Unlike the SPSS GUI, the data did not appear. So I clicked on the View
data set button. The data appeared, I looked it over, then closed it.



48 3 Running R

File Tools Window
Templates| Geometric Elements | Statistics | Scales | Facets | Coordinates | other|

— ......... - — E =
e a4 =
abline area bar bin2d blank crossbal
T B e B — : -

4 4

Components

Female Male ]

& - ,_-n—-“"’_'__' .__..0.0{'1’"'
&= » s
&0 — grid
o0 = [
80 = ._,_..—oﬂ"‘.'._' .___’H‘S‘.’ b5 %
70 = wr . .

template
20— = scatter
80 = =
70 = @
50 =
a0 — 't [
80 = ._&0'.’—4 Iy
70 = &
60 =
l l l l l l l l 1 l l l
60 &5 70 75 80 85 60 65 70 75 80 &5 : =
= x
pretest a J

Fig. 3.12. The Deducer’s powerful and easy-to-use Plot Builder

5. I then chose Statistics> Summaries> Active Data Set. You can see the
output on the bottom of the screen in Fig. 3.13.

6. Finally, I chose Statistics> Means. The menu is still open, showing that I
can choose various t-tests and analysis of variance (ANOVA) procedures.

You can learn more about R Commander at
http://socserv.mcmaster.ca/jfox/Misc/Remdr/.

3.11.3 rattle

Williams’ rattle package [77] provides a ribbon (tabbed-dialog box) style
of user interface that is similar to that used by Microsoft Office. Although
its emphasis is on data mining, the interface is useful for standard statistical
analyses as well. Its name stands for the R analytical tool to learn easily.
That name fits it well, as it is very easy to learn. Its point-and-click interface
writes and executes R programs for you.

Before you install the rattle package, you must install some other tools.
See the Web site for directions http://rattle.togaware.com. Once it is
installed, you load it from your library in the usual way.
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> load ("C:/myRfolder/mydata.RData™)

> summary (mydata)

workshop gender al az a3
R :4 f :3 Min. :1.00 Min. :1.00 Min. :2.000
SAS: 4 m :4 1st Qu.:2.00 1st Qu.:1.00 1st Qu.:4.000
NA's:1 Median :3.50 Median :2.50 Median :4.000
Mean :3.25 Mean 12,75 Mean 14,143
3rd Qu.:4.25 3rd Qu.:4.25 3rd @Qu.:5.000
Max. :5.00 Max. :5.00 Max. :5.000
NA's :1.000

« [ ] 3
Messages

[1] NOTE: R Commander Version 1.6-3: Sat Jan 29 15:05:59 2011 i
[2] WARNING: The Windows version of the R Commander works bestWE
with the single-document interface (SDI); see ?Commander. .
< i v

Fig. 3.13. The R Commander user interface with work in progress

> library("rattle")

Rattle, Graphical interface for data mining
using R, Version 2.2.64.

Copyright (C) 2007 Graham.Williams@togaware.com, GPL

Type "rattle()" to shake, rattle, and roll your data.

As the instructions tell you, simply enter the call to the rattle function
to bring up its interface:

> rattle()

The main Rattle interface shown in Fig. 3.14 will then appear. It shows
the steps it uses to do an analysis on the tabs at the top of its window. You
move from left to right, clicking on each tab to do the following steps. When
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Fig. 3.14. The rattle user interface for data mining

you are ready to run a particular step, click on the Ezecute icon in the upper
left corner of the screen.

1. Data. Choose your data type from a comma-separated value (CSV)
file, attribute-relation file format (ARFF), open database connectivity
(ODBC), .RData file, R data object already loaded or created before start-
ing Rattle, or even manual data entry.

Here you also choose your variables and the roles they play in the
analysis. T have chosen gender as the target variable (dependent variable)
and the other variables as inputs (independent variables or predictors).

2. Explore. Examine the variables using summary statistics, distributions,
interactive visualization via GGobi, correlation, hierarchical cluster anal-
ysis of variables, and principal components. A very interesting feature in
distribution analysis is the application of Benford’s law, an examination
of the initial digits of data values that people use to detect fraudulent
data (e.g., faked expense account values.)

3. Test. Perform standard analysis such as Kruskal-Wallis, Wilcoxon rank-
sum, t-test, F-test, correlation and Wilcoxon signed-rank.

4. Transform. Here you can perform data tasks such as recoding, rescaling,
taking logarithms, converting to ranks, replacing missing values with rea-
sonable estimates (imputation).

5. Cluster. Perform various types of cluster analyses.
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6. Associate. Perform association rule analysis to find relationships among
observations or variables.

7. Model. Apply models from tree, boost, forest, SVM, regression, neural
networks, or survival analysis.

8. Evaluate. Assess model quality and compare different models using con-
fusion tables, lift charts, ROC curves, and so forth.

9. Log. See the R program that Rattle wrote for you to do all of the steps.

For more details, see Williams’ book Data Mining with Rattle and R [78].

3.11.4 Red-R

Flowchart-style GUIs have been steadily growing in popularity. SAS Enter-
prise Guide and Enterprise Miner both use this approach, as does IBM SPSS
Modeler (formerly Clementine). One implementation of this approach! for R
is called Red-R [57] and is available at http://www.red-r.org/. Figure 3.15
shows an example analysis using Red-R.

Red-R comes with a set of icons called widgets that represent common
steps in data acquisition, management, graphing, analysis, and presentation.
The left side of the Red-R screen contains a widget toolbar. Clicking on a
widget there makes it appear in its flowchart area or schema where you can
move it to any position. The little “bumps” on either side of the widgets are
called slots. You use your mouse to click and drag to connect the output slot on
the right side of one widget to the input slot on the left side of another. That
causes the data to flow in that direction. Double-clicking on an icon brings up
a dialog box very similar to those in the SPSS, R Commander, and Deducer
GUIs. The main difference is that these dialog boxes save their settings so
you can use the same schema in different ways. Each dialog contains a button
to activate it (often labeled commit). The graphs are interactive, so selecting
points in a graph will cause only those points to be transferred downstream
to the next widget. When you are finished, the whole flowchart is saved with
its settings and the R code that each node used to do its work.

For example, in Fig.3.15 moving from left to right, I read an R data file,
split it by gender, and got summary statistics for each group. Then I did a
scatter plot on the males followed by a linear regression.

While flowchart-style user interfaces take a little longer to learn than those
that focus on menus and dialog boxes, they do offer several important advan-
tages:

e You can get the big picture about an analysis with a quick glance.
e Flowcharts are a time-honored approach to help simplify the construction
of complex programs.

! Another is AnalyticFlow, but it does not appear to have as much development
support: http://www.ef-prime.com/products/ranalyticflow_en/.
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Fig. 3.15. The Red-R flowchart-style graphical user interface

You have an audit trail of what was done. I frequently have clients claim
to have done the “same” analysis twice using the menu-and-dialog-box
approach common to SPSS, R Commander and Deducer. However, the
results do not match and they want to know why! Unless they saved the
program generated by that approach, there is no way to know. People using
that type of interface often do not save the program because programming
does not interest them. With the flowchart approach, the audit trail is
maintained and it is in a form its creator understands.

You can reuse an analysis on new data easily without resorting to pro-
gramming. People use GUIs to avoid programming in the first place; they
do not like to switch to a program even to change the first line and point it
to a new data set. While GUIs may never offer as much power and flexibil-
ity as programming does, at least this approach gives you a considerable
level of control.



4

Help and Documentation

R has an extensive array of help files and documentation. However, they can
be somewhat intimidating at first, since many of them assume you already
know a lot about R.

To see how R’s help files differ in style from those of SAS and SPSS, let us
examine the help file for the print function. The help file in R says you can
use the print function to “Print Values,” which is clear enough. However, it
then goes on to say that “print prints its argument and returns it invisibly
(via invisible(x)). It is a generic function which means that new printing
methods can be easily added for new classes.”

That requires a much higher level of knowledge than does the SPSS de-
scription of its similar command: “LIST displays case values for variables in
the active dataset.” However, when you are done with this book, you should
be able to understand most help files well.

4.1 Starting Help

You can start the help system by choosing Help> HTML Help in Windows
or Help> R Help in Mac OS. In any operating system you can submit the
help.start function in the R console:

help.start()

That is how Linux/UNIX users start it since they lack menus. Regardless
of how you start it, you will get a help window that looks something like
Fig. 4.1. To get help for a certain function such as summary, use the form:

help("summary")
or prefix the topic with a question mark:

?"summary"
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Fig. 4.1. R’s main help window

The quotes around your search string are often optional. However, when
requesting help on an operator, you must enclose it in quotes. For example,
to get help on the assignment operator (equivalent to the equal sign in SAS
or SPSS), enter:

lleﬁlp ( ng_n )

This also applies to flow-control statements such as if, else, for, in,
repeat, while, break, and next. For example, if we try to get help regarding
the while function without putting it in quotes, we get an error message:

> help(while)
Error: unexpected ')' in "help(while)"

> help("while")
[help will appear]

Although it is a bit of extra typing, you can always put quotes around the
item for which you are searching. If you do not know the name of a command
or operator, use the help.search function to search the help files:

help.search("your search string")

A shortcut to the help.search function is to prefix the term with two
question marks: “??”. For a single word search, use this form:

??"yourstring"
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For a string with more than one term in it, you must enclose it in quotes:
??"your multi-word string"

A particularly useful help file is the one on extracting and replacing parts
of an object. That help file is opened with the following function call (the “E”
in “Extract” is necessary):

help("Extract")

It is best to read that file after you have read Chapter 9, “Selecting Vari-
ables and Observations.”

4.2 Examples in Help Files

Most of R’s help files include examples that will execute. You can cut and
paste them into a script window to submit in easily understood pieces. You
can also have R execute all of the examples at once with the example function.
Here are the examples for the mean function, but do not try to understand
them now. We will cover the mean function later.

> example("mean")

mean> x <- c(0:10, 50)

mean> xm <- mean(x)

mean> c(xm, mean(x, trim = 0.10))
[1] 8.75 5.50

mean> mean(USArrests, trim = 0.2)

Murder Assault UrbanPop Rape
7.42 167.60 66.20 20.16

R changes its prefix of each example command from “>” to “mean>” to let
you know that it is still submitting examples from the mean function’s help
files. Note that when a help file example is labeled “Not run,” it means that
while it is good to study, it will not run unless you adapt it to your needs.

A very nice feature of the JGR GUI is that you can execute most help file
example programs by submitting them directly from the help window. You
simply select the part you wish to run, right-click on the selection, and then
choose “run line or selection.” See Sect. 3.10.2, “JGR Java GUI for R,” for
details.
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In SAS and SPSS, the help files include documentation for add-on packages
that you might not have installed. However, in R you must first install a
package and then load it from your library before you can get help. So you
cannot use help to find things that you do not already know something about.

A popular addition to R is Harrell’s Hnisc package [32]. It has many useful
functions that add SAS-like capabilities to R. One of these is the contents
function. Let us try to get help on it before loading the Hmisc package.

> help("contents")

No documentation for 'contents' in specified packages
and libraries: you could try '??contents'

The help system does not find it, but it does remind you how you might
search the help files. However, that search would find the contents function
only if the Hmisc package were already installed (but not necessarily loaded).
If you did not already know that Hmisc had such a function, you might search
the Internet (or read a good book!) to find it. Let us now load the Hmisc
package from our library.

> library("Hmisc")

R responds with a warning. We will discuss what this means later, but it
does not cause a problem now.

Attaching package: 'Hmisc'

The following object(s) are masked from package:base :
format.pval,
round.POSIXt,
trunc.POSIXt,
units

Now that the Hmisc package is loaded, we can get help on the contents
function with the command help("contents"). We do not need to look at
the actual help file at the moment. We will cover that function much later.

If you want help on a topic and you are not sure of its exact name you can
use the help.search function. Let us use it to find things that relate to the
string “contents.”

> help.search("contents")

Help files with alias or concept or title matching 'contents'...
fuzzy matching:

anchors::replace.list Updating contents of one list using...
ape::GC.content Content in GC from DNA Sequences
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DAAG: :ironslag Iron Content Measurements
geoR::ca20 Calcium content in soil samples...
Hmisc::contents Metadata for a Data Frame

MASS: :abbey Determinations of Nickel Content
MEMSS: :Milk Protein content of cows' milk
multcomp::fattyacid Fatty Acid Content of Bacillus...
nlme::Milk Protein content of cows' milk
PASWR: :Bac Blood Alcohol Content...

If you knew you wanted to use a function named contents but forgot
which package(s) had a function of that name, this is a good way to find it.

4.3 Help for Functions That Call Other Functions

R has functions that exist to call other functions. These are called generic
functions. In many cases, the help file for the generic function will refer you
to those other functions, providing all of the help you need. However, in some
cases you need to dig for such help in other ways. We will discuss this topic in
Chap. 5 “Programming Language Basics”, Sect. 5.7.4, “Controlling Functions
with an Object’s Class.” We will also examine an example of this in Chap. 15,
“Traditional Graphics,” Sect. 15.10.9, “Scatter Plot Matrices.”

4.4 Help for Packages

Thus far we have examined ways to get help about a specific function. You
can also get help on an entire package. For example, the foreign package [14]
helps you import data from other software. You can get help on a package
itself by using the package argument. Here is a partial listing of its output:

> help(package = "foreign")

Information on package 'foreign'

Description:

Package: foreign

Priority: recommended

Version: 0.8-41

Date: 2010-09-23

Title: Read Data Stored by...SAS, SPSS, Stata,
Depends: R (>= 2.10.0), stats

Imports: methods, utils

Maintainer: R-core <R-core@r-project.org>

Author: R-core members, Saikat DebRoy, Roger Bivand...
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file in the sources.
Description: Functions for reading and writing data stored by
statistical packages...SAS, SPSS, Stata,

Index:

read.dta Read Stata Binary Files

read.spss Read an SPSS Data File

read.ssd Obtain a Data Frame from a SAS Perm. Dataset...
read.xport Read a SAS XPORT Format Library

write.foreign Write Text Files and Code to Read Them...

To get help on a package, you must first install it, but you need not load
it. However, not all packages provide help for the package as a whole. Most
do, however, provide help on the functions that the package contains.

4.5 Help for Data Sets

If a data set has a help file associated with it, you can see it with the help
function. For example,

help("esoph")

will tell you that this data set is “data from a case-control study of esophageal
cancer in Ile-et-Vilaine, France.”

4.6 Books and Manuals

Other books on R are available free at http://cran.r-project.org/ under
documentation. We will use a number of functions from the Hmisc package.
Its manual is An Introduction to S and the Hmisc and Design Libraries [2] by
Alzola and Harrell. It is available at http://biostat.mc.vanderbilt.edu/
twiki/pub/Main/RS/sintro.pdf. The most widely recommended advanced
statistics book on R is Modern Applied Statistics with S (abbreviated MASS)
by Venables and Ripley [65]. Note that R is almost identical to the S language
and recently published books on S usually point out what the differences are.

An excellent book on managing data in R is Spector’s Data Manipulation
with R [51]. We will discuss books on graphics in the chapters on that topic.

4.7 E-mail Lists

There are different e-mail discussion lists regarding R that you can read about
and sign up for at http://www.r-project.org/ under Mailing Lists. I rec-
ommend signing up for the one named R-help. There you can learn a lot by
reading answers to the myriad of questions people post there.
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If you post your own questions on the list, you are likely to get an
answer in an hour or two. However, please read the posting guide, http:
//www.R-project.org/posting-guide.html, before sending your first ques-
tion. Taking the time to write a clear and concise question and providing a
descriptive subject line will encourage others to take the time to respond.
Sending a small example that demonstrates your problem clearly is particu-
larly helpful. See Chap. 12, “Generating Data,” for ways to make up a small
data set for that purpose. Also, include the version of R you are using and
your operating system. You can generate all of the relevant details using the
sessionInfo function:

> sessionInfo()

R version 2.12.1 (2010-12-16)
Platform: i386-pc-mingw32/i386 (32-bit)

locale:
[1] LC_COLLATE=English_United States.1252...

attached base packages:
[1] splines stats graphics grDevices utils datasets methods
[8] base

other attached packages:
[1] Hmisc_3.8-3 survival_2.36-2 prettyR_1.8-6

loaded via a namespace (and not attached):
[1] cluster_1.13.2 grid_2.12.1 1lattice_0.19-17 tools_2.12.1

4.8 Searching the Web

Searching the Web for information on R using generic search engines such as
Google can be frustrating, since the letter R refers to many different things.
However, if you add the letter R to other keywords, it is surprisingly effec-
tive. Adding the word “package” to your search will also narrow it down. For
example, to find packages on cluster analysis, you could search for “R, cluster
package” (without the quotes!).

An excellent site that searches just for R topics is Jonathon Barron’s
R Site Search at http://finzi.psych.upenn.edu/search.html. You can
search just the R site while in R itself by entering the RSiteSearch function

RSiteSearch("your search string")

or by going to http://www.r-project.org/ and clicking Search.
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4.9 Vignettes

Another kind of help is a wignette, a short description. People who write
packages can put anything into its vignette. The command

vignette(all = TRUE)

will show you vignettes for all of the packages you have installed. To see the
vignette for a particular package, enter it in the vignette function with its
name in quotes:

vignette ("mypackage")

Unfortunately, many packages do not have vignettes.

4.10 Demonstrations

Some packages include demonstrations, or “demos,” that can help you learn
how to use them by showing you actual running examples. You can see a list
of them by entering the demo() function. Not many packages include demos,
but when they do they are usually worth running. See Sect. 14.8 for some
examples.
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Programming Language Basics

5.1 Introduction

In this chapter we will go through the fundamental features in R. It will
be helpful if you can download the book’s files from the Web site http:
//r4stats.com and run each line as we discuss it. Many of our examples
will use our practice data set described in Sect. 1.7.

R is an object-oriented language. Everything that exists in it — variables,
data sets, functions (procedures) — are all objects.

Object names in R can be any length consisting of letters, numbers, un-
derscores “_,” or periods “.” and should begin with a letter. However, in R if
you always put quotes around a variable or data set name (actually any object
name), it can then contain any characters, including spaces.

Unlike SAS, the period has no meaning in the name of a data set. However,
given that my readers will often be SAS users, I avoid using the period.

Case matters in R, so you can have two variables — one named mywvar and
another named MyVar — in the same data set, although that is not a good
idea! Some add-on packages tweak function names like the capitalized “Save”
to represent a compatible, but enhanced, version of a built-in function like
the lowercased “save.” As in any statistics package, it is best to avoid names
that match function names like “mean” or that match logical conditions like
“TRUE.”

While in SAS you perform analyses using procedures and in SPSS you use
commands, in R you perform analyses using functions. When you execute a
function, you are said to call it. The resulting output is what the function call
returns. A few functions do not return output but have side effects such as
writing an external file.

Function calls can begin and end anywhere on a line and R will ignore
any additional spaces. R will try to execute a function call when it reaches
the end of a line. Therefore, to continue a function call on a new line, you
must ensure that the fragment you leave behind is not already a complete
function call by itself. Continuing a function call on a new line after a comma
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is usually a safe bet. As you will see, R functions separate their parameters
or arguments using commas, making them a convenient stopping point. The
R console will tell you that it is continuing a line when it changes the prompt
from “>” to “+”. If you see “+” unexpectedly, you may have simply forgotten
to add the final close parenthesis, “)”. Submitting only that character will
then finish your function call. If you are getting the “+” and cannot figure
out why, you can cancel the pending function call with the Escape key on
Windows or CTRL-C on Macintosh or Linux/UNIX. For CTRL-C, hold the
CTRL key down (Linux/UNIX) or the control key (Macintosh) while pressing
the letter C. You may end any R function call with a semicolon. This is not
required, though, except when entering multiple function calls on a single line.

5.2 Simple Calculations

Although few people would bother to use R just as a simple calculator, you
can do so with commands like

> 2+3

[1] 5

The “[1]” tells you the resulting value is the first result. It is only useful
when your results run across several lines. We can tell R to generate some
data for us to see how the numbering depends on the width of the output.
The form 1:50 will generate the integers from 1 to 50.

> 1:50

[1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19
[20] 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38
[39] 39 40 41 42 43 44 45 46 47 48 49 50

Now, it is obvious that the numbers in square brackets are counting or
indexing the values. I have set the line width to 63 characters to help things
fit in this book. You can use the options function to change the width to 40
and see how the bracketed numbers change.

> options(width = 40)
> 1:50

[1] 1 2 3 4 5 6 7 8 910 11 12
[13] 13 14 15 16 17 18 19 20 21 22 23 24
[25] 25 26 27 28 29 30 31 32 33 34 35 36
[37] 37 38 39 40 41 42 43 44 45 46 47 48
[49] 49 50
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> options(width = 63) # Set it wider again.

In SAS, that setting is done with OPTIONS LINESIZE=63. SPSS uses
SET WIDTH 63.

An important thing to keep in mind is that if you use your computer’s
mouse to shrink the R console window to have fewer columns, it will override
the width setting.

You can assign the values to symbolic variables like x and y using the
assignment operator, a two-character sequence “<-”. You can use the equal
sign as SAS and SPSS do, but there are some rather esoteric advantages® to
using “<-" instead. Here we use it to assign values to x and y and then do
some simple math.

> x <= 2
>y <=3

>x+y
[1] 5

> X *xy
[1] 6

We have added extra spaces in the above commands and extra lines in the
output for legibility. Additional spaces do not affect the commands.

5.3 Data Structures

SAS and SPSS both use one main data structure, the data set. Instead, R
has several different data structures including wectors, factors, data frames,
matrices, arrays, and lists. The data frame is most like a data set in SAS or
SPSS. R is flexible enough to allow you to create your own data structures,
and some add-on packages do just that.

5.3.1 Vectors

A wvector is an object that contains a set of values called elements. You can
think of it as a SAS or SPSS variable, but that would imply that it is a
column in a data set. It is not. It exists by itself and is neither a column nor
a row. For R, it is usually one of two things: a variable or a set of parameter
settings called arguments that you use to control functions. One of the more

! These are beyond our scope.
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intriguing aspects of R is that its arguments are often more than single static
character strings as they are in SAS and SPSS. The values of arguments are
often vectors that happen to have single values. To SAS and SPSS users that
is a radical idea. It will become clear as you read through this book.

Creating Vectors

Let us create a vector by entering the responses to the first question, “Which
workshop did you take?” without any value labels:

workshop <- c( 1, 2, 1, 2, 1, 2, 1, 2)

All of the workshop values are numeric, so the vector’s mode is numeric.
SAS and SPSS both refer to that as a variable’s type. As in SAS and SPSS,
if even one value were alphabetic (character or string), then the mode would
be coerced, or forced, to be character. R does all its work with functions,
which are similar to SAS statements and procedures, or SPSS commands and
procedures. Functions have a name followed by its parameters (or keywords
in SPSS jargon), called arguments, in parentheses. The ¢ function’s job is to
combine multiple values into a single vector. Its arguments are just the values
to combine, in this case 1,2,1,2....

To print our vector, we can use the print function. This is R’s equivalent to
the SAS PRINT procedure or SPSS’s LIST or PRINT statements. However,
this function is used so often, it is the default function used when you type
the name of any object! So when working interactively, these two commands
do exactly the same thing:

> print (workshop)
[1] 12121212
> workshop

1112121212

We run all of the examples in this book interactively; that is, we submit
function calls and see the results immediately. You can also run R in batch
mode, where you would put all your function calls into a file and tell R to
run them all at once, routing the results to a file. In batch mode you must
write out the print function. I will point out a few other instances when you
must write out the print function name in later chapters. Although typing
out the print function for most of our examples is not necessary, I will do it
occasionally when showing how the R code looks in a typical analysis.

Let us create a character variable. Using R jargon, we would say we are
going to create a character vector, or a vector whose mode is character. These
are the genders of our hypothetical students:
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> gender <_ C("f" , llfll s llfll s NA’ llmll , Ilmll , llmll s llm")
> gender

[1] llfll llfll llfll NA ||m|l ||m|l llmll llmll

NA stands for Not Available, which R uses to represent missing values. Later
I will read data from files whose values are separated by commas. In that case,
R would recognize two commas in a row as having a missing value in between
them. However, the values in the c function are its arguments. R does not
allow its functions to have missing arguments. Entering NA gets around that
limitation.

Even when entering character values for gender, never enclose NA in
quotes. If you did, it would be just those letters rather than a missing value.

Now let us enter the rest of our data:

ql <- ¢(1, 2, 2, 3, 4, 5, 5, 4)
q2 <- c(1, 1, 2, 1, 5, 4, 3, 5)
g3 <- c(5, 4, 4,NA, 2, 5, 4, 5)
q4 <- c(1, 1, 3, 3, 4, 5, 4, 5)

Using Vectors

Just as with variables in SAS or SPSS, you can do all kinds of things with
vectors, like add them:

> mySum <- gl + g2 + g3 + g4
> mySum

[1] 8 8 11 NA 15 19 16 19

That approach works just like SAS or SPSS since R added all the elements
in order simply by using the “+” sign. In many other languages that process
would have required a DO or FOR loop by creating the sums for the first
element, then the second, and so on. You could do it that way in R too, but it
is not necessary. The fact that R functions work on every element of vectors
automatically is called vectorization. R’s functions are vectorized, helping you
to avoid needless and often inefficient DO or FOR loops.

While vectorization typically works just like SAS or SPSS, sometimes it
will surprise you. For example, if you add two variables in SAS or SPSS and
one is shorter than the other, those packages will force the two to match
lengths by filling in missing values. Let us see what happens in R:

> myShortVector <- c(10, 100)

> ql
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[1] 12234554
> mySum <- gl + myShortVector
> mySum

[1] 11 102 12 103 14 105 15 104

What happened? Rather than set all but the first two values to missing, R
used the 10 and 100 values over and over again. This process is called recycling.
To SAS or SPSS users, recycling appears disastrous at first. Is it not adding
values from the wrong observations? Do not fear, though, as in most cases
vectors on the same set of observations will be padded with missing values.
That will ensure the behavior you expected will indeed happen:

> myVector <- c(10, 100, NA, NA, NA, NA, NA, NA)
> mySum <- gl + myVector
> mySum

[1] 11 102 NA NA NA NA NA NA

Once you recover from the initial shock of these differing results, you will
find that when you expect SAS- or SPSS-like results in addition or subtrac-
tion, you will have them. Furthermore, recycling offers you a way to simplify
programs that would otherwise require the use of DO or FOR loops.

Most mathematical functions in R are vectorized. For example, the sqrt
function will take the square root of each element in the vector, just as in SAS
or SPSS:

> sqrt(ql)
[1] 1.000 1.414 1.414 1.732 2.000 2.236 2.236 2.000

Statistical functions work on a whole vector at once. To get a simple table
of frequencies, we can use the table function:

> table(workshop)
workshop

12

4 4

> table(gender)
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gender
fm
34

The first thing you will notice about the output is how plain it is. No
percents are calculated and no lines drawn to form a table. When you first see
a table like the one for workshop, its complete lack of labels may leave you
wondering what it means. There are four people who took workshop 1 and
four people who took workshop 2. It is not hard to understand — just a shock
when you come from a package that labels its output better.

This is a difference in perspective between R and SAS or SPSS. R creates
or returns output that other functions can use immediately. Other functions
exist that provide more output, like percents. Still others format output into
publication-quality form.

Let us get the mean of the responses to question 3:

> mean(qg3)

[1] NA

The result is NA, or Not Available! Many R functions handle missing values
in an opposite manner from SAS or SPSS. R will usually provide output
that is NA when performing an operation on data that contains any missing
values. It will typically provide the answer you seek only when you tell it to
override that perspective. There are several ways to do this in R. For the mean
function, you set the NA remove argument, na.rm, equal to TRUE.

> mean(q3, na.rm = TRUE)

[1] 4.142857

R has most of the same mathematical (Table 10.2) and statistical (see
Table 10.1) functions that SAS and SPSS do.

Selecting Vector Elements

So far we have performed a few simple analyses on entire vectors. You can
easily select subsets using a method called subscripting or indexing.> You
specify which of the vector’s elements you want in square brackets following
the vector’s name. For example, to see the fifth element of q1, you enter

> q1[5]

(1] 4

2 To be more precise, subscripting is done by using index values, logic, or names.
However, people use subscripting and indexing interchangeably.
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When you want to specify multiple elements, you must first combine them
into a vector using the ¢ function. Therefore, to see elements 5 through 8, you
can use

> qtlc(5, 6, 7, 8)]

[1] 4565 4

@

The colon operator, “:”, can generate vectors directly, so an alternate way
of selecting elements 5 through 8 is

> q1[5:8]
[1] 4554

You can also insert logical selections. They generate logical vectors to
perform your selection. R uses “==" for logical equivalence, not the equal sign
or “EQ”:
> ql[gender == "m"]

[1] NA 4 5 5 4

The spaces on either side of the “==" or any other logical operators improve
program legibility. Usually the goal of any of these selection methods is to
perform some analysis on a subset. For example, to get the mean response to
item ql for the males, we can use

> mean(ql[gender == "m"], na.rm = TRUE)

[1] 4.5

R’s ability to select vector elements is very flexible. I will demonstrate how
to apply these techniques toward selecting parts of other data structures in
the sections that immediately follow. Later I will devote three entire chapters
to showing how to apply these techniques to data sets in Chap. 7, “Selecting
Variables,” through Chap. 9, “Selecting Variables and Observations.”

5.3.2 Factors

Two of the variables we entered above, workshop and gender, are clearly
categorical. R has a special data structure called a factor for such variables.
Regardless of whether a variable’s original values are numeric or character,
when a variable becomes a factor, its mode becomes numeric.
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Creating Factors from Numeric Vectors

Before we create a factor, let us enter workshop again as a numeric vector and
display its values.

> workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
> workshop

[1J] 12121212
Now let us perform two simple analyses.

> table(workshop)

workshop

12

4 4

> mean (workshop)

[1] 1.5

We see that four people took each workshop. We also see that the mean
function happily returned the mean of the workshops, which is a fairly non-
sensical measure for a categorical variable. R usually tries to do correct things
statistically, but we have not yet told it that workshop is categorical.

Recall that to select elements of a vector you can use subscripting and
place an index value in square brackets. For example, to choose the third
element of gender, you can use

> gender [3]
[1] £

Levels: f m

To see the first two and the last two elements, you can subscript using
those index values in a vector using the ¢ function like this:

> gender[c(1, 2, 7, 8)]
[1] f fmm

Levels: fm

Let us now see the genders of the people who took the SAS workshop,
which has a value of 2.
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> gender [workshop == 2]

[1] llfll NA llmll llmll

Now let us enter the variable again, convert it to a factor using the factor
function, and display its values.

> workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
> workshop <- factor(workshop)

> workshop

1112121212

Levels: 1 2

I could have assigned the resulting factor to a new variable name (on the left
side of the <-), of course. However, the name “workshop” that appears within
the parentheses on the factor function call (the right side) must exist already.

After using the factor function, we see that the display of workshop values
has an additional feature, the levels. Let us repeat our two analytic functions:

> table(workshop)

workshop

12

4 4

> mean(workshop)

[1] NA

Warning message:
In argument is not numeric or logical: returning NA

The output from the table function is identical, but now the mean function
warns us that this is not a reasonable request and it returns a missing value
of NA.

Now that workshop is a factor, we can check the genders of the people who
took the SAS workshop (workshop 2) in two ways:

> gender [workshop == 2]

[1] llfll NA ||m|l ||m|l
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> gender [workshop == "2"]

[1] llfll NA llmll llmll

The second example uses quotes around the 2 and it still works. This is
due to the fact that the original numeric values are now also stored as value
labels.

Now I will enter workshop again, this time using additional arguments in
the factor function call to assign more useful value labels.

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop <- factor(
workshop,
levels = c( 1, 2, 3, 4),
labels = c("R", "SAS", "SPSS", "Stata")

The factor function call above has three arguments:

1. The name of a vector to convert to a factor.

2. The levels or values that the data can have. This allows you to specify
values that are not yet in the data. In our case, workshop is limited to
the values 1 and 2, but we can include the values 3 and 4 for future
expansion. I spaced the values out just to match the spacing of the labels
below, but that is not required. Notice that these values are contained in
the c function; therefore, they are actually a vector!

The order you list the values in will determine their appearance order
in output like frequency tables and graphs. The first one you list will
determine the comparison level if you use the factor in modeling (see
Sect. 10.8 for details).

If the values have a numeric order like low, medium, or high, then you
can use the ordered function rather than the factor function. It works
almost identically but registers the variable as ordinal rather than simply
categorical.

3. Optionally, the labels for the levels. The factor function will match the
labels to the levels in the order in which they are listed in the function call.
The order of the values in the data set is irrelevant. If you do not provide
the labels argument, R will use the values themselves as the labels. If you
supply them, the values must be nested within a call to the ¢ function,
making them a character vector.

Now when we print the data, they show us that the people in our practice
data set have only taken workshops in R and SAS. It also lists the levels so
you can see what labels are possible:

> workshop
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[1] R SAS R SAS R SAS R SAS

Levels: R SAS SPSS Stata

The table function now displays the workshop labels and how many people
took each:

> table(workshop)
workshop

R SAS SPSS Stata
4 4 0 0

The labels have now replaced the original values. So to check the genders of
the people who took the SAS workshop, we can no longer use the value 2.

> gender [workshop == 2]
factor(0)

Levels: Male Female
When we select based on the value label, it works.

> gender [workshop == "SAS"]
[1] Female <NA> Male Male

Levels: Male Female

Creating Factors from Character Vectors

You can convert character vectors to factors in a similar manner. Let us again
enter gender as a character vector and print its values.

> gender <_ C("f" s |Ifl| s llfll s NA’ llmll , Ilmll , Ilmll s |Imll)
> gender

[1] IlfIl IlfIl llfII NA llmll llmll llmll llmll

Notice that the missing value, NA, does not have quotes around it. R
leaves out the quotes to let you know that it is not a valid character string
that might stand for something like North America.

If we are happy with those labels, we can convert gender to a factor by
using the simplest call to the factor function:
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> gender <- factor(gender)
> gender
[1] fffNAmmmm

Levels: fm

If, instead, we want nicer labels, we can use the longer form. It uses the
same approach we used for workshop, but the values on the levels argument
need to be in quotes:

> gender <- factor(

+ gender,

+ levels = c("m", "y,

+ labels = c("Male", "Female")
+)

> gender

[1] Female Female Female NA Male Male Male Male
Levels: Male Female
> table(gender)
gender

Male Female
4 3

You now need to use the new labels when performing selections on gender.
For example, to see which workshops the males took, this no longer works:

> workshop[gender == "m"]
[1] <NA>

Levels: R SAS SPSS STATA
Instead, specifying the new label of “Male” finds the workshops they took:

> workshop[gender == "Male"]
[1] <NA> R SAS R SAS

Levels: R SAS SPSS Stata
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Note that the last line of output conveniently tells you all of the levels of the
factor even though the males did not take all of the workshops.
We will examine factors and compare them to SPSS value labels and SAS
formats in Sect. 11.1, Value Labels or Formats (and Measurement Level).
For the remainder of the book we will use the shorter labels, “m” and “f.”

5.3.3 Data Frames

The data structure in R that is most like a SAS or SPSS data set is the data
frame. SAS and SPSS data sets are always rectangular, with variables in the
columns and records in the rows. SAS calls these records observations and
SPSS calls them cases. A data frame is also rectangular. In R terminology,
the columns are called vectors, variables, or just columns. The rows are called
observations, cases, or just rows.

A data frame is a generalized matriz, one that can contain both character
and numeric columns. A data frame is also a special type of list, one that
requires each component to have the same length. We will discuss matrices
and lists in the next two sections.

We have already seen that R can store variables in vectors and factors.
Why does it need another data structure? R can generate almost any type of
analysis or graph from data stored in vectors or factors. For example, getting
a scatter plot of the responses to ql versus g4 is easy. R will pair the first
number from each vector as the first (x,y) pair to plot and so on down the
line. However, it is up to you to make sure that this pairing makes sense. If you
sort, one vector independently of the others, or remove the missing values from
vectors independently, the critical information of how the pairs should form is
lost. A plot will still appear, but it will contain a completely misleading view
of the data. Sorting almost any two variables in ascending order independently
will create the appearance of a very strong relationship. The data frame helps
maintain this critical pairing information.

Creating a Data Frame

The most common way to create a data frame is to read it from another source
such as a text file, spreadsheet, or database. You can usually do that with a
single function call. We will do that later in Chap. 6, “Data Acquisition.”
For the moment, I will create one by combining the vectors and factors. The
following is my program so far:

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop <- factor(workshop,

levels = c( 1, 2, 3, 4),
labels = c("R", "SAS", "SPSS", "Stata") )
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gender <_ C("f" s llfll , Ilfll , NA’ llmll s llmll s llmll , Ilmll)

gender <- factor(gender)

ql <- ¢(1, 2, 2, 3, 4, 5, 5, 4)
q2 <- ¢(1, 1, 2, 1, 5, 4, 3, 5)
93 <- c(5, 4, 4,NA, 2, 5, 4, 5)
q4 <- c(1, 1, 3, 3, 4, 5, 4, 5)

Now we will use the data.frame function to combine our variables (vectors
and factors) into a data frame. Its arguments are simply the names of the
objects we wish to combine.

> mydata <- data.frame(workshop, gender, ql, q2, q3, q4)

> mydata

workshop gender ql g2 g3 g4
1 R f 11 5 1
2 SAS f 2 1 4 1
3 R f 2 2 4 3
4 SAS <NA> 3 1 NA 3
5 R m 4 5 2 4
6 SAS m 5 4 5 5
7 R m 5 3 4 4
8 SAS m 4 5 5 5

Notice that the missing value for gender is now shown as “<NA>.” When R
prints data frames, it drops the quotes around character values and so must
differentiate missing value NAs from valid character strings that happen to
be the letters “NA.”

If T wanted to rename the vectors as I created the data frame, I could do
so with the following form. Here the vector “gender” will be stored in mydata
with the name “sex” and the others will keep their original names. Of course,
I could have renamed every variable using this approach.

mydata <- data.frame(workshop, sex = gender, ql, g2, q3, q4)

For the remainder of the book I will leave the variable name as “gender.”

Although I had already made gender into a factor, the data.frame func-
tion will coerce all character variables to become factors when the data frame
is created. You do not always want that to happen (for example, when you
have vectors that store people’s names and addresses.) To prevent that from
occurring, you can add the stringsAsFactors = FALSE argument in the call
to the data.frame function.
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In SAS and SPSS, you do not know where variable names are stored or
how. You just know they are in the data set somewhere. In R however, vari-
able names are stored in the names attribute — essentially character vectors —
within data objects. In essence, they are just another form of data that you
can manipulate. We can display the names of a data frame using the names
function:

> names (mydata)

[1] llworkshopll Ilgenderll llqlll llq2ll Ilq3l| Ilq4ll

R data frames also have a formal place for an ID variable it calls the
row names attribute. These names can be informative text labels like subject
names, but, by default, they are sequential numbers stored as character values.
The row.names function will display them:

> row.names (mydata)

[1] lll" ll2ll ll3ll ll4ll ll5ll ll6ll ll7ll ll8|l

SAS and SPSS display sequential numbers like this in their data editors.
However, those numbers are reassigned to new observations when you sort
your data. Row names in R are more useful since sorting never changes their
values. You can always use them to return your data to their original state by
sorting on the row names. See Sec. 10.18, “Sorting Data Frames,” for details.

SAS and SPSS users typically enter an ID variable containing an observa-
tion/case number or perhaps a subject’s name. However, this variable is like
any other unless you manually supply it to a procedure that identifies obser-
vations. In R, procedures that identify observations will do so automatically
using row names. If you set an ID variable to be the row names while read-
ing a text file, then variable’s original name (id, subject, SSN, etc.) vanishes.
Since functions that do things like identify outliers will use the information
automatically, you usually do not need the name. We will discuss row names
further when we read text files and in Sect. 10.6, “Renaming Variables (.. .and
Observations).”

Selecting Components of Data Frames

There are several ways to select the components of a data frame. For now,
we will focus on just two: selecting by subscripting and by a method called
$ notation. We will save the other methods for later chapters.

Selecting Data Frame Components by Subscripting

While vectors and factors have only one-dimensional subscripts with which
to select their elements, data frames have two-dimensional ones. These are in
the form
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mydataframe [rows, columns]

For example, you can choose the eighth observation’s value of the sixth
variable, q4, using

> mydatal8, 6]

(11 5

If you leave out a row or column subscript, R will assume you want them all.
So to select all of the observations for the sixth variable, I can use

> mydatal ,6]

[1] 11334545

It so happens that the above example is selecting a vector. We saw ealier
that we could add subscripts to the end of a vector to select a subset of it. So
for variable g4, I can choose its fifth through eighth elements using

> q4[5:8]

[1] 4545

In our data frame, mydatal , 6] is the same vector as variable q4. There-
fore, we can make this same selection by appending [5:8] to it:

> mydatal , 6][5:8]

[1] 4545

Selecting Data Frame Components Using $ Notation

Since the components of our data frame have names, I can also select them
by name using the form

myDataFrameName$myComponentName
Therefore, to select ql from mydata, I can use

> mydata$ql

[1] 12234554

The variable ql is still a vector, so I can append index values to it to make
further selections. To select the fifth through eighth values (the males), we
can use
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> mydata$qi[ 5:8 ]

[1] 455 4

As we will soon see, there are many other ways to select subsets of data
frames. We will save the other methods for Chap. 7, “Selecting Variables,”
through Chap. 9, “Selecting Variables and Observations.”

5.3.4 Matrices

A matriz is a two-dimensional data object that looks like a SAS or SPSS
data set, but it is actually one long vector wrapped into rows and columns.
Because of this, its values must be of the same mode, (e.g., all numeric or all
character). This constraint makes matrices more efficient than data frames for
some types of analyses, but their main advantage is that they lend themselves
to the use of matrix algebra.

To use matrices in SAS, you could run PROC IML, transfer a data set from
SAS into an IML matrix, and then begin working in a whole new syntax. When
finished, you would transfer the results back into the main SAS environment.
Alternatively, you could run a whole different program: SAS/IML Studio.

SPSS has its similar MATRIX environment, with its separate syntax.

Unlike with SAS and SPSS, matrices are an integral part of R. There is
no special matrix procedure to activate. This tight level of integration is one
of the things that attracts developers to R.

Creating a Matrix

The cbind function takes columns and binds them together into a matrix:

> mymatrix <- cbind(ql, 92, 93, q4)
> mymatrix

ql 92 93 g4
[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,1]
[8,]
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As you can see, a matrix is a two-dimensional array of values. The numbers
on the left side in brackets are the row numbers. The form [1, ] means that it
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is row number one and the lack of a number following the comma means that
R has displayed all of the columns.
We can get the dimensions of the matrix with the dim function:

> dim(mymatrix)

[1] 8 4

The first dimension is the number of rows, 8, and the second is the number
of columns, 4.

To create a matrix, you do not need to start with separate vectors as I did;
you can create one directly with the matrix function. The matrix function
call below has four arguments. The first argument is data, which you must
enclose in a call to the ¢ function. The next three specify the number of rows,
columns, and whether or not you are entering the data by rows. If you leave
the byrow = TRUE argument off, you would enter the data turned on its side.
I prefer to enter it by rows since it looks more like the layout of SAS and SPSS
data sets.

> mymatrix <- matrix(

+ c(1, 1, 5, 1,

+ 2,1, 4, 1,

+ 2, 2, 4, 3,

+ 3, 1, NA,3,

+ 4, 5, 2, 4,

+ 5, 4, 5, 5,

+ 5, 3, 4, 4,

+ 4, 5, 5, 5),

+ nrow = 8, ncol = 4, byrow = TRUE)

> mymatrix

(.11 [,21 [,3] [,4]

[1,] 1 1 5 1
[2,] 2 1 4 1
[3,] 2 2 4 3
(4,] 3 1 NA 3
[5,] 4 5 2 4
[6,1] 5 4 5 5
[7,] 5 3 4 4
[8,] 4 5 5 5

You can see that the result is the same as before, except that the columns
are no longer named ql, q2, q3, q4. Now let us see what the table, mean, and
cor functions do with matrices. I will use the earlier version of the matrix, so
you will see the variable names.
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> table(mymatrix)

mymatrix
12345

64489

> mean( mymatrix, na.rm = TRUE )
[1] 3.266667

> cor( mymatrix, use = "pairwise" )

ql q2 q3 q4
ql 1.0000000 0.7395179 -0.1250000 0.9013878
q2 0.7395179 1.0000000 -0.2700309 0.8090398
q3 -0.1250000 -0.2700309 1.0000000 -0.2182179
g4 0.9013878 0.8090398 -0.2182179 1.0000000

The table function counts the responses across all survey questions at
once! That is not something SAS or SPSS would usually do. It is odd, but
not useless. We can see that nine times people strongly agreed (a value of 5)
with any of the questions on our survey.

The mean function gets the mean response of them all. Again, it is not of
much interest in our situation, but you might find cases where it would be of
value.?

The cor function correlates each item with the others, which is a very
common statistical procedure. The fact that the names ql, ql, etc. appear
shows that we are using the version of the matrix we created by combining
the vectors with those names.

If you put a matrix into a data frame, its columns will become individual
vectors. For example, now that we have mymatrix, we can create our practice
data frame in two ways. Both have an identical result:

mydata <- data.frame( workshop, gender, ql, 92, g3, g4 )
or
mydata <- data.frame( workshop, gender, mymatrix )

In our case, there is not much difference between the two approaches. However,
if you had 100 variables already in a matrix, the latter would be much easier
to do.

3 For example, sensor arrays commonly measure a single variable, such as CO2
levels, across an latitude-longitude grid. It is convenient to store such data in a
matrix and the mean CO2 level across that area would be a useful measure.
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Selecting Subsets of Matrices

Like data frames, matrices have two dimensions. You can select a subset of a
matrix by specifying the two index values in the form

mymatrix[rows, columns]
For example, I can choose the eighth row and the fourth column using
> mymatrix[8, 4]
qé
5
I can choose the males, rows five through eight, and variables q3 and g4 using;:

> mymatrix[5:8, 3:4]

[,11 [,2]
[1,] 2 4
[2,] 5 5
[3,] 4 4
[(4,] 5 5

In our discussion of vectors, you learned that you could select parts of a
vector using only one-dimensional indices. For example, q4[1:4] selects the
first four elements of vector q4. When you leave out one of the two index
values for a matrix, you are selecting a vector. Therefore, I can do this very
same example by appending [1:4] to mymatrix[ ,4] as in

> mymatrix[ ,4][1:4]

[1] 1133

Most of the other methods we have used for selecting elements of vectors
or factors work in a similar manner with matrices. An important one that does
not work with matrices is the dollar format that we used with data frames.
Even using the form of mymatrix that contained the column names this does
not work:

> mymatrix$qd # No good!

Error in mymatrix$q4 : $ operator is invalid for atomic vectors
A similar form places one name, or vectors of names, in the subscripts:

> mymatrix[ ,"q4"]

[1] 11334545

Since this latter form works with both matrices and data frames, people
who frequently work with both tend to prefer it over the dollar format.
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Table 5.1. Matrix functions

R SAS SPSS
Add a+b a+b a+b
Determinant det (a)$values DET(a) DET(a)
Diagonal diag(a) DIAG(a) DIAG(a)
Eigenvalues eigen(x) $values EIGENVAL (x) EVAL (a)
Eigenvectors eigen(a)$vectors EIGENVEC(a) Not a function
Inverse solve(a) INV(a) INV(a)
Multiply a %*h b a*b a*b
Transpose t(a) a' or T(a) T(a)

Matrix Algebra

Matrix algebra is a powerful tool for data analysis. It is used inside most of
the functions that come with R. R users most often use matrix algebra when
writing their own functions. Even if you do not plan to write your own complex
functions, the fact that R has matrix algebra capabilities tightly integrated
into it draws developers to R, resulting in a vast array of add-on packages
that everyone can use.

You can use matrix algebra at any time using the same syntax as you
would for any other part of your program. The function names are different
of course, but that is all. For example, if I wish to swap the row and column
positions in mymatrix, I can use the t function to transpose it:

> mymatrixT <- t(mymatrix)
> mymatrixT

(,11 [,2]1 [,3]1 [,41 [,5] [,6] [,7]1 [,8]
ql 1 2 2 3 4 5 5 4

@2 1 1 2 1 5 4 3 5
@3 5 4 4 NA 2 5 4 5
94 1 1 3 3 4 5 4 5

There are many packages available from CRAN that extend R’s substantial
built-in capabilities. Bates and Maechler’s Matrix package [6] is particularly
useful when dealing with sparse or dense matrices. Although further use of
matrix algebra is beyond the scope of this book, Table 5.1 contains a list of
commonly used matrix algebra functions.

5.3.5 Arrays

Just as a matrix is a two-dimensional extension of a vector, an array is a
multidimensional extension of a matrix. A three-dimensional array is a set of
matrices layered like pages in a book. Each matrix layer has the same number
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of rows and columns. A four dimensional array would be like a set of books
on a shelf, each containing the same number of pages, and so on.

Our practice data set is artificially balanced. Four people took the R work-
shop and four took the SAS workshop. Therefore, we could take the answers
to their survey questions — the data must all be the same type, in this case
numeric — and store them in an array. There would be two layers, one for each
workshop. The first layer would be a matrix of the four people who took the
R workshop, and the second layer would contain the four who took the SAS
workshop.

However, in observational studies, people choose their own workshops, and
so each set of data would have a different number of people. Therefore, we
could not store the data in an array. The data would instead be stored in a
typical data set (an R data frame) and could be viewed as a “ragged” array.

The use of arrays is beyond the scope of this book, except for the “ragged”
kind, data frames.

5.3.6 Lists

A list is a very flexible data structure. You can use it to store combinations of
any other objects, even other lists. The objects stored in a list are called its
components. That is a broader term than variables, or elements of a vector,
reflecting the wider range of objects possible.

You can use a list to store related sets of data stored in different formats
like vectors and matrices (example below). R often uses lists to store different
bits of output from the same analysis. For example, results from a linear
regression would have equation parameters, residuals, and so on. See Chap. 17,
“Statistics,” for details.

You can also use lists to store sets of arguments to control functions. We
will do that later when reading multiple lines of data per case from a text
file. Since each record we read will contain a different set of variables — each
with a different set of column widths — a list is a perfect way to store them.
For an example, see Sect. 6.7, “Reading Fixed-Width Text Files, Two or More
Records Per Case.”

We will also store arguments when aggregating data by workshop and
gender in Sect. 10.12, “Creating Summarized or Aggregated Data Sets.”

Creating a List

Now let us store some data in a list. We can combine our variables (vectors)
and our matriz into a list using the 1ist function.

> mylist <- list(workshop, gender, ql, g2, 93, g4, mymatrix)

Now let us print it.
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> mylist

[[1]]
[11 R SAS R SAS R SAS R SAS
Levels: R SAS SPSS Stata

[[2]1]
[1] £ f f <NA> m m m m
Levels: fm

(311
[11 12234554

[[4]]
(11 11215435

(0511
[11 5 4 4NA 2 5 4 5

[[6]]
[1] 11334545

[[7]1]

ql 92 93 g4
[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,1]
[8,]
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Notice how the vector components of the list print sideways now. That
allows each component to have a different length, or even to have a totally
different structure, like a matrix. Also notice that it counts the components of
the list with an additional index value in double brackets [[1]], [[2]], etc. Then
each component has its usual index values in single brackets.

Previously, when I added mymatrix to a data frame, the structure of the
matrix vanished and the matrix columns became variables in the data frame.
Here, though, the matrix is able to maintain its separate identity within the
list.

Let us create the list again, this time naming each component. Another
term for these optional component names are tags.



>
+
+
+
+
+
+
+

workshop
gender

ql = qi,
92 = 92,
q3 = g3,
q4 = g4,
mymatrix

mylist <- list(

workshop,
gender,

mymatrix)
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Now when I print it, the names [[1]], [[2]], etc. are replaced by the names (or
tags) I supplied.

> mylist

$workshop

[1] R SAS R SAS R SAS R SAS

Levels: R SAS

$gender
[1] £ f <NA> m
Levels: fm
$q1
[1] 12234554
$q2
[1] 11215435
$q3
[1] 5 4 4NA 2 5 4 5
$q4
[1] 11334545
$mymatrix

ql g2 g3 q4
[1,] 1 1 5 1
2,] 2 1 4 1
[3,] 2 2 4 3
[4,] 3 1NA 3
[65,] 4 5 2 4
[6,] 5 4 5 5
[7,] 5 3 4 4
[8,] 4 5 5 5
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Selecting Components of a List

A data frame is a specific type of list, one whose components must all be
of the same length. Therefore any method of selecting components that we
discussed for data frames will also apply here. However, since the types of
objects lists can store are broader, so too are the techniques for selecting their
components.

Selecting Components of a List by Subscripting

To select the components from a list, you can always use the double-bracketed
subscripts. For example, to select the vector containing gender, you can use:

> mylist[[2]]
[1] £ f f <NA> m m m m

Levels: fm

Back when we first learned about vectors and factors, we selected parts
of them by adding index values or logical selections in bracketed subscripts.
Since we have selected a factor from our list, we can add those, too. Here we
select observations 5 through 8:

> mylist[[2]][5:8]
[l mmmm

Levels: fm

We can also select parts of a list using single brackets, but when we do so,
the result will be a list with a single component, not just a factor!

> mylist[2]
$gender
(1] £ f f <NA> m m m m

Levels: fm

Note that it lists the name “$gender,” which does look exactly like the way
lists name their components. So what would happen now if we tried to select
observations 5 through 87

> mylist[2][5:8] # Bad!
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$<NA>
NULL

$<NA>
NULL

$<NA>
NULL

$<NA>
NULL

We got NULL results because mylist[2] is a list containing a single com-
ponent — the factor gender — and we are asking for components 5 through 8.
They do not exist!

If you wish to select multiple components from a list, you use the single
brackets. Here we select the first three:

> mylist[1:3]

$workshop
[1] R SASR SASR SASR SAS

Levels: R SAS

$gender
[1] £ f f <NA> m m m m

Levels: fm

$q1
[1] 122345514

R’s subscripting approach starts looking pretty confusing at this point,
but do not worry. In future chapters you will see that selections usually look
far more natural with variable names used to select columns and with logical
selections choosing rows.

Selecting Components of a List Using $ Notation

Since I have named our list’s components, I can make the same selections by
using the form

myListName$myComponentName

Therefore, to select the component named ql, I can use:
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> mylist$ql

[1] 12234554

You can also append index values in square brackets to our selections to
choose subsets. Here I select mymatrix, then choose the fifth through eighth
rows and third and fourth columns:

> mylist$mymatrix[ 5:8, 3:4 ]

q3 q4
(1,1 2 4
[2,] 5 5
[3,] 4 4
[4,] 5 5

5.4 Saving Your Work

When learning any new computer program, always do a small amount of work,
save it, and get completely out of the software. Then go back in and verify
that you really did know how to save your work.

This is a good point at which to stop, clean things up, and save your work.
Until you save your work, everything resides in the computer’s main random
access memory. You never know when a power outage might erase it. R calls
this temporary work area its workspace. You want to transfer everything we
have created from this temporary workspace to a permanent file on your
computer’s hard drive.

R’s workspace is analogous to the SAS work library, except that it is in
memory rather than in a temp space on your hard drive. In SPSS jargon it
would simply be your unsaved data sets.

You can use the 1s function to see all of the data objects you have created.
If you put no arguments between the 1s function’s parentheses, you will get
a list of all your objects. Another, more descriptive name for this function
is objects. I use 1ls below instead of objects because it is more popular.
That may be due to the fact that Linux and UNIX have a “Is” command that
performs a similar function by listing your files.

If you have done the examples from the beginning of this chapter, here are
the objects you will see in your workspace.

> 1s()
[1] "gender" "mydata" "mylist" "mymatrix" "ql1"
[6] llq2ll llq3|l Ilq4ll Ilworkshopll IIXII

[11] Ilyll



5.4 Saving Your Work 89

You want to save some of these objects to your computer’s hard drive, but
where will they go? The directory or folder that R will store files in is called
its working directory. Unless you tell it otherwise, R will put any file you save
into that directory. On Windows XP or earlier, this is: C:\Documents and
Settings\username\My Documents. On Windows Vista or later, this is:
C:\Users\ Username\ Documents. On Macintosh, the default working directory
is /Users/username.

The setwd function sets your working directory, telling R where you would
like your files to go. This is the equivalent to “X CD C:\myRfolder” in SAS and
“CD C:\myRfolder” in SPSS. The getwd function gets your working directory
for you to see.

> getwd()

[1] "C:/Users/Bob/Documents"
> setwd("C:/myRfolder")

> getwd ()

[1] "C:/myRfolder"

Notice that R uses a forward slash in “C:/myRfolder.” R can use forward
slashes in filenames even on computers running Windows! The usual back-
slashes used in Windows file specifications have a different meaning in R, and
in this context will generate an error message:

> setwd("C:\myRfolder") # backslashes are bad in filenames!
Error in setwd("myRfolder") : cannot change working directory

In addition: Warning messages:
1: "\m' is an unrecognized escape in a character string
2: unrecognized escape removed from "\myRfolder"

The message warns you that R is trying to figure out what “\m” means. We
will discuss why later.

So now you know what is in your workspace and where your working
directory resides. You are ready to save your work. However, which objects
should you save? Once you have combined the vectors into a data frame, you
no longer need the individual vectors. I will save just our data frame, mydata,
and the matrix of survey questions, mymatrix.

The save function writes the objects you specify, to the file you list as its
last argument.

save(mydata, mymatrix, file = "mydata.RData")
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While SAS and SPSS users typically only save one data set to a file (SAS
has exceptions that are used by experts), R users often save multiple objects
to a single file using this approach.

Rather than tell R what you do want to save, you could remove the objects
that you do not want to save and then save everything that remains. We can
remove the ones we do not want by listing them as arguments separated by
commas on the remove function. It also has a more popular shorter name, rm.

> rm(x, y, workshop, gender, ql, 92, g3, g4, mylist)
> 1s(0)

[1] "mydata" "mymatrix"

The save.image function will save all objects in your workspace to the file
you specify:

save.image(file = "myWorkspace.RData")

When you exit R, it will ask if you want to save your workspace. Since you
saved it to a file you yourself have named, you can tell it no. The next time
you start R, you can load your work with the load function:

> load("mydata.RData")
If you want to see what you have loaded, use the 1s function:

> 1s()

[1] "mydata" "mymatrix"

For more details, see Chap. 13, “Managing Your Files and Workspace.”

5.5 Comments to Document Your Programs

No matter how simple you may think a program is when you write it, it is
good to sprinkle in comments liberally to remind yourself later what you did
and why you did it.

SAS and SPSS both use the COMMENT command or the * operator
to begin a comment. SAS ends them with semicolons and SPSS ends with
periods. The /*...*/ style comments in SAS and SPSS allow you to place
comments in the middle of a line between keywords or to block off many lines
of programming that you want to “turn off” for debugging purposes.

As we have discussed briefly, R uses the # operator to begin a comment. R
comments continue until the end of the line. No special character is required
to end a comment. You can make your comments easier to read if you skip
one space after each # character. If you add a comment to the end of a
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programming line, it also improves legibility if you skip two spaces before
each # character. You can put comments in the middle of statements, but
only if they continue to the end of the line:

# This comment is on its own line, between functions.

workshop <- c(1, 2, 1, 2, # This comment is within arguments.
1, 2, 1, 2) # And this is at the end.

Unlike the SAS and SPSS /*...*/ style comments, there is no way to
comment out a whole block of code that you want to ignore. However, any
text editor that works well with R can easily add the # character to (and
later remove from) the front of each line in a selected block of code. For some
examples, see Sect. 3.9, “Running R From Within Text Editors.”

An alternative is to turn off a block of code by pretending to define a
function. For example:

BigComment <- function(x)
{
# Here is code I do not want to run,
# but I might need to run it later.
mean(x, na.rm = TRUE)
sd(x, na.rm = TRUE)
}

This is not a very good approach, though, since R is actually creating the
function, so the code within it must be correct. Since the need to turn off
blocks of code often arises from the need to debug the code, this is usually
not very helpful!

5.6 Comments to Document Your Objects

Another helpful way to document your work is to store comments in the R
objects you create. This is analogous to the SAS LABEL option on the DATA
statement. That option provides a single location for all comments regarding
the data set.

R’s comment capability is more like SPSS’s. In SPSS, to comment the
whole data set, you would use the DOCUMENT or ADD DOCUMENT commands, or
even the older FILE LABEL command. To comment an individual variable, you
would create a custom variable attribute.

To store a comment in an object, you use the comment function:

comment (mydata) <- "Example data from R for SAS and SPSS Users"

Later you can view it using the comment function:



92 5 Programming Language Basics

> comment (mydata)

[1] "Example data for R for SAS and SPSS Users"

Other functions that display object attributes will also display this com-
ment. You can assign comments to vectors as well, but they do not display
automatically in the output like variable labels, so I would not normally do
so. We will discuss variable labels later in Sect. 11.2.

5.7 Controlling Functions (Procedures)

SAS and SPSS both control the output of their procedures through statements
like GLM and related substatements such as CLASS to specify which variables
are factors (categorical). Those statements have options that control exactly
what appears in the output. Modeling statements have a formula syntax.

R has analogs to these options to control the output of its functions, plus
a few unique ones. The output itself is called what the function returns.

5.7.1 Controlling Functions with Arguments

SAS and SPSS use options to control what procedures do. R does, too, using
slightly different terminology. R uses arguments to control functions. Let us
look at the help file for the mean function. The following command will call
up its help file:

> help("mean"
mean package:base R Documentation
Arithmetic Mean

Description: Generic function for the (trimmed)
arithmetic mean.

Usage:

mean(x, ...)

## Default S3 method:

mean(x, trim = 0, na.rm = FALSE, ...)
Arguments:

x: An R object. Currently there are methods for numeric/logical
vectors and date, date-time and time interval objects, and
for data frames all of whose columns have a method...
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trim: the fraction (0 to 0.5) of observations to be trimmed
from each end of 'x' before the mean is computed. ..

na.rm: a logical value indicating whether 'NA' values should
be stripped before the computation proceeds.

: further arguments passed to or from other methods.
Value:

For a data frame, a named vector with the appropriate method
being applied column by column. If 'trim' is non-zero,...

References: Becker, R. A., Chambers, J. M. and Wilks,...
See Also: 'weighted.mean', 'mean.P0SIXct', 'colMeans' for row...

Examples:
x <- c¢(0:10, 50)
xm <- mean(x)
c(xm, mean(x, trim = 0.10))
mean (USArrests, trim = 0.2)

In the section labeled Usage, the help file tells us that the overall form of
the function is mean(x, ...). That means you have to provide an R object
represented by x, followed by arguments represented by “...”. The Default
S8 Method section tells us the arguments used by the mean function itself
as well as their initial, or default, settings. So if you do not tell it other-
wise, it will not trim any data (trim = 0) and will not remove missing values
(na.rm = FALSE). Therefore, the presence of any missing values will result in
the mean being missing or NA, too. The “...” is called the triple dot argu-
ment. It means that more arguments are possible, but the mean function will
pass those along to other functions that it calls. We will see examples of that
later.

The Arguments section gets into the details. It tells you that x can be a
numeric data frame, numeric vector, or date vector. The trim argument tells
R the percent of the extreme values to exclude before calculating the mean.
It goes on to define what na.rm and “...” do.

We can run the mean function on our q3 variable by naming each argument.
We deleted it previously with the rm function, but imagine that we had not
done that. Here we call the function, naming its arguments in the order they
appear in the help file and setting their values:

mean(x = q3, trim = .25, na.rm = TRUE)
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The spaces around the equal signs and after each comma are optional, but
they make the program easier to read. If you name all of the arguments, you
can use them in any order:

mean(na.rm = TRUE, x = g3, trim = .25)

You can also run it by listing every argument in their proper positions but
without the argument names:

mean(q3, .25, TRUE)

All of these approaches work equally well. However, people usually run R
functions by listing the object to analyze first without saying x =, followed by
the names and values of only those arguments they want to change:

mean(q3, trim = .25, na.rm = TRUE)

You can also abbreviate some argument names, but I strongly recommend
against doing so. Some functions pass on arguments they do not recognize to
other functions they control. As mentioned earlier in this section, this is indi-
cated by “...” as a function’s last argument in the help file. Once a function
has started passing arguments on to other functions, it will pass them all on
unless it sees the full name of an argument it uses!

People sometimes abbreviate the values TRUE or FALSE as T or F. This
is a bad idea, as you can define T or F to be anything you like, leading to
undesired results. You may avoid that trap yourself, but if you write a function
that others will use, they may use those variable names. R will not allow you
to redefine what TRUE and FALSE mean, so using those is safe.

The following is an example function call that uses several abbreviations.
It will run, but I do not recommend using abbreviations.

mean(g3, t = .25, na = T)

A common error for R beginners is to try to call a function using just a
set of comma-separated values, as in

> mean(1, 2, 3)

[1] 1

Clearly the means of those values is not 1! What is happening is those
numbers are being supplied as values to the arguments in order. Therefore, it
is the same as

mean(x = 1, trim = 2, na.rm = 3)

The values for trim and na.rm are invalid and ignored, so we have asked R
to get the mean of the single value “1”! The solution is to combine the values
into a vector before calling the mean function or by nesting one call within the
other:
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> mean( c(1, 2, 3) )

(11 2

Since the colon operator creates a vector directly, the use of the ¢ function
would be redundant, and this works fine:

> mean( 1:3 )

[1] 2

5.7.2 Controlling Functions with Objects

In the previous section we viewed arguments as single values. That is what
SAS and SPSS users are accustomed to. However, in R, arguments can be
much more than that: they can be entire objects. The data are usually one
of the arguments, and they are obviously more than a single value. However,
objects can be used as other arguments, too. Let us return to our previous
example where we first created workshop as a factor:

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)

workshop <- factor(
workshop,
levels = c( 1, 2, 3, 4),
labels = c("R", "SAS", "SPSS", "Stata")

Notice how the levels and labels use the ¢ function. The ¢ function cre-
ates vectors, of course, so we are in fact providing vectors for those arguments.
Therefore, we could do this just as easily in two steps:

myLevels = c( 1, 2, 3, 4)
myLabels = c("R", "SAS", "SPSS", "Stata")

workshop <- factor(
workshop,
levels = myLevels,
labels = myLabels
)

The last part could be shortened to,
workshop <- factor(workshop, myLevels, myLabels)

In SAS and SPSS this type of control is called macro substitution and it
involves a different syntax with different rules. In R, though, you can see that
there is no different syntax. We were using a vector to supply those arguments
before and we are doing so now, just in two steps.
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5.7.3 Controlling Functions with Formulas

An important type of argument is the formula. It is the first parameter in
functions that do modeling. For example, we can do linear regression, predict-
ing g4 from the others with the following call to the 1m function for [inear
models:

Im( g4 ~ ql + g2 + g3, data = mydata )

Some modeling functions accept arguments in the form of both formulas
and vectors. For example, both of these function calls will compare the genders
on the mean of the variable ql:

t.test( q1 ~ gender, data = mydata )

t.test( q1[ which(gender == "Female") 1],
ql[ which(gender == "Male") 1],
data = mydata) # Data ignored!

However, there is one very important difference. When using a formula,
the data argument can supply the name of a data frame that R will search
before looking elsewhere for variables. When not using a formula, as in the
second example, the data argument is ignored! If q1 does not exist as a vector
in your workspace or if you have not attached mydata, R will not find it. This
approach maintains R’s extreme flexibility while helping to keep formulas
short.

The symbols that R uses for formulas are somewhat different from those
used by SAS or SPSS. Table 17.1 shows some common examples.

5.7.4 Controlling Functions with an Object’s Class

As we have seen, R has various kinds of data structures: vectors, factors, data
frames, etc. The kind of structure an object is, is known as its class. Each
data structure stores its class as an attribute, or stored setting, that functions
use to determine how to process the object. In other words, R sees what you
are giving it and it tries to do the right thing with it.

For objects whose mode is numeric, character, or logical, an object’s class
is the same as its mode. However, for matrices, arrays, factors, lists, or data
frames, other values are possible (Table 5.2).

You can display an object’s class with the class function:

> workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
> class(workshop)

[1] "numeric"
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Table 5.2. Modes and classes of various R objects

Object Mode Class
Numeric vector numeric numeric
Character vector character character
Factor numeric factor
Data frame list data.frame
List list list
Numeric matrix numeric matrix
Character matrix character matrix
Model list Im. ..
Table numeric table

> summary (workshop)

Min. 1st Qu. Median Mean 3rd Qu. Max.
1.0 1.0 1.5 1.5 2.0 2.0

The class numeric indicates that this version of workshop is a numeric
vector, not yet a factor. The summary function provided us with inappropriate
information (i.e., the median workshop is nonsensical) because we have not
yet told it it that workshop is a factor. Note that when we convert workshop
into a factor, we are changing its class to factor, and then summary gives us
the more appropriate counts instead:

> workshop <- factor(workshop,
+ levels = c( 1, 2, 3, 4),
+ labels = c("R","SAS","SPSS","Stata") )

> class(workshop)
[1] "factor"

> summary (workshop)

R SAS  SPSS Stata
4 4 0 0

When we first created gender, it was a character vector, so its class was
character. Later we made its class factor. Numeric vectors like q1 have a class
of numeric. The names of some other classes are obvious: factor, data.frame,
matrix, list, and array. Objects created by functions have many other classes.
For example, the linear model function, 1m, stores its output in lists with a
class of Im.

R has some special functions called generic functions. They accept multiple
classes of objects and change their processing accordingly. These functions are
tiny. Their task is simply to determine the class of the object and then pass it
off to another that will do the actual work. The methods function will tell you
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what other functions a generic function will call. Let us look at the methods
that the summary function uses.

> methods (summary)

[1] summary.aov summary.aovlist
[3] summary.connection summary.data.frame
[6] summary.Date summary.default
[7] summary.ecdfx* summary.factor

[9] summary.glm summary.infl

[11] summary.lm summary . loess*
[13] summary.manova summary.matrix
[15] summary.mlm summary .nls*

[17] summary.packageStatus* summary.POSIXct
[19] summary.POSIX1lt summary . ppr*

[21] summary.prcomp* summary . princompx*
[23] summary.stepfun summary.stlx*

[25] summary.table summary . tukeysmooth*

Non-visible functions are asterisked

So when we enter summary(mydata), the summary function sees that my-
data is a data frame and then passes it on to the function named
summary .data.frame. The functions marked with asterisks above are “nonvis-
ible.” They are meant to be used by a package’s developer, not its end users.
Visible functions can be seen by typing their name (without any parentheses).
That makes it easy to copy and change them.

When we discussed the help files, we saw that the mean function ended with
an argument of “. . .”. That indicates that the function will pass arguments on
to other functions. While it is very helpful that generic functions automatically
do the “right thing” when you give it various objects to analyze, this flexibility
complicates the process of using help files.

When written well, the help file for a generic function will refer you to
other functions, providing a clear path to all you need to know. However,
it does not always go so smoothly. We will see a good example of this in
Chap. 15, “Traditional Graphics.” The plot function is generic. When we
call it with our data frame, it will give us a scatter plot matrix. However,
to find out all of the arguments we might use to improve the plot, we have
to use methods(plot) to find that plot.data.frame exists. We could then
use help("plot.data.frame") to find that plot.data.frame calls the pairs
function, then finally help("pairs") to find the arguments we seek. This is
a worst-case scenario, but it is important to realize that this situation does
occasionally arise.

As you work with R, you may occasionally forget the mode or class of an
object you created. This can result in unexpected output. You can always use
the mode or class functions to remind yourself.
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5.7.5 Controlling Functions with Extractor Functions

Procedures in SAS and SPSS typically display all their output at once.* R
has simple functions, like the mean function, that display all their results all
at once. However, R functions that model relationships among variables (e.g.,
regression, ANOVA| etc.) tend to show you very little output initially. You
save the output to a model object and then use extractor functions to get more
information when you need it.

This section is poorly named from an R expert’s perspective. Extractor
functions do not actually control other functions the way parameters control
SAS or SPSS output. Instead they show us what the other functions have
already done. In essence, most modeling in R is done through its equivalent
to the SAS Output Delivery System (ODS) or the SPSS Output Manage-
ment System (OMS). R’s output is in the form of data that can be readily
manipulated and analyzed by other functions.

Let us look at an example of predicting q4 from ql with linear regression
using the 1m function:

> Im( g4 ~ ql + g2 + g3, data = mydata)

Call:
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

Coefficients:
(Intercept) ql q2 q3
-1.3243 0.4297 0.6310 0.3150

The output is extremely sparse, lacking the usual tests of significance. Now,
instead, I will store the results in a model object called myModel and check
its class:

> myModel <- 1Im( g4 ~ ql + g2 + g3, data = mydata )
> class(myModel)

[1] """

The class function tells us that myModel has a class of “Im” for linear model.
We have seen that R functions offer different results (methods) for different
types (classes) of objects. So let us see what the summary function does with
this class of object:

> summary (myModel)

1 SAS has some interactive procedures that let you request additional output once
you have seen the initial output, but SAS users rarely use it that way.
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Call:
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

Residuals:
1 2 3 5 6 7
-0.31139 -0.42616 0.94283 -0.17975 0.07658 0.02257
8
-0.12468
Coefficients:
Estimate Std. Error t value Pr(>|t])
(Intercept) -1.3243 1.2877 -1.028 0.379
ql 0.4297 0.2623 1.638 0.200
q2 0.6310 0.2503 2.521 0.086
q3 0.3150 0.2557 1.232 0.306

Signif. codes: O 'sx*xx' 0.001 'xx' 0.01 '*' 0.05 '.' 0.1

Residual standard error: 0.6382 on 3 degrees of freedom
(1 observation deleted due to missingness)

Multiple R-squared: 0.9299, Adjusted R-squared: 0.8598

F-statistic: 13.27 on 3 and 3 DF, p-value: 0.03084

This is the type of output that SAS and SPSS prints immediately. There
are many other extractor functions that we might use, including anova to
extract an analysis of variance table, plot for diagnostic plots, predict to
get predicted values, resid to get residuals, and so on. We will discuss those
in Chap. 17, “Statistics.”

What are the advantages of the extractor approach?

You get only what you need, when you need it.
The output is in a form that is very easy to use in further analysis. Essen-
tially the output itself is datal!

e You use methods that are consistent across functions. Rather than having
to learning different ways of saving residuals or predicted values in every
procedure SAS and SPSS do, you learn one approach that works with all
modeling functions.

5.8 How Much Output There?

In the previous section we discussed saving output and using extractor func-
tions to get more results. However, how do we know what an output object
contains? Previously, the print function showed us what was in our objects,
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so let us give that a try. We can do that by simply typing an object’s name
or by explicitly using the print function. To make it perfectly clear that we
are using the print function, let us actually type out its name.

> print (myModel)
Call:

Im(formula = g4 ~ ql + g2 + g3, data = mydata)

Coefficients:
(Intercept) ql q2 q3
-1.3243 0.4297 0.6310 0.3150

We see that the object contains the original function call complete with its
arguments and the linear model coefficients. Now let us check the mode, class,
and names of myModel.

> mode (myModel)
[1] "list"

> class(myModel)
[1] "Im"

> names (myModel)

[1] "coefficients" "residuals" "effects" "rank"
[6] "fitted.values" "assign" "qr" "df .residual"
[9] "na.action" "xlevels" "call" "terms"
[13] "model"

So we see that myModel is a list, or collection, of objects. More specifically,
it is a list with a class of “lm.” The names function shows us the names of
all of the objects in it. Why did the print function not show them to us?
Because the print function has a predetermined method for displaying Im
class objects. That method says, basically, “If an object’s class is lm, then
print only the original formula that created the model and its coefficients.”

When we put our own variables together into a list, it had a class of simply
“list” (its mode was list also). The print function’s method for that class tells
it to print all of the list’s components. We can strip away the class attribute
of any object with the unclass function. In this case, it resets its class to
“list.” If we do that, then the print function will indeed print all of the list’s
components.

> print( unclass(mymodel) )

$coefficients
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(Intercept) ql q2
-1.3242616 0.4297468 0.6310127

$residuals
1 2 3
-0.31139241 -0.42616034 0.94282700
7 8

0.02257384 -0.12468354

$effects
(Intercept) aql 92
-8.6931829  3.6733345 -1.4475844

0.7929917 -0.7172223

$rank
[1] 4

$fitted.values
1 2 3 5
1.311392 1.426160 2.057173 4.179747
8
5.124684

$assign
[1] 0123

$qr

$qr

(Intercept) ql q2
-2.6457513 -8.6931829 -7.9372539
.3779645 3.9279220 3.3096380
.3779645 0.1677124 -2.6544861
.3779645 -0.3414626 0.4356232
.3779645 -0.5960502 -0.3321400
.3779645 -0.5960502 -0.7088608
0.3779645 -0.3414626 0.4356232
attr(,"assign")

(110123

O ~NO U1 W N =
O O O O O

$qraux

0.

q3
3149789

5

-0.17974684

0.

q3
7861009

6

6
0.07658228

0.2801541

7

4.923418 3.977426

[1] 1.377964 1.167712 1.087546 1.783367

$pivot
[11] 1 234

q3

.9609697
.3273268
. 7220481
.4957256
.1051645
.4471879
.4186885
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$tol
[1] 1e-07

$rank
[1] 4

attr(,"class")
[1] llqul

$df .residual
[1] 3

$na.action

4

4
attr(,"class")
[1] "omit"

$xlevels
list()

$call
Im(formula = g4 ~ ql + g2 + g3, data = mydata)

$terms
g4 “ ql + g2 + g3
attr(,"variables")
list (g4, qi, 92, 93)
attr(,"factors")

ql g2 g3
g4 0 0 0
ql 1 0 O
g2 0 1 0
g3 0 0 1
attr(,"term.labels")
[1] "qi" "g2" "q3"
attr(,"order")
[1] 111
attr(,"intercept")
[1] 1
attr(,"response")
[1] 1
attr(,".Environment")
<environment: R_GlobalEnv>
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attr(,"predvars")
list (g4, qi, 92, g3)
attr(,"dataClasses")

q4 ql 92 3

"numeric numeric" "numeric numeric"
$model
g4 gl g2 g3
11 1 1 5
2 1 2 1 4
3 3 2 2 4
5 4 4 5 2
6 5 5 4 5
7 4 5 3 4
8 5 4 5 5

It looks like the print function was doing us a big favor by not printing
everything! When you explore the contents of any object, you can take this
approach or, given just the names, explore things one at a time. For example,
we saw that myModel contained the object named “$coefficients.” One way to
print one component of a list is to refer to it as mylist$mycomponent. So in
this case we can see just the component that contains the model coefficients
by entering

> myModel$coefficients

(Intercept) ql q2 q3
-1.3242616 0.4297468 0.6310127 0.3149789

That looks like a vector. Let us use the class function to check:

> class( myModel$coefficients )

[1] "numeric"

Yes, it is a numeric vector. So we can use it with anything that accepts such
data. For example, we might get a bar plot of the coefficients with the following
(plot not shown). We will discuss bar plots more in Chap. 15, “Traditional
Graphics.”

> barplot( myModel$coefficients )

For many modeling functions, it is very informative to perform a similar
exploration on the objects created by them.
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5.9 Writing Your Own Functions (Macros)

In SAS or SPSS, if you wanted to use the same set of commands repeatedly,
you would write a macro. In SPSS, you might instead write a macro-like
Python program. Those approaches entail using languages that are separate
from their main programming statements, and the resulting macros operate
quite differently from the procedures that come with SAS or SPSS. In R,
you write functions using the same language you use for anything else. The
resulting function is used in exactly the same way as a function that is built
into R.

I will show you some variations of a simple function, one that calculates
the mean and standard deviation at the same time. For this example, I will
apply it to just the numbers 1, 2, 3, 4, and 5.

> myvar <- c(1, 2, 3, 4, 5)

I will begin the function called mystats and tell it that it is a function of x.
What follows in curly brackets is the function itself. I will create this with an
error to see what happens.

# A bad functionm.
mystats <- function(x) {
mean(x, na.rm = TRUE)

sd(x, na.rm = TRUE)
}

Now let us apply it like any other function.

> mystats (myvar)

[1] 1.5811

We got the standard deviation, but what happened to the mean? When I
introduced the print function, I mentioned that usually you can type an
object’s name rather than, say, print (myobject). Well, this is one of those
cases where we need to explicitly tell R to print the result. I will add that to
the function.

# A good function that just prints.
mystats <- function(x) {
print( mean(x, na.rm = TRUE) )
print( sd(x, na.rm = TRUE) )
}

Now let us run it.

> mystats (myvar)
(11 3
[1] 1.5811
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That looks better. Next I will do it in a slightly different way, so that it will
write our results to a vector for further use. I will use the ¢ function to combine
the results into a vector.

# A function with vector output.
mystats <- function(x) {
mymean <- mean(x, na.rm = TRUE)
mysd <- sd(x, na.rm = TRUE)
c( mean = mymean, sd = mysd )

}
Now when I run it, we get the results in vector form.

> mystats (myvar)

mean sd
3.0000 1.5811

As with any R function that creates a vector, you can assign the result to
a variable to use in any way you like.

> myVector <- mystats(myvar)
> myVector

mean sd
3.0000 1.5811

This simple result is far more interesting than it first appears. The vector
has a name, “myVector,” but what are the strings “mean” and “sd”? At first
they seem like value labels, but if we had another value 3.0 appear, it would
not automatically get the label of “mean.” In addition, this is a numeric vector,
not a factor, so they cannot be value labels.

These are names, stored in the names attribute, just like variable names
in a data frame. But then what is “myVector”? That is just the vector’s name.
To reduce confusion about names, these “value names” are called tags and
this type of vector is called a tagged vector. I hardly ever create such names
unless, as in this example, I am storing output.

Many R functions return their results in the form of a list. Recall that
each member of a list can be any data structure. I will use a list to save the
original data, as well as the mean and standard deviation:

# A function with list output.
mystats <- function(x) {
myinput <- x
mymean <- mean(x, na.rm
mysd <- sd(x, na.rm

TRUE)
TRUE)
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}

myinput, mean

5.10 Controlling Program Flow 107

mymean, sd = mysd)

Now I will run it to see how the results look.

mystats (myvar)

$data
[11] 1 2345

$mean
[1] 3

$sd
[1] 1.5811

You can save the result to mylist and then print just the data.

> myStatlist <- mystats(myvar)

> myStatlist$data

[1] 12345

If you want to see the function itself, simply type the name of the function

without any parentheses following.

> mystats

function(x) {
myinput <- x

mymean <- mean(x, na.rm
sd(x, na.rm
myinput, mean = mymean, sd = mysd)

mysd <-
list(data =
}

TRUE)
TRUE)

You could easily copy this function into a script editor window and change it.
You can see and change many R functions in this way.

Coming from SAS or SPSS, function is perhaps the most unusual of all
R functions. Its input is several functions and its output is one function. It is

as if it is using functions as its data.

R has an ability to use a function without naming it. I show how to use

these anonymous functions in Section10.2.4, “Applying Your Own Functions.’

)

5.10 Controlling Program Flow

R is a complete programming language with all the usual commands to control
the flow of a program. These include the functions if, else, for, in, repeat,
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while, break, and next. So your programs and functions you write can get
as complex as necessary. However, controlling the flow of commands is needed
far less in R than in SAS or SPSS. That is because R has a way to apply
functions automatically across variables or observations. For the purposes of
this book, that type of flow control is all we need, and we get a lot done within
those constraints! For details on applying functions repeatedly to variables or
observations, see Sect. 10.2

5.11 R Program Demonstrating Programming Basics

Most of the chapters in this book end with equivalent example programs in
SAS, SPSS, and R. However, this chapter focuses so much on R that I will
end it only with the program for R.

# Filename: ProgrammingBasics.R

# —-—--Simple Calculations---
+ 3

N

A

-2
-3

Mo M
* + A

y
y
# —---Data Structures—--

# Vectors

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
print (workshop)

workshop

gender <- c("f", "f", "f", NA, "m", "m", "m", "m")
ql <- c(1, 2, 2, 3, 4, 5, 5, 4)
Q2 <- ¢c(1, 1, 2, 1, 5, 4, 3, 5)
q3 <- c(5, 4, 4,NA, 2, 5, 4, 5)
94 <- c(1, 1, 3, 3, 4, 5, 4, 5)

# Selecting Elements of Vectors

q1[5]

qll c(5, 6, 7, 8) 1]
ql[5:8]

ql[gender == "m"]

mean( qi[ gender == "m" ], na.rm = TRUE)
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# —---Factors——-
# Numeric Factors

# First, as a vector

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop

table (workshop)

mean (workshop)

gender [workshop == 2]

# Now as a factor

workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop <- factor (workshop)

workshop

table (workshop)

mean (workshop) #generates error now.
gender [workshop == 2]

gender [workshop == "2"]

# Recreate workshop, making it a factor
# including levels that don't yet exist.
workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop <- factor(

workshop,

levels = c( 1, 2, 3, 4),

labels = c("R", "SAS", "SPSS", "Stata")

# Recreate it with just the levels it
# curently has.
workshop <- c(1, 2, 1, 2, 1, 2, 1, 2)
workshop <- factor(

workshop,

levels = c( 1, 2),

labels = c("R","SAS")

)

workshop

table (workshop)

gender [workshop == 2]
gender [workshop == "2"]
gender [workshop == "SAS"]

# Character factors

109
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gender <_ C("f" s llfII , Ilfll s NA, ||ml| s llmll s llmll , Ilmll)
gender <- factor(

gender,
levels = c("m", "fmy,
labels = c("Male", "Female")
)
gender
table(gender)
workshop [gender == "m"]
workshop [gender == "Male"]

# Recreate gender and make it a factor,

# keeping simpler m and f as labels.

gender <- C(llfll, nfn’ Ilfll’ NA, umu’ llmll, llmll’ Ilmll)
gender <- factor(gender)

gender

# Data Frames
mydata <- data.frame(workshop, gender, ql, g2, g3, qg4)
mydata

names (mydata)
row.names (mydata)

# Selecting components by index number
mydata[8, 6] #8th obs, 6th var

mydatal , 6] #All obs, 6th var

mydatal , 6][5:8] #6th var, obs 5:8

# Selecting components by name
mydata$ql
mydata$ql [5:8]

Example renaming gender to sex while
creating a data frame (left as a comment)

mydata <- data.frame(workshop, sex = gender,
ql, 92, g3, q4)

H OB H R

+*

Matrices

# Creating from vectors
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mymatrix <- cbind(ql, 92, g3, q4)
mymatrix
dim(mymatrix)

# Creating from matrix function
# left as a comment so we keep
# version with names ql, q2...
#

# mymatrix <- matrix(

# c(1, 1, 5,1,

# 2,1, 4, 1,

# 2, 2, 4, 3,

# 3, 1, NA,3,

# 4, 5, 2, 4,

# 5, 4, 5, 5,

# 5, 3, 4, 4,

# 4, 5, 5, 5),

# nrow = 8, ncol = 4, byrow = TRUE)
# mymatrix

table (mymatrix)

mean (mymatrix, na.rm = TRUE)
cor (mymatrix, use = "pairwise")

# Selecting Subsets of Matrices

mymatrix[8, 4]
mymatrix[5:8, 3:4]
mymatrix[ ,4][1:4]
mymatrix$qd4 # No good!
mymatrix[ ,"q4"]

# Matrix Algebra

mymatrixT <- t(mymatrix)
mymatrixT

# Lists

mylist <- list(workshop, gender,
ql, 92, 93, g4, mymatrix)

mylist

# List, this time adding names
mylist <- list(
workshop = workshop,

111
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gender = gender,

ql = qi,

q2 = 92,

a3 = g3,

q4 = q4,

mymatrix = mymatrix)
mylist

# Selecting components by index number.
mylist[[2]]
mylist[[2]][5:8]

mylist [2]
mylist[2][5:8] # Bad!

# Selecting components by name.
mylist$ql
mylist$mymatrix[5:8, 3:4]

# ---Saving Your Work---

1s()

objects() #same as 1s()

save.image("myall.RData")
save(mydata, file = "mydata.RData")

The 2nd approach is commented to keep

the q variables for following examples.

rm(x, y, workshop, gender, ql, 92, g3, g4, mylist)
1s0O

save.image(file = "mydata.RData")

H O H O H

# ———-Comments to Document Your Programs---
# This comment is on its own line, between functions.

workshop <- c(1, 2, 1, 2, #This comment is within the arguments.
1, 2, 1, 2) #And this is at the end.

# ———Comments to Document Your Objects---

comment (mydata) <- "Example data from R for SAS and SPSS Users"
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comment (mydata)
# —---Controlling Functions---
# Controlling Functions with Arguments

help("mean"

mean(x = q3, trim = .25, na.rm = TRUE)
mean(na.rm = TRUE, x = g3, trim = .25)
mean(q3, .25, TRUE)

mean(q3, t = .25, na.rm = TRUE)
mean(1, 2, 3)

mean( c(1, 2, 3) )

mean( 1:3 )

# Controlling Functions With Formulas
Im( g4 ~ ql + g2 + g3, data = mydata )
t.test(ql ~ gender, data = mydata)
t.test( ql[ which(gender == "Female") ],
ql[ which(gender == "Male") 1,

data = mydata) # Data ignored!

# Controlling Functions with Extractor Functions

Im( g4 ~ ql + g2 + g3, data = mydata )

myModel <- 1m( g4 ~ ql + g2 + g3, data = mydata )
class(myModel)
summary (myModel)

# How Much Output Is There?
print (mymodel)
mode (myModel)
class (myModel)
names (myModel)

print( unclass(myModel) )

myModel$coefficients
class( myModel$coefficients )

113
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barplot( myModel$coefficients )
# ---Writing Your Own Functions (Macros)---
myvar <- c(1, 2, 3, 4, 5)

# A bad functionm.
mystats <- function(x) {
mean(x, na.rm = TRUE)

sd(x, na.rm = TRUE)
}

mystats (myvar)

# A good function that just prints.
mystats <- function(x) {
print( mean(x, na.rm = TRUE) )
print( sd(x, na.rm = TRUE) )

}

mystats (myvar)

# A function with vector output.

mystats <- function(x) {
mymean <- mean(x, na.rm = TRUE)
mysd <- sd(x, na.rm = TRUE)
c(mean = mymean, sd = mysd )

}

mystats (myvar)

myVector <- mystats(myvar)

myVector

# A function with list output.

mystats  <- function(x) {
myinput <- x
mymean <- mean(x, na.rm = TRUE)
mysd <- sd(x, na.rm = TRUE)
list(data = myinput, mean = mymean, sd = mysd)

3

mystats (myvar)

myStatlist <- mystats(myvar)

myStatlist

mystats

save(mydata, mymatrix, mylist, mystats,
file = "myWorkspace.RData")
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Data Acquisition

You can enter data directly into R, and you can read data from a wide range
of sources. In this chapter I will demonstrate R’s data editor as well as read-
ing and writing data in text, Excel, SAS, SPSS and ODBC formats. For
other topics, especially regarding relational databases, see the R Data Im-
port/Export manual [46]. If you are reading data that contain dates or times,
see Sect. 10.21.

6.1 Manual Data Entry Using the R Data Editor

R has a simple spreadsheet-style data editor. Unlike SAS and SPSS, you can-
not use it to create a new data frame. You can only edit an existing one.
However, it is easy to create an empty data frame, which you can then fill in
using the editor. Simply submit the following command:

mydata <- edit( data.frame() )

-

R Data Editor e E@=]
id var2 var3 varéd var5

1

2 - .

3 R Variable editor M

4
variable [ id ]

5

6 type (@ numeric () character

1 O N——— —

8 | |

Fig. 6.1. Adding a new variable in the R data editor
R.A. Muenchen, R for SAS and SPSS Users, Statistics and Computing, 115

DOI 10.1007/978-1-4614-0685-3_6, © Springer Science+Business Media, LLC 2011
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[ Data Editor ol @ =
id workshop|gender |gl q2 g3 g4
1)1 1 £ 1 1 5 1
2 |2 2 f 2 1 4 1
3|3 1 £ 2 2 4 3
4 |4 2 3 1 NA 3
5 |5 1 m 4 5 2 4
6 |6 2 m 5 4 5 5
7 |7 1 m 5 3 4 4
8 |0 2 m 4 5 5 5

Fig. 6.2. The R data editor with practice data entered

The window in Fig. 6.1 will appear.! Initially the variables are named
varl, var2, and so on. You can easily change these names by clicking on them.
I clicked on the variable name wvarl, which brought up the Variable editor
window shown in the center of Fig. 6.1. T then changed it to “id” and left the
“numeric” button selected so that it would remain a numeric variable. I then
closed the variable editor window by clicking the usual X in the upper right
corner.

Follow the steps above until you have created the data frame shown in
Fig. 6.2. Make sure to click “character” when defining a character variable.
When you come to the NA values for observation 4, leave them blank. You
could enter the two-character string “NA” for numeric variables, but R will
not recognize that as a missing value for character variables here. Exit the
editor and save changes by choosing File> Close or by clicking the Windows
X button. There is no File> Save option, which feels quite scary the first time
you use it, but R does indeed save the data.

Notice that the variable in our ID variable matches the row names on the
leftmost edge of Fig. 6.2. R went ahead and created row names of “1,” “2”
etc. so why did I bother to enter them into the variable id? Because while the
data editor allows us to easily change variable names, it does not allow us to
change row names. If you are happy with its default names, you do not need
to create your own id variable. However, if you wanted to enter your own row
names using the data editor, you can enter them instead into a variable like id
and then later set that variable to be row names with the following command:

row.names (mydata) <- mydata$id

! These steps are for the Windows version. The Macintosh version is different but
easy to figure out. The Linux version does not include even this basic GUI.
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This command selects id from mydata using the form dataframe$variable,
which we will discuss further in Sect. 7.7, “Selecting Variables Using $ Nota-
tion.”

Before using these data, you would also want to use the factor function
to make workshop and gender into factors.

mydata$workshop <- factor(mydata$workshop)
mydata$gender <- factor(mydata$gender)

To see how to do this with value labels, see our discussion in Sect. 11.1,
“Value Labels or Formats (and Measurement Level).”

We now have a data frame that we can analyze, save as a permanent R
data file, or write out in text, Excel, SAS, or SPSS format.

When we were initially creating the empty data frame, we could have
entered the variable names with the following function call:

mydata <- data.frame(id = 0., workshop = 0.,
gender = " ", g1 = 0., g2 =0., g3 =0., g4 =0.)

Since this approach allows you to name all the variables, it is a major time
saver when you have to create more than one copy of the data or if you create
a similar data set in the future.

R has a fix function that actually calls the more aptly named edit func-
tion and then writes the data back to your original data frame. So

fix(mydata)
does the same thing as
mydata <- edit(mydata)

I recommend not using the edit function on existing data frames as I find it
all too easy to begin editing with just:

edit(mydata) # Do NOT do this!

It will look identical on the screen, but this does not tell edit where to save
your work. When you exit, your work will appear to be lost. However, R stores
the last value you gave it in an object named .Last.value, so you can retrieve
the data with this command.

mydata <- .Last.value

We will use the edit function later when renaming variables.

6.2 Reading Delimited Text Files

Delimited text files use special characters, such as commas, spaces, or tabs to
separate each data value. R can read a wide range of such files. In this section
I will show you how to read the most popular types.
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6.2.1 Reading Comma-Delimited Text Files

Let us begin by reading a comma-separated value (CSV) file like:

workshop,gender,ql,q2,q93,94

1,1,£,1,1,5,1

2,2,f£,2,1,4,1
3,1,f,2,2,4,3
4,2, ,3,1, ,3
5,1,m,4,5,2,4
6,2,m,5,4,5,5
7,1,m,5,3,4,4
8,2,m,4,5,5,5

There are several important things to notice about these data.

[t

. The top row contains variable names. This is called the file’s header line.
2. ID numbers are in the leftmost column, but the header line does not

contain a name like “ID” for it.

SO W

You can read this file using the read.csv function call below. If you have
already set your working directory in your current R session, you do not need

to set it again.

> setwd("c:/myRfolder")

> mydata <- read.csv("mydata.csv")

> mydata

workshop gender ql g2

1

0N O WN -
N =N~ N~ N

f
f
f

8 B B B

1

OO NN

O W OO N ==

. Values are separated by commas.

. Spaces (blanks) represent missing values.

. There are no blanks before or after the character values of “m” and “f.”

. Each line in the file ends with a single stroke of the Enter key, not with
a final tab. Your operating system stores either a line feed character or a
carriage return and a line feed. R will treat them the same.

q3 g4
5 1
4 1
4 3
NA 3
2 4
5 5
4 4
5 5
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Notice that it read the id variable and stored it automatically in the row
names position on the left side of the data frame. It did that because R found
seven columns of data but only six names. Whenever R finds one fewer names
than columns, it assumes the first column must be an id variable.

If your CSV file does not have a header line and all your data values
are numeric, R will automatically name the variables “V1,” “V2,” and so on,
similar to SAS’s and SPSS’s “VAR1,” “VAR?2,” etc. default names. 2 However,
our file has both numeric data and character data. R will have trouble figuring
out if the first line in the file contains names or data. You can tell it to not
try and interpret the first line as variable names by adding the argument
header = FALSE to the read.csv function call.

Let us see what happens when the header line does contain a name for
the first column, like the following, which is the beginning of the file named
mydatalD.csv:

id,workshop,gender,ql,q2,q93,q94
1,1,£,1,1,5,1
2,2,£,2,1,4,1

If we read the file exactly as before, we would have an additional variable
named “id.” R would also create row names of “1,” “2,” etc., but our ID variable
might have contained more useful information. Not getting your identifying
variable into the row names attribute does not cause any major problems, but
R will automatically identify observations by their row names, so if you have
an ID variable, it makes sense to get it into the row names attribute.

To tell R which variable contains the row names, you simply add the
row.names argument.

> mydata <- read.csv("mydatalID.csv",
+ row.names = "id")

> mydata

workshop gender ql g2 g3 g4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

When we let R figure out that there was an ID variable, it had to be the
first column. That is usually where ID variables reside, but if you ever have
one in another location, then you will have to use the row.names argument
to store it in the row names attribute.

2 Note the inconsistency with R’s own data editor, which uses the default names,
“varl,” “var2,” etc.
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6.2.2 Reading Tab-Delimited Text Files

Reading tab-delimited files in R is done very similarly to reading comma-
delimited files, but using the read.delim function.

The following is the tab-delimited text file we will read:

workshop gender ql g2 g3 g4
1 f 11 5 1
2 f 2 1 4 1
1 f 2 2 4 3
2 3 1 3
1 m 4 5 2 4
2 m 5 4 5 5
1 m 5 3 4 4
2 m 4 5 5 b

W ~NO Ok WN -

S W N -

There are several important things to notice about these data.

. The top row contains variable names. This is called the file’s header line.
Note that your header line should never begin nor end with tab char-
acters! That would cause R to think you have more variables than you
actually do. If you leave the names out, you should specify the argument
header = FALSE. In that case R will name the variables “V1,” “V2.” etc.

. ID numbers are in the leftmost column, but the header line does not
contain a name like “ID” for it.

. Values are separated by single tab characters.

. Two consecutive tab characters represent missing values, although a blank
space would work, too.

. There are no blanks before or after the character values “m” and “f.”

. Each line of data ends with a single stroke of the Enter key, not with a final
tab. Your operating system ends lines with either a line feed character, or
a carriage return and a line feed. R will treat them the same.

We can use the read.delim function to read this file:

setwd("c:/myRfolder")
mydata <- read.delim("mydata.tab")
mydata

workshop gender ql g2 g3 g4

1 f 1 1 5 1
2 f 2 1 4 1
1 f 2 2 4 3
2 3 1NA 3
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5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

We see that two consecutive tabs for variable q3 was correctly identified as a
missing value (NA).

To read a file whose header does name the variable in the first column,
add the row.names argument:

> mydata <- read.delim("mydataID.tab",
+ row.names = "id")

> mydata

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1

If you need to read a file that has multiple tabs or spaces between values,
use the read.table function. The read.csv and read.delim functions both
call read.table with some arguments preset to helpful values. It is a good
idea to read the help files of any of these functions to see how they relate
to each other and to see the many additional parameters you can control by
using read.table.

The read.table function actually does its work by calling the powerful
and complex scan function.

6.2.3 Reading Text from a Web Site

You can use any of the methods described above to read data stored on a
Web site. To do so, simply enter the site’s URL in place of the filename. I
have uploaded the file mydata.csv to this book’s Web site, so you can try it.
While you may access the book’s Web site at the URL http://r4stats.com,
that URL is actually an easy-to-remember pointer to the real site used in the
code below:?

myURL <- "http://sites.google.com/site/r4statistics/mydata.csv"
mydata <- read.csv(myURL)
mydata

3 As of this writing, I am planning a change in Web servers. If the code does not
work try http://réstats.com/mydata.csv or check the book’s Corrections &
Clarifications file on the download site.
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6.2.4 Reading Text from the Clipboard

In virtually all software that has a spreadsheet data editor, you can copy data
from another program and paste it in. But not in R! However, the Windows
version of R does have a way to read from the clipboard using functions. You
do begin the process in your other software as usual, by selecting the data you
wish to copy and then pressing CTRL-c.

If it is a single column of data, you can then read it with

myvector <- readClipboard()

If it is a single row of data, you can paste it into a text editor, press Enter
at the end of each line, and copy it again from there. Otherwise, a row of
values will end up as single-character vector.

If you have copied a whole set of columns (hopefully with column names),
you can read it with:

mydata <- read.delim("clipboard", header = TRUE)

If you have problems using this approach, try pasting the data into a text
editor so you can check to see if there are extraneous spaces or tabs in the data.
All the rules that apply to reading data from a file apply here as well. For
example, if you copied comma-separated values to the clipboard, read.csv
would be the function to use. I frequently see data discussed on R-help or
Web pages that are separated by multiple spaces, so I use read.table to read
them from the clipboard.

Unfortunately, this approach copies only the number of decimal places that
you had displayed at the time. Therefore, almost any other method is better
for reading numbers with many digits after the decimal point.

6.2.5 Missing Values for Character Variables

In the previous two subsections, we ignored a potential problem. The missing
value for variable q3 was always displayed as NA, Not Available. However,
the missing value for gender was displayed as a blank.

If we had entered R’s standard missing value, “NA.,” where we had missing
values, then even the character data would have shown up as missing. However,
few other programs write out NA as missing.

Just as in SAS or SPSS, you can read blanks as character values, and R
will not set them to missing unless you specifically tell it to do so. Often, it is
not very important to set those values to missing. A person’s mailing address
is a good example. You would never use it in an analysis, so there is little
need to set it to missing.

However, when you need to use a character variable in an analysis, setting
it to missing is, of course, very important. Later in the book we will use gender
in analyses, so we must make sure that blank values are set to missing.
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In our comma-delimited file, the missing value for gender was entered as
a single space. Therefore, the argument na.char = " " added to any of the
comma-delimited examples will set the value to missing. Note there is a single
space between the quotes in that argument.

In our tab-delimited file, the missing value for gender was entered as noth-
ing between two tabs (i.e., just two consecutive tabs). Therefore, the argument
na.char = "" added to any of the tab-delimited examples will set the value to
missing. Note that there is now no space between the quotes in that argument.

However, in both comma- and tab-delimited files, it is very easy to acci-
dentally have blanks where you think there are none or to enter more than
you meant to. Then your na.char setting will be wrong for some cases.

It is best to use a solution that will get rid of all trailing blanks. That is
what the argument strip.white = TRUE does. When you use that argument,
na.char = "" will work regardless of how many blanks may have been there
before.

Let us try it with our comma-delimited file, since it contains a blank we
can get rid of:

> mydata <- read.csv("mydatalD.csv",

+ row.names = "iqd",
+ strip.white = TRUE,
+ na.strings = "" )
> mydata

workshop gender ql g2 g3 g4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <KNA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

The only difference between this output and the last one we read for my-
datalD.csv is that gender is shown as <NA> now instead of blank. R adds angle
brackets, “<>” around the value so you can tell NA stands for Not Available
(missing) rather than something meaningful, such as North America. The NA
value in the g3 variable is not in angle brackets because it cannot possibly be
a valid numeric value.

The strip.white = TRUE argument also provides the benefit of getting
rid of trailing blanks that would set some genders equal to "m" and others
to "m "or "m ". We do not want trailing blanks to accidentally split the
males into different groups!
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Finally, getting rid of trailing blanks saves space. Since R stores its data
in your computer’s main memory, saving space is very important.

6.2.6 Trouble with Tabs

In many text editors, including R’s, tabs are invisible. That makes it easy to
enter an additional tab or two, throwing R off track. A helpful tool to count
the number of fields is the count.fields function. This function looks by
default for items separated by any amount of spaces or tabs. Therefore, you
must specify sep = "\t" because that is what R uses to represent the tab
character:

> count.fields("mydata.tab", sep = "\t")

M1er7777777

We see that all the lines in the file contain seven items except for the
header row. The header row has 6. That is the clue that R needs to determine
that the first column of the data contains an ID variable that it will then store
as row names.

If R complains of too many names in the header line, or not enough values
on data lines, or if it creates more variables than you expected, often you have
an inconsistent number of tabs in your file.

Check the header line that contains your variable names and the first few
lines of data for extra tabs, especially at the beginning or end of a line. If you
have an ID variable in the first column and it is not named in your header
line, it is very tempting to put a tab before the first variable name. That will
get it to line up over the first column, but it will also tell R that your first
variable name is missing!

If you have a data file that has some short values and some very long
values in the same column, the person who entered it may have put two tabs
after the short values to get the following column to line up again. In that
case, you can read it with the read.table function. That function has greater
flexibility for reading delimited files.

When a file has varying numbers of tabs between values, read.table can
read it because its default delimiter is any number of tabs or spaces! However,
this also means that you cannot represent missing values by entering two
consecutive tabs, or even by putting a space between two tabs. With our
practice tabbed data set, read.table would generate the error message “line
4 did not have 7 elements.” In that case, you must enter some code to represent
“missing.” The value “NA” is the one that R understands automatically, for
both numeric and character values. If you use any other codes, such as “.” or
“999,” specify the character as missing by using the na.char argument. See
also Sect. 10.5 to learn a wider range of approaches to handling missing values.
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With read.table, if you specify the argument, delim = "\t", then it
uses one single tab as a delimiter. That is one thing read.delim does for you
automatically.

6.2.7 Skipping Variables in Delimited Text Files

R must hold all its data in your computer’s main memory. This makes skipping
columns while reading data particularly important. The following is the R
function call to read data while skipping the fourth and fifth columns. If you
have already set your working directory in your current R session, you do not
need to set it again.

> setwd("c:/myRfolder")

> myCols <- read.delim("mydata.tab",

+ strip.white = TRUE,

+ na.strings = "",

+ colClasses = c("integer", "integer", "character",
+ "NULL", "NULL", "integer", "integer") )

> myCols

workshop gender q3 g4
1 1 f 5 1
2 2 f 4 1
3 1 f 4 3
4 2 <NA> NA 3
5 1 m 2 4
6 2 m 5 5
7 1 m 4 4
8 2 m 5 5
>

> # Clean up and save workspace.
> rm(myCols)

We used the name myCols to avoid overwriting mydata. You use the
colClasses argument to specify the class of each column. The classes include
logical (TRUE/FALSE), integer (whole numbers), numeric (can include dec-
imals), character (alphanumeric string values), and factor (categorical values
like gender). See the help file for other classes like dates. The class we need
for this example is NULL. We use it to drop variables.

However, colClasses requires you to specify the classes of all columns,
including any initial ID or row names variable. The classes must be included
within quotes since they are character strings.
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6.2.8 Reading Character Strings

Many of R’s functions for reading text are related. For example, read.csv
and read.delim both call the read.table function with some arguments set
to useful defaults. The read.table function, in turn, calls the scan function,
again with reasonable arguments set to save you the work of understanding
all of scan’s flexibility. So if you have problems reading a text file, check the
help file of the function you are using first. If you do not find a solution, read
the help file of the function it calls, often read.table. Save the help file for
the complex scan function for last.

For example, when you read string variables, R will usually convert them
to factors. However, you do not always want that to happen. Mailing addresses
are a common type of data that will never be used as a factor. To prevent the
conversion of all strings to factors, you can set stringsAsFactors = FALSE.
You could instead use as.is = "x" or as.is = c("x","y") to prevent just
the variables x or x and y from becoming factors.

6.2.9 Example Programs for Reading Delimited Text Files
SAS Program for Reading Delimited Text Files

The parts of this program to read CSV and tab-delimited files was written by
SAS itself using File> Import Data. I only had to write the last one, which
reads data from a Web site.

* Filename: ReadDelimited.sas ;
LIBNAME myLib 'C:\myRfolder';

* ———Comma Delimited Files—--;
PROC IMPORT OUT=myLib.mydata
DATAFILE="C:\myRfolder\mydataID.csv"
DBMS=CSV REPLACE;
GETNAMES=YES;
DATAROW=2;
RUN;
PROC PRINT; RUN;

* ——-Tab Delimited Files——-;
PROC IMPORT 0UT= myLib.mydata
DATAFILE= "C:\myRworkshop\mydataID.tab"
DBMS=TAB REPLACE;
GETNAMES=YES;
DATAROW=2;
RUN;
PROC PRINT; RUN;
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* ——-Reading from a Web Site---;
FILENAME myURL URL
"http://sites.google.com/site/r4statistics/mydatalD.csv";
PROC IMPORT DATAFILE= myURL
DBMS=CSV REPLACE
0UT= myLib.mydata;
GETNAMES=YES;
DATAROW=2;
RUN;
PROC PRINT; RUN;

SPSS Program for Reading Delimited Text Files

Notice that SPSS does not actually use the variable names that are embedded
within the data file. We must skip these and begin reading the data on the
second line. The VARIABLES keyword provides the names. This program
was written by SPSS itself using File> Open> Data. SPSS cannot read text
files from a URL directly, so that part of our steps is not replicated in this
program. (It can read SPSS, SAS, Excel, and Stata files from a URL through
the SPSSINC GETURI DATA extension.)

* Filename: ReadDelimited.SPS
CD 'C:\myRfolder'.

* ———Comma Delimited Files---.
GET DATA /TYPE=TXT
/FILE='mydatalD.csv'
/DELCASE=LINE
/DELIMITERS=","
/ARRANGEMENT=DELIMITED
/FIRSTCASE=2
/IMPORTCASE=ALL
/VARIABLES=id F1.0 workshop F1.0 gender A1.0
ql F1.0 g2 F1.0 q3 F1.0 g4 F1.0 .
LIST.
SAVE OUTFILE='C:\myRfolder\mydata.sav'.

* ——-Tab Delimited Files---.

GET DATA
/TYPE=TXT
/FILE="C:\myRfolder\mydataID.tab"
/DELCASE=LINE
/DELIMITERS="\t"
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/ARRANGEMENT=DELIMITED
/FIRSTCASE=2
/IMPORTCASE=ALL
/VARIABLES = id F1.0 workshop F1.0 gender A1.0
ql F1.0 92 F1.0 g3 F1.0 g4 F1.0 .
LIST.
EXECUTE.
DATASET NAME DataSetl WINDOW=FRONT.

R Program for Reading Delimited Text Files

# Filename: ReadDelimited.R
setwd("c:/myRfolder")
#-—--Comma Delimited Files—-—-

# Read comma delimited file.
# With id variable not named.

mydata <- read.csv("mydata.csv")
mydata

# This time with id named in the header

mydata <- read.csv("mydataID.csv",
row.names = "id")

mydata

#-——-Tab Delimited Files---

# Read a tab delimited file with named ID column.

mydata <- read.delim("mydata.tab")

mydata

count.fields("mydata.tab", sep = "\t")

# Again with ID named in the header

mydata <- read.delim("mydataID.tab",
row.names = "id")

mydata

# —-—--Reading Text from a Web Site---

myURL <- "http://sites.google.com/site/r4statistics/mydata.csv"
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mydata <- read.csv(myURL)
mydata

# —-—--Reading Text from the Clipboard---

# Copy a column of numbers or words, then:
myvector <- readClipboard()

myvector

# Open mydata.csv, select & copy contents, then:
mydata <- read.delim("clipboard", header = TRUE)
mydata

#---Missing Values for Character Variables---

mydata <- read.csv("mydataID.csv",

row.names = "id",

strip.white = TRUE,

na.strings = "" )
mydata

#---Skipping Variables in Delimited Text Files---

myCols <- read.delim("mydata.tab",
strip.white = TRUE,
na.strings = "",

colClasses = c("integer", "integer", "character",
"NULL", "NULL", "integer", "integer") )
myCols

# Clean up and save workspace.
rm(myCols)

save.image(file = "mydata.RData")

6.3 Reading Text Data Within a Program
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It is often useful to have a small data set entered inside a program. SAS does
this using the DATALINES or CARDS statements. SPSS uses the BEGIN DATA

and END DATA commands to accomplish this task.

This approach is popular when teaching or for an example when you post
a question on Internet discussion lists. You only have one file, and anyone can

copy it and run it without changing it to locate a data file.
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Although beginners are often drawn to this approach due to its simplicity,
it is not a good idea to use this for more than a few dozen observations. To
see the top and bottom of your program requires scrolling past all of the data,
which is needlessly time consuming. As we will soon see, R also displays data
in the console, scrolling potential error messages offscreen if there is more than
a screen’s worth of data.

We will discuss two ways to read data within an R program: one that is
easy and one that is more generally applicable.

6.3.1 The Easy Approach

The easy approach is to nest the stdin function within any other R function
that reads data. It tells R that the data are coming from the same place the
program is, which is called the standard input.

In our next example, we will use CSV format, so we will nest a call to the
stdin function within a call to the read.csv function.

mydata <- read.csv( stdin() )
workshop,gender,ql,92,93,q94
1,1,f,1,1,5,1

2,2,£,2,1,4,1
3,1,,2,2,4,3
4,2,NA,3,1,NA,3
5,1,m,4,5,2,4
6,2,m,5,4,5,5
7,1,m,5,3,4,4
8,2,m,4,5,5,5

# Blank line above ends input.

Note that I actually typed “NA” in for missing values, and I was careful to
never add any spaces before or after the gender values of “m” or “f.” That let
us dispense with any additional arguments for the read. csv function. I could
instead have used spaces as delimiters and used the read.table function in
place of read.csv.

With this approach, it is important to avoid tabs as delimiters. They are
not recognized by stdin, and your values would be read as if they were not
delimited at all. You could avoid this by using R’s “\t” character to represent
tab characters, but that makes your data quite a mess!

Let us run our comma-delimited example and see what the output looks
like.

> mydata <- read.csv( stdin() )
0: workshop,gender,ql,q2,93,94
1: 1,1,£,1,1,5,1
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2: 2,2,f,2,1,4,1
3: 3,1,f,2,2,4,3
4: 4,2,NA,3,1,NA,3
5: 5,1,m,4,5,2,4
6: 6,2,m,5,4,5,5
7:7,1,m,5,3,4,4
8: 8,2,m,4,5,5,5
9:
> # Blank line above ends input.
> mydata

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <NA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

I often add blank lines between sections of output to make it easier to
read, but given that a blank line is actually used to end the data, I did not
do so with this output.

You can see that R displays the data itself, and it prefixes each line with
“0:7) “1.7) “2.7) ete. With all of the data displayed, this is obviously not some-
thing you would want to do with hundreds of observations! When we read
data from files, we saw that R did not display them in the console.

The ninth line shows that it is blank and the numeric prefixing stops as R
returns to its usual “>” prompt. It is the blank line that tells R that there are
no more data. If you forget this, R will read your next program lines as data,
continuing until it finds a blank line!

Printing the data by entering mydata shows us that the row names were
correctly assigned and the two missing values are also correct.

6.3.2 The More General Approach

The previous subsection showed how to read data in the middle of an R
program, and it required only a minor change. It had one important limitation
however: you cannot use stdin to read data in programs that are sourced
(included) from files.

Since putting data in the middle of a file is often done for interactive
demonstrations, that is not often a serious limitation. However, there are
times when you want to put the whole program, including data, in a separate
file like “myprog.R” and bring it into R with the command

source ("myprog.R")
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To do this, we can place the whole data set into a character vector with a
single value named “mystring”:

mystring <-
"workshop,gender,ql,q2,93,q94

1,1,£,1,1,5,1
2,2,f,2,1,4,1
3,1,f,2,2,4,3
4,2,NA,3,1,NA,3
5,1,m,4,5,2,4
6,2,m,5,4,5,5
7,1,m,5,3,4,4
8,2,m,4,5,5,5"

-

mydata <- read.csv( textConnection(mystring) )

> mydata

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <NA> 3 1 NA 3

Note that the ¢ function is not used to combine all of those values into
a vector. At the moment, the whole data set is one single character value!
The textConnection function converts mystring into the equivalent of a file,
which R then processes as it would a file.

This approach still has problems with tab-delimited data since strings
do not hold tab characters unless you enter them using R’s “\t” character.
Therefore, it is best to use commas or spaces as delimiters.

6.3.3 Example Programs for Reading Text Data Within a Program
SAS Program for Reading Text Data Within a Program

* Filename: ReadWithin.sas ;

LIBNAME myLib 'C:\myRfolder';
DATA myLib.mydata;
INFILE DATALINES DELIMITER = ',
MISSOVER DSD firstobs=2 ;
INPUT id workshop gender $ ql q2 g3 q4;
DATALINES;
id,workshop,gender,ql,q2,q93,q94
1,1,£,1,1,5,1
2,2,£,2,1,4,1
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8,2,m,4,5,5,5
PROC PRINT; RUN;

SPSS Program for Reading Text Data Within a Program

* Filename: ReadWithin.sps .

DATA LIST / id 2 workshop 4 gender 6 (A)
ql 8 g2 10 g3 12 g4 14.
BEGIN DATA.

NN

-
-

o O N
ad oW W -

-

LIST.
SAVE OUTFILE='C:\myRfolder\mydata.sav'.

R Program for Reading Text Data Within a Program

# Filename: ReadWithin.R

# The stdin approach.

mydata <- read.csv( stdin() )
workshop,gender,ql,q2,93,94
1,1,£,1,1,5,1

2,2,£,2,1,4,1
3,1,£,2,2,4,3
4,2,NA,3,1,NA,3
5,1,m,4,5,2,4
6,2,m,5,4,5,5
7,1,m,5,3,4,4
8,2,m,4,5,5,5

# Blank line above ends input.
mydata

133
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# The textConnection approach
# that works when sourcing files.

mystring <-
"workshop,gender,ql,q92,q93,q4

8,2,m,4,5,5,5"
mydata <- read.csv( textConnection(mystring) )
mydata

# Set working directory & save workspace.
setwd ("c:/myRfolder")

save.image(file = "mydata.RData")

6.4 Reading Multiple Observations per Line

With small data sets it can be convenient to enter the data with more than
one observation per line. This is most often done with examples for teaching
or for demonstrating problems when asking for help on the R-help e-mail list.
I will be extending the technique covered in the previous section, so if you did
not read it just now, please go back and review it.

To read multiple observations per line in SAS, you would use the trailing
@@ symbol to read it as in

INPUT ID GENDER $ Q1-Q4 Q@;

SPSS would simply use the FREE format.

In the following example, I am reading our practice data set with two
observations per line. However, the example works with any number of obser-
vations per line.

mylist <- scan( stdin(),
what = list(id = 0, workshop = 0, gender = "",
ql =0, g2 =0, g3 =0, g4 =0) )
1151 22f2141
2243 4 2 NA 3 1NA3

w =
=
Hh Hh

L}
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51mé4524 62mb5455
71mb5344 82m4555
# Blank line above ends input.

I am reading the data into mylist by calling the scan function, with two
arguments:

1. The first argument is the “file” to scan. If the data were in a file, we would
list its name here in quotes. We are using the standard input (i.e., the same
source as the programming statements themselves), so I put the stdin()
call there. The textConnection approach would work here as well. The
example program at the end of this section includes that approach.

2. What to scan. This is the type of data to scan such as numeric or character.
Since we have various types to scan, I am giving it a list of variables that
are all initialized with zero for numeric variables and an empty character
string, "", for character variables.

Let us see what it has read:
> mylist

$id
[1] 123456738

$workshop
1112121212

$gender
[1] llfll llfll llfll NA llmll llmll llmll llmll

$q1
[1] 1223 4554...

We see that it read the data just fine, but it is in a list. We can convert
that to a data frame using

> mydata <- data.frame(mylist)
> mydata

id workshop gender ql g2 q3 g4

1 1 1 f 1 1 5 1
2 2 2 f 2 1 4 1
3 3 1 f 2 2 4 3
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I did the above example in two steps to make it easy to understand. How-
ever, it would be more efficient to do both steps at once:

mydata <- data.frame(
scan( stdin(),

what = list(id = 0, workshop = 0, gender = "",
ql =0, g2 =0, g3 =0, g4 = 0) )

11f1151 22f2141

31f2243 4 2 NA 3 1NA 3

51m4524 62mb5455

71mb5 344 82m4555

# Blank line above ends input.

6.4.1 Example Programs for Reading Multiple Observations per
Line

Example SAS Program for Reading Multiple Observations per
Line

* Filename: ReadMultiple(Obs.sas ;

DATA mydata;
INPUT id workshop gender $ ql-q4 QG;

DATALINES;

11f1151 22f2141
31f2243 42 .31.3
51m4524 62m5455
71m5344 82m4555

’

PROC PRINT; RUN;

Example SPSS Program for Reading Multiple Observations per
Line

SPSS must use the FREE format to read multiple observations per line.
With that format, it cannot read missing values without a nonblank delim-
iter. Therefore, I use commas in the example below, so that two consecutive
commas will tell SPSS that the value is missing.

* Filename: ReadMultiple(Obs.SPS.

DATA LIST FREE/ id (£f1.0) workshop (£1.0) gender (A)
ql (£1.0) q2 (£f1.0) g3 (£1.0) g4 (£1.0).
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Example R Program for Reading Multiple Observations per Line

# Filename: ReadMultipleObs.R

mylist <- scan( stdin(),

what = list(id

~N O W e
e
B B H H
O N
w o N =
BN o

Do W

0 O > Nl

# Blank line above

mylist

0, workshop =
0, g2 = 0, g3
2f2141

2 NA 3 1NAS3

ends input.

mydata <- data.frame(mylist)

head (mydata)

# The textConnection approach

mystring <-

"1T11f1151

31£f224
51m452
71mb534
]

mystring

bW

0,

gender = "",

0, g4 = 0))

mylist <- scan( textConnection(mystring),

what = list(id = 0, workshop = 0, gender = "",
ql =0, g2 =0, g3 =0, g4 = 0) )

mydata <- data.frame(mylist)

head (mydata)
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6.5 Reading Data from the Keyboard

If you want to enter data from the keyboard line by line using SAS or SPSS,
you would do so as we did in the previous two sections. They do not have
a special data entry mode outside of their data editors. You can put R’s
scan function into a special data entry mode by not providing it with any
arguments. It then prompts you for data one line at a time, but once you hit
the Enter key, you cannot go back and change it in that mode.

Although you can do this on any operating system, its main use may be
on Linux or UNIX computers, which lack the R GUI. Since this approach
requires only the console command prompt, you can use it even without the
R GUI The following is an example.

> id <- scan()

1: 12345678
9:

Read 8 items

R prompts with “1:” indicating that you can type the first observation.
When I entered the first line (just the digits 1 through 8), it prompted with
“9:” indicating that I had already entered 8 values. When I entered a blank
line, scan stopped reading and saved the vector named id.

To enter character data, we have to add the what argument. Since spaces
separate the values, to enter a value that includes a space, you would enclose
it in quotes like “R.A. Fisher.”

> gender <- scan(what = "character")
1: ffffmmmmnm
9:

Read 8 items

When finished with this approach, we could use the data.frame function
to combine the vectors into a data frame:

mydata <- data.frame(id, workshop, gender, ql, g2, 93, g4)

6.6 Reading Fixed-Width Text Files, One Record
per Case

Files that separate data values with delimiters such as spaces or commas are
convenient for people to work with, but they make a file larger. So many text
files dispense with such conveniences and instead keep variable values locked
into the exact same column(s) of every record.

If you have a nondelimited text file with one record per case, you can read
it using the following approach. R has nowhere near the flexibility in reading
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fixed-width text files that SAS and SPSS have. As you will soon see, making
an error specifying the width of one variable will result in reading the wrong
columns for all those that follow. While SAS and SPSS offer approaches that
would do that, too, I do not recommend their use. In R, though, it is your
only option which is fine so long as you carefully check your results.

Other languages such as Perl or Python are extremely good at reading

text files and converting them to a form that R can easily read.

Below are the same data that we used in other examples but now it is in

fixed-width format (Table 9.5).

011f1151
0222141
031£2243
042 31 3
051m4524
062m5455
071m5344
082m4555

[\

Important things to notice about this file.

. No names appear on first line.
. Nothing separates values.
. The first value of each record is two columns wide; the remainder take

only one column each. I made ID wider just to demonstrate how to read
a variable that is more than one column wide.

. Blanks represent missing values, but we could use any other character that

would fit into the fixed number of columns allocated to each variable.

. The last line of the file contains data. That is what SAS and SPSS expect,

but R generates a warning that there is an “incomplete final line found.”
It works fine though. If the warning in R bothers you, simply edit the file
and press Enter once at the end of the last line.

The R function that reads fixed-width files is read.fwf. The following is

an example of it reading the file above:

> setwd("c:/myRfolder")

>
+
+
+
+
+
+
+

mydata <- read.fwf (

file = "mydataFWF.txt",

width =c(2, -1, 1,1, 1, 1, 1),

col .names = C("id", "gender", "ql", nq2u’ uq3u’ nq4n)’
row.names = "id",

na.strings = "",

fill = TRUE,

strip.white = TRUE)



140 6 Data Acquisition

Warning message:

In readLines(file, n = thisblock)

>

O ~NO Ok WN -

incomplete final line found on 'mydataFWF.txt'
mydata

gender gl g2 g3 g4

f 1 1 5 1
f 2 1 4 1
f 2 2 4 3
<NA> 3 1 NA 3
m 3 5 2 4
m 5 4 5 5
m 5 3 4 4
m 4 5 5 5

The read.fwf function call above uses seven arguments:

. The file argument lists the name of the file. It will read it from

your current working directory. You can set the working directory with
setwd ("path") or you can specify a path as part of the file specification.

. The width argument provides the width, or number of columns, required
by each variable in order. The widths we supplied as a numeric vector are
created using the c function. The first number, 2, tells R to read ID from
columns 1 and 2. The next number, —1, tells R to skip one column. In our
next example, we will not need to read the workshop variable, so I have
put in a —1 to skip it now. The remaining pattern of 1, 1, 1, 1, tells R
that each of the remaining four variables will require one column each. Be
very careful at this step! If you made an error and told R that ID was one
column wide, then read.fwf would read all of the other variables from
the wrong columns.

When you are reading many variables, specifying their length by listing
them all like this is tedious. You can make this task much easier by using
R’s ability to generate vectors of repetitive patterns. For an example, see
the Chap. 12.4, “Generating Values for Reading Fixed Width Files.”

. The col.names argument provides the column or variable names. Those,
too, we provide in a character vector. We create it using the ¢ function,
c("id","gender","ql","q2","q3","q4"). Since the names are charac-
ter (string) data, we must enclose them in quotes.

Names can also be tedious to enter. R’s ability to generate vectors of
repetitive patterns, combined with the paste function, can generate long
sets of variable names. For details, see Chap. 12, “Generating Data.”

. The row.names argument tells R that we have a variable that stores a
name or identifier for each row. It also tells it which of the variable names
from the col.names argument that is: “id.”
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5. The na.strings ="" argument tells R that an empty field is a missing
value. It already is for numeric data, but, as in SAS or SPSS, a blank is
a valid character value. Note that there is no blank between the quotes!
That is because we set the strip.white option to strip out extra blanks
from the end of strings (below). As you see, R displays missing data for
character data within angle brackets as <NA>.

6. The £i1l argument tells R to fill in blank spaces if the file contains lines
that are not of full length (like the SAS MISSOVER option). Now is a
good time to stop and enter help("read.fwf"). Note that there is no
f£ill argument offered. It does, however, list its last argument as “...”.
This is called the triple dot argument. It means that it accepts addi-
tional unnamed arguments and will pass them on to another function that
read.fwf might call. In this case, it is the read.table function. Clicking
the link in the help file to that function will reveal the £i11l argument and
what it does.

7. The strip.white argument tells R to remove any additional blanks it
finds in character data values. Therefore, if we were reading a long text
string like "Bob " it would delete the additional spaces and store
just "Bob". That saves space and makes logical comparisons easier. It is
all too easy to count the number of blanks incorrectly when making a
comparison like, name == "Bob ",

The file was read just fine. The warning message about an “incomplete
final line” is caused by an additional line feed character at the end of the last
line of the file. Neither SAS nor SPSS would print a warning about such a
condition.

The read.fwf function calls the read.table function to do its work, so
you can use any of those arguments here as well.

6.6.1 Reading Data Using Macro Substitution

In Sect. 5.7.2 we first discussed how R can store the values of its arguments in
vectors. That is essentially what SAS and SPSS call macro substitution. Let
us now use that idea to simplify our program, making it easier to write and
maintain.

Since file paths often get quite long, we will store the file name in a char-
acter vector named myfile. This approach also lets you put all of the file ref-
erences you use at the top of your programs, so you can change them easily.
We do this with the command:

myfile <- "mydataFWF.txt"

Next, we will store our variable names in another character vector, my-
VariableNames. This makes it much easier to manage when you have a more
realistic data set that may contain hundreds of variables:
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myVariableNames <- c("id", "gender", "ql1", "g2", "q3", "q4")

Now we will do the same with our variable widths. This makes our next
example, which reads multiple records per case, much easier:

myVariableWidths <- ¢(2, -1, 1, 1, 1, 1, 1)
Now we will put it all together in a call to the read.fwf function:

mydata <- read.fwf (

file = myfile,

width = myVariableWidths,
col.names = myVariableNames,
row.names = "id",

na.strings = "",

fill = TRUE,

strip.white = TRUE)

Running this code will read the file in exactly the same was as in the

previous example where we filled in all the values directly into the argument
fields.

6.6.2 Example Programs for Reading Fixed-Width Text Files, One
Record per Case

These programs do not save the data as they skip the workshop variable for
demonstration purposes.

SAS Program for Fixed-Width Text Files, One Record per Case

* Filename: ReadFWF1l.sas ;

LIBNAME myLib 'C:\myRfolder';
DATA myLib.mydata;
INFILE "\myRfolder\mydataFWF.txt' MISSOVER;
INPUT id 1-2 workshop 3 gender $ 4
ql 5 926 q3 7 a4 8;
RUN;

SPSS Program for Fixed-Width Text Files, One Record per Case
* Filename: ReadFWF1l.sps .

CD 'C:\myRfolder'.

DATA LIST FILE='mydataFWF.txt' RECORDS=1

/1 id 1-2 workshop 3 gender 4 (A) ql1 5 926 q3 7 g4 8.
LIST.
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R Program for Fixed-Width Text Files, One Record per Case

# Filename: ReadFWF1.R

setwd("c:/myRfolder")
mydata <- read.fwf(

file = "mydataFWF.txt",
width =c(2, -1, 1, 1, 1, 1, 1),
col.names = c("id", "gender", "ql1", "g2", "q3", "qg4"),
row.names = "id",
na.strings = "",
fill = TRUE,
strip.white = TRUE)
mydata

# Again using "macro substitution".

myfile <- "mydataFWF.txt"

myVariableNames <- c("id", "gender", "qi1", "g2", "q3", "qg4")
myVariableWidths <- ¢(2, -1, 1, 1, 1, 1, 1)

mydata <- read.fwf(

file = myfile,
width = myVariableWidths,
col.names = myVariableNames,
row.names = "id",
na.strings = "",
fill = TRUE,
strip.white = TRUE)
mydata

6.7 Reading Fixed-Width Text Files, Two or More
Records per Case

It is common to have to read several records per case. In this section we
will read two records per case, but it is easy to generalize from here to any
number of records. This section builds on the section above, so if you have
not just finished reading it, you will want to now. We will only use the macro
substitution form in this example.

First, we will store the filename in the character vector named myfile:

myfile <- "/mydataFWF.txt"

Next, we will store the variable names in another character vector. We will
pretend that our same file now has two records per case with ql to q4 on the
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first record and g5 to g8 in the same columns on the second. Even though id,
workshop, and gender appear on every line, we will not read them again from
the second line. Here are our variable names:

myVariableNames <- c("id", "workshop", "gender",
Ilqlll s llq2ll , Ilq3l| s l|q4ll ,
Ilq5 n s llqsll , Ilq7ll s llq8|l )

Now we need to specify the columns to read. We must store the column
widths for each line of data (per case) in their own vectors. Note that on
record 2 we begin with —2, —1, —1 to skip the values for id, workshop, and
gender.

myRecordiWidths <- ¢( 2, 1, 1, 1, 1, 1, 1)
myRecord2Widths <- c(-2,-1,-1, 1, 1, 1, 1)

Next, we need to store both of the above variables in a list. The list
function below combines the two record width vectors into one list named
my VariableWidths:

myVariableWidths <- list(myRecordiWidths, myRecord2Widths)
Let us look at the new list:

> myVariableWidths

[[1]]
112111111

[[2]]
1] -2-1-1 1 1 1 1

You can see that the component labeled [[1]] is the first numeric vector and
the one labeled [[2]] is the second. In SAS you would tell it that there are two
records per case by using “#2” to move to the second record. Similarly, SPSS
uses “/2”. R uses a wvery different approach to change records! It is the fact
that the list of record lengths contains two components that tells R we have
two records per case. When it finishes using the record widths stored in the
first component of the list, it will automatically move to the second record,
and so on.

Now we are ready to use the read.fwf function to read the data file:

> mydata <- read.fwf(

+ file = myfile,

+ width = myVariableWidths,
+ col.names = myVariableNames,
+ row.names = "id",

+ na.strings = "",
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+ fill
+ strip.white

TRUE,
TRUE)

Warning message:

In readLines(file, n = thisblock)
incomplete final line found on 'mydataFWF.txt'

workshop gender ql g2 g3 g4 g5 g6 q7 g8
1 1 f 1 1 5 1 2 1 4 1
3 1 f 2 2 4 3 3 1NA 3
5 1 m 3 5 2 4 5 4 5 5
7 1 m 5 3 4 4 4 5 5 5

You can see we now have only four records and eight q variables, so it
has worked well. It is also finally obvious that the row names do not always
come out as simple sequential numbers. It just so happened that that is what
we have had until now. Because we are setting our row names from our id
variable, and we are reading two records per case, we end up with only the
odd-numbered values. However, if we had let R create its own row names, they
would have ended up, “1,” “2,” “3,” and “4.” The odd-numbered row names also
help us understand why no value of gender is now missing: we did not read
gender from the fourth record in the file.

I did not press the Enter key at the end of the last line of data, causing R
to think that the final line was incomplete. That does not cause problems.

6.7.1 Example Programs to Read Fixed-Width Text Files with
Two Records per Case

SAS Program to Read Two Records per Case

* Filename: ReadFWF2.sas ;

DATA temp;
INFILE "\myRfolder\mydataFWF.txt' MISSOVER;
INPUT
#1 id 1-2 workshop 3 gender 4 ql1 5 926 q3 7 q4 8
#2 g5 5 96 6 q7 7 g8 8;
PROC PRINT;
RUN;

SPSS Program to Read Two Records per Case

* Filename: ReadFWF2.sps .
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DATA LIST FILE='\myRfolder\mydataFWF.txt' RECORDS=2
/1 id 1-2 workshop 3 gender 4 (A) q1 5 g2 6 93 7 g4 8
/2 95 5 q6 6 q7 7 q8 8
LIST.

R Program to Read Two Records per Case

# Filename: ReadFWF2.R
setwd ("C:/myRfolder")

# Set all the values to use.
myfile <- "mydataFWF.txt"
myVariableNames <- c("id", "workshop", "gender",

"qi", "q2", "q3", "q4",

"g5", "g6", "q7", "q8")
myRecordiWidths <- c¢( 2, 1, 1, 1, 1, 1, 1)
myRecord2Widths <- c¢(-2,-1,-1, 1, 1, 1, 1)
myVariableWidths <- list(myRecordiWidths, myRecord2Widths)

#Now plug them in and read the data:
mydata <- read.fwf (

file = myfile,
width = myVariableWidths,
col.names = myVariableNames,
row.names = "id",
na.strings = "",
fill = TRUE,
strip.white = TRUE )
mydata

6.8 Reading Excel Files

The easiest way to read or write Excel files is to use Hans-Peter Suter’s aptly
named x1sReadWrite package [53]. You begin its installation as usual:

install.packages("x1sReadWrite")

However, when you load the package from your library for the first time, it
will tell you that you need an additional command to complete the installation:

library("x1sReadWrite")
x1ls.getshlib()
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The x1s.getshlib gets a binary file that is not distributed through
CRAN. You only need to run that function once when you first install
x1lsReadWrite.

Using x1sReadWrite is very easy. You can read a file using:

> setwd("c:/myRfolder")

> mydata <- read.xls("mydata.xls")

> mydata

id workshop gender ql g2 q3 g4
11 1 f 1 1 56 1
2 2 2 f 2 1 4 1

If you have an id variable in the first column and you do not name it,
unlike other R functions, it will not assume that it should go in the row
names attribute. Instead, it will name the variable V1. You can transfer the
values from any variable to the row names attribute by adding the rowNames
argument.

As of this writing, the package is not able to read or write files in Excel’s
newer XLSX format. You can read such files using ODBC as shown in the next
section. You can also read XLSX files and save them as XLS files using Ex-
cel or the free OpenOffice.org (http://www.openoffice.org/) or LibreOffice
(http://www.documentfoundation.org/).

There is a “Pro” version of x1sReadWrite that has added features, such as
the ability to read specific cell ranges or to to append what it writes to the
bottom of an existing Excel file. It also has more functions to convert Excel
date and time variables. It is available at http://www.swissr.org/.

6.8.1 Example Programs for Reading Excel Files
SAS Program for Reading Excel Files

* Filename: ReadExcel.sas;

LIBNAME myLib "c:\myRfolder";

PROC IMPORT OUT = mylib.mydata

DATAFILE = "C:\myRfolder\mydata.xls"
DBMS = EXCELCS REPLACE;

RANGE = "Sheet1$";
SCANTEXT = YES;
USEDATE = YES;
SCANTIME = YES;

RUN;
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SPSS Program for Reading Excel Files

* Filename: ReadExcel.sps.

GET DATA
/TYPE=XLS
/FILE='C:\myRfolder\mydata.xls'
/SHEET=name 'Sheet1'
/CELLRANGE=full
/READNAMES=on
/ASSUMEDSTRWIDTH=32767 .
EXECUTE.

R Program for Reading Excel Files

# Filename: ReadExcel.R

# Do this once:
install.packages("x1sReadWrite")
library("x1sReadWrite")
xls.getshlib()

# Do this each time:
library("xlsReadWrite")
setwd("c:/myRfolder")

mydata <- read.xls("mydata.xls")
mydata

save(mydata, "mydata.RData")

6.9 Reading from Relational Databases

R has the ability to access data in most popular database programs. The R
Data Import/Export manual that appears in the Help> Manuals (in PDF)
menu covers this area thoroughly. I will give a brief overview of it by using
Ripley and Lapsley’s RODBC package [47]. This package comes with the main
R installation. However, it requires Microsoft’s Open Database Connectivity
standard (ODBC). That comes standard with Windows, but you must add it
yourself if you use Macintosh, Linux, or UNIX.

Accessing a database normally requires installing one on your computer
and then using your operating system to establish a connection to it. Instead,
we will simulate this process by using ODBC to access our practice Excel file.
You do not have to have Excel installed for this to work, but if you are not a
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Windows user, you will have to install an ODBC driver to use this approach.
Here is how to read an Excel file using ODBC:

library ("RODBC")
myConnection <- odbcConnectExcel("mydata.xls")

Now that the connection is established, we can read it using the sqlFetch
function and then close the connection:

> mydata <- sqlFetch(myConnection, "Sheetl")

> close(myConnection)

> mydata

id workshop gender ql g2 g3 g4
1 1 1 f 1 1 5 1
2 2 2 f 2 1 4 1
3 3 1 f 2 2 4 3
4 4 2 3 1 NA 3
5 5 1 m 4 5 2 4
6 6 2 m 5 4 5 5
T 7 1 m 5 3 4 4
8 8 2 m 4 5 5 5

If you do not name the id variable, R will not assume the first column is
an id variable and so will not transfer its contents to the row names attribute.
Instead, it will name the first column “F'1.”

6.10 Reading Data from SAS

If you have SAS installed on your computer, you can read SAS data sets from
within R. If you have Revolution R Enterprise, a commercial version of R
from Revolution Analytics, you can read SAS data sets without having SAS
installed. Finally, without having SAS or Revolution R Enterprise, R can still
read SAS XPORT files.

If you do have SAS installed on your machine, you can use SAS itself to
help read and translate any SAS data set using the read.ssd function in the
foreign package that comes with the main R distribution:

> library("foreign")

> mydata <- read.ssd("c:/myRfolder", "mydata",
+ sascmd = "C:/Program Files/SAS/SASFoundation/9.2/sas.exe")

> mydata



150 6 Data Acquisition

ID WORKSHOP GENDER Q1 Q2 Q3 Q4
1 1 1 f 1 1 5 1
2 2 2 f 2 1 4 1

The read.ssd function call above uses three arguments:

1. The libname, or path where your SAS data set is stored. In this example,
the file is stored in myRfolder on my C: drive.

2. The member name(s). In this example, I am reading mydata.sas7bdat.
You do not list the file extension along with the member name.

3. The sascmd argument. This shows the full path to the sas.exe command.

If you do not have SAS installed, you can read SAS data sets in XPORT
format. Although the foreign package reads XPORT files too, it lacks im-
portant capabilities. Functions in Harrell’s Hmisc package add the ability to
read formatted values, variable labels, and lengths.

SAS users rarely use the LENGTH statement, accepting the default storage
method of double precision. This wastes a bit of disk space but saves program-
ming time. However, since R saves all its data in memory, space limitations
are far more important. If you use the SAS LENGTH statement to save space,
the sasxport.get function in Hmisc will take advantage of it. However, un-
less you know a lot about how computers store data, it is probably best to
only shorten the length used to store integers. The Hmisc package does not
come with R but it is easy to install. For instructions, see Sect. 2.1, “Installing
Add-on Packages.”

The example below loads the two packages we need and then translates
the data.

library("foreign")
library ("Hmisc")

mydata <- sasxport.get("mydata.xpt")

The sasxport.get function has many arguments to control its actions. It
is documented in An Introduction to S and the Hmisc and Design Libraries
[2].

Another way to read SAS files is via the SAS ODBC Driver. It lets you
read files using the RODBC package described in Sec. 6.9.

6.10.1 Example Programs to Write Data from SAS
and Read It into R

Unlike most of our example programs, the SAS and R code here do opposite
things rather than the same thing. The first program writes the data from
SAS, and the second reads into R both the original SAS data set and the
XPORT file created by the SAS program.



6.11 Reading Data from SPSS
SAS Program to Write Data from SAS

* Filename: WriteXPORT.sas ;

LIBNAME myLib 'C:\myRfolder';
LIBNAME To_R xport '\myRfolder\mydata.xpt';

DATA To_R.mydata;

SET myLib.mydata;
RUN;

R Program to Read a SAS Data Set

# Filename: ReadSAS.R
setwd("c:/myRfolder")

# Reads ssd or sas7bdat if you have SAS installed.
library("foreign")

mydata <- read.ssd("c:/myRfolder", "mydata",

sascmd = "C:/Program Files/SAS/SASFoundation/9.2/sas.exe")

mydata
# Reads SAS export format without installing SAS
library("foreign")

library("Hmisc")

mydata <- sasxport.get("mydata.xpt")
mydata

6.11 Reading Data from SPSS

151

If you have SPSS 16 or later, the best way to read data into R from SPSS is by
using the SPSS-R Integration Plug-in. It includes support of recent features

such as long file names. For details, see Sect. 3.7.

You can also install a free ODBC driver in the IBM SPSS Data Access
Pack that will let you read SPSS files using the RODBC package described in

Sec. 6.9.

If you do not have SPSS, you can read an SPSS save file using the spss.get

function in the foreign package:

> library("foreign")
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> mydata <- read.spss("mydata.sav",
+ use.value.labels = TRUE,

+  to.data.frame = TRUE)
> mydata

id workshop gender ql g2 g3 q4
11 1 f 1 1 5 1
2 2 2 f 2 1 4 1
3 3 1 f 2 2 4 3
4 4 2 3 1NA 3

Setting to.data.frame to TRUE gets the data into a data frame rather
than as a list. Setting the use.value.labels argument to TRUE causes it
to convert any variable with value labels to R factors with those labels. That
keeps the labels but turns them into categorical variables. This is the default
value, so I list it here only to point out its importance. Setting it to FALSE
will leave your variables numeric, allowing you to calculate means and stan-
dard deviations more easily. SPSS users often have Likert scale 1 through
5 items stored as scale variables (numeric vectors in R) and have labels as-
signed to them. For more details about factors, Read Sect. 11.1, “Value Labels
or Formats (and Measurement Level).”

See help("read.spss") when the foreign package is loaded for many
more arguments that control the way the file is read.

Note that it left gender with a blank value instead of setting that to miss-
ing. You could fix that with:

mydata[mydata == " "] <- NA

or any of the other methods discussed in Section10.5, “Missing Values”.

If you have an SPSS portable file, you can read that using the spss.get
function in the Hmisc package. For instructions on installing Hmisc, see
Sect. 2.1, “Installing Add-on Packages”.

Here is an example:

library("Hmisc")
mydata <- spss.get("mydata.por")

It also has a use.value.labels argument, but I did not use it here.

Other useful arguments include lowernames = TRUE to convert all names
to lowercase and datevars to tell R about date variables to convert. After
you have loaded the Hmisc package, you can use help("spss.get") for more
information.

6.11.1 Example Programs for Reading Data from SPSS

Unlike most of our example programs, the SPSS and R code here do opposite
things rather than the same thing.
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SPSS Program to Write a Portable Format File

* Filename: WritePortable.sps

CD 'C:\myRfolder'.
GET FILE='mydata.sav'.
EXPORT OUTFILE='C:\myRfolder\mydata.por'.

R Program to Read an SPSS Data File
# Filename: ReadSPSS.R

setwd ("c:/myRfolder")
library("foreign")

mydata <- read.spss("mydata.sav",
use.value.labels = TRUE,

to.data.frame = TRUE)
mydata
mydata[mydata == " "] <- NA

library("Hmisc")

mydata <- spss.get("mydata.por",
use.value.labels = TRUE)

mydata

save(mydata, "mydata.RData")

6.12 Writing Delimited Text Files

Writing text files from R is generally much easier than reading them because
you know exactly what you already have. You have no worries about extra-
neous commas or tab characters causing trouble.

Writing a comma-delimited file is as simple as:

write.csv(mydata, "mydataFromR.csv")

Of course you have to consider who is likely to read the file and what their
concerns are. For example, an American sending a file to Europe might want
to look at the help files for read. csv2, which uses commas for decimal points
and semicolons for delimiters.

To write a tab-delimited file, there is no direct equivalent to read.delim.
Instead, you use write.table. Accepting all the defaults will give you a space-
delimited file with “NA” written for missing values. Many packages, SAS and
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SPSS included, will print warnings when they read “NA” strings in numeric
variables and then set them to missing. Here is how it works:

write.table(mydata, "mydata.txt")

If necessary, you can specify many different arguments to control what
write.table does. Here is a more complicated example:

write.table(mydata,

file = "mydataFromR.tab",
quote = FALSE,

sep = "\t n s

na = nn s

row.names = TRUE,
col.names = TRUE)

This function call uses seven arguments:

1. The name of the R data frame to write out.

2. The file argument names the output text data file. R will write it to the
working directory.

3. The quote = FALSE argument tells R not to write quotes around character
data like “m” and “f.” By default, it will write the quotes.

4. The sep = "\t" that tells it the separator (delimiter) to use between
values is one single tab. Changing that to sep = "," would write out a
comma-delimited file instead. If you did that, you would want to change
the filename to “mydata2.csv.”

5. Thena = "" argument tells R not to write anything to represent missing
values. By default, it will write out “NA” instead. That is what you want
only if you plan to read the data back into R. Few other packages recognize
NA as a code for missing values. SAS and SPSS will convert it to missing,
but they will generate a lot of irritating messages, so it is probably best
to use a blank.

6. The row.names = TRUE argument tells R to write row names in the first
column of the file. In other words, it will write out an ID-type variable.
This is the default value, so you do not actually need to list it here. If you
do not want it to write row names, then you must use row.names = FALSE.

7. The col.names = TRUE argument tells R to write variable names in the
first row of the file. This is the default value, so you do not actually need
to list it here. If you do not want it to write variable names, then you
must use col.names = FALSE. Unlike most programs, R will not write
out a name for an ID variable.

6.12.1 Example Programs for Writing Delimited Text Files
SAS Program for Writing Delimited Text Files

* Filename: WriteDelimited.sas;
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LIBNAME myLib 'C:\myRfolder';
PROC PRINT DATA=myLib.mydata; run;

PROC EXPORT DATA= MYLIB.MYDATA
OUTFILE= "C:\myFolder\mydataFromSAS.csv"
DBMS=CSV REPLACE;
PUTNAMES=YES;
RUN;

PROC EXPORT DATA= MYLIB.MYDATA
OUTFILE= "C:\myFolder\mydataFromSAS.txt"
DBMS=TAB REPLACE;
PUTNAMES=YES;
RUN;

SPSS Program for Writing Delimited Text Files

* Filename: WriteDelimited.sps

GET
FILE='C:\myRfolder\mydata.sav'.
DATASET NAME DataSet2 WINDOW=FRONT.

SAVE TRANSLATE OUTFILE='C:\myRfolder\mydataFromSPSS.csv'
/TYPE=CSV
/MAP
/REPLACE
/FIELDNAMES
/CELLS=VALUES.

SAVE TRANSLATE OUTFILE='C:\myRfolder\mydataFromSPSS.dat'
/TYPE=TAB
/MAP
/REPLACE
/FIELDNAMES
/CELLS=VALUES.

R Program for Writing Delimited Text Files

# Filename: WriteDelimited.R

setwd("c:/myRfolder")
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write.csv(mydata, "mydataFromR.csv")
write.table(mydata, "mydataFromR.txt")

write.table(mydata,

file = "mydataFromR.txt",
quote = FALSE,

sep = "\t",

na = n u,

row.names = TRUE,

col.names = TRUE)

# Look at the contents of the last file.
file.show("mydataFromR.txt")

6.13 Viewing a Text File

When you are writing data from R, it is helpful to be able to open the file(s)
under program control. That way you can adjust the arguments until you get
what you need.

To look at the contents of any text file in R, you can use the file.show
function. On Windows or Macintosh, it will open a read-only window showing
you the file’s contents. On Linux or UNIX it will simply list the file’s contents.

Here is an example. Note that it did not write out a name for the row
names variable, so the name workshop appears in the first column:

> file.show("mydataFromR.csv")

workshop gender ql q2 q3 qé
1 R f 1 1 5 1
2 SAS f 2 1 4 1

6.14 Writing Excel Files

Writing an Excel file is easy using the xl1sReadWrite package described in
Sect. 6.8.

library("x1lsReadWrite")

write.xls(mydata, "mydataFromR.xls")

As of this writing, x1sReadWrite is not able to write files in Excel’s newer
XLSX format. However, since almost any package can read the older XLS
format, it is not a cause for concern as it was when we read Excel files.
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6.14.1 Example Programs for Writing Excel Files
SAS Program for Writing Excel Files

* Filename: WriteExcel.sas;
LIBNAME mylib "c:\myRfolder";

PROC EXPORT DATA= MYLIB.MYDATA
OUTFILE= "C:\myRfolder\mydata.xls"
DBMS=EXCELCS LABEL REPLACE;
SHEET="mydata";
RUN;

SPSS Program for Writing Excel Files

* Filename: WriteExcel.sps .

GET FILE = 'C:\myRfolder\mydata.sav'.
DATASET NAME DataSet2 WINDOW=FRONT.

SAVE TRANSLATE OUTFILE='C:\myRfolder\mydataFromSPSS.x1ls'
/TYPE=XLS
/VERSION=2
/MAP
/REPLACE
/FIELDNAMES.
EXECUTE.

R Program for Writing Excel Files

# Filename: WriteExcel.R

# Do this once:
install.packages("x1sReadWrite")
library("x1lsReadWrite")
xls.getshlib()

# Do this each time:
library("x1lsReadWrite")
setwd("c:/myRfolder")

load("mydata.RData")
write.xls(mydata, "mydataFromR.xls")
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6.15 Writing to Relational Databases

Writing to databases is done in a very similar manner to reading them.
See Sect. 6.9 for the software requirements. The main difference is the
readonly = FALSE argument on the odbcConnectExcel function call:

library("RODBC")

myConnection <- odbcConnectExcel("mydataFromR.x1s",
readOnly = FALSE)

sqlSave (myConnection, mydata)

close (myConnection)

The SAS and SPSS approaches to writing to relational databases are be-
yond our scope.

6.16 Writing Data to SAS and SPSS

In Sect. 6.12, “Writing Delimited Text Files,” we examined several ways to
write text files. In this section we will use the write.foreign function to write
out a comma-delimited text file along with either a SAS or SPSS program file
to match. To complete the importation into SAS or SPSS, you must edit the
program file in SAS or SPSS and then execute it to read the text file and
finally create a data set. To begin the process, you must load the foreign
package that comes with the main R distribution.

library("foreign")

write.foreign(mydata,

datafile = "mydataFromR.csv",
codefile = "mydata.sas",
package = "SAS")

This function call uses four arguments:

1. The name of the R data frame you wish to write out.

2. The datafile argument tells R the name of the text data file. R will write
it to the current working directory unless you specify the full path in the
filename.

3. The codefile argument tells R the filename of a program that SAS or
SPSS can use to read the text data file. You will have to use this file in
SAS or SPSS to read the data file and create a SAS- or SPSS-formatted
file. R will write it to the current working directory unless you specify the
full path in the filename.

4. The package argument takes the values “SAS” or “SPSS” to determine
which type of program R writes to the codefile location. Note that these
two examples write out the gender values as 1 and 2 for “f” and “m,”
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respectively. It then creates SAS formats or SPSS value labels for those
values, so they will display as f and m when you read them into your other
package. Some people prefer other values, or they prefer converting factors
to character variables before writing the file out. To change those values,
read Sect. 11.1, “Value Labels or Formats (and Measurement Level).”

Here is the SAS program that R wrote:

Written by R;
write.foreign(mydata, datafile = "mydataFromR.txt",
codefile = "mydataFromR.sas", ;

PROC FORMAT;
value gender
1 ="
2 = nfn
3 = "m"

DATA rdata ;
INFILE "mydataFromR.txt"
DSD
LRECL= 15 ;
INPUT
workshop
gender
ql
q2
q3
q4
FORMAT gender gender. ;
RUN;

You can see it needs a bit of work, but you could use this to read the
data into R fairly quickly and you would have the formats that you would
otherwise have lacked using the other approaches to write text files.

6.16.1 Example Programs to Write Data to SAS and SPSS

This section presents programs to write a text file from R for use in any
program. They can also be used to write text files and matching SAS and
SPSS programs to read them.
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R Program to Write Data to SAS

This program writes data to one file and a SAS program to another file. You
run the SAS program in SAS to read the data into that package.

# Filename: WriteSAS.R

setwd("c:/myRfolder")
library("foreign")

write.foreign(mydata,
datafile = "mydataFromR.txt",
codefile "mydataFromR.sas",
package = "SAS")

# Look at the contents of our new files.
file.show("mydataFromR.txt")
file.show("mydataFromR.sas")

R Program to Write Data to SPSS

This program exports data to one file and an SPSS program to another file.
You run the SPSS program in SPSS to read the data into that package.

# Filename: WriteSPSS.R

setwd("c:/myRfolder")
library("foreign")

write.foreign(mydata,
datafile = "mydataFromR.txt",
codefile = "mydataFromR.sps",
package "SPSS")

# Look at the contents of our new files.
file.show("mydataFromR.txt")
file.show("mydataFromR.sps")
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Selecting Variables

In SAS and SPSS, selecting variables for an analysis is simple, while selecting
observations is often much more complicated. In R, these two processes can be
almost identical. As a result, variable selection in R is both more flexible and
quite a bit more complex. However, since you need to learn that complexity
to select observations, it does not require much added effort.

Selecting observations in SAS or SPSS requires the use of logical conditions
with commands like [F, WHERE, SELECT IF, or FILTER. You do not usually
use that logic to select variables. It is possible to do so, through the use of
macros or, in the case of SPSS, Python, but it is not a standard approach.
If you have used SAS or SPSS for long, you probably know dozens of ways
to select observations, but you did not see them all in the first introductory
guide you read. With R, it is best to dive in and see all of the methods of
selecting variables because understanding them is the key to understanding
other documentation, especially the help files and discussions on the R-help
mailing list. Even though you select variables and observations in R using
almost identical methods, I will describe them in two different chapters, with
different example programs. This chapter focuses only on selecting variables.
In the next chapter I will use almost identical descriptions with very similar
examples for selecting observations. I do so to emphasize the similarity of the
two tasks, as this is such an alien concept to SAS and SPSS users. In the
relatively short Chap. 9, I will combine the methods and show how to select
variables and observations simultaneously.

7.1 Selecting Variables in SAS and SPSS

Selecting variables in SAS or SPSS is quite simple. It is worth reviewing their
basic methods before discussing R’s approach. Our example data set contains
the following variables: workshop, gender, ql, q2, g3, and q4. SAS lets you
refer to them by individual name or in contiguous order separated by double
dashes, “-=,” as in
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PROC MEANS DATA=myLib.mydata; VAR workshop--q4;

SAS also uses a single dash, “-.” to request variables that share a numeric
suffix, even if they are not next to each other in the data set:

PROC MEANS DATA=myLib.mydata; VAR ql-qg4;

You can select all variables beginning with the letter “q” using the colon
operator.

PROC MEANS DATA=myLib.mydata; VAR q: ;

Finally, if you do not tell it which variable to use, SAS uses them all.
SPSS allows you to list variables names individually or with contiguous
variables separated by “TO,” as in

DESCRIPTIVES VARIABLES=gender to q4.

If you want SPSS to analyze all variables in a data set, you use the keyword
ALL.

DESCRIPTIVES VARIABLES=ALL.

SPSS’s main command language does not offer a built-in way to easily
select variables that begin with a common root like “q”. However, the company
provides the SPSS extension command SPSSINC SELECT VARIABLES that
can make this type of selection.

Now let us turn our attention to how R selects variables.

7.2 Subscripting

In Chap. 5, “Programming Language Basics,” I described how you could select
the elements (values) of a vector or matrix or the components (often variables)
of a data frame or list using subscripting. Subscripting allows you to follow an
object’s name with selection information in square brackets:

vector [elements]
matrix[rows, columns]
datal[rows, columns]

list[[component]]

As you will see throughout this chapter and the next, the selection infor-
mation you place in the subscript brackets can be index values (e.g., 1, 2, 3,
etc.), logical selections (e.g., gender == “f”), or names (e.g., “gender”).
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If you leave the subscripts out, R will process all rows and all columns.
Therefore, the following three statements have the same result, a summary
of all the rows (variables) and all the columnns (observations or cases) of
mydata:

summary ( mydata )
summary( mydatal ] )
summary ( mydatal , ] )

This chapter focuses on the second parameter, the columns (variables).

7.3 Selecting Variables by Index Number

Coming from SAS or SPSS, you would think a discussion of selecting variables
in R would begin with variable names. R can use variable names, of course,
but column index numbers are more fundamental to the way R works. That is
because objects in R do not have to have names for the elements or components
they contain, but they always have index numbers.

Our data frame has six variables or columns, which are automatically given
index numbers, or indices, of 1, 2, 3, 4, 5, and 6. You can select variables by
supplying one index number or a vector of indices in subscript brackets. For
example,

summary ( mydatal ,3] )

selects all rows of the third variable or column, 1. If you leave out a subscript,
it will assume you want them all. If you leave the comma out completely, R
assumes you want a column, so

summary ( mydatal[3] )
is almost the same as
summary ( mydatal ,3] )

Both refer to our third variable, ql. While the summary function treats the
presence or absence of the comma in the same way, some functions will have
problems. That is because with a comma, the variable selection passes a vector
and without a comma, it passes a data frame that contains only one vector.
To the summary function the result is the same, but some functions prefer one
form or the other. See Chap. 10.19, “Converting Data Structures,” for details.

To select more than one variable using indices, you combine the indices
into a vector using the c function. Therefore, this will analyze variables 3
through 6.

summary ( mydatal c(3,4,5,6) 1 )
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You will see the ¢ function used in many ways in R. Whenever R requires
one object and you need to supply it several, it combines the several into one.
In this case, the several index numbers become a single numeric vector.

W,

The colon operator “:” can generate a numeric vector directly, so
summary ( mydatal[3:6] )

will use the same variables.
Unlike SAS’s use of

workshop--q4
or SPSS’s use of
workshop TO q4

the colon operator is not just shorthand. We saw in an earlier chapter that
entering 1:N causes R to generate the sequence, 1, 2, 3,...N. If you use a
negative sign on an index, you will exclude those columns. For example,

summary ( mydatal -c(3,4,5,6) 1 )

will analyze all variables exzcept for variables 3, 4, 5, and 6. Your index values
must be either all positive or all negative. Otherwise, the result would be
illogical. You cannot say, “include only these” and “include all but these” at
the same time. Index values of zero are accepted but ignored.

The colon operator can abbreviate patterns of numbers, but you need to
be careful with negative numbers. If you want to exclude columns 3:6, the
following approach will not work:

> -3:6

[1] -3 -2 -1 0123456
This would, of course, generate an error since you cannot exclude 3 and include
3 at the same time. Adding parentheses will clarify the situation, showing R

that you want the minus sign to apply to just the set of numbers from +3
through +6 rather than -3 through +6:

> -(3:6)
[1] -3 -4 -5 -6

Therefore, we can exclude variables 3 through 6 with
summary( mydatal -(3:6) ] )

If you find yourself working with a set of variables repeatedly, you can
easily save a vector of indices so you will not have to keep looking up index
numbers:

myQindices <- c(3, 4, 5, 6)
summary ( mydata[myQindices] )
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You can list indices individually or, for contiguous variables, use the colon
operator. For a large data set, you could use variables 1, 3, 5 through 20, 25,
and 30 through 100 as follows:

myindices <- c(1, 3, 5:20, 25, 30:100)

This is an important advantage of this method of selecting variables. Most
of the other variable selection methods do not easily allow you to select mixed
sets of contiguous and noncontiguous variables, as you are used to doing in
either SAS or SPSS. For another way to do this, see “Selecting Variables Using
the subset Function”, Sect. 7.9.

If your variables follow patterns such as every other variable or every tenth,
see Chap. 12 for ways to generate other sequences of index numbers.

The names function will extract a vector of variable names from a data
frame. The data.frame function, as we have seen, combines one or more
vectors into a data frame and creates default row names of “1,” “2,” “3.” etc.
Combining these two functions is one way to quickly generate a numbered list
of variable names that you can use to look up index values:

> data.frame( names(mydata) )

names.mydata.
workshop
gender

ql

q2

q3

q4

O WN -

It is easy to rearrange the variables to put the four q variables in the be-
ginning of the data frame. In that way, you will easily remember, for example,
that g3 has an index value of 3 and so on.

Storing them in a separate data frame is another way to make indices easy
to remember for sequentially numbered variables like these. However, that
approach runs into problems if you sort one data frame, as the rows then no
longer match up in a sensible way. Correlations between the two sets would
be meaningless.

The ncol function will tell you the number of columns in a data frame.
Therefore, another way to analyze all your variables is

summary( mydatal 1:ncol(mydata) ] )

If you remember that gl is the third variable and you want to analyze all
of the variables from there to the end, you can use

summary( mydatal 3:ncol(mydata) ] )
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7.4 Selecting Variables by Column Name

Variables in SAS and SPSS are required to have names, and those names
must be unique. In R, you do not need them since you can refer to variables
by index number as described in the previous section. Amazingly enough, the
names do not have to be unique, although having two variables with the same
name would be a terrible idea! R data frames usually include variable names,
as does our example data: workshop, gender, ql, g2, g3, q4.

Both SAS and SPSS store their variable names within their data sets.
However, you do not know exactly where they reside within the data set.
Their location is irrelevant. They are in there somewhere, and that is all you
need to know. However, in R, they are stored within a data frame in a place
called the names attribute. The names function accesses that attribute, and
you can display them by entering

> names (mydata)

[1] "workshop" "gender"  "ql" "g2" "q3" "q4"
To select a column by name, you put it in quotes, as in
summary ( mydatal["q1"] )
R still uses the form
mydatal[row, column]

However, when you supply only one index value, it assumes it is the column.
So

summary ( mydatal ,"q1"] )

works as well. Note that the addition of the comma before the variable name
is the only difference between the two examples above. While the summary
function treats the presence or absence of a comma the same, some functions
will have problems. That is because with a comma, the selection results in a
vector, and without a comma, the selection is a data frame containing only
that vector. See Sect. 10.19 for details.

If you have more than one name, combine them into a single character
vector using the c¢ function. For example,

summary( mydata[ C("ql","q2","q3","q4") :| )

Since it is tedious to write out so many variables repeatedly, sets of variable
names are often stored in character vectors. This allows you to easily use the
vector as what SAS or SPSS would call macro substitution. For example, we
can make that same selection with:
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manameS <- C("ql" s l|q2|l , |’q3" s llq4")
summary ( mydata[myQnames] )

When I start working with a new data set, I often create several sets of
variables like that and use them throughout my analysis. I usually try to make
them as short and descriptive as possible For example, “Qs” for questions and
“demos” for demographics. However, throughout this chapter I have selected
the questions using several methods and I want the names longer to clarify
the examples.

In that last example, the q variable names all ended in numbers, which
would have allowed SAS users to refer to them as ql-q4. Although we have
seen that R’s colon operator can use 1:4 to generate 1, 2, 3, 4, it does not
work directly with character prefixes. So the form ql:q4 does not work in this
context. However, you can paste the letter “q” onto the numbers you generate
using the paste function:

manames <— paste( nqn’ 1:4’ sep = nu)

summary ( mydata[myQnames] )
The paste function call above has three arguments:

1. The string to paste, which for this example is just the letter “q.”

2. The object to paste it to, which is the numeric vector 1, 2, 3, 4 generated
by the colon operator 1:4.

3. The separator character to paste between the two. Since this is set to "",
the function will put nothing between “q” and “1,” then “q” and “2,” and
SO on.

R will store the resulting names “ql,” “q2,” “q3,” “q4” in the character
vector myQnames. You can use this approach to generate variable names to
use in a variety of circumstances. Note that merely changing the 1:4 above to
1:400 would generate the sequence from ql to q400.

R can easily generate other patterns of repeating values that you can use
to create variable names. For details, see Chap. 12, “Generating Data.”

For another way to select variables by name using the colon operator, see
“Selecting Variables Using the Subset Function,” Sect. 7.9.

7.5 Selecting Variables Using Logic

You can select a column by using a logical vector of TRUE/FALSE values.
You can enter one manually or create one by specifying a logical condition.
Let us begin by entering one manually. For example,

summary ( mydatal c(FALSE, FALSE, TRUE, FALSE, FALSE, FALSE) ] )
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will select the third column, q1, because the third value is TRUE and the third
column is q1. In SAS or SPSS, the digits 1 and 0 can represent TRUE and
FALSE, respectively. They can do this in R, but they first require processing
by the as.logical function. Therefore, we could also select the third variable
with

summary( mydatal[ as.logical( ¢(0, 0, 1, 0, 0, 0) ) 1)

If we had not converted the 0/1 values to logical FALSE/TRUE, the above
function call would have asked for two variables with index values of zero. Zero
is a valid value, but it is ignored. It would have then asked for the variable
in column 1, which is workshop. Finally, it would have asked for three more
variables in column zero. The result would have been an analysis only for the
first variable, workshop. It would have been a perfectly valid, if odd, request!

Luckily, you do not have to actually enter logical vectors like those above.
Instead, you will generate a vector by entering a logical statement such as

names (mydata) == "q1"

That logical comparison will generate the following logical vector for you:
FALSE, FALSE, TRUE, FALSE, FALSE, FALSE

Therefore, another way of analyzing ql is

summary ( mydatal names(mydata) == "qi1" ] )

While that example is good for educational purposes, in actual use you
would prefer one of the shorter approaches using variable names:

summary ( mydata["q1"] )

Once you have mastered the various approaches of variable selection, you
will find yourself alternating among the methods, as each has its advantages
in different circumstances.

The “==" operator compares every element of a vector to a value and
returns a logical vector of TRUE/FALSE values. The vector length will match
the number of variables, not the number of observations, so we cannot store
it in our data frame. So if we assigned it to an object name, it would just
exist as a vector in our R workspace. As we will see in the next chapter, a
similar selection on observations can be stored in the data frame very much
like SPSS’s filter variables.

The “!” sign represents NOT, so you can also use that vector to get all of
the variables except for q1 using the form

summary ( mydatal !names(mydata) == "qi" 1 )
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To use logic to select multiple variable names, we can use the OR operator,
. For example, select q1 through g4 with the following approach. Complex
selections like this are much easier when you do it in two steps. First, create
the logical vector and store it; then use that vector to do your selection. In
the name myQtf below, I use the “tf” part to represent TRUE/FALSE. That
will help us remind that this is a logical vector.

££|77

myQtf <- names(mydata) == "qi1" |
names (mydata) == "q2" |
names (mydata) == "q3" |
names (mydata) == "g4"

Then we can get summary statistics on those variables using
summary ( mydata[myQtf] )

Whenever you are making comparisons to many values, you can use the
%inY, operator. This will generate exactly the same logical vector as the OR
example above:

myQtf <- names(mydata) %in}% c("ql","q2","q3","q4")

summary ( mydata[myQtf] )

You can easily convert a logical vector into an index vector that will select
the same variables. For details, see “Converting Data Structures,” Sect. 10.19.

7.6 Selecting Variables by String Search (varname: or
varnamel-varnamelN)

You can select variables by searching all of the variable names for strings of
text. This approach uses the methods of selection by index number, name,
and logic as discussed above, so make sure you have mastered them before
trying this.

SAS uses the form:

VAR q: ;

to select all of the variables that begin with the letter q. SAS also lets you
select variables in the form

PROC MEANS; VAR ql-qg4;

which gets only the variables q1, q2, q3, and g4 regardless of where they occur
in the data set or how many variables may lie in between them. The searching
approach we will use in R handles both cases.
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The main SPSS syntax does not offer this type of selection but it can do
full string searches via Python using the SPSS extension command SPSSINC
SELECT VARIABLES.

R searches variable names for patterns using the grep function. The name
grep itself stands for global regular expression print. It is just a fancy name
for a type of search.

The grep function creates a vector containing variable selection criteria
we need in the form of indices, names, or TRUE/FALSE logical values. The
grep function and the rules that it follows, called reqular expressions, appear
in many different software packages and operating systems.

SAS implements this type of search in the PRX function (Perl Regular
eXpressions), although it does not need it for this type of search. Below we
will use the grep function to find the index numbers for names for those that
begin with the letter q:

myQindices <- grep(""q", names(mydata), value = FALSE)

The grep function call above uses three arguments.

1. The first is the command string, or regular expression, “~p”, which means,
“find strings that begin with lowercase p.” The symbol “~” represents “be-
gins with.” You can use any regular expression here, allowing you to search
for a wide range of patterns in variable names. We will discuss using wild-
card patterns later.

2. The second argument is the character vector that you wish to search,
which, in our case, is our variable names. Substituting names (mydata)
here will extract those names.

3. The value argument tells it what to return when it finds a match. The
goal of grep in any computer language or operating system is to find
patterns. A value of TRUE here will tell it to return the variable names
that match the pattern we seek. However, in R, indices are more important
than names, so the default setting is FALSE to return indices instead. We
could leave it off in this particular case, but we will use it the other way
in the next example, so we will list it here for educational purposes.

The contents of myQindices will be 3, 4, 5, 6. In all our examples that use
that name, it will have those same values.
To analyze those variables, we can then use

summary ( mydata[myQindices] )

Now let us do the same thing but have the grep function save the actual
variable names. All we have to do is set value = TRUE.

myQnames <- grep("~q", names(mydata), value = TRUE)

The character vector myQnames now contains the variable names “ql,” “q2,”
“q3,” and “q4,” and we can analyze those variables with
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summary( mydata[myQnames] )

This approach gets what we expected: variable names. Since it uses names,
it makes much more sense to a SAS or SPSS user. So, why did I not do this
first? Because in R, indices are more flexible than variable names.

Finally, let us see how we would use this search method to select variables
using logic. The %in% operator works just like the IN operator in SAS. It finds
things that occur in a set of character strings. We will use it to find when a
member of all our variable names (stored in mynames) appears in the list of
names beginning with “q” (stored in myQnames). The result will be a logical
set of TRUE/FALSE values that indicate that the q variables are the last
four:

FALSE, FALSE, TRUE, TRUE, TRUE, TRUE

We will store those values in the logical vector myQtf:
myQtf <- names(mydata) %in)% myQnames

Now we can use the myQtf vector in any analysis we like:
summary ( mydata[myQtf] )

It is important to note that since have been searching for variables that
begin with the letter “q,” our program would have also found variables qA
and B if they had existed. We can narrow our search with a more complex
search expression that says the letter “q” precedes at least one digit. This
would give us the ability to simulate SAS’s ability to refer to variables that
have a numeric suffix, such as “varl-var100.”

This is actually quite easy, although the regular expression is a bit cryptic.

It requires changing the myQnames line in the example above to the following:
myQnames <- grep("~q[1-9]", names(mydata), value = TRUE)

This regular expression means “any string that begins with ‘q,” and is followed
by one or more numerical digits.” Therefore, if they existed, this would select
ql, q27, and qlold but not qA or gB. You can use it in your programs by
simply changing the letter q to the root of the variable name you are using.

You may be more familiar with the search patterns using wildcards in Mi-
crosoft Windows. That system uses “*” to represent any number of characters
and “?7” to represent any single character. So the wildcard version of any vari-
able name beginning with the letter ¢ is “q*.” Computer programmers call this
type of symbol a “glob,” short for global. R lets you convert globs to regular
expressions with the glob2rx function. Therefore, we could do our first grep
again in the form

myQindices <- grep(glob2rx("qg+*"), names(mydata), value = FALSE)

Unfortunately, wildcards or globs are limited to simple searches and cannot
do our example of q ending with any number of digits.
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7.7 Selecting Variables Using $ Notation

You can select a column using $ notation, which combines the name of the
data frame and the name of the variable within it, as in

summary ( mydata$ql )

bEIN14

This is referred to in several ways in R, including “$ prefixing,” “prefixing by
dataframe$,” or “$ notation.” When you use this method to select multiple
variables, you need to combine them into a single object like a data frame, as
in

summary( data.frame( mydata$ql, mydata$q2 ) )

Having seen the c function, your natural inclination might be to use it for
multiple variables as in

summary( c( mydata$ql, mydata$q2 ) ) # Not good!

This would indeed make a single object, but certainly not the one a SAS or
SPSS user expects. The ¢ function would combine them both into a single
variable with twice as many observations! The summary function would then
happily analyze the new variable. When the data.frame function combines
vectors into a single data frame, they remain separate vectors within that data
frame. That is what we want here.

An important limitation of dollar notation is that you cannot use it with
a matrix. Recall that in Sect. 5.3.4 we put our q variables into mymatrix. The
variable names went along with the vectors. Therefore, this form would work:

mymatrix[ ,"ql"] # Good
but this would not:
mymatrix$ql # Not good!

As a result, some R users who use matrices that contain row and column
names tend to prefer using names in subscripts since this works with matrices
and data frames.

7.8 Selecting Variables by Simple Name

This section introduces the use of short names for variables stored in a data
frame, like gender instead of mydata$gender. I will cover the technical details
in Chap. 13, “Managing Your Files and Workspace.”

In SAS and SPSS, you refer to variables by short names like gender or ql.
You might have many data sets that contain a variable named gender, but
there is no confusion since you have to specify the data set in advance. In SAS,
you can specify the data set by adding the DATA= option on every procedure.
Alternatively, since SAS will automatically use the last data set you created,
you can pretend you just created a data set by using:
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OPTIONS _LAST_=myLib.mydata;

Every variable selection thereafter would use that data set.

In SPSS, you clarify which data set you want to use by opening it with
GET FILE. If you have multiple data sets open, you instead use DATASET
NAME.

In R, the potential for confusing variable names is greater because it is
much more flexible. For example, you can actually correlate a variable stored
in one data frame with a variable stored in a different data frame! All of the
variable selection methods discussed above made it perfectly clear which data
frame to use, but they required extra typing. You can avoid this extra typing
in several ways.

7.8.1 The attach Function

One approach R offers to simplify the selection of variables is the attach
function. You attach a data frame using the following function call:

attach(mydata)

Once you have done that, you can refer to just ql, and R will know which one
you mean. With this approach, getting summary statistics might look like

summary (q1)
or
summary( data.frame(ql, g2, 93, q4) )

If you finish with that data set and wish to use another, you can detach it
with

detach( mydata )

Objects will detach automatically when you quit R, so using detach is
not that important unless you need to use those variable names stored in a
different data frame. In that case, detach one file before attaching the next.

The attach function works well when selecting existing variables, but it is
best avoided when creating them. An attached data frame can be thought of as
a temporary copy, so changes to existing variables will be lost. Therefore, when
adding new variables to a data frame, you need to use any of the other above
methods that make it absolutely clear where to store the variable. Afterward,
you can detach the data and attach it again to gain access to the modified
or new variables. We will look at the attach function more thoroughly in
Chap. 13, “Managing Your Files and Workspace.”
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7.8.2 The with Function

The with function is another way to use short variable names. It is similar
to using the attach function, followed by any other single function, and then
followed by a detach function. The following is an example:

with( mydata, summary( data.frame(ql, 92, 93, q4) ) )

It lets you use simple names and even lets you create variables safely. The
downside is that you must repeat it with every function, whereas you might
need the attach function only once at the beginning of your program. The
added set of parentheses also increases your odds of making a mistake. To
help avoid errors, you can type this as

with( mydata,
summary( data.frame(ql, 92, g3, q4) )
)

7.8.3 Using Short Variable Names in Formulas

A third way to use short variable names works only with modeling functions.
Modeling functions use formulas to perform analyses like linear regression or
analysis of variance. They also have a data argument that specifies which data
frame to use. This keeps formulas much shorter.

At first glance, R’s data argument looks just like SAS’s DATA option. How-
ever, while each SAS procedure has a DATA option, R’s data argument is found
usually only in modeling functions. In addition, R’s data argument applies
only to the modeling formula itself!

Here are two ways to perform a linear regression. First, using dollar nota-
tion:

In( mydata$q4 ~ mydata$ql + mydata$q2 + mydata$q3 )

The following is the same regression, using the data argument to tell the
function which data frame to use:

Im(g4 ~ ql + g2 + g3, data = mydata)

As formulas get longer, this second approach becomes much easier. For
functions that feature a data argument, this is the approach I recommend. It
is easier to use than either the attach or with functions. It also offers other
benefits when making predictions from a model. We will defer that discussion
to Chap. 17, “Statistics.”

To use this approach, all of the data must reside in the same data frame,
making it less flexible. However, it is usually a good idea to have all of the
variables in the same data frame anyway.

That rule has important implications that may not occur to you at first.
Recall that we initially created our variables as vectors and then combined
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them into a data frame. Until we deleted the redundant vectors, they existed
in our workspace both in and outside of the data frame. Any nonmodeling
function would choose a vector if you referred to it by its short name. But in a
modeling function, using the data argument would force R to use the variable
in the data frame instead. If you used a modeling function and did not use
the data argument, then the function would use the variables stored outside
the data frame. In this example, the two sets of variables were identical, but
that is not always the case.

It is also important to know that the data = mydata argument applies only
to the variables specified in the formula argument. Some modeling functions
can specify which variables to use without specifying a formula. In that case,
you must use an alternate approach (attach or with) if you wish to use shorter
variable names. We will see an example of this when doing t-tests in Chap. 17.

7.9 Selecting Variables with the subset Function

R has a subset function that you can use to select variables (and observa-

tions). It is the easiest way to select contiguous sets of variables by name such
as in SAS

PROC MEANS; VAR ql--q4;

or in SPSS

DESCRIPTIVES VARIABLES=ql to q4.

It follows the form

subset (mydata, select = ql:q4)

For example, when used with the summary function, it would appear as
summary ( subset(mydata, select = ql:q4 ) )

or

summary ( subset(mydata, select = c(workshop, ql:q4) ) )

The second example above contains three sets of parentheses. It is very easy
to make mistakes with so many nested functions. A syntax-checking editor will
help. Another thing that helps is to split them across multiple lines:

summary (
subset (mydata, select = c(workshop, ql:q4) )
)

It is interesting to note that when using the ¢ function within the subset
function’s select argument, it combines the variable names, not the vectors
themselves. So the following example will analyze the two variables separately:
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summary (
subset (mydata, select = c(ql,q2) ) # Good
)

That is very different from
summary ( c(mydata$ql, mydata$q2) ) # Not good

which combines the two vectors into one long one before analysis.

While the form 1:N works throughout R, the form vari:varN is unique
to the subset function. That and its odd use of the ¢ function in combining
variable names irritates some R users. I find that its usefulness outweighs its
quirks.

7.10 Selecting Variables by List Subscript

Our data frame is also a list. The components of the list are vectors that
form the columns of the data frame. You can address these components of the
list using a special type of subscripting. You place an index value after the
list’s name enclosed in two square brackets. For example, to select our third
variable, we can use

summary ( mydatal[[3]] )
With this approach, the colon operator will not extract variables 3 through 6:

mydatal[[3:6]] # Will NOT get variables 3 through 6.

7.11 Generating Indices A to Z from Two
Variable Names

We have discussed various variable selection techniques. Now we are ready to
examine a method that blends several of those methods together. If you have
not mastered the previous examples, now would be a good time to review
them.

We have seen how the colon operator can help us analyze variables 3
through 6 using the form

summary ( mydata[3:6] )

With that method, you have to know the index numbers, and digging
through lists of variables can be tedious work. However, we can have R do
that work for us, finding the index value for any variable name we like. This
call to the names function,

names (mydata) == "q1"
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will generate the logical vector
FALSE, FALSE, TRUE, FALSE, FALSE, FALSE, FALSE

because ql is the third variable. The which function will tell us the index
values of any TRUE values in a logical vector, so

which( names(mydata) == "ql1" )

will yield a value of 3. Putting these ideas together, we can find the index
number of the first variable we want, store it in myqA, then find the last
variable, store it in myqZ, and then use them with the colon operator to
analyze our data from A to Z:

mygqA <- which( names(mydata) == "qi" )
myqZ <- which( names(mydata) == "g4" )

summary ( mydatal ,myqA:myqZ ] )

7.11.1 Selecting Numeric or Character Variables

When a data frame contains both numeric and character variables, it can be
helpful to select all of one or the other. SAS does this easily; SPSS would
require a Python program to do it. For example, in SAS to print only the
numeric variables followed by only the character ones you could use:

PROC PRINT; VAR _NUMERIC_;
PROC PRINT; VAR _CHARACTER_;

If you wanted to limit your selection to the specific type of variables that
fall between variables A and Z, you would use:

PROC PRINT; VAR A-NUMERIC-Z;
PROC PRINT; VAR A-CHARACTER-Z;

This is easy to do in R, since the class function can check the type of
variable. There is a series of functions that test if a variable’s class is numeric,
character, factor, or logical. Let us use the is.numeric function to see if some
variables are numeric:

> is.numeric( mydata$workshop )
[1] FALSE

> is.numeric( mydata$ql )
[1] TRUE
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So we see that workshop is not numeric (it is a factor) but gl is. We would
like to apply that test to each variable in our data frame. Unfortunately, that
puts us into territory that we will not fully cover until Sect. 10.2. However, it
is not much of a stretch to discuss some of it here. The sapply function will
allow us to use the is.numeric function with each variable using the following
form:

> myNums <- sapply(mydata, is.numeric)

> myNums
workshop  gender ql q2 q3 q4
FALSE FALSE TRUE TRUE TRUE TRUE

Since myNums is a logical vector that contains the selection we seek, we
can now easily perform any analysis we like on only those variables using the
form:

> print( mydata[myNums] )

This example could easily be changed to select only character variables
using the is.character function or factors using the is.factor function.

We can also extend this idea to selecting only numeric variables that appear
between any two other variables. To do so, we need to refer back to the
previous section. Let us assume we want to get all the numeric variables that
lie between gender and g3.

First we need to determine the index numbers for the variables that de-
termine our range of interest.

> myA <- which( names(mydata) == "gender" )
> myA

(1] 2

> myZ <- which( names(mydata) == "q3" )
> myZ

(11 5
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So we see that part of our goal is to focus on variables 2 through 5. In
our simple data set, that is obvious, but in a more realistic example we would
want to be able to extract the values.

Next we need to create a logical vector that shows when the full range of
index values falls within the range we seek. We can do this with:

> myRange <- 1:length(mydata) %in)% myA:myZ
> myRange

[1] FALSE TRUE TRUE TRUE TRUE FALSE

Recall that the length of a data frame is the number of variables it contains,
and the %in% function finds when the elements of one vector are contained
within another. Knowing the values in our data set, we could have written
that statement as:

myRange <- 1:6 %in% 2:5

We now have two logical vectors: myNums, which shows us which are
numeric, and myRange which shows the range of variables in which we are
interested. We can now combine them and perform an analysis on the numeric
variables between gender and 3 with the following:

> print( mydata[ myNums & myRange ] )

ql 92 q3
1115
2 2 1 4
3. 2 2 4

Here is a warning that will remain cryptic until you read Sect. 10.2. The
following will not work as you might expect it to:

> apply(mydata, 2, is.numeric)

workshop  gender ql q2 q3 q4
FALSE FALSE FALSE FALSE FALSE FALSE

Why? Because the apply function coerces a data frame into becoming
a matrix. A matrix that contains any factors or character variables will be
coerced into becoming a character matrix!

> apply(mydata, 2, class)

workshop gender ql q2 q3...
"character" '"character" "character" '"character" '"character"...
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7.12 Saving Selected Variables to a New Data Set

You can use any variable selection method to create a new data frame that
contains only those variables. If we wanted to create a new data frame that
contained only the q variables, we could do so using any method described
earlier. Here are a few variations:

myqs <- mydatal[3:6]

myqs <_ mydata[ C("ql","q2","q3","q4") ]

This next example will work, but R will name the variables “mydata.ql,”
“mydata.q2,” and so forth, showing the data frame from which they came:

myqs <- data.frame(mydata$ql, mydata$q2,
mydata$q3, mydata$q4)

You can add variable name indicators to give them any name you like. With
this next one, we are manually specifying original names:

myqs <- data.frame(ql = mydata$ql, 92 = mydata$q2,
g3 = mydata$q3, g4 = mydata$qd)

Using the attach function, the data.frame function leaves the variable names
in their original form:

attach(mydata)
myqs <- data.frame(ql, 92, 93, g4)
detach(mydata)

Finally, we have the subset function with its unique and convenient use of
the colon operator directly on variable names:

myqs <- subset(mydata, select = ql:q4)

7.13 Example Programs for Variable Selection

In the examples throughout this chapter, we used the summary function to
demonstrate how a complete analysis request would look. However, here we
will use the print function to make it easier to see the result of each selection
when you run these programs. Even though

mydatal["ql"]
is equivalent to

print( mydatal["ql1"] )
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because print is the default function, we will use the longer form because it
is more representative of its look with most functions. As you learn R, you
will quickly choose the shorter approach when printing.

For most of the programming examples in this book, the SAS and SPSS
programs are shorter because the R programs demonstrate R’s greater flexibil-
ity. However, in the case of variable selection, SAS and SPSS have a significant
advantage in ease of use. These programs demonstrate roughly equivalent fea-
tures.

7.13.1 SAS Program to Select Variables

* Filename: SelectingVars.sas;

LIBNAME myLib 'C:\myRfolder';
OPTIONS _LAST_=myLib.mydata;

PROC PRINT; RUN;

PROC PRINT; VAR workshop gender ql g2 g3 q4; RUN;
PROC PRINT; VAR workshop--qg4; RUN;

PROC PRINT; VAR workshop gender ql-qg4; RUN;

PROC PRINT; VAR workshop gender q: ;

PROC PRINT; VAR _NUMERIC_; RUN;

PROC PRINT; VAR _CHARACTER_; RUN;

PROC PRINT; VAR workshop-NUMERIC-q4;  RUN;

PROC PRINT; VAR workshop-CHARACTER-q4; RUN;

* Creating a data set from selected variables;
DATA myLib.mygs;

SET myLib.mydata (KEEP=q1-q4) ;
RUN;;

7.13.2 SPSS Program to Select Variables
* Filename: SelectingVars.sps .

CD 'C:\myRfolder'.
GET FILE='mydata.sav'.

LIST.
LIST VARIABLES=workshop,gender,ql,q2,q93,q4.
LIST VARIABLES=workshop TO qg4.

* Creating a data set from selected variables.

SAVE OUTFILE='C:\myRfolder\myqgs.sav' /KEEP=ql TO qg4.
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7.13.3 R Program to Select Variables

# Filename: SelectingVars.R

# Uses many of the same methods as selecting observations.
setwd ("c:/myRfolder")
load(file = "myData.RData")

# This refers to no particular variables,
# so all are printed.
print (mydata)

# —-—--Selecting Variables by Index Number---

# These also select all variables by default.
print( mydatal ] )
print( mydatal , 1 )

# Select just the 3rd variable, ql.
print( mydatal ,3] ) #Passes g3 as a vector.
print( mydatal[3] )  #Passes g3 as a data frame.

# These all select the variables ql1,92,q3 and g4 by indices.
print( mydatal c(3, 4, 5, 6) 1)
print( mydatal 3:6 ] )

# These exclude variables ql1,92,q93,94 by indices.
print( mydatal -c(3, 4, 5, 6) 1)
print( mydatal -(3:6) 1 )

# Using indices in a numeric vector.
myQindices <- c(3, 4, 5, 6)
myQindices

print( mydata[myQindices] )

print( mydata[-myQindices] )

# This displays the indices for all variables.
print( data.frame( names(mydata) ) )

# Using ncol to find the last index.
print( mydatal 1:ncol(mydata) ] )
print( mydatal 3:ncol(mydata) ] )
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# --—-Selecting Variables by Column Name---

# Display all variable names.
names (mydata)

# Select one variable.
print( mydata["ql"] ) #Passes ql as a data frame.
print( mydatal ,"ql"] ) #Passes ql as a vector.

# Selecting several.
print( mydata[ C("ql", nq2u’ nq3u, nq4n) ] )

# Save a list of variable names to use.
manaIneS <_ C("ql" s llq2" s Ilq3l| s llq4|l)
myQnames

print ( mydata[myQnames] )

# Generate a list of variable names.
myQnames <- paste( "q", 1:4, sep = "")
myQnames

print( mydata[myQnames] )

# —-—-Selecting Variables Using Logic---

# Select ql by entering TRUE/FALSE values.
print( mydata[ c(FALSE,FALSE,TRUE,FALSE,FALSE,FALSE) ] )

# Manually create a vector to get just ql.
print( mydata[ as.logical( c(0, 0, 1, 0, 0, 0) ) 1)

# Automatically create a logical vector to get just ql.
print( mydatal[ names(mydata) == "qi" 1 )

# Exclude ql using NOT operator "!".

print( mydatal !names(mydata) == "qi" ] )
# Use the OR operator, "|" to select ql through g4,
# and store the resulting logical vector in mygs.
myQtf <- names(mydata) == "ql1" |

names (mydata) == "q2" |

names (mydata) == "q3" |

names (mydata) == "qg4"
myQtf

print( mydata[myQtf] )
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# Use the %inJ% operator to select ql through q4.
myQtf <- names(mydata) %in}% c("ql", "g2", "q3", "q4")
myQtf

print( mydata[myQtf] )

# -—-Selecting Variables by String Search---

# Use grep to save the q variable indices.

myQindices <- grep("~"q", names(mydata), value = FALSE)
myQindices

print( mydata[myQindices] )

# Use grep to save the q variable names (value = TRUE now).
myQnames <- grep("~q", names(mydata), value = TRUE)
myQnames

print( mydata[myQnames] )

# Use %in% to create a logical vector
# to select q variables.

myQtf <- names(mydata) %in) myQnames
myQtf

print( mydata[myQtf] )

# Repeat example above but searching for any
# variable name that begins with q, followed
# by one digit, followed by anything.
myQnames <- grep("~ql[:digit:]JI\{1\}",

names (mydata), value = TRUE)
myQnames
myQtf <- names(mydata) %in)% myQnames
myQtf
print( mydata[myQtf] )

# Example of how glob2rx converts g* to “q.
glob2rx("g*")
# ---Selecting Variables Using $ Notation---

print( mydata$ql )
print( data.frame(mydata$ql, mydata$q2) )
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# -—-Selecting Variables by Simple Name---

# Using the "attach" function.
attach(mydata)

print(ql)

print( data.frame(ql, 92, 93, q4) )
detach(mydata)

# Using the "with" function.
with( mydata,

summary ( data.frame(ql, 92, 93, q4) )
)

# —-—-Selecting Variables with subset Function--—-
print( subset(mydata, select = ql:q4) )
print( subset(mydata,
select = c(workshop, ql:q4)
) )

# -—-Selecting Variables by List Subscript--—-

print( mydatal[3]] )

# ---Generating Indices A to Z from Two Variables---
mygA <- which( names(mydata) == "qi1" )

myqgA

myqZ <- which( names(mydata) == "q4" )

myqZ

print( mydatal[myqA:myqZ] )

# —-—-Selecting Numeric or Character Variables——-

is.numeric( mydata$workshop )
is.numeric( mydata$ql )

# Find numeric variables
myNums <- sapply(mydata, is.numeric)
myNums
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print( mydata[myNums] )

myA <- which( names(mydata) == "gender" )
myA

myZ <- which( names(mydata) == "q3" )

myZ

myRange <- 1:length(mydata) %in’ myA:myZ
myRange

print( mydata[ myNums & myRange ] )

apply(mydata, 2, is.numeric)
apply(mydata, 2, class)

as.matrix(mydata)

# ---Creating a New Data Frame of Selected Variables---

myqs <- mydatal[3:6]

myqs

myqs <- mydatal c("ql1", "q2", "q3", "q4") 1]

myqs

myqgs <- data.frame(mydata$ql, mydata$q2,
mydata$q3, mydata$q4d)

myqs

myqs <- data.frame(ql = mydata$ql, 92 = mydata$q2,

g3 = mydata$q3, g4 = mydata$q4d)
myqs
attach(mydata)
myqs <- data.frame(ql, 92, 93, g4)
myqs
detach(mydata)

myqs <- subset(mydata, select = ql:q4)
myqs
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Selecting Observations

It bears repeating that the approaches that R uses to select observations are,
for the most part, the same as those discussed in the previous chapter for
selecting variables. This chapter builds on that one, so if you have not read it
recently, now would be a good time to do so.

Here I focus only on selecting observations. The amount of repetition be-
tween this chapter and the last may seem tedious, but, I have found from
teaching that people learn much more easily when these topics are presented
separately.

If you followed the last chapter easily, feel free to skip this one until you
have problems using one of the approaches for selecting observations. The
next chapter will cover the selection of variables and observations at the same
time but will do so in much less detail.

8.1 Selecting Observations in SAS and SPSS

There are many ways to select observations in SAS and SPSS, and it is beyond
our scope to discuss them all here. However, we will look at some approaches
for comparison purposes. For both SAS and SPSS, if you do not select obser-
vations, they assume you want to analyze all of the data. So in SAS

PROC MEANS;
RUN;

will analyze all of the observations, and in SPSS
DESCRIPTIVES VARIABLES=ALL.

will also use all observations.
To select a subset of observations (e.g., the males), SAS uses the WHERE
statement.
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PROC MEANS;
WHERE gender="m";
RUN;

It is also common to create a logical 0/1 value in the form
female = gender='f';

which you could then apply with

PROC MEANS;
WHERE female;
RUN;

SPSS does the same selection using both the TEMPORARY and the
SELECT IF commands:

TEMPORARY .
SELECT IF(gender EQ "m").
DESCRIPTIVES VARIABLES=ALL.

If we had not used the TEMPORARY command, the selection would have
deleted the females from the data set. We would have had to open the data
set again if we wanted to analyze both groups in a later step. R has no similar
concept. Alternatively, we could create a variable that has a value of 1 for
observations we want and zero otherwise. Using that variable on the FILTER
command leaves a selection in place until a USE ALL brings the data back.
As we will see, R uses a similar filtering approach.

COMPUTE male=(gender="m"

FILTER BY male.

DESCRIPTIVES VARIABLES=workshop TO qg4.
* more stats could follow for males.
USE ALL.

8.2 Selecting All Observations

In R, if you perform an analysis without selecting any observations, the func-
tion will use all of the observations it can. That is how both SAS and SPSS
work. For example, to get summary statistics on all observations (and all
variables), we could use

summary (mydata)

The methods to select observations apply to all R functions that accept
variables (vectors and so forth) as input. We will use the summary function so
you will see the selection in the context of an analysis.
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8.3 Selecting Observations by Index Number

Although it is as easy to use subscripting to select observations by index
number, you need to be careful doing it. This is because sorting a data frame
is something you do often, and sorting changes the index number of each row
(if you save the sorted version, of course). Variables rarely change order, so
this approach is much more widely used to select them. That said, let us dive
in and see how R does it.

Since this chapter focuses on selecting observations, we will now discuss
just the first subscript, the rows. Our data frame has eight observations or
rows, which are automatically given index numbers, or indices, of 1, 2, 3, 4,
5, 6, 7, and 8. You can select observations by supplying one index number or
a vector of indices. For example,

summary ( mydatal5, ] )

selects all of the variables for only row 5. There is not much worth analyzing
with that selection! Note that when selecting observations, the comma is very
important, even though we request no columns in the example above. If you
leave the comma out, R will assume that any index values it sees are column
indices, and you will end up selecting variables instead of observations!

As long as you include the comma, this selection goes across columns of a
data frame, so it must return a one-row data frame. A data frame can contain
numeric, character, or factor variables. Only a data frame could store such a
mixture. That is the opposite of selecting the fifth variable with mydatal ,5]
because that would select a vector. In many cases, this distinction might not
matter, but in some cases it will. The difference will become clear as we work
through the rest of the book.

To select more than one observation using indices, you must combine them
into a numeric vector using the c function. Therefore, this will select rows 5
through 8, which happen to be the males:

summary ( mydatal c(5, 6, 7, 8, 1)

You will see the ¢ function used in many ways in R. Whenever R requires
one object and you need to supply it several, it combines the several into
one. In this case, the several index numbers become a single numeric vector.
Again, take note of the comma that precedes the right square bracket. If we
left that comma out, R would try to analyze variables 5 through 8 instead of
observations 5 through 8! Since we have only six variables, that would generate
an error message. However, if we had more variables, the analysis would run,
giving us the wrong result with no error message. I added extra spaces in this
example to help you notice the comma. You do not need additional spaces in
R, but you can have as many as you like to enhance legibility.

@, ”

The colon operator “:” can generate a numeric vector directly, so

summary( mydata[5:8, 1 )
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selects the same observations.

The colon operator is not just shorthand. Entering 1:N in an R program
will cause it to generate the sequence, 1,2,3,... ,N.

If you use a negative sign on an index, you will exclude those observations.
For example,

summary ( mydatal -c(1,2,3,4) , 1)

will exclude the first four records, three females and one with a gender of NA.
R will then analyze the males.

Your index values must be either all positive or all negative. Otherwise,
the result would be illogical. You cannot say “include only these observations”
and “include all but these observations” at the same time.

The colon operator can abbreviate sequences of numbers, but you need to
be careful with negative numbers. If you want to exclude rows 1 through 4,
the following sequence will not work:

> -1:4

[1] -1 0 1 2 3 4

This would, of course, generate an error because they must all have the same
sign. Adding parentheses will clarify the situation, showing R that you want
the minus sign to apply to just the set of numbers from +1 through +4 rather
than —1 through +4:

> -(1:4)
[1] -1 -2 -3 -4

> summary( mydatal -(1:4) , 1)

If you find yourself working with a set of observations repeatedly, you
can easily save a vector of indices so you will not have to keep looking up
index numbers. In this example, we are storing the indices for the males in
myMindices (M for male). If T were not trying to make a point about indices,
I would choose a simpler name like just “males.”

myMindices <- ¢(5,6,7,8)
From now on, we can use that variable to analyze the males:
summary ( mydata[myMindices, ] )

For a more realistic data set, typing all of the observation index numbers
you need would be absurdly tedious and error prone. We will use logic to create
that vector in Sect. 8.6. You can list indices individually or, for contiguous
observations, use the colon operator. For a larger data set, you could use
observations 1, 3, 5 through 20, 25, and 30 through 100 as follows:
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mySubset <- c(1, 3, 5:20, 25, 30:100)

See Chap. 12, “Generating Data,” for ways to generate other sequences of
index numbers.

It is easy to have R list the index for each observation in a data frame.
Simply create an index using the colon operator and append it to the front of
the data frame.

> data.frame(myindex = 1:8, mydata)

myindex workshop gender ql q2 g3 g4
1 1 R f 1 1 5 1
2 2 SAS f 2 1 4 1
3 3 R f 2 2 4 3
4 4 SAS <NA> 3 1 NA 3
5 5 R m 4 5 2 4
6 6 SAS m 5 4 5 5
7 7 R m 5 3 4 4
8 8 SAS m 4 5 5 5

Note that the unlabeled column on the left contains the row names. In our
case, the row names look like indices. However, the row names could have
been descriptive strings like “Bob,” so there is no guarantee of a relationship
between row names and indices. Index values are dynamic, like the case num-
bers displayed in the SAS or SPSS data editors. When you sort or rearrange
the data, they change. Row names, on the other hand, are fixed when you
create the data frame. Sorting or rearranging the rows will not change row
names.

You can use the nrow function to find the number of rows in a data frame.
Therefore, another way to analyze all your observations is

summary ( mydata[ 1:nrow(mydata) , 1 )

If you remember that the first male is the fifth record and you want to
analyze all of the observations from there to the end, you can use

summary ( mydatal 5:nrow(mydata) , 1 )

8.4 Selecting Observations Using Random Sampling

Selecting random samples of observations in SAS and SPSS is done in two to
three steps:

1. Create a variable whose values are uniformly random between zero and
one.
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2. Select observations whose values on that variable fall at or below the pro-
portion you seek. If an approximate number of observations is sufficient,
you are done.

3. If you seek an exact number of observations, you can assure that by sorting
on the random variable and then choosing the first n you want. Alterna-
tively, you might count each observation as you select it and stop selecting
when your goal is met. SPSS will even write the latter steps out for you
if you use the Data> Select Cases dialog box.

R uses an approach that takes advantage of the topic we just learned in
the previous section: subscripting by index value. The sample function will
select n values at random from any vector. If that vector holds the numbers 1,
2, 3...,N, where N is the number of observations in our data set, then we end
up sampling the index values for our rows. All that remains is to use those
values to select the observations.

Let us do an example where we want to select 25% of our data, a massive
data set of two whole records! The index values to sample are the values 1:8,
or, more generally, 1:nrow(mydata). To ensure that you get the same selection
as I do, I will use the set.seed function:

> set.seed(123)
> myindices <- sample( 1l:nrow(mydata), 2 )
> myindices

[1]1 3 6

The sample function call used just two arguments, the vector to sample
and how many to get: 2. We see the two index values are 3 and 6. Let us now
use them to select our sample from the main data set. I will put myindices in
the row position and leave the column position empty so that I will select all
the variables:

> mySample <- mydatal[myindices, ]
> print (mySample)

workshop gender ql g2 g3 g4
3 R f 2 2 4 3
6 SAS m 5 4 5 5

We see that our sample consists of one female who took the R workshop and
a male who took the SAS one.
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8.5 Selecting Observations by Row Name

SAS and SPSS data sets have variable names but not observation or case
names. In R, data frames always name the observations and store those names
in the row names attribute. When we read our data set from a text file, we
told it that the first column would be our row names. The row.names function
will display them:

row.names (mydata)
R will respond with
lllll’ ll2|l’ "3"’ |l4ll, ||5|l’ ll6|l’ |l7l|’ "8"

The quotes show that R treats these as characters, not as numbers. If you
do not provide an ID or name variable for R to use as row names, it will
always create them in this form. Therefore, if we had not had an ID variable,
we would have ended up in exactly the same state. I included an ID variable
because it emphasizes the need to be able to track your data back to its most
original source when checking for data entry errors. With such boring row
names, there is little need to use them. indices are numerically more useful.
So let us change the names; we will then have an example that makes more
sense.

I will use common first names to keep the example easy to follow. First,
let us create a new character vector of names:

> mynames <- c("Ann", "Cary", "Sue", "Carla",
"Bob" s "Scott" s "Mike" s "RiCh")
Now we will write those names into the row names attribute of our data frame:

row.names (mydata) <- mynames

This is a very interesting command! It shows that the row.names function
does not just show you the names, it provides access to the names attribute
itself. Assigning mynames to that vector renames all of the rows! In Sect. 10.6,
“Renaming Variables (and Observations),” we will see this again with several
variations.

Let us see how this has changed our data frame.

> mydata

workshop gender ql g2 g3 q4

Ann R f 1 1 5 1
Cary SAS f 2 1 4 1
Sue R f 2 2 4 3
Carla SAS <NA> 3 1 NA 3
Bob R m 4 5 2 4
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Scott SAS m 5 4 5 5
Mike R m 5 3 4 4
Rich SAS m 4 5 5 5

Now that we have some interesting names to work with, let us see what
we can do with them. If we wanted to look at the data for “Ann,” we could
use

mydata["Ann", ]

You might think that if we had several records per person, we could use
row names to select all of the rows for any person. R, however, requires that
row names be unique, which is a good idea.! You could always use an ID
number that is unique for row names, then have the subjects’ names on each
record in their set and a counter like time 1, 2, 3, 4. We will look at just that
structure in Sect. 10.17, “Reshaping Variables to Observations and Back.”

To select more than one row name, you must combine them into a single
character vector using the ¢ function. For example, we could analyze the
females using

summary ( mydatal[ c("Ann","Cary","Sue","Carla"), ] )

With a more realistically sized data frame, we would probably want to save
the list of names to a character vector that we could use repeatedly. Here, I
use F' to represent females and names to remind me of what is in the vector:

myFnames <- c("Ann","Cary","Sue","Carla")
Now we will analyze the females again using this vector:

summary ( mydata[ myFnames, ] )

8.6 Selecting Observations Using Logic

You can select observations by using a logical vector of TRUE/FALSE values.
You can enter one manually or create one by specifying a logical condition.
Let us begin by entering one manually. For example, the following will print
the first four rows of our data set:

> myRows <- c(TRUE, TRUE, TRUE, TRUE,
+  FALSE, FALSE, FALSE, FALSE)

> print( mydata[myRows, ] )

! Recall that R does allow for duplicate variable names, although that is a bad
idea.
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workshop gender ql q2 g3 q4

1 R f 1 1 56 1
2 SAS f 2 1 4 1
3 R f 2 2 4 3
4 SAS <NA> 3 1 NA 3

In SAS or SPSS, the digits 1 and 0 can represent TRUE and FALSE,
respectively. Let us see what happens when we try this in R.

> myBinary <- c(1, 1, 1, 1, 0, 0, 0, 0)
> print( mydata[myBinary, ] )

workshop gender ql g2 g3 q4

1 R f 1 1 5 1
1.1 R £f 1 1 5 1
1.2 R f 1 1 5 1
1.3 R f 1 1 5 1

What happened? Remember that putting a 1 in for the row subscript asks for
row 1. So our request asked for row 1 four consecutive times and then asked
for row 0 four times. Index values of zero are ignored. We can get around this
problem by using the as.logical function:

> myRows <- as.logical (myBinary)

Now, myRows contains the same TRUE/FALSE values it had in the previous
example and would work fine.

While the above examples make it clear how R selects observations using
logic, they are not very realistic. Hundreds of records would require an absurd
amount of typing. Rather than typing such logical vectors, you can generate
them with a logical statement such as

> mydata$gender == "f"

[1] TRUE TRUE TRUE NA FALSE FALSE FALSE FALSE

The “==" operator compares every value of a vector, like gender, to a value,
like “f”, and returns a logical vector of TRUE/FALSE values. These logical
conditions can be as complex as you like, including all of the usual logical
conditions. See Table 10.3, “Logical operators,” for details.

The length of the resulting logical vector will match the number of obser-
vations in our data frame. Therefore, we could store it in our data frame as a
new variable. That is essentially the same as the SPSS filter variable approach.

Unfortunately, we see that the fourth logical value is NA. That is because
the fourth observation has a missing value for gender. Up until this point, we
have been mirroring Chap. 7, “Selecting Variables.” There, logical comparisons
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of variable names did not have a problem with missing values. Now, however,
we must take a different approach. First, let us look at what would happen if
we continued down this track.

> print( mydata[ mydata$gender == "f", ] )

workshop gender ql g2 g3 q4

1 R f 1 1 56 1
2 SAS f 2 1 4 1
3 R f 2 2 4 3
NA <NA> <NA> NA NA NA NA

What happened to the fourth observation? It had missing values only for
gender and g3. Now all of the values for that observation are missing. R has
noticed that we were selecting rows based on only gender. Not knowing what
we would do with the selection, it had to make all of the other values missing,
too. Why? Because we might have been wanting to correlate q1 and q4. Those
two had no missing values in the original data frame. If we want to correlate
them only for the females, even their values must be set to missing.

We could select observations using this logic and then count on R’s other
functions to remove the bad observations as they would any others with miss-
ing values. However, there is little point in storing them. Their presence could
also affect future counts of missing values for other analyses, perhaps when
females are recombined with males.

Luckily, there is an easy way around this problem. The which function
gets the index values for the TRUE values of a logical vector. Let us see what
it does.

> which( mydata$gender == "f" )

[1] 123

It has ignored both the NA value and the FALSE values to show us that only
the first three values of our logical statement were TRUE. We can save these
index values in myFemales.

> myFemales <- which( mydata$gender == "f" )

> myFemales
[1]1 123

We can then analyze just the females with the following function call:
summary ( mydata[ myFemales , ] )

Negative index values exclude those rows, so we could analyze the non-
females (males and missing) with the following function call:
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summary ( mydata[-myFemales , ] )

We could, of course, get males and exclude missing the same way we got the
females.

We can select observations using logic that is more complicated. For exam-
ple, we can use the AND operator “&” to analyze subjects who are both male
and who “strongly agree” that the workshop they took was useful. Compound
selections like this are much easier when you do it in two steps. First, create
the logical vector and store it; then use that vector to do your selection.

> HappyMales <- which(mydata$gender == "m
+ & mydata$qd == 5)

> HappyMales
[1]1 6 8

So we could analyze these observations with
summary ( mydata[HappyMales , ] )

Whenever you are making comparisons to many values, you can use
the %inJ operator. Let us select observations who have taken the R or
SAS workshop. With just two target workshops, you could use a simple
workshop == "R" | workshop == "SPSS", but the longer the target list, the
happier you will be to save all of the repetitive typing.

> myRsas <-
+ which( mydata$workshop %inj, c("R","SAS") )

> myRsas
[1] 1357

Then we can get summary statistics on those observations using
summary ( mydata[myRsas, ] )

The various methods we described in Chap. 7, “Selecting Variables,” make a
big difference in how complicated the logical commands to select observations
appear. Here are several different ways to analyze just the females:

myFemales <- which( mydata$gender == "f")
myFemales <- which( mydata[2] == "f")
myFemales <- which( mydata["gender"] == "f")
with(mydata,

myFemales <- which(gender == "f")
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)

attach(mydata)
myFemales <- which(gender == "f")
detach(mydata)

You could then use any of these to analyze the data using
summary ( mydata[ myFemales, ] )

You can easily convert a logical vector into an index vector that will select
the same observations. For details, see Sect. 10.19, “Converting Data Struc-
tures.”

8.7 Selecting Observations by String Search

If you have character variables, or useful row names, you can select obser-
vations by searching their values for strings of text. This approach uses the
methods of selection by indices, row names, and logic discussed earlier, so
make sure you have mastered them before trying these.

R searches variable names for patterns using the grep function. We pre-
viously replaced our original row names, “1,” “2,” etc., with more interesting
ones, “Ann”, “Cary,” and so forth. Now we will use the grep function to search
for row names that begin with the letter “C”:

myCindices <- grep(""C", row.names(mydata), value = FALSE)
This grep function call uses three arguments.

1. The first is the command string, or regular expression, “~C,” which means
“find strings that begin with a capital letter C.” The symbol “~” represents
“begins with.” You can use any regular expression here, allowing you to
search for a wide range of patterns in variable names. We will discuss
using wildcard patterns later.

2. The second argument is the character vector that you wish to search.
In our case, we want to search the row names of mydata, so I call the
row.names function here.

3. The value argument tells it what to store when it finds a match. The goal
of grep in any computer language or operating system is to find patterns.
A value of TRUE here will tell it to save the row names that match the
pattern we seek. However, in R, indices are more fundamental than names,
which are optional, so the default setting is FALSE to save indices instead.
We could leave it off in this particular case, but we will use it in the other
way in the next example, so we will list it here for educational purposes.
The contents of myCindices will be 2 and 4 because Cary and Carla are
the second and fourth observations, respectively. If we wanted to save this
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variable, it does not match the eight values of our other variables, so we
cannot store it in our data frame. We would instead just store it in the
workspace as a vector outside our data frame.

To analyze those observations, we can then use
summary ( mydata[myCindices , ] )

Now let us do the same thing but have grep save the actual variable names.
All we have to do is change to value = TRUE:

myCnames <- grep("~C", row.names(mydata), value = TRUE)

The character vector myCnames now contains the row names “Cary” and
“Carla,” and we can analyze those observations with

summary ( mydata[myCnames , 1 )

Finally, let us do a similar search using the %in% function. In R, it works
just like the IN operator in SAS. It finds matches between two sets of values.
We will use it to find which of our row names appears in this set of target
names:

myTargetNames <- ("Carla","Caroline","Cary","Cathy","Cynthia")

myMatches <- row.names(mydata) %in}% myTargetNames

The result will be a logical set of TRUE/FALSE values that indicate that the
names that match are in the second and fourth positions:

FALSE, TRUE, FALSE, TRUE, FALSE, FALSE, FALSE, FALSE
Now we can use the myMatches vector in any analysis like summary:
summary ( mydata[myMatches, ] )

You may be more familiar with the search patterns using wildcards in
Microsoft Windows. They use “*” to represent any number of characters and
“?” to represent any single character. So the wildcard version of any variable
name beginning with the letter “C” is “C*.” Computer programmers call this
type of symbol a “glob,” short for global. R lets you convert globs to regular
expressions with the glob2rx function. Therefore, we could do our first grep
again in the form

myCindices <- grep( glob2rx("Cx"),
row.names (mydata), value = FALSE)
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8.8 Selecting Observations with the subset Function

You can select observations using the subset function. You simply list your
logical condition under the subset argument, as in

subset (mydata, subset = gender == "f")

Note that an equal sign follows the subset argument because that is what
R uses to set argument values. The gender == "f" comparison is still done
using “==" because that is the symbol R uses for logical comparisons. You can
use subset to analyze your selection using the form

summary (
subset (mydata, subset = gender == "f")

)

The following selection, in which we select the males who were happy with
their workshop, is slightly more complicated . In R, the logic is a single object,
a logical vector, regardless of its complexity.

summary (
subset( mydata, subset = gender == "m" & g4 == 5 )
)

Since the first argument to the subset function is the data frame to use,
you do not have to write out the longer forms of names like mydata$ql or
mydata$gender. Also, its logical selections automatically exclude cases for
which the logic would be missing. So it acts like the which function that is
built into every selection. That is a very helpful function!

8.9 Generating Indices A to Z from Two Row Names

This method uses several of the approaches from the previous examples. We
have seen how the colon operator can help us analyze the males, who are
observations 5 through 8, using the form

summary ( mydata[5:8, 1 )

However, you had to know the index numbers, and digging through lists of
observation numbers can be tedious work. However, we can use the row.names
function and the which function to get R to find the index values we need.
The function call

row.names (mydata) == "Bob"
will generate the logical vector

FALSE, FALSE, FALSE, FALSE, TRUE, FALSE, FALSE, FALSE
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because Bob is the fifth observation. The which function will tell us the index
values of any TRUE values in a logical vector, so

which(FALSE, FALSE, FALSE, FALSE,
TRUE, FALSE, FALSE, FALSE)

will yield a value of 5. Putting these ideas together, we can find the index
number of the first observation we want, store it in myMaleA, then find the last
observation, store it in myMaleZ, and then use them with the colon operator
to analyze our data from A to Z:

myMaleA <- which( names(mydata) == "Bob" )
myMaleZ <- which( names(mydata) == "Rich" )

summary ( mydatal[ myMaleA:myMaleZ , ] )

8.10 Variable Selection Methods with No Counterpart
for Selecting Observations

As we have seen, the methods that R uses to select variables and observa-
tions are almost identical. However, there are several techniques for selecting
variables that have no equivalent in selecting observations:

The $ prefix form (e.g., mydata$gender),

The attach function’s approach to short variable names,

The with function’s approach to short variable names,

The use of formulas.

The list form of subscripting that uses double brackets (e.g., mydata[[2]]),
Using variable types to select only numeric variables, character variables,
or factors.

We also had one method of selecting observations, random sampling, that
we used to select observations but not variables. That would be a most unusual
approach to selecting variables, but one that might be useful in an area such
as genetic algorithms.

8.11 Saving Selected Observations to a New Data Frame

You can create a new data frame that is a subset of your original one by using
any of the methods for selecting observations. You simply assign the data to
a new data frame. The examples below all select the males and assign them
to the myMales data frame:
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myMales <- mydata[5:8, ]
myMales <- mydata[ which(mydata$gender == "m") , ]

myMales <- subset( mydata, subset = gender == "m" )

8.12 Example Programs for Selecting Observations

The SAS and SPSS programs in this section demonstrate standard ways to se-
lect observations in those packages, and they match each other. The R program
uses different methods, especially subscripting, and is much more detailed.

8.12.1 SAS Program to Select Observations

* Filename: SelectingQObs.sas ;
LIBNAME myLib 'C:\myRfolder';

* Ways to Select Males and Females;
PROC PRINT DATA=myLib.mydata;
WHERE gender="m";
RUN;

PROC PRINT DATA=myLib.mydata; ;
WHERE gender="m" & q4=5;

DATA myLib.males;
SET myLib.mydata;
WHERE gender="m";
RUN;

PROC PRINT; RUN;

DATA myLib.females;
SET myLib.mydata;
WHERE gender="f";
RUN;

PROC PRINT; RUN;

* Random Sampling;

DATA myLib.sample;
SET myLib.mydata;
WHERE UNIFORM(123) <= 0.25;
RUN;

PROC PRINT; RUN;
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8.12.2 SPSS Program to Select Observations

Note that the UNIFORM function in SPSS is quite different from that of SAS.
Its only parameter is its highest value (usually 1), not the random generator
seed.

* Filename: SelectingObs.sps .

CD 'c:\myRfolder'.
GET FILE='mydata.sav'.

* Ways to Select Males and Females.
COMPUTE male=(gender="m").
COMPUTE female=(gender="f").

FILTER BY male.
LIST.
* analyses of males could follow here.

FILTER BY female.
LIST.
* analyses of females could follow here.

USE ALL.

DO IF male.

XSAVE OUTFILE='males.sav'.
ELSE IF female.

XSAVE OUTFILE='females.sav'.
END IF.

* Selecting a Random Sample.
SET SEED=123.

DO IF uniform(1) LE 0.25.
XSAVE OUTFILE='sample.sav'.
END IF.

LIST.

8.12.3 R Program to Select Observations

Throughout this chapter we have used the summary function to demonstrate
how a complete analysis request would look. Here we will instead use the
print function to make it easier to see the result of each selection when you
run the programs. Even though

mydata[5:8, ]
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is equivalent to
print( mydatal5:8, ] )

because print is the default function, we will use the longer form because it
is more representative of its look with most functions. As you learn R, you
will quickly opt for the shorter approach when you only want to print data.

# Filename: SelectingQObs.R

setwd("c:/myRfolder")
load(file = "myWorkspace.RData")
print (mydata)

# ——-Selecting Observations by Index---

# Print all rows.

print( mydatal ] )
print( mydatal , ] )
print( mydatal1:8, ] )

# Just observation 5.
print( mydatal5 , ] )

# Just the males:
print ( mydatal c(5, 6, 7, 8) , 1)
print( mydatal 5:8, 1 )

# Excluding the females with minus sign.
print( mydatal -c(1, 2, 3, 4), 1)
print( mydatal -(1:4), ] )

# Saving the Male (M) indices for reuse.
myMindices <- c(5, 6, 7, 8)
summary ( mydata[myMindices, ] )

# Print a list of index numbers for each observation.
data.frame(myindex = 1:8, mydata)

# Select data using length as the end.

print( mydatal 1:nrow(mydata), 1 )
print( mydatal 5:nrow(mydata), 1 )

# --—-Selecting Observations by Row Name---
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# Display row names.
row.names (mydata)

# Select rows by their row name.
print( mydata[ C("l", u2u’ nsn, u4n)’ ] )

# Assign more interesting names.

mynames <- c("Ann", "Cary", "Sue", "Carla",
"Bob", "Scott", "Mike", "Rich")

print (mynames)

# Store the new names in mydata.
row.names (mydata) <- mynames
print (mydata)

# Print Ann's data.
print( mydata["Ann" , ] )
mydata["Ann" , ]

# Select the females by row name.
print( mydatal c("Ann", "Cary", "Sue", "Carla"), ] )

# Save names of females to a character vector.
myFnames <- c("Ann", "Cary", "Sue", "Carla")
print (myFnames)

# Use character vector to select females.
print( mydata[ myFnames, ] )

# —---Selecting Observations Using Logic---

#Selecting first four rows using TRUE/FALSE.
myRows <- c(TRUE, TRUE, TRUE, TRUE,

FALSE, FALSE, FALSE, FALSE)
print( mydata[myRows, ] )

# Selecting first four rows using 1s and Os.
myBinary <- c(1, 1, 1, 1, 0, 0, 0, 0)

print( mydata[myBinary, ] )

myRows <- as.logical(myBinary)

print( mydatal myRows, ] )

# Use a logical comparison to select the females.

205
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mydata$gender == "f"

print( mydatal mydata$gender == "f", ] )

which( mydata$gender == "f" )

print( mydatal which(mydata$gender == "f") , 1 )

# Select females again, this time using a saved vector.
myFemales <- which( mydata$gender == "f" )

print (myFemales)

print( mydatal[ myFemales , ] )

# Excluding the females using the "!" NOT symbol.
print( mydata[-myFemales , ] )

# Select the happy males.

HappyMales <- which(mydata$gender == "m"
& mydata$qé4 == 5)

print (HappyMales)

print ( mydata[HappyMales , ] )

# Selecting observations using %in%.
myRsas <-
which( mydata$workshop %in’% c("R", "SAS") )
print (myRsas)
print( mydata[myRsas , ] )

# Equivalent selections using different
# ways to refer to the variables.

print( subset(mydata, gender == 'f') )
attach(mydata)

print( mydatal which(gender =
detach(mydata)

Ilfll) s ] )

with(mydata,
print ( mydatal which(gender == "f"), ] )
)
print( mydatal which(mydata["gender"] == "f") , ] )

print( mydatal which(mydata$gender == "£f") , 1 )

# ---Selecting Observations by String Search---
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# Search for row names that begin with "C".
myCindices <- grep(""C", row.names(mydata), value = FALSE)
print( mydata[myCindices , ] )

# Again, using wildcards.

myCindices <- grep( glob2rx("Cx")
row.names (mydata), value = FALSE)

print( mydata[myCindices , ] )

# ---Selecting Observations by subset Function---
subset (mydata, subset=gender == "f")
summary (

subset ( mydata, subset = gender == "m" & q4 == 5 )
)
# —---Generating indices A to Z from Two Row Names---
myMaleA <- which( row.names(mydata) == "Bob" )
print (myMaleA)
myMaleZ <- which( row.names(mydata) == "Rich" )
print (myMaleZ)

print( mydata[myMaleA:myMaleZ , ] )

# ——-Creating a New Data Frame of Selected Observations---

# Creating a new data frame of only males (all equivalent).
myMales <- mydata[5:8, ]

print (myMales)

myMales <- mydata[ which( mydata$gender == "m" ) , ]
print (myMales)

myMales <- subset( mydata, subset = gender == "m"
print (myMales)

# Creating a new data frame of only females (all equivalent).
myFemales <- mydatal[1:3, ]
print (myFemales)
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myFemales <- mydata[ which( mydata$gender == "f" ) , ]
print (myFemales)
myFemales <- subset( mydata, subset = gender == "f" )

print (myFemales)
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Selecting Variables and Observations

In SAS and SPSS, variable selection is done using a very simple yet flexible
set of commands using variable names, and the selection of observations is
done using logic. Combining the two approaches is quite simple. For example,
selecting the variables workshop and gl to g4 for the males only is done in
SAS with

PROC PRINT;
VAR workshop ql-q4;
WHERE gender="m";

SPSS uses a very similar approach:

TEMPORARY .
SELECT IF (gender EQ "m").
LIST workshop ql TO 4.

In the previous two chapters, we focused on selecting variables and obser-
vations separately, and we examined a very wide range of ways to do both.
Different books and help files use various approaches, so it is important to
know the range of options to perform these basic tasks in R. However, you
can still use the approach that is already most familiar to you: using names
to select variables and logic to select observations.

As an example, we will use the various methods to select the variables
workshop and ql to g4 for only the males.

The explanations in this chapter are much sparser. If you need clarification,
see the detailed discussions of each approach in the previous two chapters.

9.1 The subset Function

Although you can use any of the methods introduced in the previous two
chapters to select both variables and observations, variables are usually chosen
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by name and observations by logic. The subset function lets you use that
combination easily.

When selecting variables, subset allows you to use the colon operator on
lists of contiguous variables, like gender:q4. Variable selections that are more
complex than a single variable or two contiguous variables separated by a
colon must be combined with the ¢ function.

When selecting observations, you perform logic like gender == "m" with-
out having to use which(gender == "m") to get rid of the observations
that have missing values for gender. The logic can be as complex as you
like, so we can select the males who are happy with their workshop using
gender == "m" & g4 == 5. Note that the result of a logical condition is al-
ways a single logical vector, so you never need the c function for logic. See
Table 10.3, “Logical Operators,” for details.

We can perform our selection by nesting the subset function directly
within other functions:

summary (
subset (mydata,
subset = gender == "m",

select = c(workshop, ql:q4) )

Since R allows you to skip the names of arguments as long as you have
them in proper order, you often see subset used in the form

summary (
subset (mydata, gender == "m",
c(workshop, ql:q4) )

If you plan to use a subset like this repeatedly, it would make more sense
to save the subset in a new data frame. Here we will add the print function
just to make the point that selection is done once and then used repeatedly
with different functions. Here I am using the name myMalesWQ to represent
the males with workshop and the q variables.

myMalesWQ <- subset(mydata,
subset = gender == "m",
select = c(workshop,ql:q4)

print (myMalesWQ)
summary (myMalesWQ)

Performing the task in two steps like that often makes the code easier to
read and less error prone.
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9.2 Subscripting with Logical Selections and
Variable Names

Another very useful approach is to use subscripting with logic to select obser-
vations and names to select variables. For example:

summary (
mydata[ which(gender == "m") ,
c ( "WOI‘kShOp" s Ilql n s Ilq2 n s llqsll , llq4||) ]
)

This is very similar to what we did with the subset function, but we cannot
use the form ql:q4 to choose contiguous variables. That shortcut works only
with subset. So if you had many variables, you could instead use the shortcut
described in Sect. 7.11, “Generating indices A to Z from Two Variable Names.”

We could make our example more legible by defining the row and column
indices in a separate step:

myMales <- which(gender == "m"
myvars <_ C("Workshop" s llqlll , |lq2ll s llq3ll , |lq4")

Since the q variables make up most of the list and we have seen how to
paste the letter q onto the numeric list of 1:4, we can make the same variable
list using

myVars <- c("workshop", paste(q, 1:4, sep = "") )

I used the c function to combine just workshop with the results of the
paste function, ql, q2, etc. Regardless of how you choose to create myVars,
you can then make the selection with:

summary ( mydata[ myMales, myVars ] )

This has the added benefit of allowing us to analyze just the males, for all
variables (we are not selecting any specifically) with

summary ( mydatal myMales, ] )

We can also analyze males and females (by not choosing only males) for just
my Vars:

summary ( mydatal , myVars ] )

If we did not need that kind of flexibility and we planned to use this subset
repeatedly, we would save it to a data frame:

myMalesWQ <- mydatal myMales, myVars ]

summary (myMalesWQ)
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9.3 Using Names to Select Both Observations
and Variables

The above two approaches usually make the most sense. You usually know
variable names and the logic you need to make your selection. However, for
completeness’ sake, we will continue on with additional combinations, but if
you feel you understood the previous two chapters and the examples above,
feel free to skip these examples and go to Sect. 9.6, “Saving and Loading
Subsets.”

Since the males have character row names of “5” through “8,” we could use
both row names and column with

summary ( mydatal

C(||5|l s ||6|l s ||7|l s ||8|l) ,

C(llworkshopll s |lq1Il s llq2|l , l|q3|I , Ilq4l|)
1)

This is an odd approach for selecting rows. We do not often bother to learn
such meaningless row names. If we had row names that made more sense, like
“Ann,” “Bob,” “Carla,”. .., this approach would make more sense. However,
we can at least be assured that the row names will not be affected by the
addition of new observations or by sorting. Such manipulations do not change
row names as they do numeric index values for rows.

If you plan on using these character index vectors often or if you have
many values to specify, it is helpful to store them separately. This also helps
document your program, since a name like myMales will remind you, or your
colleagues, what you were selecting.

myMales <- C("5","6","7","8")
myVars <- c("workshop" ,"ql","q2","q3", "q4")

Now we can repeat the eract same examples that we used in the section
immediately above. Once you have a vector of index values, it does not matter
if they are character names, numeric indices, or logical values.

Here we analyze our chosen observations and variables:

summary ( mydata[ myMales, myVars] )

Here we analyze only the males, but include all variables:

summary ( mydatal myMales, 1 )

Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal , myVars] )
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9.4 Using Numeric Index Values to Select Both
Observations and Variables

The males have numeric index values of 5 through 8, and we want the first
variable and the last four, so we can use numeric index vectors to choose them
as in either of these two equivalent approaches:

summary( mydatal c(5, 6, 7, 8), c(1, 3, 4, 5, 6) 1)

summary ( mydatal 5:8, c(1, 3:6) 1)

This selection is impossible to interpret without a thorough knowledge
of the data frame. When you are hard at work on an analysis, you may well
recall these values. However, such knowledge fades fast, so you would do well to
add comments to your programs reminding yourself what these values select.
Adding new variables or observations to the beginning of the data frame, or
sorting it, would change these index values. This is a risky approach!

As we discussed in the last section, we can save the numeric index vectors
for repeated use.

myMales <- c(5, 6, 7, 8)

myVars <- c(1, 3:6)

Again, we can repeat the exact same examples that we used in the sections
above. Once you have a vector of index values, it does not matter if they are
character names or numeric indices.

Here we analyze our chosen observations and variables:

summary( mydata[ myMales, myVars ] )

Here we analyze only the males but include all variables:

summary ( mydata[ myMales, ] )

Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal , myVars ] )

9.5 Using Logic to Select Both Observations
and Variables

Selecting observations with logic makes perfect sense, but selecting variables
using logic is rarely worth the effort. Here is how we would use this combina-
tion for our example:
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summary (
mydata[which(gender == "m"),
names (mydata) %in)% c("workshop", "qi", "g2", "q3", "g4") ]
)

Let us reconsider using variable names directly. For this example, it is clearly
simpler:

summary (
mydata[ which(gender == "m") ,
C("WOI‘kShOp" , Ilql n s ||q2|| , Ilq3l| s ||q4||) ]
)

However, once we save these values, we use them with no more work than
earlier.

myMales <- which(gender == "m"

myVars <- names(mydata) %in%
c ( "WOrkShOp n s Ilql n s ||q2|l , n q3|| s Ilq4 ll)

Here we analyze our chosen observations and variables:
summary ( mydata[ myMales, myVars ] )
Here we analyze only the males but include all variables:
summary ( mydatal myMales, ] )
Here we select all of the observations but analyze only our chosen variables:

summary ( mydatal , myVars] )

9.6 Saving and Loading Subsets

Every method you use to create a subset results in a temporary copy that
exists only in your workspace. To use it in future R sessions, you need to
write it out to your computer’s hard drive using the save or save.image
functions. The more descriptive a name you give it, the better.

myMalesWQ <- subset(mydata,
subset = gender == "m",
select = c(workshop,ql:q4)

If your files are not too large, you can save your original data and your
subset with

save(mydata, myMalesWQ, file = "mydata.RData")
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The next time you start R, you can load both data frames with
load("mydata.RData")

If you are working with large files, you might save only the subset.
save (myMalesWQ, file = "myMalesWQ.RData")

Now when you start R, you can load and work with just the subset to save
space.

load("myMalesWQ.RData")

summary (myMalesWQ)

9.7 Example Programs for Selecting Variables
and Observations

9.7.1 SAS Program for Selecting Variables and Observations

* Filename: SelectingVarsAndObs.sas;

LIBNAME myLib 'C:\myRfolder';
OPTIONS _LAST_=myLib.mydata;

PROC PRINT; VAR workshop ql g2 93 q4;
WHERE gender="m";
RUN;

* Creating a data set from selected variables;
DATA myLib.myMalesWQ;

SET myLib.mydata;

WHERE gender="m";

KEEP workshop ql-q4;

RUN;

PROC PRINT DATA=myLib.myMalesWQ; RUN;

9.7.2 SPSS Program for Selecting Variables and Observations

* Filename: SelectVarsAndObs.sps.

CD 'c:\myRfolder'.
GET FILE='mydata.sav'.
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SELECT IF (gender EQ "m").
LIST workshop ql TO 4.

SAVE OUTFILE='myMalesWQ.sav'.
EXECUTE.

9.7.3 R Program for Selecting Variables and Observations

# Filename: SelectingVarsAndObs.R

setwd("c:/myRfolder")
load(file = "mydata.RData")
attach(mydata)

print (mydata)

# —-—-The subset Function—--

print(
subset (mydata,
subset = gender == "m",
select = c(workshop, ql:q4) )

myMalesWQ <- subset(mydata,
subset = gender == "m",

select = c(workshop, ql:q4)

print (myMalesWQ)
summary (myMalesWQ)

# —-—-Logic for Obs, Names for Vars---

print(
mydata[ which(gender == "m") ,
C("WOrkShOp" s ||q1|l , Ilq2l| s ||q3|l s Ilq4l|) ]

myMales <- which(gender == "m")

myVars <- c("workshop", "qi", "q2", "q3", "g4")
myVars

myVars <- c("workshop", paste(q, 1:4, sep="") )
myVars

print( mydata[myMales, myVars] )
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print( mydata[myMales, ] )
print( mydatal , myVars] )

myMalesWQ <- mydata[myMales, myVars]
print (myMalesWQ)

# ---Row and Variable Names—---

print( mydatal

C(”5", II6II’ Il7||, |I8l|)’

C(llworkshopll s Ilqlll , Iqull s llq3|l , Ilq4ll)
19

myMaleS <- C("5"’ "6", ||7||’ ll8ll)
myVars <- C("WOI’kShOp", llqlll’ uq2u, "q3", "q4")

print( mydata[myMales, myVars] )
print( mydatal[myMales, ] )
print( mydatal , myVars] )

# —-—-Numeric Index Vectors—--

print( mydatal <(5, 6, 7, 8), c(1, 3, 4, 5, 6) 1)
print( mydatal 5:8, c(1, 3:6) 1 )

myMales <- ¢(5,6,7,8)
myVars <- c(1,3:6)

print( mydata[myMales, myVars] )
print( mydatal[myMales, ] )
print( mydatal , myVars] )

# ---Saving and Loading Subsets---
myMalesWQ <- subset(mydata,

subset = gender == "m",
select = c(workshop,ql:q4)

save(mydata, myMalesWQ, file = "myBoth.RData")
load("myBoth.RData")

save(myMalesWQ, file = "myMalesWQ.RData")
load("myMalesWQ.RData")
print (myMalesWQ)
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Data Management

An old rule of thumb says that 80% of your data analysis time is spent trans-
forming, reshaping, merging, and otherwise managing your data. SAS and
SPSS have a reputation of being more flexible than R for data management.
However, as you will see in this chapter, R can do everything SAS and SPSS
can do on these important tasks.

10.1 Transforming Variables

Unlike SAS, R has no separation of phases for data modification (data step)
and analysis (proc step). It is more like SPSS where as long as you have data
read in, you can modify it using COMPUTE commands, or, via the Python
plug-in, the SPSSINC TRANSFORM extension command. Anything that you
have read into or created in your R workspace you can modify at any time.

R performs transformations such as adding or subtracting variables on the
whole variable at once, as do SAS and SPSS. It calls that vector arithmetic.
R has loops, but you do not need them for this type of manipulation. R
can nest one function call within another within any other. This applies to
transformations as well. For example, taking the logarithm of our q4 variable
and then getting summary statistics on it, you have a choice of a two-step
process like

mydata$qélog <- log(mydata$q4)
summary ( mydata$qéLlog )

or you could simply nest the log function: within the summary function
summary ( log(mydata$q4) )

If you planned to do several things with the transformed variable, saving it
under a new name would lead to less typing and quicker execution. Table 10.1
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Table 10.1. Mathematical operators and functions

R SAS SPSS
Addition x+y x+y X +y
Antilog, base 10 107x 10%*x 10%*x
Antilog, base 2 2°x 2%*x 2k*x
Antilog, natural exp(x) exp(x) exp (x)
Division x/y x/y x/y
Exponentiation x"2 X**2 X**2
Logarithm, base 10 logl0(x) logl0(x) 1g10(x)
Logarithm, base 2 log2(x) log2(x) 1g10(x)*3.3212
Logarithm, natural log(x) log(x) 1n(x)
Multiplication X *y X *y X *y
Round off round (x) round (x) rnd (x)
Square root sqrt (x) sqrt (x) sqrt (x)
Subtraction X -y X -y X -y

shows basic transformations in both packages. In Chap. 7, “Selecting Vari-
ables,” we chose variables using various methods: by index, by column name,
by logical vector, using the style mydata$myvar, by simply using the variable
name after you have attached a data frame, and by using the subset or with
functions.

Here are several examples that perform the same transformation using
different variable selection approaches. The within function is a variation of
the with function that has some advantages for variable creation that are
beyond our scope. We have seen that R has a mean function, but we will
calculate the mean the long way just for demonstration purposes.

mydata$meanQ <- (mydata$ql + mydata$q2
+ mydata$q3 + mydata$q4) / 4

mydatal,"meanQ"] <- (mydatal ,"qi1"] + mydatal ,"q2"]
+ mydatal ,"q3"] + mydatal ,"q4"] ) / 4

within( mydata,
meanQ <- (q1 + g2 + g3 + q4) / 4
)

Another way to use the shorter names is with the transform function. It
is similar to attaching a data frame, performing as many transformations as
you like using short variable names, and then detaching the data (we do that
example next). It looks like this:

mydata <- transform(mydata, meanQ=(ql + g2 + g3 + q4) / 4)

w_"

It may seem strange to use the now in an equation instead of “<-.”" but
in this form, meanQ is the name of an argument, and arguments are always
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specified using “=.” If you have many transformations, it is easier to read them
on separate lines:

mydata <- transform(mydata,
scorel=(ql + q2) / 2,
score2=(q3 + q4) / 2

)

Before beginning, the transform function reads the data, so if you want
to continue to transform variables you just created, you must do it in a second
call to that function. For example, to get the means of scorel and score2, you
cannot do the following:

mydata <- transform(mydata,
scorel=(ql + q2) / 2,
score2=(q3 + q4) / 2,
meanscore=scorel + score2 / 2 # Does not work!

)

It will not know what scorel and score2 are for the creation of meanscore.
You can do that in two steps:

mydata <- transform(mydata,
scorel=(ql + q2) / 2,
score2=(q3 + q4) / 2
)
mydata <- transform(mydata,
meanscore=scorel + score2 / 2 # This works.

)

Wickham’s plyr package [73] has a mutate function that is very similar
to transform, but it can use variables that it just created.

You can create a new variable using the index method, but it requires a bit
of extra work. Let us load the data set again since we already have a variable
named meanQ in the current one:

load(file = "mydata.RData")

Now we will add a variable at index position 7 (we currently have six vari-
ables). Using the index approach, it is easier to initialize a new variable by
binding a new variable to mydata. Otherwise, R will automatically give it a
column name of V7 that we would want to rename later. We used the column
bind function, cbind, to create mymatrix earlier. Here we will use it to name
the new variable, mean(), initialize it to zero, and then bind it to mydata:

mydata <- data.frame( cbind( mydata, meanQ = 0.) )

Now we can add the values to column 7.
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mydata[7] <- (mydata$ql + mydata$q2 +
mydata$q3 + mydata$q4d)/4

Let us examine what happens when you create variables using the attach
function. You can think of the attach function as creating a temporary copy
of the data frame, so changing that is worthless. See Sect.13.3 for details.
However, you can safely use the attach method to simplify naming variables
on the right side of the equation. This is a safe example because the variable
being created is clearly going into our data frame since we are using the long
dataframe$varname style:

attach(mydata)
mydata$meanQ <- (ql + g2 + q3 + q4) / 4

detach(mydata)

If you were to modify an existing variable in your data frame, you would
have to reattach it before you would see it. In the following example, we attach
mydata and look at ql:

> attach(mydata)
> ql

[1] 12234554

So we see what ql looks like. Next, we will see what it looks like squared and
then write it to mydata$ql (choosing a new name would be wiser but would
not make this point clear). By specifying the full name mydata$ql, we know
R will write it to the original data frame, not the temporary working copy:

> mydata$ql~2
[11] 1 4 4 9 16 25 25 16

> mydata$ql <- q1°2

However, what does the short name of q1 show us? The unmodified tem-
porary version!

> ql
[11 12234554

If we attach the file again, it will essentially make a new temporary copy and
ql finally shows that we did indeed square it:
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> attach(mydata)

The following object(s) are masked from mydata (position 3):
gender ql g2 g3 g4 workshop

> ql

[1] 1 4 4 9 16 25 25 16

The message warning about masked objects is telling you that there were
other objects with those names that are now not accessible. Those are just the
ones we attached earlier, so that is fine. We could have avoided this message
by detaching mydata before attaching it a second time. The only problem that
confronts us now is a bit of wasted workspace.

Just like SAS or SPSS, R does all of its calculations in the computer’s
main memory. You can use them immediately, but they will exist only in your
current session unless you save your workspace. You can use either the save
or the save.image function to write your work to a file:

setwd("c:/myRfolder")
save.image ("mydataTransformed.RData")

See Chap. 13, “Managing Your Files and Workspace,” for more ways to
save new variables.

10.1.1 Example Programs for Transforming Variables
SAS Program for Transforming Variables

* Filename: Transform.sas ;
LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydataTransformed;
SET myLib.mydata;

totalqg = (q1 + g2 + g3 + q4);
logtot = loglO(totalq);

meanl = (ql + q2 + g3 + q4) / 4;
mean2 = mean(of ql-q4);

PROC PRINT; RUN;

SPSS Program for Transforming Variables

* Filename: Transform.sps .
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CD 'C:\myRfolder'.
GET FILE='mydata.sav'.

COMPUTE Totalg = ql + g2 + g3 + g4.
COMPUTE Logtot = 1gl0(totalq).

COMPUTE Meanl = (ql + g2 + g3 + q4) / 4.
COMPUTE Mean2 = MEAN(ql TO q4).

SAVE OUTFILE='C:\myRfolder\mydataTransformed.sav'.
LIST.

R Program for Transforming Variables

# Filename: Transform.R

setwd ("c:/myRfolder")
load(file = "mydata.RData")
mydata

# Transformation in the middle of another function.
summary ( log(mydata$q4) )

# Creating meanQ with dollar notation.
mydata$meanQ <- (mydata$ql + mydata$q2

+ mydata$q3 + mydata$qd) / 4
mydata

# Creating mean( using attach.
attach(mydata)

mydata$meanQ <- (q1 + 92 + g3 + gq4) / 4
detach(mydata)

mydata

# Creating mean( using transform.
mydata <- transform(mydata,

meanQ=(ql + g2 + 93 + q4) / 4 )
mydata

# Creating two variables using transform.
mydata <- transform(mydata,

scorel = (q1 + q2) / 2,

score2 = (q3 + q4) / 2)
mydata

# Creating mean(Q using index notation on the left.



10.2 Procedures or Functions? The apply Function Decides 225

load(file = "mydata.RData")
mydata <- data.frame( cbind( mydata, meanQ = 0.) )
mydatal[7] <- (mydata$ql + mydata$q2 +
mydata$q3 + mydata$qs) / 4
mydata

10.2 Procedures or Functions?
The apply Function Decides

The last section described simple data transformations, using mathematics
and algebra. We applied functions like logarithms to one variable at a time. I
avoided the use of statistical functions.

SAS and SPSS each have two independent ways to calculate statistics:
functions and procedures. Statistical functions work within each observation
to calculate a statistic like the mean of our g variables for each observation.
Statistical procedures work within a variable to calculate statistics like the
mean of our g4 variable across all observations. Mathematical transformations
affect one variable at a time, unless you use a DO loop to apply the same
function to variable after variable.

R, on the other hand, has only one way to calculate: functions. What
determines if a function is working on variables or observations is how you
apply it! How you apply a function also determines how many variables or
observations a function works on, eliminating much of the need for DO loops.
This is a very different perspective!

Let us review an example from the previous section:

mydata$meanQ <- (mydata$ql + mydata$q2
mydata$q3 + mydata$qd) / 4

This approach gets tedious with long lists of variables. It also has a problem
with missing values. The mean(Q variable will be missing if any of the variables
has a missing value. The mean function solves that problem.

10.2.1 Applying the mean Function

We saw previously that R has both a mean function and a summary function.
For numeric objects, the mean function returns a single value, whereas the
summary function returns the minimum, first quartile, median, mean, third
quartile, and maximum. We could use either of these functions to create a
meanQ variable. However, the mean function returns only the value we need,
so it is better for this purpose.

Let us first call the mean function on mydata while selecting just the q
variables:
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> mean(mydata[3:6], na.rm = TRUE)

ql q2 g3 q4
3.250000 2.750000 4.142857 3.250000

We see that the mean function went down the columns of our data frame
like a SAS procedure or SPSS command would do.

To try some variations, let us put our q variables into a matrix. Simply
selecting the variables with the command below will not convert them into
matrix form. Even though variables 3 through 6 are all numeric, the selection
will maintain its form as a data frame:

mymatrix <- mydatal[ ,3:6] # Not a matrix!
The proper way to convert the data is with the as.matrix function:

> mymatrix <- as.matrix( mydata[3:6] )

> mymatrix

ql 92 g3 g4
[1,] 1 1 5 1
[2,] 2 1 4 1
3,] 2 2 4 3
[4,] 3 1NA 3
[5,] 4 5 2 4
[6,] 5 4 5 5
[7,] 5 3 4 4
[8,] 4 5 5 5

Let us review what happens if we use the mean function on mymatrix:

> mean(mymatrix, na.rm = TRUE)

[1] 3.322581

This is an interesting ability, but it is not that useful in our case. What is
of much more interest is the mean of each variable, as a SAS/SPSS procedure
would do, or the mean of each observation, as a SAS/SPSS function would
do. We can do either by using the apply function. Let us start by getting the
means of the variables:

> apply(mymatrix, 2, mean, na.rm = TRUE)

ql q2 q3 q4
3.250000 2.750000 4.142857 3.250000
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That is the same result as we saw from simply using the mean function on the
q variables.

The apply function call above has three arguments and passes a fourth on
to the mean function.

1. The name of the matrix (or array) you wish to analyze. If you supply
a data frame instead, it will coerce it into a matrix if possible (i.e., if
all its variables are of the same type). In our case we could have used
mydatal ,3:6] since apply would have coerced it into a matrix on the
fly. I coerced it into a matrix manually to emphasize that that is what R
is doing behind the scenes. It also clarifies the call to the apply function.

2. The margin you want to apply the function over, with 1 representing
rows and 2 representing columns. This is easy to remember since R uses
the subscript order of [rows, columns|, so the margin values are [1, 2],
respectively.

3. The function you want to apply to each row or column. In our case, this is
the mean function. It is important to note that you can only apply only a
single function. If you wish to apply a formula, perhaps involving multiple
functions, you must first create a new function that does what you need,
and then apply it.

4. The apply function passes any other arguments on to the function you are
applying. In our case, na.rm = TRUE is an argument for the mean function,
not the apply function. If you look at the help file for the apply function,
you will see its form is apply (X, MARGIN, FUN, ...).That means it only
uses three arguments, but the triple dot argument shows that it will pass
other arguments, indicated by the ellipsis “...”, to the function “FUN"
(mean in our case).

Applying the mean function to rows is as easy as changing the value 2,
representing columns, to 1, representing rows:

> apply(mymatrix, 1, mean, na.rm = TRUE)

1 2 3 4 5
2.000000 2.000000 2.750000 2.333333 3.750000
6 7 8

4.750000 4.000000 4.750000

Since means and sums are such popular calculations, there are special-
ized functions to get them: rowMeans, colMeans, rowSums, and colSums. For
example, to get the row means of mymatrix, we can do

> rowMeans (mymatrix, na.rm = TRUE)

1 2 3 4 5
2.000000 2.000000 2.750000 2.333333 3.750000
6 7 8
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4.750000 4.000000 4.750000

To add a new variable to our data frame that is the mean of the q variables,
we could any one of the following forms:

> mydata$meanQ <- apply(mymatrix, 1, mean, na.rm = TRUE)
> mydata$meanQ <- rowMeans(mymatrix, na.rm = TRUE)

> mydata <- transform(mydata,
+ meanQ = rowMeans(mymatrix, na.rm = TRUE)

+)
> mydata

workshop gender ql g2 g3 q4 meanQ
1 R f 1 1 5 1 2.000000
2 SAS f 2 1 4 1 2.000000
3 R f 2 2 4 3 2.750000
4 SAS <NA> 3 1 NA 3 2.333333
5 R m 4 5 2 4 3.750000
6 SAS m 5 4 5 5 4.750000
7 R m 5 3 4 4 4.000000
8 SAS m 4 5 5 5 5.750000

Finally, we can apply a function to each vector in a data frame by using the
lapply function. A data frame is a type of list, and the letter “1” in lapply
stands for [/ist. The function applies other functions to lists, and it returns
its results in a list. Since it is clear we want to apply the function to each
component in the list, there is no need for a row/column margin argument.

> lapply(mydatal ,3:6], mean, na.rm = TRUE)

$q1
[1] 3.25

$q2
[1] 2.75

$q3
[1] 4.1429

$q4
[1] 3.25

Since the output is in the form of a list, it takes up more space when
printed than the vector output from the apply function. You can also use
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the sapply function on a data frame. The “s” in sapply means it simplifies
its output whenever possible to vector, matrix, or array form. Its simplified
vector output would be much more compact:

> sapply(mydatal ,3:6], mean, na.rm = TRUE)

ql q2 q3 q4
3.250000 2.750000 4.142857 3.250000

Since the result is a vector, it is very easy to get the mean of the means:

> mean (
+ sapply(mydatal ,3:6], mean, na.rm = TRUE)
+ )

[1] 3.3482

Other statistical functions that work very similarly are shown in Table 10.2.
The length function is similar to the SAS N function or SPSS NVALID function,
but different enough to deserve its own section (below).

10.2.2 Finding N or NVALID

In SAS, saying, N(ql1, 92, g3, g4) or in SPSS saying, NVALID(Q1 TO Q4)
would count the valid values of those variables for each observation. Running
descriptive statistical procedures would give you the number of valid obser-
vations for each variable. R has several variations on this theme. First, let us
look at the length function:

> length( mydatal ,"q3"] )

(1] 8

The variable g3 has seven valid values and one missing value. The length
function tells us the number of total responses. Oddly enough, it does not
have an na.rm argument to get rid of that missing value.

Since every variable in a data frame must have the same length, the nrow
function will give us the same answer as the previous function call:

> nrow(mydata)

(1] 8

If you were seeking the number of observations on the data frame, that would
be the best way to do it. However, we are after the number of valid observations
per variable. One approach is to ask for values that are not missing. The “!”
sign means “not,” so let us try the following;:
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> lis.na( mydatal ,"q3"] )

[1] TRUE TRUE TRUE FALSE TRUE TRUE TRUE TRUE

This identifies them logically. Since statistical functions will interpret TRUE
as 1 and FALSE as 0, summing them will give us the number of valid values:

> sum( !is.na( mydatal ,"q3"] ) )

(11 7

It boggles my mind that such complexity is considered the standard ap-
proach to calculating such a simple and frequently needed measure! Luckily,
Lemon and Grosjean’s prettyR package has a valid.n function that does
that very calculation. Let us load that package from our library and apply the
function to our data frame using sapply:

> library("prettyR")
> sapply(mydata, valid.n)

workshop  gender ql q2 q3 q4
8 7 8 8 7 8

That is the kind of output we would get from descriptive statistics procedures
in SAS or SPSS. In Chap. 17, “Statistics,” we will see functions that provide
that information and much more, like means and standard deviations.

What about applying it across rows, like the SAS N function or the SPSS
NVALID function? Let us create a myQn variable that contains the number of
valid responses in ql through g4. First, we will pull those variables out into a
matrix. That will let us use the apply function on the rows:

> mymatrix <- as.matrix( mydatal ,3:6] )

> mymatrix

ql g2 g3 g4
11 1 56 1
2 2 1 4 1
3 2 2 4 3
4 3 1NA 3
5 4 5 2 4
6 5 4 5 5
7 5 3 4 4
8 4 5 5 5

Now we use the apply function with the margin argument set to 1, which
asks it to go across rows:
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> apply(mymatrix, 1, valid.n)
123
4 4 4
So we see that all of the observations have four valid values except for the

fourth. Now let us do that again, but this time save it in our data frame as
the variable myQn.

> mydata$myQn <- apply(mymatrix, 1, valid.n)
> mydata

workshop gender ql g2 g3 g4 myQn

1 1 f 1 1 56 1 4
2 2 f 2 1 4 1 4
3 1 f 2 2 4 3 4
4 2 <NA> 3 1 NA 3 3
5 1 m 4 5 2 4 4
6 2 m 5 4 5 5 4
7 1 m 5 3 4 4 4
8 2 m 4 5 5 b 4

Another form of the apply function is tapply. It exists to create tables
by applying a function repeatedly to groups in the data. For details, see
Sect. 10.12, “Creating Summarized or Aggregated Data Sets.”

There is also the mapply function, which is a multivariate version of
sapply. See help("mapply") for details. Wickham’s plyr package has a com-
plete set of applying functions that are very popular.

The functions we have examined in this section are very basic. Their sparse
output is similar to the output from SAS and SPSS functions. For R functions
that act more like SAS or SPSS procedures, see Chap. 17, “Statistics.” Still,
R does not differentiate one type of function from another as SAS and SPSS
do for their functions and procedures.

10.2.3 Standardizing and Ranking Variables

The previous section showed how to apply functions to matrices and data
frames. To convert our variables to Z scores, we could subtract the mean
of each variable and divide by its standard deviation. However, the built-in
scale function will do that for us:

> myZs <- apply(mymatrix, 2, scale)

> myZs
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Table 10.2. Basic statistical functions. Note that valid.n is in the prettyR package.

R SAS SPSS

Maximum max (x) MAX (varlist) MAX (varlist)
Mean mean (x) MEAN (varlist) MEAN (varlist)
Median median(x) MEDIAN (varlist) MEDIAN (varlist)
Minimum min(x) MIN(varlist) MIN(varlist)
N valid.n(x) N(varlist) NVALID(varlist)
Range range (x) RANGE (varlist) Not equivalent
Rank scale(x) PROC RANK RANK Command
Std. dev. sd(x) STD(varlist) SD(varlist)
Variance var (x) VAR (varlist) VARIANCE (varlist)
7, scores scale(x) PROC STANDARD DESCRIPTIVES Cmd.

ql q2 q3 q4

[1,] -1.5120484 -0.9985455 0.8017837 -1.4230249
[2,] -0.8400269 -0.9985455 -0.1336306 -1.4230249
[3,] -0.8400269 -0.4279481 -0.1336306 -0.1581139
[4,] -0.1680054 -0.9985455 NA -0.1581139

[5,] 0.5040161 1.2838442 -2.0044593 0.4743416
[6,] 1.1760376 0.7132468 0.8017837 1.1067972
[7,] 1.1760376 0.1426494 -0.1336306 0.4743416
[8,] 0.5040161 1.2838442 0.8017837 1.1067972

If you wanted to add these to mydata, you could rename the variables (see
Sect. 10.6) and then merge them with mydata (see Sect. 10.11).

Converting the variables to ranks is also easy using the built-in rank
function:

> myRanks <- apply(mymatrix, 2, rank)
> myRanks
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If you need to apply functions like these by groups, Wickham’s plyr pack-
age makes the task particularly easy.
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10.2.4 Applying Your Own Functions

We have seen throughout this book that R has an important feature: Its
functions are controlled by arguments that accept only a single value. When
we provided value labels for a factor, we had to first combine them into a single
character vector. When we read two records per case, the field widths of each
record were stored in two numeric vectors. We had to combine them into a
single list before supplying the information. When using the apply family of
functions, this rule continues: You can apply only a single function. If that
does not meet your needs, you must create a new function that does, then
apply it.
Let us try to apply two functions, mean and sd:

> apply(mymatrix, 2, mean, sd) # No good!

Error in mean.default(newX[, il, ...)
'trim' must be numeric of length one

R warns us that only one is possible. Previously in Sect. 5.9 “Writing Your
Own Functions (Macros),” we created several versions of a function called
mystats. It returned both the mean and standard deviation. Let us recreate
a simple version of it here:

mystats <- function(x) {
c( mean = mean(x, na.rm
sd = sd (x, na.rm

TRUE) ,
TRUE) )

Now we can apply it:

> apply(mymatrix, 2, mystats)

ql q2 g3 q4
mean 3.250000 2.750000 4.142857 3.250000
sd  1.488048 1.752549 1.069045 1.581139

That worked well.

The apply family of functions also lets you do something unusual: create
a function on the fly and use it without even naming it. Functions without
names are called anonymous functions.

Let us run the example again using an anonymous function:

> apply(mymatrix, 2, function(x){

+ c( mean=mean(x, na.rm = TRUE),
+ sd=sd(x, na.rm = TRUE) )

+ 1)

ql q2 g3 q4
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mean 3.250000 2.750000 4.142857 3.250000
sd 1.488048 1.752549 1.069045 1.581139

We have essentially nested the creation of the function within the call to
the apply function and simply left off its name.

This makes for dense code, so I seldom use this approach. However, you
will see it in other books and help files, so it is important to know how it
works.

10.2.5 Example Programs for Applying Statistical Functions
SAS Program for Applying Statistical Functions

* Filename: ApplyingFunctions.sas;
LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydata;

SET myLib.mydata;
myMean = MEAN(OF ql-qg4);
myN = N(OF ql1-q4);

RUN;

PROC MEANS;
VAR ql1-g4 myMean myN;
RUN;

* Get Z Scores;

PROC STANDARD DATA=mylib.mydata
MEAN=0 STD=1 out=myZs;

RUN;

PROC PRINT;

RUN;

* Get Ranks;

PROC RANK DATA=mylib.mydata OUT=myRanks;
RUN;

PROC PRINT;

RUN;

SPSS Program for Applying Statistical Functions

* Filename: ApplyingFunctions.SPS.

CD 'C:\myRfolder'.
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GET FILE='mydata.sav'.

* Functions work for each observation (row).
COMPUTE myMean = Mean(ql TO q4).

COMPUTE mySum = Sum(ql TO g4).

COMPUTE myN = mySum / myMean.

* Procedures work for all observations (column).
DESCRIPTIVES VARIABLES=ql g2 g3 g4 myMean myN.

* Get Z Scores.

DESCRIPTIVES VARIABLES=ql q2 g3 q4
/SAVE
/STATISTICS=MEAN STDDEV MIN MAX.

* Get Ranks.

RANK VARIABLES=ql g2 q3 q4 (A)
/RANK
/PRINT=YES
/TIES=MEAN.

EXECUTE.

R Program for Applying Statistical Functions

# Filename: ApplyingFunctions.R

setwd("c:/myRfolder")
load(file = "mydata.RData")
mydata

attach(mydata)

# Mean of the q variables
mean(mydata[3:6], na.rm = TRUE)

# Create mymatrix.
mymatrix <- as.matrix( mydatal ,3:6] )

mymatrix

# Get mean of whole matrix.
mean (mymatrix, na.rm = TRUE)

# Get mean of matrix columns.
apply(mymatrix, 2, mean, na.rm = TRUE)

# Get mean of matrix rows.

235
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apply (mymatrix, 1, mean, na.rm = TRUE)
rowMeans (mymatrix, na.rm = TRUE)

# Add row means to mydata.
mydata$meanQ <- apply(mymatrix, 1, mean, na.rm = TRUE)
mydata$meanQ <- rowMeans(mymatrix, na.rm = TRUE)
mydata <- transform(mydata,

meanQ = rowMeans(mymatrix, na.rm = TRUE)
)
mydata

# Means of data frames & their vectors.
lapply(mydatal[ ,3:6], mean, na.rm = TRUE)
sapply (mydatal[ ,3:6], mean, na.rm = TRUE)

mean (
sapply(mydatal ,3:6], mean, na.rm = TRUE)

# Length of data frames & their vectors.
length(mydatal ,"q3"] )

nrow (mydata)

is.na( mydatal ,"q3"] )

lis.na( mydatal ,"q3"] )

sum( !is.na( mydatal ,"q3"] ) )

# Like the SAS/SPSS n from stat procedures.
library("prettyR")
sapply (mydata, valid.n)

apply(myMatrix, 1, valid.n)

mydata$myQn <- apply(myMatrix, 1, valid.n)
mydata

# Applying Z Transformation.

myZs <- apply(mymatrix, 2, scale)

myZs

myRanks <- apply(mymatrix, 2, rank)
myRanks

# Applying Your Own Functions.

apply (mymatrix, 2, mean, sd) # No good!
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mystats <- function(x) {
c( mean=mean(x, na.rm
sd=sd (x, na.rm

TRUE) ,
TRUE) )

}
apply(mymatrix, 2, mystats)

apply (mymatrix, 2, function(x){
c( mean = mean(x, na.rm = TRUE),
sd = sd( x, na.rm = TRUE) )
i)

10.3 Conditional Transformations

Conditional transformations apply different formulas to various groups in your
data. For example, the formulas for recommended daily allowances of vitamins
differ for males and females. Conditional transformations are also used to chop
up continuous variables into categories like low and high, or grades like A, B,
C, D, F. Such transformations can be useful in understanding and explaining
relationships in our data, but they also result in a dramatic loss of information.
Your chance of finding a significant relationship when using such simplified
variables is shockingly worse than with the original variables. Analyses should
always be done using the most continuous form of your measures, saving
chopped-up versions for simplifying explanations of the results.

R’s ifelse function does conditional transformations in a way that is
virtually identical to what SAS and SPSS do. R also has a variety of cutting
functions that are very useful for chopping up variables into groups. We will
consider both in this section. Sect. 10.7, “Recoding Variables,” offers a different
solution to similar problems.

10.3.1 The ifelse Function

The general form of the ifelse function is:
ifelse(logic, true, false)

where “logic” is a logical condition to test, “true” is the value to return when
the logic is true, and “false” is the value to return when the logic is false. For
example, to create a variable that has a value of 1 for people who strongly
agree with question 4 on our survey, we could use

> mydata$qdSagree <- ifelse( q4 == 5, 1, 0 )
> mydata$qéSagree

[1] 00000101
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Table 10.3. Logical operators. See also help("Logic") and help("Syntax").

R SAS SPSS
Equals == = or EQ = or EQ
Less than < < or LT < or LT
Greater than > > or GT > or GT
Less than or equal <= <= or LE <= or LE
Greater than or equal >= >= or GE >= or GE
Not equal 1= “=, <> or NE “= or NE
And & &, AND &, AND
Or | |, OR |, OR
0<=x<=1 (0<=x) & (x<=1) 0<=x<=1 (0<=x) & (x<=1)
Missing value size Missing values Minus infinity Missing values
have no size have no size
Identify missing is.na(x)==TRUE x=. MISSING(x)=1
values (x==NA can never
be true.)

This is such a simple outcome that we can also do this using
mydata$g4Sagree <- as.numeric(géd == 5)

However, the latter approach only allows the outcomes of 1 and 0, whereas
the former version allows for any value. The statement q4 == 5 will result in
a vector of logical TRUE/FALSE values. The as.numeric function converts
it into zeros and ones.

R uses some different symbols for logical comparisons, such as the “==" for
logical equality. Table 10.3 shows the different symbols used by each package.

If we want a variable to indicate when people agree with question 4, (i.e.,
they responded with agree or strongly agree), we can use

> mydata$qdagree <- ifelse(qd >= 4, 1, 0)
> mydata$qdagree

[1J]o0OOO1111

The logical condition can be as complicated as you like. Here is one that
creates a score of 1 when people took workshop 1 (abbreviated wsl) and agreed
that it was good:

> mydata$wslagree <- ifelse(workshop == 1 & g4 >=4 , 1, 0)
> mydata$wslagree

[1] 00001010
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We can fill in equations that will supply values under the two conditions.
The following equations for males and females are a bit silly, but they make
the point obvious. SAS users might think that if gender were missing, the
second equation would apply. Luckily, R is more like SPSS in this regard, and
if gender is missing, it sets the result to missing.

mydata$score <- ifelse(gender == "f",
(2 * q1) + q2,
(3 x q1) + g2

)

What follows is our resulting data frame:
> mydata

workshop gender ql g2 g3 g4 g4Sagree g4agree wslagree score

1 1 f 1 1 5 1 0 0 0 3
2 2 f 21 4 1 0 0 0 5
3 1 f 2 2 4 3 0 0 0 6
4 2 <NA> 3 1 NA 3 0 0 0 NA
5 1 m 4 5 2 4 0 1 1 17
6 2 m 5 4 5 5 1 1 0 19
7 1 m 5 3 4 4 0 1 1 18
8 2 m 4 5 5 5 1 1 0 17

Let us now consider conditional transformations that divide or cut a con-
tinuous variable into a number of groups. One of the most common examples
of this is cutting test scores into grades. Our practice data set mydatalO0
is just like mydata, but it has 100 observations and includes a pretest and
posttest score. Let us read it in and cut posttest into groups:

detach(mydata)
load("mydatal00.RData")
attach(mydatal00)

> head(mydatal00)

gender workshop ql g2 g3 g4 pretest posttest

1 Female R 4 3 4 5 72 80
2 Male SPSS 3 4 3 4 70 75
3 <NA> <NA> 3 2 NA 3 74 78
4 Female SPSS 5 4 5 3 80 82
5 Female Stata 4 4 3 4 75 81
6 Female SPSS 5 4 3 5 72 7

First we will use elseif in a form that is not very efficient but easy to
understand:
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> postGroup <- posttest
> postGroup <- ifelse(posttest< 60 , 1, postGroup)
> postGroup <- ifelse(posttest>=60 & posttest<70, 2, postGroup)
> postGroup <- ifelse(posttest>=70 & posttest<80, 3, postGroup)
> postGroup <- ifelse(posttest>=80 & posttest<90, 4, postGroup)
> postGroup <- ifelse(posttest>=90 , 5, postGroup)
> table(postGroup)
postGroup

2 3 4 5

3 31 52 13

The very first statement, postGroup <- posttest, is important just to
give postGroup some initial values. It must exist and have the same length as
posttest (the initial values are not important) since it is used at the end of
the very first ifelse.
A much more efficient approach nests each ifelse in the FALSE position
of the previous ifelse call:

> postGroup <-
+ ifelse(posttest < 60
ifelse(posttest >= 60 & posttest < 70, 2,
ifelse(posttest >= 70 & posttest < 80, 3,
ifelse(posttest >= 80 & posttest < 90, 4,
ifelse(posttest >= 90

+

+
+
+
+

))))

> table(postGroup)

postGroup
2 3 4
3 31 52

5
13

,1)

, 5, posttest)

With this approach, as soon as the TRUE state of a value is determined,
the following ifelse function calls are not checked. Note now that posttest
itself appears only one time, in the final FALSE position. Therefore, we did
not need to initialize postGroup with postGroup <- posttest.

You can also perform this transformation by taking advantage of a logical
TRUE being equivalent to a mathematical 1. Each observation gets a 1, and
then another 1 is added for every condition that is true:

> postGroup <- 1+

(posttest >= 60)+
(posttest >= 70)+
(posttest >= 80)+

+
+
+
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+  (posttest >= 90)
> table(postGroup)

postGroup
1 2 3 4 5
1 33152 13

These examples use code that is quite long, so I have avoided using the
even longer form of mydata100$postGroup. When you do this type of trans-
formation, remember to save your new variable in your data frame with:

mydatal00$postGroup <- postGroup

or an equivalent command.

10.3.2 Cutting Functions

R has a more convenient approach to cutting continuous variables into groups.
They are called cutting functions. R’s built-in function for this is named cut,
but the similar cut2 function from Harrell’s Hmisc package has some advan-
tages. To use it, you simply provide it with the variable to cut and a vector
of cut points:

> library("Hmisc")
> postGroup <- cut2(posttest, c(60, 70, 80, 90) )

> table(postGroup)

postGroup
59 [60,70) [70,80) [80,90) [90,98]
1 3 31 52 13

It creates a factor with default labels that indicate where the data got
cut. The labels even show you that 59 was the smallest score and 98 was the
largest.

SAS and SPSS do not offer the approach just presented, but they do offer
a way to cut a variable up into groups determined by percentiles using their
rank procedures (see example programs at the end of this section).

The cut2 function can do this, too.! To cut a variable up into equal-sized
groups, you specify the number of groups you want using the g (for group)
argument:

! R’s built-in cut function cannot do this directly, but you could nest a call to
quantile within it.
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> postGroup <- cut2(posttest, g = 5)

> table(postGroup)

postGroup
[59,78) [78,82) [82,85) [85,89) [89,98]
26 22 17 19 16

Previously we had equally spaced intervals. You can see that cut2 has
tried instead to create groups of equal size.

If you know in advance the size of groups you would like, you can also use
cut2 and specify the minimum number of observations in each group using
the m (for minimum) argument:

> postGroup <- cut2(posttest, m = 25)

> table(postGroup)

postGroup
[59,78) [78,83) [83,87) [87,98]
26 27 23 24

Another method of cutting is to form the groups into naturally occurring
clusters. Williams’ Rattle package includes a binning function that does
that.

10.3.3 Example Programs for Conditional Transformations
SAS Program for Conditional Transformations

* Filename: TransformIF.sas ;
LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydataTransformed;
SET myLib.mydata;
IF g4 = 5 then x1 = else x1 = 0;
IF g4 >= 4 then x2 = else x2 = 0;
IF workshop = 1 & g4 >= 5 then x3 = 1;
ELSE x3 = 0;
IF gender = "f" then scoreA = 2 * ql + g2;
Else scoreA = 3 * ql + q2;
IF workshop = 1 and g4 >= 5
THEN scoreB = 2 * ql + q2;
ELSE scoreB = 3 * gl + g2;
RUN;

1
1
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PROC PRINT; RUN;

DATA myLib.mydataTransformed;
SET myLib.mydatal00;

IF (posttest < 60) THEN postGroup = 1;
ELSE IF (posttest >= 60 & posttest < 70) THEN postGroup = 2;
ELSE IF (posttest >= 70 & posttest < 80) THEN postGroup = 3;
ELSE IF (posttest >= 80 & posttest < 90) THEN postGroup = 4;
ELSE IF (posttest >= 90) THEN postGroup = 5
RUN;

>

PROC FREQ; TABLES postGroup; RUN;

PROC RANK OUT=myLib.mydataTransformed GROUPS=5;
VAR posttest;
RUN;

PROC FREQ; TABLES posttest; RUN;

SPSS Program for Conditional Transformations

*Filename: TransformIF.sps .

CD 'C:\myRfolder'.
GET FILE = 'mydata.sav'.

DO IF (Q4 eq 5).
+ COMPUTE X1 = 1.
ELSE.

+ COMPUTE X1 = 0.
END IF.

DO IF (Q4 GE 4).
+ COMPUTE X2 = 1.
ELSE.

+ COMPUTE X2 = O.
END IF.

DO IF (workshop EQ 1 AND g4 GE 4).
+ COMPUTE X3 = 1.

ELSE.

+ COMPUTE X3 = O.

END IF.
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DO IF (gender = 'f").

+ COMPUTE scoreA = 2 * gl + g2.
ELSE.

+ COMPUTE scoreA = 3 * gl + g2.
END IF.

DO IF (workshop EQ 1 AND g4 GE 5).
+ COMPUTE scoreB = 2 * gl + g2.
ELSE.

+ COMPUTE scoreB = 3 * gl + g2.
END IF.

EXECUTE.

GET FILE='mydatal00.sav'.
DATASET NAME DataSet2 WINDOW=FRONT.

DO IF (posttest LT 60).

+ COMPUTE postGroup = 1.

ELSE IF (posttest GE 60 AND posttest LT 70).
+ COMPUTE postGroup = 2.

ELSE IF (posttest GE 70 AND posttest LT 80).
+ COMPUTE postGroup = 3.

ELSE IF (posttest GE 80 AND posttest LT 90).
+ COMPUTE postGroup = 4.

ELSE IF (posttest GE 90).

+ COMPUTE postGroup = 5.

END IF.

EXECUTE.

DATASET ACTIVATE DataSet2.
FREQUENCIES VARIABLES=postGroup
/ORDER=ANALYSIS.

DATASET ACTIVATE DataSetl.
RANK VARIABLES=posttest (A)
/NTILES(5)
/PRINT=YES
/TIES=MEAN.

FREQUENCIES VARIABLES=Nposttes
/ORDER=ANALYSIS.

R Program for Conditional Transformations

# Filename: TransformIF.R
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setwd("c:/myRfolder")
load(file = "mydata.RData")
mydata

attach(mydata)

mydata$q4Sagree <- ifelse(q4 == 5, 1, 0)
mydata$q4Sagree

mydata$qéSagree <- as.numeric(q4 == 5 )
mydata$qé4Sagree

mydata$qdagree <- ifelse(qd >= 4, 1, 0)
mydata$qdagree

mydata$wslagree <- ifelse(workshop == 1 & g4 >=4 , 1, 0)

mydata$wslagree

mydata$score <- ifelse(gender == "f",
(2 *x q1) + q2,
(3 x q1) + g2

)

mydata

# —-—-Cutting posttest---

detach(mydata)
load("mydatal00.RData")
attach(mydatal00)

head (mydatal00)

# An inefficient approach:
postGroup <- posttest
postGroup <- ifelse(posttest< 60

>

postGroup <- ifelse(posttest>=60 & posttest<70,
postGroup <- ifelse(posttest>=70 & posttest<80,
postGroup <- ifelse(posttest>=80 & posttest<90,

postGroup <- ifelse(posttest>=90
table(postGroup)

# An efficient approach:

postGroup <-

ifelse(posttest < 60 , 1,
ifelse(posttest >= 60 & posttest < 70, 2,

>

postGroup)
postGroup)
postGroup)
postGroup)
postGroup)

245
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ifelse(posttest >= 70 & posttest < 80, 3,
ifelse(posttest >= 80 & posttest < 90, 4,
ifelse(posttest >= 90 , b, posttest)
))))
table(postGroup)

# Logical approach:

postGroup <- 1+
(posttest >= 60)+
(posttest >= 70)+
(posttest >= 80)+
(posttest >= 90)

table (postGroup)

# —-—-Cutting Functions---

# Hmisc cut2 function

library("Hmisc")

postGroup <- cut2(posttest, c(60, 70, 80, 90) )
table (postGroup)

postGroup <- cut2(posttest, g = 5)

table (postGroup)

postGroup <- cut2(posttest, m = 25)
table (postGroup)

10.4 Multiple Conditional Transformations

Conditional transformations apply different formulas to different subsets of
your data. If you have only a single formula to apply to each group, read
Sect. 10.3, “Conditional Transformations.” SAS and SPSS both offer distinctly
different approaches to single conditional transformations and multiple condi-
tional transformations. However, R uses the same approach regardless of how
many transformations you need to apply to each group. It does, however, let
us look at some interesting variations in R.

The simplest approach is to use the ifelse function a few times. Let
us create two scores, cleverly named scorel and score2, which are calculated
differently for the males and the females. Here are the two scores for the
females:

mydata$scorel <- ifelse( gender == "f",
(2 * q1) + g2, # Score 1 for females.
(20% q1) + g2 # Score 1 for males.



10.4 Multiple Conditional Transformations

)

mydata$score2 <- ifelse( gender == "f",
(3 * ql) + g2, # Score 2 for females.
(30 * q1) + g2 # Score 2 for males.

)

As earlier, the calls to the ifelse functions have three arguments.

1. The gender == "f" argument provides the logical condition to test.
2. The first formula applies to the TRUE condition, for the females.
3. The second formula applies to the FALSE condition, for the males.
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We can do the same thing using the index approach, but it is a bit trickier.
First, let us add the new score names to our data frame so that we can refer

to the columns by name:

> mydata <- data.frame(mydata, scorel = NA, score2 = NA)

> mydata

workshop gender ql g2 g3 g4 scorel score2

1 R f 1 1 5 1 NA
2 SAS f 2 1 4 1 NA
3 R f 2 2 4 3 NA
4 SAS <NA> 3 1 NA 3 NA
5 R m 4 5 2 4 NA
6 SAS m 5 4 5 5 NA
7 R m 5 3 4 4 NA
8 SAS m 4 5 5 5 NA

NA
NA
NA
NA
NA
NA
NA
NA

This initializes the scores to missing. We could also have initialized them to

zero by changing “scorel=NA, score2=NA" to “scorel=0, score2=0".

Next, we want to differentiate between the genders. We can use the form
gender == "f" but we do not want to use it directly as indices to our
data frame because gender has a missing value. What would R do with
mydata[NA, 17 Luckily, the which function only cares about TRUE values,

so we will use that to locate the observations we want:

> gals <- which( gender == "f" )
> gals
[1] 123

> guys <- which( gender == "m" )
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> guys
[11 5678

We can now use the gals and guys variables to make the actual formula
with the needed indices much shorter:

mydatal[gals, "scorel"] <- 2 * ql[gals] + g2[gals]
mydata[gals, "score2"] <- 3 * ql[gals] + g2[gals]
mydata[guys, "scorel"] <- 20 * ql[guys] + qg2[guys]
mydata[guys, "score2"] <- 30 * ql[guys] + q2[guys]

vV V V V

> mydata

workshop gender ql g2 g3 g4 scorel score2

1 R f 1 1 5 1 3 4
2 SAS f 2 1 4 1 5 7
3 R f 2 2 4 3 6 8
4 SAS <NA> 3 1 NA 3 NA NA
5 R m 4 5 2 4 85 125
6 SAS m 5 4 5 5 104 154
7 R m 5 3 4 4 103 153
8 SAS m 4 5 5 5 85 125

We can see that this approach worked, but look closely at the index val-
ues. We are selecting observations based on the rows. So where is the required
comma? When we attached the data frame, variables q1 and 2 became acces-
sible by their short names. In essence, they are vectors now, albeit temporary
ones. Vectors can use index values, too, but since they only have one dimen-
sion, they only use one index. If we had not attached the file, we would have
had to write the formulas as:

2x mydata[gals, "q1"] + mydatal[gals, "q2"]

We no longer need the guys and gals variables, so we can remove them
from our workspace.

rm(guys,gals)

10.4.1 Example Programs for Multiple
Conditional Transformations

SAS Program for Multiple Conditional Transformations

* Filename: TransformIF2.sas ;

LIBNAME myLib 'C:\myRfolder';
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DATA myLib.mydata;
SET myLib.mydata;

IF gender="f" THEN DO;
scorel = (2 * ql) + q2;
score2 = (3 * ql) + g2;

END;

ELSE IF gender="m" THEN DO;
scorel = (20 * ql) + qg2;
score2 = (30 * ql) + qg2;

END;

RUN;

SPSS Program for Multiple Conditional Transformations

* Filename: TransformIF2.sps .

CD 'C:\myRfolder'.
GET FILE = 'mydata.sav’.

DO IF (gender EQ 'm").

+ COMPUTE scorel = (2%ql) + g2.

+ COMPUTE score2 = (3%ql) + g2.
ELSE IF (gender EQ 'f').

+ COMPUTE scorel = (20%ql) + qg2.
+ COMPUTE score2 = (30*ql) + qg2.
END IF.

EXECUTE.

R Program for Multiple Conditional Transformations

# Filename: TransformIF2.R

setwd("c:/myRfolder")
load(file = "mydata.RData")
attach(mydata)

mydata

# Using the ifelse approach.
mydata$scorel <- ifelse( gender == "f",
(2 *x q1) + g2, # Score 1 for females.

249



250 10 Data Management

(20% q1) + g2  # Score 1 for males.

)

mydata$score2 <- ifelse( gender == "f",
(3 * ql) + g2, # Score 2 for females.
(30 * q1) + q2 # Score 2 for males.

)

mydata

# Using the index approach.
load(file = "mydata.RData")

# Create names in data frame.

detach(mydata)

mydata <- data.frame(mydata, scorel = NA, score2 = NA)
mydata

attach(mydata)

# Find which are males and females.

gals <- which( gender == "f" )

gals

guys <- which( gender == "m"

guys

mydatal[gals, "scorel"] <- 2 * ql[gals] + g2[gals]
mydatal[gals, "score2"] <- 3 * ql[gals] + g2[gals]
mydata[guys, "scorel"] <- 20 * qll[guys] + g2[guys]
mydata[guys, "score2"] <- 30 * qll[guys] + g2[guys]
mydata

# Clean up.

rm(guys, gals)

10.5 Missing Values

We discussed missing values briefly in several previous chapters. Let us bring
those various topics together to review and expand on them. R represents
missing values with NA, for Not Available. The letters NA are also an object
in R that you can use to assign missing values. Unlike SAS, the value used
to store NA is not the smallest number your computer can store, so logical
comparisons such as x < 0 will result in NA when x is missing. SAS would
give a result of TRUE instead, while the SPSS result would be missing.
When importing numeric data, R reads blanks as missing (except when
blanks are delimiters). R reads the string NA as missing for both numeric and
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character variables. When importing a text file, both SAS and SPSS would
recognize a period as a missing value for numeric variables. R will, instead,
read the whole variable as a character vector! If you have control over the
source of the data, it is best not to write them out that way. If not, you can
use a text editor to replace the periods with NA, but you have to be careful
to do so in a way that does not also replace valid decimal places. Some editors
make that easier than others. A safer method would be to fix it in R, which
we do below.

When other values represent missing, you will, of course, have to tell R
about them. The read.table function provides an argument, na.strings,
that allows you to provide a set of missing values. However, it applies that
value to every variable, so its usefulness is limited. Here is a data set that we
will use to demonstrate the various ways to set missing values. The data frame
we use, mydataNA, is the same as mydata in our other examples, except that
it uses several missing-value codes:

> mydataNA <- read.table("mydataNA.txt")
> mydataNA

workshop gender ql g2 g3 g4

1 1 f 1 1 56 1
2 2 f 2 1 4099
3 . f 9 2 4 3
4 2 3 999 3
5 1 m 4 5 2 4
6 . m 9 9 5 b
7 1 . 5 39 4
8 2 m 4 5 5 99

In the data we see that workshop and gender have periods as missing val-
ues, ql and g2 have 9’s, and g3 and g4 have 99s. Do not be fooled by the
periods in workshop and gender; they are not already set to missing! If so,
they would have appeared as NA instead. R has seen the periods and has con-
verted both variables to character (string) variables. Since read.table con-
verts string variables to factors unless the as.is = TRUE argument is added,
both workshop and gender are now factors. We can set all three codes to miss-
ing by simply adding the na.strings argument to the read.table function:

> mydataNA <- read.table("mydataNA.txt",
+ na.strings = c(".", "9", "99") )

> mydataNA

workshop gender ql g2 g3 q4
1 1 f 1 1 5 1
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2 2 f 2 1 4 NA
3 NA fNA 2 4 3
4 2 <NA> 3 NA NA 3
5 1 m 4 5 2 4
6 NA m NANA 5 5
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5NA

If the data did not come from a text file, we could still easily scan every
variable for 9 and 99 to replace with missing values using:

mydata[mydata == " "] <- NA

Both of the above approaches treat all variables alike. If any variables, like
age, had valid values of 99, each approach would set them to missing too!
For how to handle that situation, see Sect. 10.5.3, “When “99” Has Meaning.”
Of course “.” never has meaning by itself, so getting rid of them all with
na.strings = "." is usually fine.

10.5.1 Substituting Means for Missing Values

There are several methods for replacing missing values with estimates of what
they would have been. These methods include simple mean substitution, re-
gression, and — the gold standard— multiple imputation. We will just do mean
substitution. For a list of R packages that do missing value imputation, see
the table “R-SAS-SPSS Add-on Module Comparison” under “Missing Value
Analysis” available at http://rdstats.com.

Any logical comparison on NAs results in an NA outcome, so q1 == NA
will never be TRUE, even when 1 is indeed NA. Therefore, if you wanted to
substitute another value such as the mean, you would need to use the is.na
function. Its output is TRUE when a value is NA. Here is how you can use it
to substitute missing values (this assumes the data frame is attached):

mydataNA$ql[ is.na(ql) ] <- mean( ql, na.rm = TRUE )

On the left-hand side, the statement above selects mydataNA$ql as a vec-
tor and then finds its missing elements with is.na(mydata$ql). On the right,
it calculates the mean of 1 across all observations to assign to those NA val-
ues on the left. We are attaching mydata so we can use short variables names
to simplify the code, but we are careful to use the long form, mydataNAS$ql,
where we write the result. This ensures that the result will be stored within
the data frame, mydata, rather than in the attached copy. See Sect. 13.3,
“Attaching Data Frames,” for details.



10.5 Missing Values 253

10.5.2 Finding Complete Observations

You can omit all observations that contain any missing values with the
na.omit function. The new data frame, myNoMissing, contains no missing
values for any variables.

> myNoMissing <- na.omit(mydataNA)
> myNoMissing

workshop gender ql g2 g3 g4
1 1 f 1 1 5 1
5 1 m 4 5 2 4

Yikes! We do not have much data left. Thank goodness this is not our
dissertation data. The complete.cases function returns a value of TRUE
when a case is complete — that is, when an observation has no missing values:

> complete.cases (mydataNA)

[1] TRUE FALSE FALSE FALSE TRUE FALSE FALSE FALSE

Therefore, we can use this to get the cases that have no missing values (the
same result as the na.omit function) by doing

> myNoMissing <- mydataNA[ complete.cases(mydataNA), ]
> myNoMissing
workshop gender ql g2 g3 q4

1 1 f 1 1 5 1
5 1 m 4 5 2 4

Since we already saw na.omit do that, it is of greater interest to do the
reverse. If we want to see which observations contain any missing values, we
can use “!” for NOT:

> myIncomplete <- mydataNA[ !complete.cases(mydataNA), ]
> myIncomplete

workshop gender ql g2 g3 g4

2 2 f 2 1 4 0NA
3 NA fNA 2 4 3
4 2 <NA> 3 NA NA 3
6 NA mNANA 5 5
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA
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10.5.3 When “99” Has Meaning

Occasionally, data sets use different missing values for different sets of vari-
ables. In that case, the methods described earlier would not work because
they assume every missing value code applies to all variables.

Variables often have several missing value codes to represent things like
“not applicable,” “do not know,” and “refused to answer.” Early statistics pro-
grams used to read blanks as zeros, so researchers got used to filling their
fields with as many 9’s as would fit. For example, a two-column variable such
as years of education would use 99, to represent missing. The data set might
also have a variable like age, for which 99 is a valid value. Age, requiring three
columns, would have a missing value of 999. Data archives like the Interuni-
versity Consortium of Political and Social Research (ICPSR) have many data
sets coded with multiple values for missing.

We will use conditional transformations, covered earlier in this chapter, to
address this problem. Let us read the file again and put NAs in for the values
9 and 99 independently:

> mydataNA <- read.table("mydataNA.txt", na.strings = ".")

> attach(mydataNA)

> mydataNA$ql[ql == 9 ] <- NA
> mydataNA$q2[q2 == 9 ] <- NA
> mydataNA$q3[q3 == 99] <- NA
> mydataNA$q4[q4 == 99] <- NA
> mydataNA

workshop gender ql g2 g3 g4
1 1 f 1 1 5 1
2 2 f 2 1 40NA
3 NA fNA 2 4 3
4 2 <NA> 3 NA NA 3
5 1 m 4 5 2 4
6 NA m NANA 5 5
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA

That approach can handle any values we might have and assign NAs only
where appropriate, but it would be quite tedious with hundreds of variables.
We have used the apply family of functions to execute the same function
across sets of variables. We can use that method here. First, we need to create
some functions, letting x represent each variable. We can do this using the
index method:
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my9isNA  <- function(x) { x[x == 9 ] <- NA; x}
my99isNA <- function(x) { x[x == 99 ] <- NA; x}

or we could use the ifelse function:

my9isNA <- function(x) { ifelse( x == 9, NA, x) }
my99isNA <- function(x) { ifelse( x == 99, NA, x) }

Either of these approaches creates functions that will return a value of NA
when x == 9 or x == 99 and will return a value of just x if they are false. If
you leave off that last “. . .x}” above, what will the functions return when the

conditions are false? That would be undefined, so every value would become
NA!

Now we need to apply each function where it is appropriate, using the
lapply function.

> mydataNA <- read.table("mydataNA.txt", na.strings = ".")
> attach(mydataNA)

> mydataNA[3:4] <- lapply( mydataNA[3:4], my9isNA )
> mydataNA[5:6] <- lapply( mydataNA[5:6], my99isNA )

> mydataNA

workshop gender ql g2 g3 g4

1 1 f 1 1 5 1
2 2 f 2 1 4 NA
3 NA fNA 2 4 3
4 2 <NA> 3 NA NA 3
5 1 m 4 5 2 4
6 NA m NANA 5 5
7 1 <NA> 5 3 NA 4
8 2 m 4 5 5 NA

The sapply function could have done this, too. With our small data frame,
this has not saved us much effort. However, to handle thousands of variables,
all we would need to change are the above indices from 3:4 and 5:6 to perhaps
3:4000 and 4001:6000.

10.5.4 Example Programs to Assign Missing Values
SAS Program to Assign Missing Values

* Filename: MissingValues.sas ;
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LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydata;
SET myLib.mydata;

*Convert 9 to missing, one at a time.
IF q1=9 THEN ql=.;
IF g2=9 THEN qg2=.;
IF 93=99 THEN g2=.;
IF 94=99 THEN g4=.;
* Same thing but is quicker for lots of vars;
ARRAY g9 ql1-q2;
DO OVER q9;
IF q9=9 THEN g=.;
END;

ARRAY q99 q3-q4;
DO OVER q99;

IF =99 THEN q99=.;
END;

SPSS Program to Assign Missing Values
* Filename: MissingValues.sps .

CD 'C:\myRfolder'.
GET FILE=('mydata.sav').

MISSING q1 TO g2 (9) q3 TO g4 (99).
SAVE OUTFILE='mydata.sav'.

R Program to Assign Missing Values
# Filename: MissingValues.R
setwd("c:/myRfolder")

mydataNA <- read.table("mydataNA.txt")
mydataNA

# Read it so that ".", 9, 99 are missing.
mydataNA <- read.table("mydataNA.txt",
na.strings = c(".", "9", "99") )
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mydatalNA

# Convert 9 and 99 manually
mydataNA <- read.table("mydataNA.txt",

na.strings=".")
mydataNA [mydataNA == 9 | mydataNA == 99] <- NA
mydataNA

# Substitute the mean for missing values.
mydataNA$ql[is.na(mydataNA$ql)] <-

mean (mydataNA$ql, na.rm = TRUE)
mydataNA

# Eliminate observations with any NAs.
myNoMissing <- na.omit(mydataNA)
myNoMissing

# Test to see if each case is complete.
complete.cases (mydataNA)

# Use that result to select complete cases.
myNoMissing <- mydataNA[ complete.cases(mydataNA), ]
myNoMissing

# Use that result to select incomplete cases.
myIncomplete <- mydataNA[ !complete.cases(mydataNA), ]

myIncomplete

# When "99" Has Meaning...

mydataNA <- read.table("mydataNA.txt", na.strings = ".")
mydataNA
attach(mydataNA)

# Assign missing values for q variables.
mydataNA$ql[ql == 9] <- NA
mydataNA$q2[q2 == 9] <- NA
mydataNA$q3[g3 == 99] <- NA
mydataNA$q4 [q4 == 99] <- NA

mydataNA

detach(mydataNA)

# Read file again, this time use functiomns.

mydataNA <- read.table("mydataNA.txt", na.strings = ".")
mydataNA

attach(mydataNA)
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Fig. 10.1. Renaming a variable using R’s data editor

#Create a functions that replaces 9, 99 with NAs.
my9isNA <- function(x) { x[x == 9] <- NA; x}
my99isNA <- function(x) { x[x == 99] <- NA; x}

# Now apply our functions to the data frame using lapply.
mydataNA[3:4] <- lapply( mydataNA[3:4], my9isNA )
mydataNA[5:6] <- lapply( mydataNA[5:6], my99isNA )
mydataNA

10.6 Renaming Variables (and Observations)

In SAS and SPSS, you do not know where variable names are stored or how.
You just know they are in the data set somewhere. Renaming is simply a
matter of matching the new name to the old name with a RENAME statement.
In R however, both row and column names are stored in attributes — essentially
character vectors — within data objects. In essence, they are just another form
of data that you can manipulate.

If you use Microsoft Windows, you can see the names in R’s data editor,
and changing them there manually is a very easy way to rename them. The
function call fix(mydata) brings up the data editor. Clicking on the name of
a variable opens a box that enables you to change its name. In Fig. 10.1, I
am in the midst of changing the name of the variable q1 (see the name in the
spreadsheet) to x1.

Closing the variable editor box, the data editor completes your changes.
If you use Macintosh or Linux, the fix function does not work this way.
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However, on any operating system, you can use functions to change variable
names.

The programming approach to changing names that feels the closest to
SAS or SPSS is the rename function in Wickham’s reshape?2 package [70]. It
works with the names of data frames or lists. To use it, install the package
and then load it with the 1library function. Then create a character vector
whose values are the new names. The names of the vector elements are the old
variable names. This approach makes it particularly easy to to rename only a
subset of your variables. It also feels very familiar to SAS or SPSS users since
it follows the old-name = new-name style of their RENAME commands.

> library("reshape2")
> myChanges <- c(ql = "x1", g2 = "x2", g3 = "x3", g4 = "x4")
> myChanges

ql g2 g3 g4
"Xl" IIX2|I "XB" IIX4II

Now it is very easy to change names with

> mydata <- rename(mydata, myChanges)

> mydata

workshop gender x1 x2 x3 x4
1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
4 2 <KNA> 3 1 NA 3
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

R’s built-in approach to renaming variables is very different. It takes ad-
vantage of the fact that the variable names are simply stored as a character
vector. Therefore, any method for manipulating vectors or character strings
will work with them. You just have to know how to access the name vector.
That is what the names function does. Simply entering names (mydata) causes
R to print out the names vector:

> names (mydata)

[1] llworkshopll Ilgenderll llqlll llq2ll Ilq3l| Ilq4ll
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Fig. 10.2. Renaming variables using the edit function

The names function works for data frames, lists, and vectors. You can also
assign a character vector of equal length to that function call, which renames
the variables. With this approach, you supply a name for every variable.

> names(mydata) <- c("workshop","gender","x1", "x2","x3","x4")
> mydata

workshop gender x1 x2 x3 x4
1 1 f 11 5 1
2 2 f 2 1 4 1

If you work with matrices, use the very similar rownames and colnames
functions. You access the names of arrays via the dimnames function.

You can also use subscripting for this type of renaming. Since gender is
the second variable in our data frame, you could change just the name gender
to sex as follows:

names (mydata) [2] <- "sex"

The edit function, described in Sect. 6.1, “The R Data Editor,” will gen-
erate a character vector of variable names, complete with the ¢ function and
parentheses. In Fig. 10.2, you can see the command I entered and the window
that it opened. I have changed the name of the variable “gender” to “sex.”
When I finish my changes, closing the box will execute the command.

10.6.1 Advanced Renaming Examples

The methods shown above are often sufficient to rename your variables. You
can view this section either as beating the topic to death, or as an opportunity
to gain expertise in vector manipulations that will be helpful well outside the
topic at hand. The approach used in Sect. 10.6.4, “Renaming Many Sequen-
tially Numbered Variable Names,” can be a real time saver.
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10.6.2 Renaming by Index

Let us extract the names of our variables using the names function.

> mynames <- names (mydata)

> mynames

[1] "WOI'kShOP" llgender q-1|I Ilq2l| Ilqsll |Iq4ll

Now we have a character vector whose values we can change using the R
techniques we have covered elsewhere. This step is not really necessary since
the names are already stored in a vector inside our data frame, but it will make
the examples easier to follow. We would like to obtain the index value of each
variable name. Recall that whenever a data frame is created, row names are
added that are sequential numbers by default. So we can use the data.frame
function to number our variable names:

> data.frame (mynames)

mynames
1 workshop
2 gender
3 ql
4 q2
5 q3
6 q4

We see from the above list that gl is the third name and g4 is the sixth.
We can now use that information to enter new names directly into this vector
and print the result so that we can see if we made any errors:

mynames [3] <- "x1"
mynames [4] <- "x2"
mynames [5] <- "x3"
mynames [6] <- "x4"

vV V V V

> mynames

[1] llworkshopll llgenderll "Xl“ IIX2II IIXSII IIX4II

That looks good, so let us place those new names into the names attribute of
our data frame and look at the results:

> names (mydata) <- mynames
> mydata
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workshop gender x1 x2 x3 x4
1 5 1
1 4 1

1 1 f 1
2 2 f 2

As you will see in the program below, each time we use another method
of name changes, we need to restore the old names to demonstrate the new
techniques. We can accomplish this by either reloading our original data frame

or using

names (mydata) <- c("workshop", "gender", "ql", "g2", "q3", "g4")

10.6.3 Renaming by Column Name

If you prefer to use variable names instead of index numbers, that is easy to

do. We will make another copy of mynames:

> mynames <- names (mydata)

> mynames

[1] "workshop" "gender

Now we will make the same changes but using a logical match to find where
mynames == "ql1" and so on and assigning the new names to those locations:

q1 n

Ilq2l|

IIX2 n

> mynames [ mynames == "qi1" ] <- "x1"
> mynames [ mynames == "g2" ] <- "x2"
> mynames [ mynames == "q3" ] <- "x3"
> mynames [ mynames == "qg4" ] <- "x4"
> mynames

[1] "workshop" ‘"gender" "x1"

Finally, we put the new set mynames into the names attribute of our data

frame, mydata:

> names (mydata) <- mynames

> mydata

workshop gender x1 x2 x3 x4
1 1 5
2 1 4

1 1 £
2 2 £
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You can combine all these steps into one, but it can be very confusing to read
at first:

names (mydata) [names (mydata) == "q1"] <- "x1"
names (mydata) [names (mydata) == "q2"] <- "x2"
names (mydata) [names (mydata) == "q3"] <- "x3"
names (mydata) [names (mydata) == "q4"] <- "x4"

10.6.4 Renaming Many Sequentially Numbered Variable Names

Our next example works well if you are changing many variable names, like
100 variables named x1, x2, etc. over to similar names like y1, y2, and so
forth. You occasionally have to make changes like this when you measure
many variables at different times and you need to rename the variables in
each data set before joining them all.

In Sect. 7.4, “Selecting Variables by Column Name,” we learned how the
paste function can append sequential numbers onto any string. We will use
that approach here to create the new variable names:

> mst <- paste( nx", 1:4, sep = iy
> myXs

[1] Ny Nxon IIXBII Mg

Now we need to find out where to put the new names. We already know this
of course, but we found that out in the previous example by listing all of the
variables. If we had thousands of variables, that would not be a very good
method. We will use the method we covered previously (and in more detail)
in the Sect. 7.11, “Generating indices A to Z from Two Variable Names™:

> myA <- which( names(mydata) == "ql1" )
> myA

(1] 3

> myZ <- which( names(mydata) "q4" )
> myZ
[1] 6

Now we know the indices of the variable names to replace; we can replace
them with the following command:
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> names (mydata) [myA:myZ] <- myXs
> mydata

workshop gender x1 x2 x3 x4
1 1 f 11 5 1
2 2 f 2 1 4 1

10.6.5 Renaming Observations

R has row names that work much the same as variable names, but they apply
to observations. These names must be unique and often come from an ID vari-
able. When reading a text file using functions like read.csv, the row.names
argument allows you to specify an ID variable. See Sect. 6.2, “Reading Delim-
ited Text Files,” for details.

Row names are stored in a vector called the row names attribute. Therefore,
when renaming rows using a variable, you must select it so that it will pass
as a vector. In the examples below, the first three select a variable named “id”
as a vector, so they work. The last approach looks almost like the first, but it
selects id as a data frame, which will not fit in the row names attribute. Recall
that leaving out the comma in mydata["id"] makes R select a variable as a
data frame. The moral of the story is that when renaming observations using
index values, keep the commal!

> row.names (mydata) <- mydatal ,"id"] # This works.

> row.names (mydata) <- mydata$id # This works too.
> row.names (mydata) <- mydatal[["id"]] # This does too.
> row.names (mydata) <- mydata["id"] # This does not.
Error in 'row.names<-.data.frame'('*tmp*',

value = list(id = c(1, 2, 3,
invalid 'row.names' length

10.6.6 Example Programs for Renaming Variables

For many of our programming examples, the R programs are longer because
they demonstrate a wider range of functionality. In this case, renaming vari-
ables is definitely easier in SAS and SPSS. R does have a greater flexibility in
this area, but it is an ability that only a fanatical programmer could love!
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SAS Program for Renaming Variables

* Filename: Rename.sas ;
LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydata;
RENAME ql-g4=x1-x4;

*or;
*RENAME ql=x1 q2=x2 q3=x3 q4=x4;

RUN;

SPSS Program for Renaming Variables

* Filename: Rename.sps .

CD 'C:\myRfolder'.

GET FILE='mydata.sav'.

RENAME VARIABLES (ql=x1) (q2=x2) (q3=x3) (q4=x4) .
* Or...

RENAME VARIABLES (ql g2 93 g4 = x1 x2 x3 x4).
* Or...

RENAME VARIABLES (ql TO g4 = x1 TO x4).

R Program for Renaming Variables

# Filename: Rename.R
setwd("c:/myRfolder")
load(file = "mydata.RData")
mydata

# Using the data editor.

fix(mydata)
mydata

# Restore original names for next example.

names (mydata) <- c("workshop", "gender",
Ilqlll s llq2ll , Ilq3ll s llq4ll>

# Using the reshape2 package.

library("reshape2")

265
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myChanges <- c(ql = "x1", g2 = "x2", g3 = "x3",

myChanges

mydata <- rename(mydata, myChanges)
mydata

# Restore original names for next example.
names (mydata) <- c("workshop", "gender",

Ilqlll s llq2ll , Ilq3l| s llq4ll)

# The standard R approach.

names (mydata) <- c("workshop", "gender",
lelll’ ||X2||’ "XB", ||X4||)
mydata

# Restore original names for next example.
names (mydata) <- c("workshop", "gender",
Ilqlll s l|q2|l , Ilq3l| s l|q4|l)

# Using the edit function.
names (mydata) <- edit( names(mydata) )
mydata

# Restore original names for next example.
names (mydata) <- ¢ ("workshop", "gender",
Ilqlll s l|q2ll , Ilq3l| s llq4ll)

#---Selecting Variables by Index Number---
mynames <- names (mydata)

# Data.frame adds index numbers to names.
data.frame (mynames) )

# Then fill in index numbers in brackets.
mynames [3] <- "x1"
mynames [4] <- "x2"
mynames [5] <- "x3"
mynames [6] <- "x4"

# Finally, replace old names with new.
names (mydata) <- mynames

mydata

# Restore original names for next example.

q4="X4")
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names (mydata) <- c("workshop", "gender",
Ilq1 n s l|q2|l , Ilq3l| s ||q4||)

#---Selecting Variables by Name---
# Make a copy to work on.
mynames <- names (mydata)

mynames

# Replace names in copy.

mynames [ mynames == "q1" ] <- "x1"
mynames [ mynames == "q2" ] <- "x2"
mynames [ mynames == "q3" ] <- "x3"
mynames [ mynames == "g4" ] <- "x4"
mynames

# Then replace the old names.
names (mydata) <- mynames
mydata

# Restore original names for next example.
names (mydata) <- c¢ ("workshop", "gender",

Ilqlll s llq2|l , Ilq3’l s llq4ll>

#-—--Same as Above, but Confusing!---

names (mydata) [names (mydata) == "q1"] <- "x1"
names (mydata) [names (mydata) == "q2"] <- "x2"
names (mydata) [names (mydata) == "q3"] <- "x3"
names (mydata) [names (mydata) == "q4"] <- "x4"

print (mydata)

# Restore original names for next example.
names (mydata) <- c("workshop", "gender",
Ilqlll s l|q2|l , Ilq3l| s l|q4|l)

#-—--Replacing Many Numbered Names---

# Examine names
names (mydata)

# Generate new numbered names.
myXs <- paste( "x", 1:4, sep = "")
myXs
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# Find out where to put the new names.

myA <- which( names(mydata) == "ql1" )
myA
myZ <- which( names(mydata) == "q4" )
myZ

# Replace names at index locations.
names (mydata) [myA:myZ] <- myXs(mydata)

#remove the unneeded objects.
rm(myXs, myA, myZ)

10.7 Recoding Variables

Recoding is just a simpler way of doing a set of related IF/THEN conditional
transformations. Survey researchers often collapse five-point Likert-scale items
into simpler three-point Disagree/Neutral/Agree scales to summarize results.
This can also help when a cross-tabulation (or similar analysis) with other
variables creates tables that are too sparse to analyze.

Recoding can also reverse the scale of negatively worded items so that
a large numeric value has the same meaning across all items. It is easier to
reverse scales by subtracting each score from 6 as in

mydata$qrl <- 6-mydata$ql

That results in 6-5=1, 6-4=2, and so on.

There are two important issues to consider when recoding data. First,
collapsing a scale loses information and power. You will lessen your ability to
find significant, and hopefully useful, relationships. Second, recoding nominal
categorical variables like race can be disastrous. For example, inexperienced
researchers often recode race into Caucasian and Other without checking to
see how reasonable that is beforehand. You should do an analysis to see if the
groups you are combining show similar patterns with regard to your dependent
variable of interest. Given how much time that can add to the overall analysis,
it is often far easier to set values to missing. Simply focus your analysis on the
groups for which you have sufficient data rather than combine groups without
justification.

SAS does not have a separate recode procedure as SPSS does, but it does
offer a similar capability using its value label formats. That has the useful
feature of applying the formats in categorical analyses and ignoring them oth-
erwise. For example, PROC FREQ will use the format but PROC MEANS
will ignore it. You can also recode the data with a series of IF/THEN state-
ments. I show both methods below. For simplicity, I leave the value labels out
of the SPSS and R programs. I cover those in Sect. 11.1, “Value Labels or
Formats (and Measurement Level).”
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For recoding continuous variables into categorical ones, see the cut func-
tion in base R and the cut2 function in Frank Harrell’s Hnisc package. For
choosing optimal cut points with regard to a target variable, see the rpart
function in the rpart package or the tree function in the Hmisc package.

It is wise to avoid modifying your original data, so recoded variables are
typically stored under new names. If you named your original variables ql, q2,
etc. then you might name the recoded ones qrl, qr2, etc. with "r” representing
recoded.

10.7.1 Recoding a Few Variables

We will work with the recode function from John Fox’s car package, which
you will have to install before running this. See Chap. 2, “Installing and
Updating R,” for details. We will apply it below to collapse our five-point
scale down to a three-point one representing just disagree, neutral, and agree:

> library("car")

mydata$qrl <- recode(ql, "1=2; 5
mydata$qr2 <- recode(q2, "1=2; 5=
mydata$qr3 <- recode(q3, "1=2; 5
mydata$qrd <- recode(qd, "1=2; 5

V V V V

> mydata

workshop gender ql g2 g3 g4 qrl gr2 qr3 qr4

1 1 f 1 1 5 1 2 2 4 2
2 2 f 2 1 4 1 2 2 4 2
3 1 f 2 2 4 3 2 2 4 3
4 2 <KNA> 3 1 NA 3 3 2 NA 3
5 1 m 4 5 2 4 4 4 2 4
6 2 m 5 4 5 5 4 4 4 4
7 1 m 5 3 4 4 4 3 4 4
8 2 m 4 5 5 5 4 4 4 4

The recode function needs only two arguments: the variable you wish to
recode and a string of values in the form “oldi=newl; old2=new2;...".

10.7.2 Recoding Many Variables

The above approach worked fine with our tiny data set, but in a more realistic
situation, we would have many variables to recode. So let us scale this example
up. We learned how to rename many variables in Sect. 10.6.4, so we will use
that knowledge here.
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> myQnames <- paste( "q", 1:4, sep = "")
> my(Qnames

[1] "g1" "g2" "g3" "g4"

> myQRnames <- paste( "qr", 1:4, sep = "")
> myQRnames

[1] llqull Ilqr2ll llqr3|I Ilqr4ll

Now we will use the original names to extract the variables we want to recode
to a separate data frame:

> myQRvars <- mydatal ,myQnames]
> myQRvars

ql g2 g3 g4
11 1 56 1
2 2 1 4 1
3 2 2 4 3
4 3 1NA 3
5 4 5 2 4
6 5 4 5 5
7 5 3 4 4
8 4 5 5 5

We will use our other set of variable names to rename the variables we just
selected:

> names (myQRvars) <- myQRnames
> myQRvars

qrl qr2 qr3 qr4

1 1 1 5 1
2 2 1 4 1
3 2 2 4 3
4 3 1 NA 3
5 4 5 2 4
6 5 4 5 b5
7T 5 3 4 4
8 4 &5 5 b

Now we need to create a function that will allow us to apply the recode
function to each of the selected variables. Our function only has one argument,
x, which will represent each of our variables:
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myRecoder <- function(x) { recode(x,"1=2;5=4") }

Here is how we can use myRecoder on a single variable. Notice that the
qrl variable had a 1 for the first observation, which myRecoder made a 2. It
also had values of 5 for the sixth and seventh observations, which became 4s:

> myQRvars$qri
[1] 12234554
> myRecoder (myQRvars$qrl)

[11 22234444

To apply this function to our whole data frame, myQRvars, we can use the
sapply function:

> myQRvars <- sapply( myQRvars, myRecoder)
> myQRvars

qrl qr2 qr3 qr4

1,17 2 2 4 2
2,] 2 2 4 2
3,] 2 2 4 3
[(4,] 3 2 NA 3
[5,] 4 4 2 4
6,] 4 4 4 4
(7,1 4 3 4 4
8,1] 4 4 4 4

The sapply function has converted our data frame to a matrix, but that is
fine. We will use the cbind function to bind these columns to our original
data frame:

> mydata <- cbind(mydata,myQRvars)
> mydata

workshop gender ql g2 g3 g4 qrl gr2 qr3 qr4

1 1 f 1 1 56 1 2 2 4 2
2 2 f 2 1 4 1 2 2 4 2
3 1 f 2 2 4 3 2 2 4 3
4 2 <NA> 3 1NA 3 3 2 NA 3
5 1 m 4 5 2 4 4 4 2 4
6 2 m 5 4 5 5 4 4 4 4
7 1 m 5 3 4 4 4 3 4 4
8 2 m 4 5 5 5 4 4 4 4
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Now we can use either the original variables or their recoded counterparts in
any analysis we choose. In this simple case, it was not necessary to create the
myRecoder function. We could have used the form,

sapply (myQRvars, recode, "1=2;5=4")

However, you can generalize the approach we took to far more situations.

10.7.3 Example Programs for Recoding Variables
SAS Program for Recoding Variables

* Filename: Recode.sas ;

LIBNAME myLib 'C:\myRfolder';

DATA myLib.mydata;

INFILE 'S\myRfolder\mydata.csv' csvS delimiter = 'S,' S
MISSOVER DSD LRECL=32767 firstobs=2 ;

INPUT id workshop gender $ ql g2 g3 q4;
PROC PRINT; RUN;

PROC FORMAT;
VALUE Agreement 1="Disagree" 2="Disagree"
3="Neutral"
4="Agree" b="Agree"; run;

DATA myLib.mydata;
SET myLib.mydata;
ARRAY q ql-q4;
ARRAY gr qrl-qr4; *r for recoded;

DO i=1 to 4;
qr{it=q{i};
if g{i}=1 then qr{i}=2;
else
if q{i}=5 then qr{i}=4;
END;
FORMAT q1-94 ql-qg4 Agreement.;
RUN;

* This will use the recoded formats automatically;
PROC FREQ; TABLES ql-q4; RUN;

* This will ignore the formats;
* Note high/low values are 1/5;
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PROC UNIVARIATE; VAR ql-qg4; RUN;

* This will use the 1-3 codings, not a good idea!;
x High/Low values are now 2/4;

PROC UNIVARIATE; VAR grl-qr4;

RUN;

SPSS Program for Recoding Variables

* Filename: Recode.sps .

CD 'C:\myRfolder'.
GET FILE='mydata.sav'.

RECODE q1 to g4 (1=2) (5=4).

SAVE OUTFILE='myleft.sav'.

R Program for Recoding Variables
# Filename: Recode.R
setwd("c:/myRfolder")

load(file = "myWorkspace.RData")
mydata

attach(mydata)

library("car")

mydata$qrl <- recode(ql, "1=2; 5=4")
mydata$qr2 <- recode(q2, "1=2; 5=4")
mydata$qr3 <- recode(q3, "1=2; 5=4")
mydata$qrd <- recode(qd, "1=2; 5=4")

mydata

# Do it again, stored in new variable names.
load(file = "mydata.RData")

attach(mydata)

# Generate two sets of var names to use.

myQnames <- paste( "q", 1:4, sep = "")
myQnames
myQRnames <- paste( "qr", 1:4, sep = "")
myQRnames

# Extract the q variables to a separate data frame.
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myQRvars <- mydatal ,myQnames]
myQRvars

# Rename all of the variables with R for Recoded.
names (myQRvars) <- myQRnames
myQRvars

# Create a function to apply the labels to lots of variables.
myRecoder <- function(x) { recode(x,"1=2; 5=4") }

# Here's how to use the function on one variable.
myQRvars$qri
myRecoder (myQRvars$qril)

#Apply it to all of the variables.
myQRvars <- sapply( myQRvars, myRecoder)
myQRvars

# Save it back to mydata if you want.
mydata <- cbind(mydata,myQRvars)
mydata

summary (mydata)

10.8 Indicator or Dummy Variables

When modeling with categorical variables like workshop, it is often useful to
create a series of indicator variables (also called dummy variables) that have
the value of one when true and zero when false. We have four workshops, so we
would usually need three indicator variables. You often need one less indicator
variable than there are categories because if someone took a workshop and it
was not SAS, SPSS, or Stata, then it must have been R. So there are only
k—1 unique pieces of information contained in a factor with k levels. However,
it is occasionally useful to include all k variables in a model with restrictions
on the corresponding parameter estimates.

Let us create indicator variables using mydatalO0 since it has all four
workshops:

> setwd("c:/myRfolder")
> load("mydatal00.RData")
> attach(mydatal00)

> head (mydatal00)
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gender workshop gl g2 g3 g4 pretest posttest

1 Female R 4 3 4 5 72 80
2 Male SPSS 3 4 3 4 70 75
3 <NA> <NA> 3 2 NA 3 74 78
4 Female SPSS 5 4 5 3 80 82
5 Female Stata 4 4 3 4 75 81
6 Female SPSS 5 4 3 5 72 7

You can create indicator variables using the ifelse function (Sect. 10.3)
or using the recode function (Sect. 10.7), but the easiest approach is the same
as in SAS or SPSS: using logic to generate a series of zeros and ones:

>r <- as.numeric(workshop == "R" )
> sas  <- as.numeric(workshop == "SAS" )
> spss <- as.numeric(workshop == "SPSS" )
> stata <- as.numeric(workshop == "Stata")

In each command the logical comparison resulted in TRUE if the person
took that workshop or FALSE if not. Then the as.numeric function converted
that to one or zero, respectively.

To see the result, let us use the data.frame function just to line up the
variables neatly and then call head to print the top six observations:

> head( data.frame(
+  workshop, r, sas, spss, stata) )

workshop r sas spss stata

1 R 1 0 0 0
2 SPSS 0 O 1 0
3 <NA> NA NA NA NA
4 SPSS 0 O 1 0
5 Stata 0 O 0 1
6 SPSS 0 O 1 0

Now that we have the variables, let us use them in a model. To keep it
simple, we will do a linear regression that only allows the y-intercepts of each
group to differ:

> Im(posttest ~ pretest + sas + spss + stata)

Call:
Im(formula = posttest

pretest + sas + spss + stata)

Coefficients:
(Intercept) pretest sas spss stata
16.3108 0.9473 -8.2068 -7.4949 -7.0646
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I left out the r variable, so the intercept is for the people in the r workshop;
all the other weights would be multiplied against their zero values. We will
consider linear regression in more detail in Chap. 17.

While knowing how to create indicator variables is useful in R, we did not
need to do it in this case. R, being object oriented, tries to do the right thing
with your data. Once you have told it that workshop is a factor, it will create
the indicator variables for you. Here I use workshop directly in the model:

> Im(posttest ~ pretest + workshop)

Call:
Im(formula = posttest

pretest + workshop)

Coefficients:
(Intercept) pretest workshopSAS workshopSPSS workshopStata
16.3108 0.9473 -8.2068 -7.4949 -7.0646

So you see that the result is the same except that in our first example we got
to choose the variable names while in the second, R chose reasonable names
for us.

It is clear in the first example why the R workshop is the “all zeros” level
to which the others are being compared because I chose to leave out the
variable r. But why did R choose to do that, too? Let us print a few workshop
values and then count them:

> head (workshop)

[11 R SPSS <NA> SPSS Stata SPSS
Levels: R SAS SPSS Stata

> table(workshop)

workshop
R SAS SPSS Stata
31 24 25 19

Notice in both cases that when the levels of the factor are displayed that they
are in the same order and “R” is the first level. This is caused by their order
on the levels and matching labels arguments when the factor was created.
You can change that by using the relevel function:

> workshop <- relevel(workshop, "SAS")

This relevel function call used only two arguments, the factor to relevel
and the level that we want to make first in line. Now let us see how it changed
things:
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> table(workshop)

workshop
SAS R SPSS Stata
24 31 25 19

> coef( 1lm(posttest ~ pretest + workshop) )

(Intercept) pretest  workshopR workshopSPSS workshopStata
8.1039484 0.9472987 8.2068027 0.7119439 1.1421791

We see that the order in the table output has SAS first, and we see that
the equation now includes a parameter for all workshops except for SAS. If a
person took a workshop and it was not for R, SPSS, or Stata, well, then it
was for SAS.

If we did a more realistic model and included the interaction between
pretest and workshop, R would have generated another three parameters to
allow the slopes of each group to differ.

There is a function in the built-in nnet package called class.ind that
creates indicator variables. However, it assigns missing values on a factor to
zeros on the indicator variables. That is not something I typically want to
have happen.

If you have a factor that is ordinal, that is, created using the ordered
function rather than factor, then the dummy variables will be coded using
polynomial contrasts. For more details on contrasts, see help("contrast").

10.8.1 Example Programs for Indicator or Dummy Variables
SAS Program for Indicator or Dummy Variables

* Filename: IndicatorVars.sas ;

LIBNAME myLib 'C:\myRfolder';
DATA temp; SET myLib.mydatalOO;

r = workshop = 1;
sas = workshop = 2;
spss = workshop = 3;
stata = workshop = 4;
RUN;
PROC REG;

MODEL posttest = pretest sas spss stata;
RUN;
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SPSS Program for Indicator or Dummy Variables

This program uses standard SPSS syntax. An alternative approach is to in-
stall the Python plug-in and use the SPSSINC CREATE DUMMIES extension
command. It will discover the values and generate and label the indictor vari-
ables automatically. Its dialog appears on the Transform> Create Dummy
Variables menu after installation.

* Filename: IndicatorVars.sps.

CD 'C:\myRfolder'.
GET FILE='mydatal0O.sav'.
DATASET NAME DataSet2 WINDOW=FRONT.

COMPUTE r = workshop EQ 1.
COMPUTE sas = workshop EQ 2.
COMPUTE spss = workshop EQ 3.
COMPUTE stata = workshop EQ 4.
EXECUTE.

REGRESSION

/DEPENDENT posttest
/METHOD=ENTER pretest sas spss stata.
EXECUTE.

R Program for Indicator or Dummy Variables

# Filename: IndicatorVars.R

setwd("c:/myRfolder")
load("mydatal00.RData")

attach(mydatal00)

head (mydatal00)

r <- as.numeric(workshop == "R" )
sas  <- as.numeric(workshop == "SAS" )
spss <- as.numeric(workshop == "SPSS" )
stata <- as.numeric(workshop == "Stata")

head( data.frame(
workshop, r, sas, spss, stata) )

Im(posttest ~ pretest + sas + spss + stata)
lm(posttest ~ pretest + workshop)
head (workshop)

table (workshop)
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workshop <- relevel (workshop, "SAS")
table (workshop)
coef ( lm(posttest

pretest + workshop) )

library("nnet")
head( class.ind(workshop) )

10.9 Keeping and Dropping Variables

In SAS, you use the KEEP and DROP statements to determine which vari-
ables to save in your data set. The SPSS equivalent is the DELETE VARI-
ABLES command. In R, the main methods to do this within a data frame are
discussed in Chap. 7, “Selecting Variables.” For example, if we want to keep
variables on the left side of our data frame, workshop through q2 (variables 1
through 4), an easy way to do this is with

myleft <- mydatal ,1:4]

We will strip off the ones on the right side in a future example on merging
data frames.
Another way to drop variables is to assign the NULL object to them:

mydata$varname <- NULL

This has the advantage of removing a variable without having to make a
copy of the data frame. That may come in handy with a data frame so large
that your workspace will not hold a copy, but it is usually much safer to work
on copies when you can. Mistakes happen! You can apply NULL repeatedly
with the form

myleft <- mydata

myleft$q3 <- myleft$q4 <- NULL

NULL is only used to remove components from data frames and lists. You
cannot use it to drop elements of a vector, nor can you use it to remove a
vector by itself from your workspace.

In Sect. 13.6, “Removing Objects from Your Workspace,” we will discuss
removing objects using the rm function. That function removes only whole
objects; it cannot remove variables from within a data frame:

rm( mydata$q4 ) # This does NOT work.
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10.9.1 Example Programs for Keeping and Dropping Variables
SAS Program for Keeping and Dropping Variables

* Filename: DropKeep.sas ;

LIBNAME myLib 'C:\myRfolder';
DATA myleft; SET mydata;

KEEP id workshop gender ql q2;
PROC PRINT;
RUN;

*or equivalently;

DATA myleft; SET mydata;
DROP g3 q4;

PROC PRINT;

RUN;

SPSS Program for Keeping and Dropping Variables
* Filename: DropKeep.sps ;

CD 'C:\myRfolder'.

GET FILE='mydata.sav'.
DELETE VARIABLES g3 to q4.
LIST.

SAVE OUTFILE='myleft.sav'.

R Program for Keeping and Dropping Variables

# Filename: DropKeep.R

setwd("c:/myRfolder")
load(file = "mydata.RData")

# Using variable selection.
myleft <- mydatal ,1:4]
myleft

# Using NULL.

myleft <- mydata

myleft$q3 <- myleft$qé <- NULL
myleft
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10.10 Stacking/Concatenating/Adding Data Sets

Often we find data divided into two or more sets due to collection at different
times or places. Combining them is an important step prior to analysis. SAS
calls this concatenation and accomplishes this with the SET statement. SPSS
calls it adding cases and does it using the ADD FILES statement. R, with its
row/column orientation, calls it binding rows.

To demonstrate this, let us take our practice data set and split it into
separate ones for females and males. Then we will bind the rows back together.
A split function exists to do this type of task, but it puts the resulting data
frames into a list, so we will use an alternate approach.

First, let us get the females:

> females <- mydatal which(gender == "f"), ]
> females

workshop gender ql g2 g3 q4

1 1 f 11 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
Now we get the males:
> males <- mydatal which(gender == "m"), ]
> males

workshop gender ql g2 g3 g4
5 1 m 4 5 2 4
6 2 m 5 4 5 5
7 1 m 5 3 4 4
8 2 m 4 5 5 5

We can put them right back together by binding their rows with the rbind
function. The “r” in rbind stands for row.

> both <- rbind(females, males)
> both

workshop gender ql g2 g3 g4
1 f 1 1 5

0N OWwN
N RN RPN
B B B B H m
OO NN
gwd 0N e
G0N
a0 W
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This works fine when the two data frames share the exact same variables.
Often the data frames you will need to bind will have a few variables missing.
We will drop variable g2 in the males data frame to create such a mismatch:

> males$q2 <- NULL
> males

workshop gender ql q3 g4

0 N o O,

2 m 5 5 5
1 m 5 4 4
2 m 4 5 5
Note that variable q2 is indeed gone. Now let us try to put the two data frames

together again:

> both <- rbind(females, males)

Error in match.names(clabs, names(xi))
names do not match previous names

It fails because the rbind function needs both data frames to have the ex-
act same variable names. Luckily, Wickham’s plyr package has a function,
rbind.fill, that binds whichever variables it finds that match and then fills
in missing values for those that do not. This next example assumes that you
have installed the plyr package. See Chap. 2, “Installing and Updating R,”
for details.

> library("plyr")
> both <- rbind.fill(females, males)
> both

workshop gender ql g2 g3 q4

1 1 f 1 1 5 1
2 2 f 2 1 4 1
3 1 f 2 2 4 3
5 1 m 4NA 2 4
6 2 m 5NA 5 5
7 1 m 5NA 4 4
8 2 m 4NA 5 5

We can do the same thing with the built-in rbind function, but we have to
first determine which variables we need to add and then add them manually
with the data.frame function and set them to NA:
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> males <- data.frame( males, g2=NA )
> males

workshop gender ql g3 g4 g2

5 1 m 4 2 4 NA
6 2 m 5 5 5 NA
7 1 m 5 4 4 NA
8 2 m 4 5 5 NA

The males data frame now has a variable q2 again, and so we can bind the
two data frames using rbind. The fact that g2 is now on at the end will not
matter. The data frame you list first on the rbind function call will determine
the order of the final data frame. However, if you use index values to refer to
your variables, you need to be aware of the difference!

> both <- rbind(females, males)
> both

workshop gender ql g2 q
1 f 1

1

2

NA

NA

NA

4 NA

0 ~NOoOwWN -
N =N R =N
8 B B B H H
OO NN -
abd N D D oW
Q
(2SN & 2 IRV SN O I T

With such a tiny data frame, this is an easy way to address the mismatched
variables problem. However, in situations that are more realistic, rbind.fill
is usually a great time saver.

10.10.1 Example Programs for Stacking/Concatenating/Adding
Data Sets

SAS Program for Stacking/Concatenating/Adding
Data Sets

* Filename: Stack.sas ;
LIBNAME myLib 'C:\myRfolder';

DATA males;
SET mydata;
WHERE gender='m';
RUN;
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PROC PRINT; RUN;

DATA females;
SET mydata;
WHERE gender='f';
RUN;

PROC PRINT; RUN;

DATA both;
SET males females;
RUN;

PROC PRINT; RUN;

SPSS Program for Stacking/Concatenating/Adding
Data Sets

* Filename: Stack.sps .
CD 'C:\myRfolder'.

GET FILE='mydata.sav'.
SELECT IF(gender = "f").
LIST.

SAVE OUTFILE='females.sav'.
EXECUTE .

GET FILE='mydata.sav'.
SELECT IF(gender = "m").
LIST.

SAVE OUTFILE='males.sav'.
EXECUTE .

GET FILE='females.sav'.

ADD FILES /FILE=x
/FILE='males.sav'.

LIST.

EXECUTE .

R Program for Stacking/Concatenating/Adding Data Sets

# Filename: Stack.R

setwd ("c:/myRfolder")
load(file = "mydata.RData")
mydata

attach(mydata)
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# Create female data frame.
females <- mydatal which(gender == "f"), 1]
females

# Create male data frame.
males <- mydata[ which(gender == "m"), ]
males

#Bind their rows together with the rbind function.
both <- rbind(females, males)
both

# Drop g2 to see what happens.
males$q2 <- NULL
males

# See that row bind will not work.
both <- rbind(females, males)

# Use plyr rbind.fill.
library("plyr")

both <- rbind.fill(females, males)
both

# Add a g2 variable to males.
males <- data.frame(males, g2 = NA)
males

# Now rbind can handle it.

both <- rbind(females, males)
both

10.11 Joining/Merging Data Sets
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One of the most frequently used data manipulation methods is joining or merg-
ing two data sets, each of which contains variables that the other lacks. SAS
does this with its MERGE statement, and SPSS uses its ADD VARIABLES

command.

If you have a one-to-many join, it will create a row for every possible
match. A common example is a short data frame containing household-level
information such as family income joined to a longer data set of individual
family member variables. A complete record of each family member along
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with his or her household income will result. Duplicates in more than one
data frame are possible, but you should study them carefully for errors.

So that we will have an ID variable to work with, let us read our practice
data without the row.names argument. That will keep our ID variable as is
and fill in row names with 1, 2, 3, etc.

> mydata <- read.table("mydata.csv",
TRUE, sep = ",",

+ header

> mydata

id workshop gender ql g2

1

O ~NO Ok WN -
0 N O O WwN

1

N =N~ N~ N

f
f
f
<NA>
m

m
m
m

1

OO W NN

4

g wd oL, N = =

na.strings = " ")

Now we will split the left half of the data frame into one called myleft:

> myleft <- mydatal c("id", "workshop", "gender", "ql", "q2") ]

> myleft

id workshop gender ql g2

1

O ~NO O WN -
0 N O O d W N

1

N = N~ N~ N

£
f
f
<NA>
m

m
m
m

1

OO W NN

4

O wWd L, N = =

We then do the same for the variables on the right, but we will keep id and

workshop to match on later:

> myright <- mydatal c("id", "workshop", "q3", "q4") 1]

> myright

id workshop q3 q4

1 1
2 2

1
2

5 1
4 1
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Now we can use the merge function to put the two data frames back together:

> both <- merge(myleft, myright, by = "id")

> both

id workshop.x gender ql q2 workshop.y q3 g4

1 1 1
2 2 2
3 3 1
4 4 2
5 5 1
6 6 2
7T 1
8 8 2

This call to the merge function has three arguments:

N =

f
f
£
<NA>
m

m
m
m

1

OO NN

1

O Wb PN -

. The first data frame to merge.
. The second data frame to merge.

1

N =N~ DN~ N

5
4
4
NA

o 0N

Od 0w W -

3. The by argument, which has either a single variable name in quotes or a
character vector of names.

If you leave out the by argument, it will match by all variables with com-
mon names! That is quite unlike SAS or SPSS, which would simply match
the two row by row. That is what the R cbind function will do. It is much
safer to match on some sort of ID variable(s), though. Very often, rows do not
match up as well as you think they will.

Sometimes the same variable has two different names in the data frames
you need to merge. For example, one may have “id” and another “subject.” If
you have such a situation, you can use the by.x argument to identify the first
variable or set of variables and the by.y argument to identify the second. The
merge function will match them up in order and do the proper merge. In this
next example, I do just that. The variables have the same name, but it still

works:

> both <- merge(myleft,

+

by.x =

myright,
Ilid", by.y = llidll)
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> both

id workshop gender ql g2 q3 g4
11 1 f 11 5 1
2 2 2 f 2 1 4 1
3 3 1 f 2 2 4 3
4 4 2 <KNA> 3 1 NA 3
5 5 1 m 4 5 2 4
6 6 2 m 5 4 5 5
T T 1 m 5 3 4 4
8 8 2 m 4 5 5 5

If you have multiple variables in common, but you only want to match on
a subset of them, you can use the form

both <- merge( myleft, myright,
by = c("id", "workshop") )

If each file had variables with slightly different names, you could use the form

both <- merge( myleft,myright, by.x = c("id", "workshop")
y.y = c("subject", "shortCourse") )

By default, SAS and SPSS keep all records regardless of whether or not
they match (a full outer join). For observations that do not have matches in
the other file, the merge function will fill them in with missing values. R takes
the opposite approach, keeping only those that have a record in both (an inner
join). To get merge to keep all records, use the argument all = TRUE. You can
also use all.x = TRUE to keep all of the records in the first file regardless of
whether or not they have matches in the second. The all.y = TRUE argument
does the reverse.

While SAS and SPSS can merge any number of files at once, base R can
only do two at a time. To do more, you can use the merge_all function in
the reshape package.

10.11.1 Example Programs for Joining/Merging Data Sets
SAS Program for Joining/Merging Data Sets

* Filename: Merge.sas ;
LIBNAME myLib 'C:\myRfolder';

DATA myLib.myleft;

SET mylib.mydata;

KEEP id workshop gender ql q2;
PROC SORT; BY id workshop; RUN;
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DATA myLib.myright;
SET myLib.mydata;
KEEP id workshop q3 qg4;
PROC SORT; BY id workshop; RUN;

DATA myLib.both;
MERGE myLib.myleft myLib.myright;
BY id workshop;

RUN;

SPSS Program for Joining/Merging Data Sets

* Filename: Merge.sps .
CD 'C:\myRfolder'.

GET FILE='mydata.sav'.
DELETE VARIABLES g3 to q4.
SAVE OUTFILE='myleft.sav'.

GET FILE='mydata.sav'.
DELETE VARIABLES gender, gl to qg2.
SAVE OUTFILE='myright.sav'.

GET FILE='myleft.sav'.

MATCH FILES /FILE=*
/FILE="myright.sav'
/BY id.

R Program for Joining/Merging Data Sets

# Filename: Merge.R
setwd ("c:/myRfolder")

# Read data keeping ID as a variable.
mydata <- read.table("mydata.csv",

header = TRUE, sep = ",", na.strings = " ")
mydata

# Create a data frame keeping the left two q variables.

myleft <- mydatal c("id", "workshop", "gender", "qi", "q2") ]

myleft

# Create a data frame keeping the right two q variables.
myright <- mydatal c("id", "workshop", "q3", "q4") ]
myright

289
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# Merge the two data frames by ID.
both <- merge(myleft, myright, by = "id")
both

# Merge the two data frames by ID.
both <- merge(myleft, myright,
by.x = "id", by.y = "id" )

#Merge data frames by both ID and workshop.
both <- merge(myleft, myright, by = c("id","workshop"))
both

#Merge dataframes by both ID and workshop,
#while allowing them to have different names.
both <- merge(myleft,
myright,
by.x=c("id", "workshop"),
by.y=c("id", "workshop") )
both

10.12 Creating Summarized or Aggregated Data Sets

We often have to work on data that are a summarization of other data. For
example, you might work on household-level data that you aggregated from a
data set that had each family member as its own observation. SAS calls this
summoarization and performs it with the SUMMARY procedure. SPSS calls
this process aggregation and performs it using the AGGREGATE command.

Database programmers call this rolling up data.

R has three distinct advantages over SAS and SPSS regarding aggregation.

1. It is possible to perform multilevel calculations and selections in a single

step, so there is less need to create aggregated data sets.

2. R can aggregate with every function it has and any function you write! It
is not limited to the few that SAS and SPSS build into SUMMARY and

AGGREGATE.

3. R has data structures optimized to hold aggregate results. Other functions

offer methods to take advantage of those structures.

10.12.1 The aggregate Function

We will use the aggregate function to calculate the mean of the ql variable

by gender and save it to a new (very small!) data frame.
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> attach(mydata)

> myAggl <- aggregate(ql,

+
+

by = data.frame(gender),
mean, na.rm = TRUE)

> myAggl

1
2

gender X

f 1.666667
m 4.500000

The aggregate function call above has four arguments.

. The variable you wish to aggregate.
. One or more grouping factors. Unlike SAS, the data do not have to be

sorted by these factors. The factors must be in the form of a list (or
data frame, which is a type of list). Recall that single subscripting of a
data frame creates a list. So mydata["gender"] and mydata[2] work.
Adding the comma to either one will prevent them from working. There-
fore, mydatal ,"gender"] or mydatal ,2] will not work. If you have at-
tached the data frame, data.frame (gender) will work. The function call
list(gender) will also work, but it loses track of the grouping variable
names.

. The function that you wish to apply — in this case — the mean function.

An important limitation of the aggregate function is that it can apply
only functions that return a single value. If you need to apply a function
that returns multiple values, you can use the tapply function.

. Arguments to pass to the function applied. Here na.rm = TRUE is passed

to the mean function to remove missing, or NA, values.

Next we will aggregate by two variables: workshop and gender. To keep

our by factors in the form of a list (or data frame), we can use any one of the
following forms:

mydatal c("workshop", "gender")]

or

mydatal c(2, 3) ]

or, if you have attached the data frame,

data.frame(workshop, gender)

In this example, we will use the latter form.
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> myAgg2 <- aggregate(ql,
+ by = data.frame(workshop, gender),
+ mean, na.rm = TRUE)

> myAgg2

workshop gender x
1 R f 1.5
2 SAS f 2.0
3 R m 4.5
4 SAS m 4.5

Now let us use the mode and class functions to see the type of object the
aggregate function creates is a data frame:

> mode (myAgg2)
[1] "1list"
> class(myAgg2)

[1] "data.frame"

It is small, but ready for further analysis.

10.12.2 The tapply Function

In the last subsection we discussed the aggregate function. That function has
an important limitation: you can only use it with functions that return single
values. The tapply function works very similarly to the aggregate function
but can perform aggregation using any R function. To gain this ability, it has
to abandon the convenience of creating a data frame. Instead, its output is in
the form of a matrix or an array.

Let us first duplicate the last example from the above subsection using

tapply:

> myAgg2 <- tapply(ql,
+ data.frame(workshop, gender),
+ mean, na.rm = TRUE)

> myAgg?2
gender
workshop f m
R 1.5 4.5
SAS 2.0 4.5
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The tapply function call above uses four arguments:

. The variable to aggregate.
. One or more grouping factors (or vectors that it will coerce into fac-

tors). Unlike SAS and SPSS, the data do not have to be sorted by these
factors. This must be in the form of a list (or data frame, which is a
list). Recall that single subscripting of a data frame creates a list. So
mydata["gender"] and mydata[2] work. Adding the comma to either
one will prevent them from working. Therefore, mydatal ,"gender"]
or mydatal ,2] will not work. If you have attached the data frame,
data.frame(gender) will work. The function call 1ist (gender) will also
work, but it loses track of the grouping variable names.

. The function to apply — in this case, the mean function. This function can

return any result, not just single values.

. Any additional parameters to pass to the applied function. In this case,

na.rm = TRUE is used by the mean function to remove NA or missing
values.

The actual means are, of course, the same as we obtained before using the

aggregate function. However, the result is now a numeric matrix rather than
a data frame.

> class(myAgg2)

(1]

"matrix"

> mode (myAgg2)

(1]

"numeric"

Now let us do an example that the aggregate function could not perform.

The range function returns two values: the minimum and maximum for each
variable:

> myAgg2 <- tapply(ql,

+
+

data.frame (workshop,gender) ,
range, na.rm = TRUE)

> myAgg2

gender

workshop £ m

R Numeric,2 Numeric,2
SAS Numeric,2 Numeric,2

This output looks quite odd! It is certainly not formatted for communicating
results to others. Let us see how it is stored:

> mode (myAgg2)
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[1] "list"
> class(myAgg2)

[1] "matrix"

It is a matrix, whose elements are lists. Let us look at the entry for the
females who took the R workshop. That result is stored in the first row and
first column:

> class( myAgg2[1,1] )
[1] "list"
> myAgg2[1,1]

[[1]1]
[11 1 2

So we see that each component in this matrix is a list that contains a single
vector of minimum and maximum values. The opinions of the females who
took the R workshop range from 1 to 2. While this output is not very useful
for communicating results, it is very useful as input for further programming.

10.12.3 Merging Aggregates with Original Data

It is often useful to add aggregate values back to the original data frame. This
allows you to perform multilevel transformations that involve both individual-
level and aggregate-level values. A common example of such a calculation is
a Z-score, which subtracts a variable’s mean and then divides by its standard
deviation (see Sect. 10.2.3 for an easier way to do that particular task).

Another important use for merging aggregates with original data is to
perform multilevel selections of observations. To select individual-level obser-
vations based on aggregate-level values requires access to both at once. For
example, we could create a subset of subjects who fall below their group’s
mean value.

This is an area in which R has a distinct advantage over SAS and SPSS. R’s
greater flexibility allows it to do both multilevel transformations and selections
in a single step.

Now let us calculate a Z-score for variable ql with the single following
statement. Note that we are specifying the long form of the name for our new
variable, mydata$Zql, so that it will go into our data frame.

> mydata$Zql <- (ql - mean(ql) ) / sd(ql)
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> mydata

workshop gender ql g2 g3 q4 Zq1
1 R f 1 1 5 1 -1.5120484
2 SAS f 2 1 4 1 -0.8400269
3 R f 2 2 4 3 -0.8400269
4 SAS <NA> 3 1 NA 3 -0.1680054
5 R m 4 5 2 4 0.5040161
6 SAS m 5 4 5 5 1.1760376
7 R m 5 3 4 4 1.1760376
8 SAS m 4 5 5 5 0.5040161

You can also select the observations that were below average with this single
statement:

> mySubset <- mydatal ql < mean(ql), ]

> mySubset

workshop gender ql g2 g3 g4 Zq1
1 R f 1 1 5 1 -1.5120484
2 SAS f 2 1 4 1 -0.8400269
3 R f 2 2 4 3 -0.8400269
4 SAS <NA> 3 1 NA 3 -0.1680054

SAS and SPSS cannot perform such calculations and selections in one step.
You would have to create the aggregate-level data and then merge it back into
the individual-level data set. R can use that approach too, and as the number
of levels you consider increases, it becomes more reasonable to do so.

So let us now merge myAgg2, created in Sect. 10.12.1, “The aggregate
Function,” to mydata. To do that, we will rename the mean of ql from x to
mean.ql using the rename function from the reshape package. If you do not
have that package installed, see Chap. 2, “Installing and Maintaining R.”

> library("reshape")
> myAgg3 <- rename(myAgg2, c(x = "mean.ql"))
> myAgg3

workshop gender mean.ql

1 R f 1.5
2 SAS f 2.0
3 R m 4.5
4 SAS m 4.5

Now we merge the mean onto each of the original observations:
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> mydata2 <- merge(mydata, myAgg3,
+ by = c("workshop", "gender") )

> mydata2

workshop gender ql g2 g3 q4 Zql mean.ql
1 R f 1 1 5 1 -1.5120484 1.5
2 R f 2 2 4 3 -0.8400269 1.5
3 R m 4 5 2 4 0.5040161 4.5
4 R m 5 3 4 4 1.1760376 4.5
5 SAS f 2 1 4 1 -0.8400269 2.0
6 SAS m 5 4 5 5 1.1760376 4.5
7 SAS m 4 5 5 5 0.5040161 4.5

The merge function call above has only two arguments.

1. The two data frames to merge. Unlike SAS and SPSS, which can merge
many data sets at once, R can only do two at a time.

2. The by argument specifies the variables to match on. In this case, they
have the same name in both data frames. They can, however, have different
names. See the merge help files for details. While some other functions
require by variables in list form, here you provide more than one variable
in the form of a character vector.

We can now perform multilevel transformations or selections
on mydata2.

10.12.4 Tabular Aggregation

The aim of table creation in SAS and SPSS is to communicate results to
people. You can create simple tables of frequencies and percentages using
the SAS FREQ procedure and SPSS CROSSTABS. For more complex tables,
SAS has PROC TABULATE, and SPSS has its CTABLES procedure. These
two create complex tables with basic statistics in almost any form, as well as
some basic hypothesis tests. However, no other procedures are programmed
to process these tables further automatically. You can analyze them further
using the SAS Output Delivery (ODS) or SPSS Output Mangement System
(OMS), but not as easily as in R.

R can create tables for presentation, too, but it also creates tables and
matrices that are optimized for further use by other functions. They are a
different form of aggregated data set. See Chap. 17, “Statistics,” for other uses
of tables.

Let us revisit simple frequencies using the table function. First, let us
look at just workshop attendance (the data frame is attached, so I am using
short variable names):
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> table(workshop)

workshop
R SAS
4 4

And now gender and workshop:

> table(gender,workshop)
workshop

gender R SAS
£f2 1
m2 2

Let us save this table to an object, myCounts, and check its mode and
class:

> myCounts <- table(gender, workshop)
> mode (myCounts)

[1] "numeric"

> class(myCounts)

[1] "table"

We see that the mode of myCounts is numeric and its class is table. Other
functions that exist to work with presummarized data know what to do with
table objects. In Chap. 15, “Traditional Graphics,” we will see the kinds of
plots we can make from tables. In Chap. 17, “Statistics,” we will also work
with table objects to calculate related values like row and column percents.

Other functions prefer count data in the form of a data frame. This is the
type of output created by the SAS SUMMARY procedure or the similar SPSS
AGGREGATE command. The as.data.frame function makes quick work
of it:

> myCountsDF <- as.data.frame(myCounts)
> myCountsDF

gender workshop Freq

1 £ R 2
2 m R 2
3 f SAS 1
4 m SAS 2
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> class(myCountsDF)
[1] "data.frame"

This approach is particularly useful for people who use analysis of variance.
You can get cell counts for very complex models in a form that is very easy
to read and use in further analyses.

10.12.5 The plyr and reshape2 Packages

If you perform a lot of data aggregation, you will want to learn how to use two
of Wickham’s packages. His plyr package [73] provides a useful set of apply-
like functions that are more comprehensive and consistent than those built
into R. His reshape2 package [70] is also very useful for aggregation. While
its main purpose is to reshape data sets, it can also aggregate them as it does
so. Its use is covered in Sect. 10.17, “Reshaping Variables to Observations and
Back.”

10.12.6 Comparing Summarization Methods

Table 10.4. Comparison of summarization functions.See Sect. 10.17 for reshape2.

Input Functions it Output
can apply
by Data frame Any function List with class of “by.” Easier to

read but not as easy to program
aggregate Data frame Only functions that Data frame. Easy to read
return single values and program

tapply List or Any function List. Easy to access components
data frame for programming. Not as nicely
formatted for reading.
table Factors Does counting only Table object. Easy to read

and easy to analyze further.
reshape2 Data frame Only functions that Data frame (dcast) or list
return single values (lcast). Easy to read and
program, especially useful
for ANOVA data.

In this section we have examined several methods of summarization. In
the following section, we will see that the by function not only does analyses
in the “by” approach used by SAS and the SPLIT FILE approach used by
SPSS, but it can also create summarized data sets. Table 10.4, can help you
choose which one to use.
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10.12.7 Example Programs for Aggregating/Summarizing Data
SAS Program for Aggregating/Summarizing Data

* Filename: Aggregate.sas ;
LIBNAME myLib 'C:\myRfolder';

* Get means of ql for each gender;
PROC SUMMARY DATA=myLib.mydata MEAN NWAY;
CLASS GENDER;
VAR qi;
OUTPUT OUT=myLib.myAgg;
RUN;
PROC PRINT; RUN;
DATA myLib.myAgg;
SET myLib.myAgg;
WHERE _STAT_='MEAN'SMEANS;
KEEP gender ql;
RUN;
PROC PRINT; RUN;

*Get means of ql by workshop and gender;
PROC SUMMARY DATA=myLib.mydata MEAN NWAY;
CLASS WORKSHOP GENDER;

VAR Q1;

OUTPUT OUT=myLib.myAgg;RUN;

PROC PRINT; RUN;

*Strip out just the mean and matching variables;
DATA myLib.myAgg;
SET myLib.myAgg;
WHERE _STAT_='MEAN';
KEEP workshop gender ql;
RENAME gl=meanQ1;
RUN;
PROC PRINT; RUN;

*Now merge aggregated data back into mydata;
PROC SORT DATA=myLib.mydata;
BY workshop gender; RUN:
PROC SORT DATA=myLib.myAgg;
BY workshop gender; RUN:
DATA myLib.mydata2;
MERGE myLib.mydata myLib.myAgg;
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BY workshop gender;
PROC PRINT; RUN;

SPSS Program for Aggregating/Summarizing Data

* Filename: Aggregate.sps .

CD 'C:\myRfolder'.
GET FILE='mydata.sav'.

AGGREGATE
/OUTFILE="myAgg.sav'
/BREAK=gender
/ql_mean = MEAN(q1).

GET FILE='myAgg.sav'.

LIST.

* Get mean of gl by workshop and gender.
GET FILE='mydata.sav'.
AGGREGATE
/OUTFILE="myAgg.sav'.
/BREAK=workshop gender
/ql_mean = MEAN(q1l).
GET FILE='myAgg.sav'.
LIST.

* Merge aggregated data back into mydata.
* This step can be saved by using

* MODE=ADDVARIABLES in the previous step.
GET FILE='mydata.sav'.

SORT CASES BY workshop (A) gender (A)
MATCH FILES /FILE=*

/TABLE="\myAgg . sav'

/BY workshop gender.

SAVE OUTFILE='mydata.sav'.

R Program for Aggregating/Summarizing Data

# Filename: Aggregate.R

setwd("c:/myRfolder")
load(file = "mydata.RData")
attach(mydata)

mydata
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# The aggregate Function.

# Means by gender.

myAggl <- aggregate(ql,
by=data.frame(gender),
mean, na.rm = TRUE)

myAggl

# Now by workshop and gender.

myAgg2 <- aggregate(ql,
by = data.frame(workshop, gender),
mean, na.rm=TRUE)

myAgg?2

mode (myAgg?2)

class(myAgg2)

# Aggregation with tapply.

myAgg2 <- tapply(ql,
data.frame(workshop, gender),
mean, na.rm = TRUE)

myAgg?2

class(myAgg2)

mode (myAgg?2)

myAgg2 <- tapply(ql,
data.frame(workshop, gender),
range, na.rm = TRUE)

myAgg?2

mode (myAgg1l)

class(myAgg2)

myAgg2[[1]]

# Example multi-level transformation.

mydata$Zql <- (gl - mean(ql) ) / sd(ql)
mydata

mySubset <- mydatal[ gl < mean(ql), ]
mySubset

# Rename x to be mean.ql.
library("reshape2")

myAgg3 <- rename(myAgg2, c(x = "mean.ql")

myAgg3

301
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# Now merge means back with mydata.
mydata2 <- merge(mydata, myAgg3,

by=c("workshop", "gender") )
mydata?2

# Tables of Counts

table (workshop)

table(gender, workshop)

myCounts <- table(gender, workshop)
mode (myCounts)

class(myCounts)

# Counts in Summary/Aggregate style.
myCountsDF <- as.data.frame(myCounts)
myCountsDF

class (myCountsDF)

# Clean up
mydata["Zql"] <- NULL
rm(myAggl, myAgg2, myAgg3,
myComplete, myMeans, myCounts, myCountsDF)

10.13 By or Split-File Processing

When you want to repeat an analysis for every level of a categorical variable,
you can use the BY statement in SAS, or the SPLIT FILE command in SPSS.
SAS requires you to sort the data by the factor variable(s) first, but SPSS and
R do not.

R has a by function, which repeats analysis for levels of factors. In
Sect. 10.12, “Creating Summarized or Aggregated Data Sets,” we did simi-
lar things while creating summary data sets. When we finish with this topic,
we will compare the two approaches.

Let us look at the by function first and then discuss how it compares to
similar functions. We will use the by function to apply the mean function.
First, let us use the mean function by itself just for review. To get the means
of our q variables, we can use

> mean( mydata[ C("ql","q2","q3","q4") ] s
+ na.rm = TRUE)

ql q2 q3 q4
3.25003.2500 2.7500 4.1429 3.7500

Now let us get means for the males and females using the by function:
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> myBYout <- by( mydatal c("q1","q2","q3","q4") 1 ,

+ mydata["gender"],
+ mean,na.rm = TRUE)
> myBYout
gender: f

ql q2 q3 q4

1.666667 1.333333 4.333333 1.666667

gender: m

ql g2 g3 94
4.50 4.25 4.00 4.50

The by function call above has four arguments:

. The data frame name or variables to analyze,

mydata[ C("ql" s ||q2|| R nq3u R ||q4n) ]

. One or more grouping factors. Unlike SAS, the data does not have to

be sorted by these factors. The factors must be in the form of a list (or
data frame, which is a type of list). Recall that single subscripting of a
data frame creates a list. So mydata["gender"] and mydata[2] work.
Adding the comma to either one will prevent them from working. There-
fore, mydatal ,"gender"] or mydatal[ ,2] will not work. If you have at-
tached the data frame, data.frame (gender) will work. The function call
list(gender) will also work, but it loses track of the grouping variable
names.

. The function to apply — in this case, the mean function. The by func-

tion can apply functions that calculate more than one value (unlike the
aggregate function).

. Any additional arguments are ignored by the by function and simply

passed on to the applied function. In this case, na.rm = TRUE is simply
passed on to the mean function.

Let us check to see what the mode and class are of the output object.

> mode (myBYout)

(1]

lllistll

> class (myBYout)

(1]

llbyll

It is a list, with a class of “by.” If we would like to convert that to a data frame,

we

can do so with the following commands. The as.table function gets the
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data into a form that the as.data.frame function can then turn into a data
frame:

> myBYdata <- as.data.frame( (as.table(myBYout) ) )
> myBYdata

gender Freq.f Freq.m

ql f 1.666667 4.50
q2 m 1.333333  4.25
93 f 4.333333  4.00
q4 m 1.666667  4.50

Now let us break the mean down by both workshop and gender. To keep
our by factors in the form of a list (or data frame), we can use any one of
these forms:

mydatal[ c("workshop", "gender")]
or

mydatal c(2, 3) ]

or, if you have attached the data frame,
data.frame( workshop, gender)

This starts to look messy, so let us put both our variable list and our factor
list into character vectors:

myVars <- C(llqlll , Ilq2’l s llq3|l , Ilq4ll)

myBys <- mydatal c("workshop", "gender") ]

By using our character vectors as arguments for the by function, it is much
easier to read. This time, let us use the range function to show that the by
function can apply functions that return more than one value.

> myBYout <- by( mydatal[myVars],
+ myBys, range, na.rm = TRUE )

> myBYout

workshop: R
gender: f

(11 15
workshop: SAS
gender: f
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workshop: R
gender: m

[11 2 5
workshop: SAS
gender: m

[1]1 4 5

That output is quite readable. Recall that when we did this same analysis
using the tapply function, the results were in a form that were optimized for
further analysis rather than communication. However, we can save the data
to a data frame if we like. The approach it takes is most interesting. Let us
see what type of object we have:

> mode (myBYout)
[1] "list"

> class(myBYout)
[1] Ilbyll

> names (myBYout)
NULL

It is a list with a class of “by” and no names. Let us look at one of its compo-
nents:

> myBYout [[1]]
[1] 1 5

This is the first set of ranges from the printout above. If we wanted to create
a data frame from these, we could bind them into the rows of a matrix and
then convert that to a data frame with

> myBYdata <- data.frame(

+  rbind( myBYout[[1]], myBYout[[2]],
+ myBYout [[3]], myBYout[[4]] )
+)

\4

myBYdata

X1 X2
1 5

DWW N -

1 4
2 5
4 5



306 10 Data Management

That approach is easy to understand but not much fun to use if we had
many more factor levels! Luckily the do.call function can call a function you
choose once, on all of the components of a list, just as if you had entered them
individually. That is quite different from the lapply function, which applies
the function you choose repeatedly on each separate component. All we have
to do is give it the function to feed the components into, rbind in this case,
and the list name, byBYout:

> myBYdata <- data.frame( do.call(rbind, myBYout) )
> myBYdata

X1 X2
1 5

SwWw N -

1 4
2 5
4 5

10.13.1 Example Programs for By or Split-File Processing
SAS Program for By or Split-File processing

* Filename: By.sas ;
LIBNAME myLib 'C:\myRfolder';

PROC MEANS DATA=myLib.mydata;
RUN;

PROC SORT DATA=myLib.mydata;
BY gender;
RUN;

PROC MEANS DATA=myLib.mydata;
BY gender;
RUN;;

PROC SORT DATA=myLib.mydata;
BY workshop gender;
RUN;

PROC MEANS DATA=myLib.mydata;
BY workshop gender;
RUN;

SPSS Program for By or Split-File processing

* Filename: By.sps .
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CD 'C:\myRfolder'.
GET FILE='mydata.sav'.

DESCRIPTIVES
VARIABLES=q1 q2 g3 q4
/STATISTICS=MEAN STDDEV MIN MAX .

SORT CASES BY gender .

SPLIT FILE
SEPARATE BY gender .

DESCRIPTIVES
VARIABLES=ql g2 q3 q4
/STATISTICS=MEAN STDDEV MIN MAX .

SORT CASES BY workshop gender .
SPLIT FILE

SEPARATE BY workshop gender .
DESCRIPTIVES

VARIABLES=ql q2 g3 g4

/STATISTICS=MEAN STDDEV MIN MAX .

R Program for By or Split-File processing

# Filename: By.R

setwd("c:/myRfolder")
load(file = "mydata.RData")
attach(mydata)
options(width=64)

mydata

# Get means of q variables for all observations.
mean( mydata[ C(llqlll’ Ilq2ll, IIqBII’ Ilq4ll) ] R
na.rm = TRUE)

# Now get means by gender.

myBYout <- by( mydatal c("q1", "g2", "g3", "q4") 1 ,
mydatal["gender"],
mean,na.rm = TRUE)

myBYout

mode (myBYout)

class(myBYout)

myBYdata <- as.data.frame( (as.table(myBYout) ) )

myBYdata
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# Get range by workshop and gender
myVars <- c("qi", "g2", "q3", "g4")
myBys <- mydatal c("workshop", "gender") ]
myBYout <- by( mydatal[myVars],
myBys, range, na.rm = TRUE )
myBYout

# Converting output to data frame.
mode (myBYout)

class(myBYout)

names (myBYout)

myBYout [[1]]

# A data frame the long way.
myBYdata <- data.frame(
rbind (myBYout [[1]], myBYout[[2]],
myBYout [[3]], myBYout[[4]])
)
myBYdata

# A data frame using do.call.

myBYdata <- data.frame( do.call( rbind, myBYout) )
myBYdata

mode (myBYdata)

class(myBYdata)

10.14 Removing Duplicate Observations

Duplicate observations frequently creep into data sets, especially those that
are merged from various other data sets. One SAS approach is to use PROC
SORT NODUPRECS to get rid of duplicates without examining them. The
SPSS approach uses the menu choice, Identify Duplicate Cases to generate
programming code that will identify or filter the observations. Of course SAS
and SPSS are powerful enough to do either approach. We will use both the
methods in R.

We will first see how to identify observations that are duplicates for every
variable (NODUPRECS) and then find those who duplicate just key values
(NODUPKEY).

10.14.1 Completely Duplicate Observations

First, let us create a data frame that takes the top two observations from
mydata and appends them to the bottom with the rbind function:
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> myDuplicates <- rbind(mydata, mydatal1:2, ])
> myDuplicates

workshop gender ql g2 g3 g4

1 R f 1 1 5 1 <- We are copying
2 SAS f 2 1 4 1 <- these two...

3 R f 2 2 4 3

4 SAS <NA>3 1 NA 3

5 R m 4 5 2 4

6 SAS m 5 4 5 5

7 R m 5 3 4 4

8 SAS m 4 5 5 5

9 R f 1 1 5 1 <- ...down here
10 SAS f 2 1 4 1 <- as duplicates.

Next we will use the unique function to find and delete them:

> myNoDuplicates <- unique(myDuplicates)

> myNoDuplicates

workshop gender ql g2 g3 q4
1 R f 1 1 5 1
2 SAS f 2 1 4 1
3 R f 2 2 4 3
4 SAS <NA>3 1 NA 3
5 R m 4 5 2 4
6 SAS m 5 4 5 5
7 R m 5 3 4 4
8 SAS m 4 5 5 5

So the unique function removed them but did not show them to us. In
a more realistic data set, we would certainly not want to print the whole
thing and examine the duplicates visually as we did above. However, knowing
more about the duplicates might help us prevent them from creeping into our
future analyses. Let us put the duplicates back and see what the duplicated
function can do:

> myDuplicates <- rbind(mydata, mydatal[1:2, 1)
> myDuplicates$DupRecs <- duplicated(myDuplicates)
> myDuplicates

workshop gender ql g2 g3 g4 DupRecs
1 R f 1 1 5 1 FALSE
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2 SAS f 2 1 4 1 FALSE
3 R f 2 2 4 3 FALSE
4 SAS <NA> 3 1 NA 3 FALSE
5 R m 4 5 2 4 FALSE
6 SAS m 5 4 5 5 FALSE
7 R m 5 3 4 4 FALSE
8 SAS m 4 5 5 5 FALSE
9 R £f 1 1 56 1 TRUE
10 SAS f 2 1 4 1 TRUE

The duplicated function added the variable named DupRecs to our data
frame. Its TRUE values show us that R has indeed located the duplicate
records. It is interesting to note that now we technically no longer have com-
plete duplicates! The original first two records now have values of FALSE,
whereas the last two, which up until now had been exact duplicates, have
values of TRUE. So they have ceased to be exact duplicates! Therefore, the
unique function would no longer identify the last two records. That is okay
because now we will just get rid of those marked TRUE after we print a report
of duplicate records.

> attach(myDuplicates)
> myDuplicates [DupRecs, ]

workshop gender ql g2 g3 g4 DupRecs
9 R f 1 1 56 1 TRUE
10 SAS f 2 1 4 1 TRUE

Finally, we will choose those not duplicated (i.e., !DupRecs) and drop the
seventh variable, which is the TRUE/FALSE variable itself:

> myNoDuplicates <- myDuplicates[!DupRecs, -7 ]

> myNoDuplicates

workshop gender ql g2 g3 q4
1 R f 1 1 5 1
2 SAS f 2 1 4 1
3 R f 2 2 4 3
4 SAS <NA>3 1 NA 3
5 R m 4 5 2 4
6 SAS m 5 4 5 5
7 R m 5 3 4 4
8 SAS m 4 5 5 5

Now our data are back to their original, duplicate-free state.
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If T were doing this just for myself, I would have left the DupRecs vari-
able as a vector outside the data frame. That would have saved me the need
to attach the data frame (simplifying the selection) and later removing this
variable. However, adding it to our small data frame made it more clear what
it was doing.

10.14.2 Duplicate Keys

SAS also has a NODUPKEY option that eliminates records that have du-
plicate key values while allowing other values to differ. This approach uses
the method in the section above, but applies it only to the key variables of
workshop and gender.

Since we are now focusing on just workshop and gender, our original data
set already contained duplicates, so our job now is to identify them.

I will first create a character vector containing the keys of interest:

> myKeys <- c("workshop", "gender")

Next, I will apply the duplicated function only to the part of the data
frame that contains our keys:

> mydata$DupKeys <- duplicated(mydatal ,myKeys])
> mydata

workshop gender ql g2 g3 g4 DupKeys

1 R f 1 1 5 1 FALSE
2 SAS f 2 1 4 1 FALSE
3 R f 2 2 4 3 TRUE
4 SAS <NA> 3 1 NA 3 FALSE
5 R m 4 5 2 4 FALSE
6 SAS m 5 4 5 5 FALSE
7 R m 5 3 4 4 TRUE
8 SAS m 4 5 5 5 TRUE

Now we see that only the first occurrence of each workshop—-gender com-
bination is considered a nonduplicate.

Using the DupKeys variable, you can now print the duplicated records or
delete them using the same steps as we used previously for records that were
complete duplicates.

10.14.3 Example Programs for Removing Duplicates
SAS Program for Removing Duplicates

* Filename: Duplicates.sas ;
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LIBNAME myLib 'C:\myRfolder';

DATA mycopy; SET myLib.mydata;
Data lastTwo;

SET myLib.mydata;

IF ID GE 7;

RUN;

DATA Duplicates;
SET mycopy lastTwo;
PROC PRINT; RUN;

PROC SORT NODUPREC DATA=Duplicates;
BY id workshop gender ql-q4;
RUN;

PROC PRINT;
RUN;

PROC SORT NODUPKEY EQUALS DATA=mycopy;
BY workshop gender;
RUN;

PROC PRINT DATA=mycopy;
RUN;;

SPSS Program for Removing Duplicates

* Filename: Duplicates.sps .

CD 'C:\myRfolder'.

GET FILE='mydata.sav'.

* Identify Duplicate Cases.

SORT CASES BY workshop(A) gender (A)
q2(A) q1(A) q3(A) q4(A)

MATCH FILES /FILE = x*

/BY workshop gender g2 ql g3 q4
/FIRST = PrimaryFirst
/LAST = PrimaryLast.

DO IF (PrimaryFirst).

+ COMPUTE MatchSequence

ELSE.

+ COMPUTE MatchSequence

END IF.

1 - Primarylast.

MatchSequence + 1.
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LEAVE MatchSequence.
FORMAT MatchSequence (f7).
COMPUTE InDupGrp = MatchSequence > 0.
SORT CASES InDupGrp(D).
MATCH FILES /FILE = *

/DROP = PrimaryFirst InDupGrp MatchSequence.
VARIABLE LABELS

PrimaryLast 'Indicator of each last matching case as Primary'.
VALUE LABELS PrimaryLast

0 'Duplicate SDuplicate Case' CaseS

1 'Primary SPrimary Case'CaseS.
VARIABLE LEVEL PrimaryLast (ORDINAL).
FREQUENCIES VARIABLES = PrimaryLast .

R Program for Removing Duplicate Observations

# Filename: Duplicates.R

setwd("c:/myRfolder")
load("mydata.RData")
mydata

# Create some duplicates.
myDuplicates <- rbind(mydata, mydatal[1:2, ])
myDuplicates

# Get rid of duplicates without seeing them.
myNoDuplicates <- unique(myDuplicates)
myNoDuplicates

# This checks for location of duplicates
# before getting rid of them.

myDuplicates <- rbind(mydata, mydata[1:2, 1)
myDuplicates

myDuplicates$DupRecs <- duplicated(myDuplicates)
myDuplicates

# Print a report of just the duplicate records.
attach(myDuplicates)
myDuplicates[DupRecs, ]

# Remove duplicates and Duplicated variable.
myNoDuplicates <- myDuplicates[!DupRecs, -7 ]



314 10 Data Management

myNoDuplicates

# Locate records with duplicate keys.

myKeys <- c("workshop", "gender")
mydata$DupKeys <- duplicated(mydatal ,myKeys])
mydata

10.15 Selecting First or Last Observations per Group

When a data set contains groups, members within each group are often sorted
in a useful order. For example, a company may have divisions divided into
departments. Each department might have salary information for each person
and a running total. So the last person’s running total value would be the
total for each department.

The SAS approach on this problem is quite flexible. Simply saying,

DATA mydata;
SET mydata;
BY workshop gender;

creates four temporary variables, first.workshop, first.gender, last.workshop
and last.gender. These all have values of 1 when true and 0 when false. These
variables vanish at the end of the data step unless you assign them to regular
variables, but that is usually not necessary.

SPSS uses a very similar approach in the MATCH FILES procedure. Nor-
mally, you think of MATCH FILES as requiring two files to join, but you
can use it in this case with only one file. It creates only a single FIRST or
LAST variable that is saved to the data set. Be careful with this approach as
it subsets the main file, so you need to save it to a new name.

SPSS can also view this problem as an aggregation. Unlike SAS, its
AGGREGATE procedure has FIRST and LAST functions. This works fine
for just a few variables, but since it requires naming every variable you wish
to save, it is not very useful for saving many variables. The example SPSS
program at the end of this section demonstrates both approaches.

The R approach to this problem demonstrates R’s extreme flexibility. It
does not have a function aimed directly at this problem. However, it is easy
to create one using several other functions. We have seen the head function
print the top few observations of a data frame. The tail function does the
same for the last few. We have also used the by function to apply a function
to groups within a data frame. We can use the by function to apply the head
function to get the first observation in each group or use the tail function to
get the last. Since the head and tail functions both have an “n=" argument,
we can not only use n = 1 to get the single first or last, but we could also use
n = 2 to get the first two or l